Photoshop CS4

FOR

DUMMIES

by Peter Bauer

WILEY
Wiley Publishing, Inc.






Photoshop CS4

FOR

DUMMIES

by Peter Bauer

WILEY
Wiley Publishing, Inc.



Photoshop® CS4 For Dummies®
Published by

Wiley Publishing, Inc.

111 River Street

Hoboken, NJ 07030-5774

www.wiley.com

Copyright © 2008 by Wiley Publishing, Inc., Indianapolis, Indiana
Published by Wiley Publishing, Inc., Indianapolis, Indiana
Published simultaneously in Canada

No part of this publication may be reproduced, stored in a retrieval system or transmitted in any form or
by any means, electronic, mechanical, photocopying, recording, scanning or otherwise, except as permit-
ted under Sections 107 or 108 of the 1976 United States Copyright Act, without either the prior written
permission of the Publisher, or authorization through payment of the appropriate per-copy fee to the
Copyright Clearance Center, 222 Rosewood Drive, Danvers, MA 01923, (978) 750-8400, fax (978) 646-8600.
Requests to the Publisher for permission should be addressed to the Legal Department, Wiley Publishing,
Inc., 10475 Crosspoint Blvd., Indianapolis, IN 46256, (317) 572-3447, fax (317) 572-4355, or online at
http://www.wiley.com/go/permissions.

Trademarks: Wiley, the Wiley Publishing logo, For Dummies, the Dummies Man logo, A Reference for the
Rest of Us!, The Dummies Way, Dummies Daily, The Fun and Easy Way, Dummies.com, and related trade
dress are trademarks or registered trademarks of John Wiley & Sons, Inc. and/or its affiliates in the United
States and other countries, and may not be used without written permission. Adobe and Photoshop are reg-
istered trademarks of Adobe Systems Incorporated. All other trademarks are the property of their respec-
tive owners. Wiley Publishing, Inc., is not associated with any product or vendor mentioned in this book.

LIMIT OF LIABILITY/DISCLAIMER OF WARRANTY: THE PUBLISHER AND THE AUTHOR MAKE NO REP-
RESENTATIONS OR WARRANTIES WITH RESPECT TO THE ACCURACY OR COMPLETENESS OF THE
CONTENTS OF THIS WORK AND SPECIFICALLY DISCLAIM ALL WARRANTIES, INCLUDING WITHOUT
LIMITATION WARRANTIES OF FITNESS FOR A PARTICULAR PURPOSE. NO WARRANTY MAY BE CRE-
ATED OR EXTENDED BY SALES OR PROMOTIONAL MATERIALS. THE ADVICE AND STRATEGIES CON-
TAINED HEREIN MAY NOT BE SUITABLE FOR EVERY SITUATION. THIS WORK IS SOLD WITH THE
UNDERSTANDING THAT THE PUBLISHER IS NOT ENGAGED IN RENDERING LEGAL, ACCOUNTING, OR
OTHER PROFESSIONAL SERVICES. IF PROFESSIONAL ASSISTANCE IS REQUIRED, THE SERVICES OF A
COMPETENT PROFESSIONAL PERSON SHOULD BE SOUGHT. NEITHER THE PUBLISHER NOR THE
AUTHOR SHALL BE LIABLE FOR DAMAGES ARISING HEREFROM. THE FACT THAT AN ORGANIZATION
OR WEBSITE IS REFERRED TO IN THIS WORK AS A CITATION AND/OR A POTENTIAL SOURCE OF FUR-
THER INFORMATION DOES NOT MEAN THAT THE AUTHOR OR THE PUBLISHER ENDORSES THE
INFORMATION THE ORGANIZATION OR WEBSITE MAY PROVIDE OR RECOMMENDATIONS IT MAY
MAKE. FURTHER, READERS SHOULD BE AWARE THAT INTERNET WEBSITES LISTED IN THIS WORK
MAY HAVE CHANGED OR DISAPPEARED BETWEEN WHEN THIS WORK WAS WRITTEN AND WHEN IT
IS READ.

For general information on our other products and services, please contact our Customer Care
Department within the U.S. at 800-762-2974, outside the U.S. at 317-572-3993, or fax 317-572-4002.

For technical support, please visit www.wiley.com/techsupport.

Wiley also publishes its books in a variety of electronic formats. Some content that appears in print may
not be available in electronic books.

Library of Congress Control Number: 2008934803
ISBN: 978-0-470-32725-8

Manufactured in the United States of America
10987654321

WILEY



About the Author

Peter Bauer is best known as the Help Desk Director for the National
Association of Photoshop Professionals (NAPP), but he has also authored

or coauthored a dozen books on Adobe Photoshop, Illustrator, computer
graphics, and photography. Pete is also the host of video-training titles at
Lynda.com, a contributing writer for Photoshop User and Layers magazines,
and an award-winning fine-art photographer. An Adobe Certified Expert, he
also appears regularly as a member of the Photoshop World Instructor Dream
Team. As NAPP Help Desk Director, Pete personally answers thousands of
e-mail questions annually about Photoshop and computer graphics. He has
contributed to and assisted on such projects as feature film special effects,
major book and magazine publications, award-winning Web sites, and fine art
exhibitions. He has taught computer graphics at the university level, serves
as a computer graphics efficiency consultant for a select corporate clientele,
and shoots exclusive photographic portraiture. Pete and his wife, Professor
Mary Ellen O’Connell, of the University of Notre Dame Law School, live in
South Bend, Indiana. Despite being considered a world-class technogeek,
Pete still plays organized ice hockey:.






Dedication

For my wife — I am continually in awe of all you have accomplished and all
you continue to accomplish! Your dedication to the law governing armed
conflict makes the world a safer and more civilized place.

Author’s Acknowledgments

First, I'd like to thank Bob Woerner and Linda Morris of Wiley, as well as

Ron Rockwell and the rest of the superb crew at Wiley that put the book itself
together. I'd also like to acknowledge Scott and Kalebra Kelby, Jean Kendra,
Larry Becker, Jeff Kelby, and Dave Moser of the National Association of
Photoshop Professionals (NAPP), who make my professional life what it is
today. With their support, 'm the Help Desk Director for NAPP, and get to
share my Photoshop knowledge with tens of thousands of NAPP members —
and with you. I also thank my Help Desk colleagues Jeanne Rubbo and Rob
Sylvan for their support during the development of this book.

Another great group from whom I continue to receive support are my col-
leagues on the Photoshop World Instructor Dream Team. If you haven’t been
to Photoshop World, try to make it — soon. Rather than “Photoshop confer-
ence” think “Photoshop festival.” Where else can you see suits and slackers,
side by side, savoring every single syllable? It's more than just training and
learning, it’s a truly intellectually invigorating environment. (I most especially
value the incredibly-stimulating conversations with renowned photographers
Vincent Versace and John Paul Caponigro — hail the S6ze Society!) I would
also like to single out Robb Kerr, one of the original Photoshop World instruc-
tors, who continues to inspire me both spiritually and intellectually.

And, of course, | thank my wife, the wonderful Professor Mary Ellen O’Connell
of the Notre Dame Law School, for her unwavering support during yet
another book project, all the while finishing her own extremely important

The Power and Purpose of International Law (Oxford University Press).



Publisher’s Acknowledgments

We’re proud of this book; please send us your comments through our online registration form
located at www .dummies.com/register/.

Some of the people who helped bring this book to market include the following:

Acquisitions and Editorial Composition Services
Project Editor: Linda Morris Project Coordinator: Katie Key
Senior Acquisitions Editor: Bob Woerner Layout and Graphics: Reuben W. Davis,

Melissa Jester, Ronald Terry,

Editor: Linda Morri
Copy Editor: Linda Morris Christine Williams, Erin Zeltner

Technical Editor: Ron Rockwell

Editorial Manager: Jodi Jensen

Proofreaders: Laura Albert, Lisa Stiers

Indexer: Sharon Shock
Editorial Assistant: Amanda Foxworth

Sr. Editorial Assistant: Cherie Case

Cartoons: Rich Tennant
(www . the5thwave . com)

Publishing and Editorial for Technology Dummies
Richard Swadley, Vice President and Executive Group Publisher
Andy Cummings, Vice President and Publisher
Mary Bednarek, Executive Acquisitions Director
Mary C. Corder, Editorial Director
Publishing for Consumer Dummies
Diane Graves Steele, Vice President and Publisher
Composition Services
Gerry Fahey, Vice President of Production Services

Debbie Stailey, Director of Composition Services



Contents at a Glance

TNEFOAUCEION .......eeeeeeeeeeeaaaeeeeeeeeeennnnnaaeeeeeeeeennnnnsseseeeeeene ]

Part I: Breezing through Basic Training.............cccceeueeec ¥

Chapter 1: Welcome to PhotosShop!..........oooiiiiiiii e 9
Chapter 2: Knowing Just Enough about Digital Images...........ccccoevvevervirniinvienciennenne. 23
Chapter 3: Taking the Chef’s Tour of Your Photoshop Kitchen...........c.cccccevveeurennnne. 43
Chapter 4: Getting Images into and out of Photoshop ..........cccceceveniiinininiene. 65

Part 1I: Easy Enhancements for Digital Images .............85

Chapter 5: Adding Dark Shadows and Sparkling Highlights ..........cccccecvvininveciennen. 87
Chapter 6: Making Color LOOK Natural ..........ccceevieniienieniienieiienienecseeie e 107
Chapter 7: The Adobe Camera Raw PIUg-In ..........ccocveviieiiiniiiiiiiieciccceceeeeee 133
Chapter 8: Fine-Tuning YOUr FiXeS.........ccccoeiiiiiiieiininiiieeeeeeee e 157
Chapter 9: Common Problems and Their Cures.............cccoeeuveeeiieeciieecieecie e 185
Part I11: Creating “Art” in Photoshop ...............cccccee.. 199
Chapter 10: Combining IMAagEeS ........cccevviirierieiiiiieieeececte ettt 201
Chapter 11: Precision Edges with Vector Paths .........ccccccoeviiiiiiienieniiicicecee 223
Chapter 12: Dressing Up Images with Layer Styles.........cccccovevininiiniineieieeene 247
Chapter 13: Giving Your Images a Text MeSSaGE ......cccevvverierieneeniiiieieeieeeeeeenieens 271
Chapter 14: Painting in PhotoShop .......cccceviiiiiiiiiicecee e 297
Chapter 15: Filters: The Fun Side of PhotoShop..........ccccvevviviiiiiiicicicceeeeee 315
Part IU: Power Photoshop...............ccceeeceeeeaeeeacenaaaen 333
Chapter 16: Streamlining Your Work in PhotosShop ... 335
Chapter 17: Introducing Photoshop CS4 Extended..........ccccooieviiniininniinnieniienienene 357
Part U: The Part of Tens .........cccccueeeeiaceeeeccaacneeeecaaaeees 309
Chapter 18: Pete’s Top Ten Favorite Photoshop Tips and Tricks.........cccccecvevvennenne 371
Chapter 19: Ten Reasons to Love Your Wacom Tablet ..........ccccceveevieiiinnienniennennnnne 381
Chapter 20: Ten Reasons to Own a Digital Camera..........cccceevevierieninirnienieneneseeeene 385

Indes .......cceaoeaauaiaiaainiaananennennencaeneeceeceecaccncenceceas 389






Table of Contents

JHEFOAUCTION .........eeeeeeeeeeeeeeeeenaaaaaeeeeeeeeeeeeeessnnnnnnnnnsseeeeaseeees |

ADbOUt This BOOK........oviiiiiiiiiiiiieeee et 1

How This Book Is Organized...........ccccooeverininieieeeieeceeeeeeese e 2

Part [: Breezing through Basic Training..........cccccoeeevvervienvienieneennenne. 2

Part II: Easy Enhancements for Digital Images ..........cccccocvevveneenennee. 3

Part III: Creating “Art” in PhotoShop.......ccccecevveverivieeeeee e, 3

Part IV: Power PhotOShOD ......ccocviiiiiiicieieeceeeeee e 3

Part V: The Part of TENS......ccccceeviieiiiiecieieeeeeeeeeee e 3
Conventions Used in This BOOK .........ccccceviiiiiiiiiniiiniiiicceeceeeeeeeee 4
Icons Used in This BOOK.........ccccoviviiiiiiiiniiiicicccceeeecceccene e 4

How to Use This BOOK ......c.coiiuiiiiiiiiicieeieee ettt 5
Part I: Breezing through Basic Training...............ccoeeeceeecanenns 7
Chapter 1: Welcome to Photoshop! ................. ...t 9
Exploring Adobe PhotoShop........cccoveeiiiiieecee e 10
What Photoshop is designed to do.......ccccevvevieriieciiiniieeiieeieee. 10

Other things you can do with Photoshop........cccccceeveviiniiiieinnnnns 12

If you don’t have specialized software ...........cocceevevienienieneeniennnenns 14

Viewing Photoshop’s Parts and Processes...........cccoeeeieeieciieneesieecieeienns 16
Reviewing basic computer operations...........ccecceeveieenieenieeniieennnnn. 16
Photoshop’s incredible selective Undo........c.cccceeevevvenienieneeniennnns 18

Installing Photoshop: Need to KNow ..........cccccevviiviieniiniiniinciienens 20

Chapter 2: Knowing Just Enough about Digital Images .................. 23
What Exactly Is a Digital Image?........ccocovievieniiiiiiiiiieiesteeeeeeeeeiene 24

The True Nature of Pixels ........ccccocooiiiiiiiininiccceeceeeeen 24

How Many Pixels Can Dance on the Head of a Pin?...........c.ccocooinenne. 26
Resolution revelations...........ccceeceiieniienieiecieeiececeseee e 27

Resolving image resolution...........coceecveviiiiniiinnieniienieieeeceeeiee 28

File Formats: Which Do You Need? ..........ccccccooinininiiiininiincceeeeeees 36
Formats for digital photosS.......c.ccceeiieieeiecicicecece e 37

Formats for Web graphicCs .......ccccccovviiviinienienieicecieeeeeeeeeiee 39

Formats for commercial printing .........c.ccocevevvinieniinienieneeenens 40

Formats for PowerPoint and Word............cccoeoveinieneninencnceenee. 40

Chapter 3: Taking the Chef's Tour of Your Photoshop Kitchen ............ 43
Food for Thought: How Things WOrk ..........cccceveriiiniiniiniiniieneeieneee 44
Ordering from the MenuUS ..........cccceeieviieciiiciicieeeceeeeee e 44

Your platter full of panels.........cccoceevieeienieniiinieceiecc e 45

The tools of your trade.........cceceviirieriinieiiieeeeeeeeee e 47

Get Cookin’ with Customization.........c.ccccveeieireriiincnenccncceeceeeen 49
Clearing the table: Custom WOrkSpaces.........c.cccceeueveeneneneeceneennens 49

Sugar and spice, shortcuts are nice..........ccceeueevieevieriereenieneeieeiens 52

Spoons can’t chop: Creating tool presets .........cccceeveevieneeneeniennens 53



X

Photoshop CS4 For Dummies

Season to Taste: The Photoshop Settings.........cccecceevvevienienieniinneniee, 54
Standing orders: Setting the Preferences..........cccccoecvevieniinenncnnnens 54
Ensuring consistency: Color Settings ...........cccceceevieverenenenceeeenen. 61

When Good Programs Go Bad: Fixing Photoshop ........cccccceevvevieniecieennnn. 62

Chapter 4: Getting Images into and out of Photoshop ................... 65

Bringing Images into PhotoShop .......ccccoovevieiiieiicciiieeeeceee 65
Downloading from your digital camera..........cccoeevevcveneenieneeniennnnnns 67
SCANNING PIINES ...viiiiiiiiiiciieiececee ettt seene e 68

Keeping Your Images Organized...........ccceecveeieneienieneenieenieeieeieeee e 71
Creating a folder StruCture...........coceevveeiinieniienierecceeeeceee e 71
Using Adobe Bridge........coceevueeiiriiniiniiiieiecieeieeestestesteee e 72
Renaming image files €asily ........ccccevererinininieeeeeceeeeen 75

Printing YOUr IMA@es........ccuieiiiiieiieiecieseeeeeee ettt 75
Cropping to a specific aspect ratio ........ccccceevvevviencienienieneeecieeies 76
Remembering resolution ............cccoccvveeiiiiiiiesciecie e 78
Controlling color using Filem>Print .........cccovvieviiiiiiniiiciecciees 78
Considering color management SOIUtiONS .........ccccoevereerieenieeniennen. 80
Printing alternatives........occooeiieriiiiinieniceceeeeeeeee e 81

Sharing YOUr IMAZES ........cccueuerierireniieieeieteiese ettt 83
Creating PDFs and Web Sites .......ccccecieciiriiieiienienienieseeeeieeie e 83
E-mailing your images........ccccceceeiiriinienieieeieeieceeeeeseeseeeeie e 83

Part I1: Easy Enhancements for Digital Images ....................85

Chapter 5: Adding Dark Shadows and Sparkling Highlights ............. 87
Adjusting Tonality to Make Your Images Pop........cccocevvvevieniiniencnienienns 88
Histograms Simplified...........cccooiriiniiniiniiiee e 88
Using Photoshop’s Auto Corrections ..........ccoeceeeveeieiienieneneneececeeeeenen 92
Levels and Curves and YOU........ccceecuirrieerieeieniienienieneeieesie e eve e 93

Level-headed youl........oocoviiiiiiiiiiinieneteeceeee et 94
Tonal corrections with the eyedroppers..........cccccceevevieieeneecieenns 96
Adjusting your curves without dieting...........cccoceeveeviivinvenencennen. 97
Grabbing Even More Control........c.cccocvvvieeienieniienienienceeeieeeeee e 100
Using Shadow/Highlight .........ccccccooiiiiiiiieiieicececeeeeeeee e, 101
Changing exposure after the fact ...........coceoeieiinniniiiieee 104
Using Photoshop’s toning tools..........ccceceeeveeviinnieeiieniienieneeeeieee, 105

Chapter 6: Making Color Look Natural ............................... 107

What Is Color in PhotoShop?.......ccceiiiiiiiiniiiiciciceeeeeeeee 107
Color modes, models, and depths .........cccccoveeiieeiiecciecieeee e, 108
Recording color in your image ...........ccceeeveeeeeeiieenieecieeeieeeeeeeen. 113

Making Color Adjustments in PhotoShop.........cccocvevvevieiieciiniicieeiee 113
Watching the Histogram and Info panels ........c.cccccoeeeniiniininnnnns 114
Choosing color adjustment commands............ccceceeveerrienreesreenennen. 116
Working with Variations ...........cccecceevieevienienienieccecieeieeeeeeeeene 129
Manual corrections in individual channels............c.ccoceerienennnnnee. 130

The People Factor: Flesh Tone Formulas...........cccoocveeiiieiiieciiiieeiees 131

Chapter 7: The Adobe CameraRaw Plug-In ........................... 133
Understanding the Raw Facts........ccccooiiiiiniiiiniiiiieecceeeee 133

What’s the big deal about Raw?..........cccccovevienieniieiiieiiciecieeeeeeas 134

WOrKing in RAW .....ocviiiiiiiieiciecececeteeseee et 135



Table of Contents Xi

Do You Have What It TaKeS? ......cccuevieviiiiieiieieciecieceeseeeee e 137
Working in the Camera Raw Plug-In.........ccocoviiiiiiininiiniiicieeeee, 138
Tools and preview OpPtioNS........ccccceierieverierieeeeeeeeeeeeee e 138

The hiStOGrami.......ccccoieiiiiiieiieieeie e 143

The PreVIEW QI€a .....cc.cevuiiiieiieiiiiiniienienieeieeie ettt 144
Workflow options and Presets.........cccoccveeeiieeciieccieeeciie e 144

The Basic PAnel ........ccooiioiieiiieiicieceeceeeee et 146
Adjusting the tONe CUIVE........cccveviieiieieceeceeeeece e 148

The Detail panel...........cc.cooiiiiiieiiieieceeeee e 149

HSL, grayscale, and split tONINg .........ccceceevieierierereeeeeeeieeee e 152
Compensating with Lens Correction ............ccccoceevevveevienenenenenene 153
Customizing camera profiles and the Presets tab.......................... 155

The Camera Raw BUttons ..........cccoevevvivieieieieieseseeeeeeeee e 155
Chapter 8: Fine-Tuning YourFixes ..., 157
What Is @ SEleCtioN? ........ccoeoviiiieiieeeiceeeeeee et 158
Feathering and Anti-Aliasing.........cceccevvieiiiniiniiniienienieeececeeeeee e 160
Making Your Selections with TOOIS .........ccceeieieiiiniiniicieceeeeee 162
Marquee selection tOOlS ........cceevveviierieeiieieceeeeeee e 162
Lasso selection tOOIS .........cocuevcueeiinienienieiccceeeee e 165

The Quick Selection tOOl ........cc.eoeevvviiieeiiiececieee e 167

The Magic Wand toOl ..........cceecieeiiiiinieceeeeeee e 168
RefiNE EAGE.....uooiieiieiiieieeteeteeeee et 168

Your Selection COMMANAS ........ccecuerierienienienieeieeieeeeteseese e 169
The primary selection commands ..........cccccecveevieeeiiencieenieeeeeeen. 170

The Color Range command............ccccoeiririeiieneninineceeeeee e 170
Selection modification commands..........ccceeceeveneneninienienienenenn. 172
Transforming the shape of selections ...........ccocceevveviiininninncnnnnnen. 173

The mask-related selection commands.........c.cccceceeevceececiincncnnen. 174
Masks: Not Just for Halloween Anymore ...........ccccocevevinenieneenieneneniene 175
Saving and loading selections...........ccceecvevieeiienieeieniienieeeeeeee, 175
Editing an alpha channel ...........c.ccoooviiniiininnineee, 176
Working in Quick Mask mode ..........ccocceeeieiiieiienieieciecieeeeeeeeeae 178
Adding masks to layers and Smart Objects .........cccceceeevieceeniennennns 178
Masking with vector paths........cccooeeveeviiicieiinceeceee e, 179
Adjustment Layers: Controlling Changes.........ccccoccevvveviienciinienennennennee. 179
Adding an adjustment [ayer ..........cceceevverieniereneneeeee e 180
Limiting your adjustments ............ccccovvvevieniieniesiecieceecceceee e 181
Chapter 9: Common Problems and TheirCures ........................ 185
Making People Prettier .........cooooieiiieeiiieieciecece e 186
Getting the red out . . . digitally .......ccoeeviiriiiiviieiieeeeeeeee, 186

The digital fountain of youth ..........cccoceviiiiiiiniiiie, 187
Dieting digitally........coceriiriiiiiirieeeeeee s 188
De-glaring glasSes .......cccuivuiirierrieriienieneesieeeee et 189
Whitening teeth ........cccoviiiiiiiiicicceeeee e 190
Reducing Noise in Your Images .........ccccevvevieeieriieniienienieneeieeieeieeveeenn 191
Decreasing digital NOISe.........ccccoeviiriiriiniiiiiieeeeeeen 191
Eliminating luminance NOiSe...........cccccvevieeiieiiiecieeiecieceeceeee e 192
Fooling Around with Mother Nature...........cccccoeeeeviiriiinienieieeeeeeieee 192
Removing the unwanted from photos ........ccccecevviiriininninnceinnen. 192
Eliminating the lean: Fixing perspective ...........cccceevevciieriienreenneen. 197

Rotating images PreciSely ......ccovviiierienieciiecieeieeeeeecee e 198



Xl‘ i Photoshop CS4 For Dummies

Part I11: Creating “Art” in Photoshop ................ccccceueeeeeec. 199

Chapter 10: Combininglmages ...................ccoiiiiiiiiiinnnnnt. 201
Compositing Images: 1 + 1 = L. 201
Understanding layers.........cccceeeiieeiiieecieeiieee e 202

Why you should use Smart Objects........cccceeevereninceniienienenenenene 203
Using the basic blending modes...........ccccocevviieniiecieniienienieeeeenee, 204
Opacity, transparency, and layer masks.........c.ccoeceeveenenneeneneennne. 207
Creating Clipping SroUPS .......ccceevievieevieeieeieeie ettt 208
Making composited elements look natural............cccceevevieenueennnnen. 209
Making Complex SeleCtions ..........cccveviirriiriieriienienieseeeeieee e 211
Vanishing POINt........cooiiiiiiiiiieee s 213
Putting Together Images Automatically........c.cccceecverienieneeniiesiecieeieeen, 217
Creating panoramas with Photomerge.........c.ccccoocvevieviinienieennnnen. 217
Combining exposures for HDR images .........cccocevvvevvenieneeniennenen. 219
Chapter 11: Precision Edges with VectorPaths ....................... 223
Pixels, Paths, and YOU.........ccccovviieiiiieniiiccecece e 224
Easy Vectors: Using Shape Layers .......ccccooeeveeiienieniieneeneeieeieeieeeeeene 226
Your basic shape tools...........cceeciieeeiieciiee e 226

The Custom Shape tool ..........ccooievieiiniriieeeeee e 227
More custom shapes — free! ........cccocveviveviieiiiniieniienieeeeeeee e, 229
Changing the appearance of the shape layer ...........cccccovveennnnnee. 231
Simulating a multicolor shape layer ............cccoeeevveevienienieneeieen. 231
Using Your Pen Tool to Create Paths.........cccccceeviieiinienienicieccceeee 233
Understanding paths .........cooeeveeiiiiiiniincceeeceee e 233
Clicking and dragging your way down the path of knowledge.....234

A closer look at the Paths panel..........ccccccoovevieiieciieciciicieeeees 237
Customizing Any Path ........ccccooiiiiiiiiieeceeeee e 241
Adding, deleting, and moving anchor points.........ccccceeevevcveneenennns 241
Combining Paths ....cccueviiiiiie e 244
Tweaking type for a custom font..........ccceeveeieviecieecieniecieeeee, 245
Chapter 12: Dressing Up Images with Layer Styles .................... 247
What Are Layer STYLES?......ccooirieieieieereeeeeet et 248
Using the Styles Panel ..........ccoociviieieiiiiieeceee e 250
Creating Custom Layer Styles.......cccovieviieieriienienieneeieeeee e 251
Exploring the Layer Style menu...........ccoceeevevevieneneeenceieieeeeene 252
Exploring the Layer Style dialog boX........ccccceveveveeircienieieceeee 253
Layer effects DaSiCS.....c.ociiievieieieieeeceeeeeee e 255
Opacity, fill, and advanced blending...........c.ccceevevvierieneeneeneenennnn. 264
Saving Your Layer StYLES ........cocevieriiniinieieeieeieeeestesteeeie e 267
Adding styles to the Style panel..........cccccooveiieiiecieecieeiecieeeeeeas 267
Preserving your layer Styles .........ccccoovevieciienieenieeieeiesieseesieeve e 268
Chapter 13: Giving Your Images a Text Message ...................... 2n
Making a Word Worth a Thousand Pixels ........c.ccocceviiieniiiniieniieeieee, 272
A type tool for every season, Or r€aSOM ...........eceevueeveeveneeneeneenns 274
What are all those options? ..........cccceevvieeiiiciiiceeeeeee s 277

Taking control of your text with panels............ccccoeeviiviienieninnnnen. 280



Table of Contents

The panel menus — even more OptionS.........coceecveeceeneeneenieeeennne. 284
Putting a picture in your text........cccoevevieiiniinnenienieneeeeeeeen 286
Creating Paragraphs with Type Containers..........ccccocceecereereenienienenenene 288
Selecting alignment or justification...........cccccceeveeviencienienieneeienee, 290
Ready, BREAK! Hyphenating your text .........cccooceevvevciinienieneeiennen. 291
Shaping Up Your Language with Warp Text and Type on a Path........... 292
Applying the predefined Warps .......c.cccceeveeveenieniececieeieeeeeeeeeae 292
Customizing the course with paths ........ccccecevviiiviiiiniiieecee, 293
Chapter 14: Painting in Photoshop . .................. ..ottt 297
Discovering Photoshop’s Painting ToOIS ........cccccccevievienieniieniecieeieeene 298
Painting with the Brush tool .........c.cccocveviiiiiiiiniiieeeee, 299
Adding color with the Pencil tool..........ccccoocivviiiiniiniiniiiiieees 302
Removing color with the Eraser tool..........cccoveeiiiiniininncnnenne. 302
PicKiNg @ COLOT ....oiiiiiiiiieiieiecece et 303
Working with other brush-using tools..........ccccccccevererenceeeeiennne. 305
Filling, stroking, and dumping to add color ...........ccceverrirnuennennen. 308
USING Gradients ........coeeviiiiiiiiinierientete et 309
Browsing the Brushes Panel.............ccccoviiiieiiiniiniiiiieeceeeeeeee 310
An overview of OPtiONS.........ccoieviiiiiieeeceeeee s 311
Creating and saving custom brush tips.........ccccceverevieniincinreenienee. 314
Chapter 15: Filters: The Fun Side of Photoshop ........................ 315
Smart Filters: Your Creative Insurance Policy........cccocevviininninnieniencn. 315
The Filters You Really Need...........ccceeiiiieiiiiiieciieeeeeceeeee e 317
Sharpening to focus the eye........c.cccoevvevievieiievicieeee, 317
UnSharp MasK ......couoviiiiiiiiiiciececeeeeeeee e 318
SMArt SHArPEN ......ccvieeeiiiiieceeeeeee e 319
Blurring images or selections .......c..ccoceeveeveeiinnenicnicnceeeeeen 320
Using the Lens Correction filter..........ccoceveevieniieiieniienienieeeieeeee, 324
Cleaning up with Reduce NOiSe€ .......cccceevuvriiriiinieniiiececceeeee, 325
Getting Creative with the Filter Gallery..........ccccooveviiniiiiniinninierenee 327
Push, Pull, and Twist with Liquify........cccceevievieiiiiiiiieieeeeeceeee 329
Do I Need Those Other Filters? .........cccccoveviniriniiiiininineneeeereseee 332
Bending and bubbling.........ccceeceriiiniiniiniiiiciieceeeeee e 332
Creating CloOUdS ........ccueevieieiiieiieeeeee et 332
Part IU: Power PROtOSAOP.............cccceeeeecueeicccrecieaceeceeaaccs 333
Chapter 16: Streamlining Your Work in Photeshop .................... 335
Ready, Set, ACHION!........ooiiiiiiieiieeeeecee e 336
Recording your own AcCtions.........coceeveeveriiiniinnienienienceeeeeeeeen 337
Working with the Batch command...........ccccoooveiieiiiiiiiiiiiieiees 342
Sticking to the SCrIPL ...ooveviieiiieiieieeeee e 343
Tooling around in Bridge..........cccocuevieniiniiniiiicieciecieeeceeeeee e 346
Creating Presentations and Multi-page PDFS .........ccccccoveeieiiieciieciecienen, 348
Creating a PDF presentation ..........coccoceveeveiiineninincnieeeneeee 349
Collecting thumbnails in a contact sheet.......c.ccoceevevirrienieennnnnn. 351
Saving paper with picture packages ...........ccccevevvieriienienieneeiennnn. 354

Creating Web Galleries ..........covevuieeiieiiieiieeiecieeeeseeie e 354

XIi



XI‘ (/ Photoshop CS4 For Dummies

Chapter 17: Introducing Photoshop CS4 Extended ..................... 357
Understanding Photoshop CS4 Extended...........ccccoevvevvenieniinnieenieniennnne 358
Painting and Layers in 32-Bit COlOT..........cccoecvrieieieieieeeecceeee e 358
Smart Object Stack MOAES........coveieieieieiieeeeeee e 360
Working with 3D ArtWOrK........cccieieiiiiiieiieeeeeeeeeee e 361
Editing Imported VIAEO ........ccocueviirieniiiieiecieciecteceseeeeie e 362
Measuring, Counting, and Analyzing Pixels........c.cccocevirvinninninnenienene 364

Measuring length, area, and more...........coccceeeveerieneenenneeneneennne. 364

Counting crows or maybe avian flu ..........cccoceevveevienienienieneeieen, 366

Ignoring MATLAB, DICOM, and Other Initials........cccccoccovenennnenincncnnn. 367

Part U: The Part of Tens ..........ccceeeeeeaaceeeeecaaneeeeeeasaneeeeean 369

Chapter 18: Pete’s Top Ten Favorite Photoshop Tips and Tricks.......... 3n

Adding Artistic and Creative Effects........cccooeeiivieciiiiiiniicieieeeeeeee, 371
Smoothing skin perfectly.......ccccoceviiniinieniniiieeeeeee, 372
From a photo to a painting........cccccecevieviiiiniinnineneeeeeee, 373
Creating a sketch from a photo ........cccoeeeeiiiiiiiiiniieee 374
Creating SNOW OF FAIM.....cccceriierieriienieeieeieeieeieeeeseesieesseesaeesaeeaeennas 376
The Glass Text effect......ccvviviniiiienieee e, 377

Useful Tricks to Make Life Easier .........ccccocoevevveiiiinincnnnccccncene 377
Changing product colors in @ SNAP ........ccceeeevierinenenieieereseeeene 377
Deleting a plain white background...........c.cccceevirviiniiiniinieneeienen. 377
Quick and easy edge effects......c.coveeveriiirciiniinieieeen 378
Making dashed and dotted lines ..........cccceeevieeiienieeeciieeieeee e, 379
Printing multiple documents at the same time..............ccccccueneenee. 380

Chapter 19: Ten Reasons to Love Your Wacom Tablet .................. 381
More Natural MOVEMENL ........ccceecueeiiieiiieieeieeiecieeeeeeeesve e eveeaeeae e seeens 381
Health and Safety .......c.cocevieiiiiiiieiececeeeeeeee e 381
Artistic CONTIOL......ooiiiiiiieiicieeeceeeee e 382
Extended COmIOTt........cooveriiriirieieieeeeee e 382
Programmable ExpressKeys and Touch Strips ........ccccooeeieveieiencnenene 382
The Optimal Tablet ......c.ccoiiiiieiiiieieeeeeeeee e 383
The Pen’s SWItCH ..c..cooiiiiici e 383
Setting Prefer€nCes ........oooievieiieieeieeeeeeeeee ettt 383
Don’t forget the aCCeSSOTIES ......cccvivuiiviiiieiieiecece e 384
Cintiq for the Ultimate CONtrol...........ccceceevieriienienienieneeeeieeeeeeeee e 384

Chapter 20: Ten Reasons to Own a Digital Camera .................... 385
Shooting Digital for Your WOrK..........ccccovverieiiieiiieiieiieneeseeieesieeieeee e 386
Shooting Digital for Yourself..........cccoooviniiniiiiniiniinienecececeeeiene 387
Shooting Digital for the Rest of Us.......ccccoveiiiniiiniiniinieceeeeee 388

JRACK «...nnnnnnnnnnennaneeneeeneeneeeeeeeeeeeeeeeeeeeeeeeeeeececceceeeees 389



Introduction

A dobe Photoshop is one of the most important computer programs of
our age. It’s made photo editing a commonplace thing, something for
the everyperson. Still, Photoshop can be a scary thing (especially that first
purchase price!), comprising a jungle of menus and panels and tools and
options and shortcuts as well as a bewildering array of add-ons and plug-ins.
And that’s why you’re holding this book in your hands. And why I wrote it.
And why Wiley published it.

You want to make sense of Photoshop — or, at the very least, be able to work
competently and efficiently in the program, accomplishing those tasks that
need to get done. You want a reference that discusses how things work and
what things do, not in a technogeek or encyclopedic manner, but rather as an
experienced friend might explain something to you. Although step-by-step
explanations are okay if they show how something works, you don’t need
rote recipes that don’t apply to the work you do. You don’t mind discovering
tricks, as long as they can be applied to your images and artwork in a produc-
tive, meaningful manner. You're in the right place!

About This Book

This is a For Dummies book, and as such, it was produced with an eye toward
you and your needs. From Day One, the goal has been to put into your hands
the book that makes Photoshop understandable and useable. You won'’t find
a technical explanation of every option for every tool in every situation, but
rather a concise explanation of those parts of Photoshop you’re most likely
to need. If you happen to be a medical researcher working toward a cure for
cancer, your Photoshop requirements might be substantially more specific
than what you’ll find covered here. But for the overwhelming majority of the
people who have access to Adobe Photoshop, this book provides the back-
ground needed to get your work done with Photoshop.

As I updated this book, I intentionally tried to strike a balance between the
types of images with which you’re most likely to work and those visually
stimulating (yet far less common) images of unusual subjects from far away
places. At no point in this book does flavor override foundation. When you
need to see a practical example, that’s what I show you. I included a number
of images from PhotoSpin.com, my favorite subscription stock art source.
But, again, [ worked to ensure that each piece of artwork illustrates a tech-
nique and does so in a meaningful, nondistracting way for you.
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You'll see that I used mostly Apple computers in producing this book. That’s
simply a matter of choice and convenience. You'll also see (if you look
closely) that I shoot mostly with Canon cameras and use Epson printers.
That doesn’t mean that you shouldn’t shoot with Nikon, Sony, or Fuji, or that
you shouldn’t print with HP or Canon. If that’s what you have, if it’s what
you’re comfortable with, and if it fulfills your needs, stick with it! You'll also
find that I mention Wacom drawing tablets here and there (and devoted one
of the final chapters to the subject). Does that mean you should have one? If
you do any work that relies on precise cursor movement (painting, dodging,
burning, path creation and editing, cloning, healing, patching, lassoing, just to
name a few), then yes, I do recommend a Wacom Cintiq display or Intuos
tablet, or at least a Graphire tablet. Next to more RAM and good color man-
agement, it’s the best investment just about any Photoshop user can make.

One additional note: If you're brand new to digital imaging and computers,
this probably isn’t the best place to start. I do indeed make certain assump-
tions about your level of computer knowledge (and, to a lesser degree, your
knowledge of digital imaging). But if you know your File>Open from your
Filez>Close and can find your lens cap with both hands, read Chapter 1, and
you’ll have no problem with Photoshop CS4 For Dummies.

How This Book Is Organized

Photoshop CS4 For Dummies is primarily a reference book. As such, you can
check the Table of Contents or the index for a specific subject, flip to those
pages, and get the information you need. You can also start at the beginning
and read cover to cover (just to make sure you don’t miss a single tip, tech-
nique, or joke). To give you an indication of the type of information in each
chapter, I organized the book into parts. Here’s a quick look at what sort of
content you can find in each part.

Part I: Breezing through Basic Training

The first set of chapters presents the basic operation of Photoshop, what you
need to know to get around in the program, and the core process of getting
images into Photoshop and back out again. If you're new to digital imaging,
and particularly unfamiliar with Photoshop, make sure to read Chapter 1
through Chapter 3. If you've worked with Photoshop or another image editing
program and aren’t quite sure about the concept of resolution or which file
formats are best for which purposes, don’t overlook Chapter 2. Chapter 4 is
the meat and potatoes of Photoshop: scanning and downloading images from
cameras, cropping to fit specific print and frame sizes, and printing or post-
ing your images on the Web. All in one nice, tidy package.
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Part 1I: Easy Enhancements for Digital Images

In Chapters 5 through 9, you discover ideas and techniques for improving the
appearance of your images. You read about tonality (the lightness and dark-
ness of the image), color correction (making the image’s color look natural),
and making selections to isolate individual parts of your image for correction.
Part II also includes a full chapter on the Raw file format for digital cameras —
what it is, why it’s important, and how to determine whether it’s right for
you. At the end of this part, I include a chapter on the most common prob-
lems in digital photos: red-eye, wrinkles, and unwanted objects and people.
And, yes, that chapter includes what to do about those problems, too!

Part 11I: Creating “Art” in Photoshop

The chapters in Part Il take a walk on the creative side. Although not every-
one wants to use Photoshop as a digital painting program, everyone should
understand how to get around in the complex and daunting Brushes panel.
Compositing images (making one picture from two or more), adding text
(whether a simple copyright notice or an entire page), using paths, and
adding layer styles are all valuable skills for just about all folks who work
with Photoshop, even if they don’t consider their work to be art.

Part 1U: Power Photoshop

The two chapters in Part [V are more specialized than the rest of the book. If
you don’t work in a production environment (even regularly cropping to the
same size for printing on your inkjet printer can count as production), you
might not need to use Actions in Photoshop. But there’s far more to Chapter
16 than just Actions and scripting! It also shows you how you can create an
on-screen presentation that anyone can view, generate a single page with
small thumbnail images of all your photos, and save paper by printing multi-
ple copies of a photo on a single sheet. Chapter 17 is a brief introduction to
those features found only in Photoshop CS4 Extended. If you have Photoshop
CS4 rather than Photoshop CS4 Extended, you might be interested in the
highly technical, very complex scientific, technical, video, and 3D features.
Or not.

Part U: The Part of Tens

The final part of this book, The Part of Tens, was both the easiest and most
difficult section to prepare. It was easy because, well, the chapters are short.
It was incredibly tough because it’s so hard to narrow any Photoshop-related
list to just ten items. Photoshop is such a beautifully complex and deep pro-
gram that [ had a very hard time (as you’ll read) restricting myself to just ten
favorite tips and tricks, just ten reasons a Wacom tablet can be your best
friend, and just ten reasons to own a digital camera. But I did it. (More or less
— beware of hidden tips and tricks!)

3
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Conventions Used in This Book

To save some space and maintain clarity, [ use an arrow symbol as shorthand
for Photoshop menu commands. [ could write this:

Move the cursor onto the word Image at the top of your screen and press
the mouse button. Continuing to press the mouse button, move the
cursor downward to the word Adjustments. Still pressing the mouse
button, move the cursor to the right and downward onto the words
Shadow/Highlight. Release the mouse button.

But it makes more sense to write this:
Choose Shadow/Highlight from the Image=>Adjustments menu.

Or even to use this:
Choose the Imager>Adjustmentst>Shadow/Highlight command.

You'll also note that I include keyboard shortcuts (when applicable) for both

Mac and Windows. Generally the shortcuts are together, with Mac always

first, and look like this:

Move the selection to a separate layer with the shortcut
38+Shift+J/Ctrl+Shift+J.

Icons Used in This Book

EATURe

A\\J
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&

You'll see icons in the margins as you read this book, icons that indicate
something special. Here, without further ado, is the gallery:

This icon tells you I'm introducing a new feature, something just added to the
program with Photoshop CS4. If you’re brand new to Photoshop yourself, you
can ignore this icon — it’s all new to you. If you're an experienced Photoshop
user, take note.

When I have a little secret or shortcut to share with you — something that
can make your life easier, smoother, more convenient — you see the Tip icon.

This icon doesn’t appear very often, but when it does, read carefully! I
reserve the Warning icon for those things that can really mess up your day —
things that can cause you to lose work by ruining your file or messing up
Photoshop. If there were to be a quiz afterward, every Warning would be in
the essay section!
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The Remember icon shows you good-to-know stuff, things that are applicable
in a number of different places in Photoshop, or things that can make your
Photoshop life easier.

You might notice this icon in a place or two in the book. It’s not common
because I exclude most of the highly technical background info: you know,
the boring techno-geek concepts behind Photoshop.

How to Use This Book

This is a reference book, not a lesson-based workbook or a tips-and-tricks
cookbook. When you have a question about how something in Photoshop
works, flip to the Table of Contents or the index to find your spot. You cer-
tainly can read the chapters in order, cover to cover, to make sure that you
get the most out of it. Nonetheless, keep this book handy while you work in
Photoshop. (Reading cover to cover not only ensures that you find out the
most about Photoshop, but it guarantees that you don’t miss a single cartoon
or joke.)

Unless you’re borrowing a friend’s copy or you checked this book out of
the library, I suggest you get comfortable with the thought of sticky notes
and bent page corners. Photoshop is a very complex program — no one
knows everything about Photoshop. And many concepts and techniques in
Photoshop are hard to remember, especially if you don’t use them often.
Bookmark those pages so they're easy to find next time because you're sure
to be coming back time and again to Photoshop CS4 For Dummies.
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In this part . . .

A solid understanding of certain basic
concepts and techniques makes learning
Photoshop much easier. Heck, it’s difficult to
understand a discussion of feathered selections
when you don’t know your pixels from a hole in
the ground, right?

In Chapter 1, I introduce you to Adobe Photoshop.
Chapter 2 focuses on the basic concepts of digital
imaging and offers a look at the primary file for-
mats in which you save Photoshop images. Even if
you're upgrading to CS4, you should also take a
look at Chapter 3, which presents the revised
Photoshop interface. Finally, Chapter 4 covers
bringing images into Photoshop from digital
cameras or scanners, organizing those files,

and basic output through printing.
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Welcome to Photoshop!

In This Chapter
What Photoshop does very well, kind of well, and just sort of, well . . .
What you need to know to work with Photoshop
What you need to know about installing Photoshop

A dobe Photoshop is, without question, the leading image-editing program
in the world. Photoshop has even become somewhat of a cultural icon.
It’s not uncommon to hear Photoshop used as a verb (“That picture is obvi-
ously Photoshopped!”), and you’ll even see references to Photoshop in the
daily comics and cartoon strips. And now you’re part of this whole gigantic
phenomenon called Photoshop.

Whether you're new to Photoshop, upgrading from Photoshop CS3 or earlier,
or transitioning from Elements to the full version of Photoshop CS4
or Photoshop CS4 Extended, you're in for some treats.
Photoshop CS4 has an intriguing new look that enables
you to do more, and do it more easily, than ever. Before
[ take you on this journey through the intricacies of
Photoshop, | want to introduce you to Photoshop in a
more general way. In this chapter, I tell you what
Photoshop is designed to do, what it can do

(although not as capably as job-specific software),
and what you can get it to do if you try really, really
hard. I also review some basic computer operation
concepts and point out a couple of places where
Photoshop is a little different than most other pro-
grams. At the end of the chapter, | have a few tips for
you on installing Photoshop to ensure that it runs

properly.
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Exploring Adobe Photoshop

Photoshop is used for an incredible range of projects, from editing and cor-
recting digital photos to preparing images for magazines and newspapers to
creating graphics for the Web. You can also find Photoshop in the forensics
departments of law-enforcement agencies, scientific labs and research facili-
ties, and dental and medical offices, as well as in classrooms, offices, studios,
and homes around the world. As the Help Desk Director for the National
Association of Photoshop Professionals (NAPP), my team and I solve prob-
lems and provide solutions for Photoshop users from every corner of the
computer graphics field and from every corner of the world. People are doing
some pretty amazing things with Photoshop, many of which are so far from
the program’s original roots that it boggles the mind!

What Photoshop is designed to do

Adobe Photoshop is an image-editing program. It’s designed to help you edit
images — digital or digitized images, photographs, and otherwise. This is the
core purpose of Photoshop. Over the years, Photoshop has grown and devel-
oped, adding features that supplement its basic operations. But at its heart,
Photoshop is an image editor. At its most basic, Photoshop’s workflow goes
something like this: You take a picture, you edit the picture, and you print the
picture (as illustrated in Figure 1-1).

Figure 1-1: Basic Photoshop: Take photo, edit photo, print photo. Drink coffee (optional).

Whether captured with a digital camera, scanned into the computer, or cre-
ated from scratch in Photoshop, your artwork consists of tiny squares of
color, which are picture elements called pixels. (Pixels and the nature of digi-
tal imaging are explored in depth in Chapter 2.) Photoshop is all about chang-
ing and adjusting the colors of those pixels — collectively, in groups, or one
at a time — to make your artwork look precisely how you want it to look.
(Photoshop, by the way, has no Good Taste or Quality Art filter. It’s up to you
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to decide what suits your artistic or personal vision and what meets your
professional requirements.) Some very common Photoshop image-editing
tasks are shown in Figure 1-2: namely, correcting red-eye and minimizing
wrinkles (both discussed in Chapter 9); and compositing images (see
Chapter 10).

Astronaut image courtesy of NASA
Figure 1-2: Some common Photoshop tasks.

New in Photoshop CS4 is the powerful ability to rotate the image on screen
while you're working. Not rotate the image itself — Photoshop has had that
capability for ages — but to rotate the appearance of the image in the work-
space. This is especially handy when doing delicate masking and painting,
enabling you to orient the image on screen to best suit your stroke. As you
can see in Figure 1-3, while you’re rotating, a red arrow indicates the image’s
true “up.” Double-clicking the Rotate tool icon in the Toolbox restores the
image’s orientation. (This feature is not available on older computers with
less powerful video cards.)

Figure 1-3: Rotate while you work, without damaging the image’s quality!

11
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Over the past few updates, Photoshop has developed some rather powerful
illustration capabilities to go with its digital-imaging power. Although
Photoshop is still no substitute for Adobe Illustrator, Photoshop certainly
can serve you well for smaller illustration projects. (Keep in mind that
Photoshop is a raster art program — it works with pixels — and vector art-
work is only simulated in Photoshop.) Photoshop also has a very capable
brush engine, which makes it feasible to paint efficiently on your digital
canvas. Figure 1-4 shows a comparison of raster artwork (the digital photo,
left), vector artwork (the illustration, center), and digital painting (right). The
three types of artwork can appear in a single image, too. (Simulating vector
artwork with Photoshop’s shape layers is presented in Chapter 11, and you
can read about painting with Photoshop in Chapter 14.)

Figure 1-4: You can use Photoshop with raster images, vector artwork, and even to paint.

Photoshop CS4 includes some basic features for creating Web graphics,
including slicing and animations (but Web work is best done in a true Web
development program, such as Dreamweaver). Photoshop’s companion pro-
gram Adobe Bridge even includes the Output panel to help you create entire
Web sites to display your artwork online and PDF presentations for on-screen
display, complete with transition effects between slides. (Read about Bridge’s
Output panel’s capabilities in Chapter 16.)

Other things you can do with Photoshop

Although Photoshop isn’t a page layout or illustration program, you certainly
can produce simple brochures, posters, greeting cards, and the like using
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only Photoshop. (See Figure 1-5.) One of the features that sets Photoshop
apart from basic image editors is its powerful type engine, which can add,
edit, format, and stylize text as capably as many word-processing programs.
Photoshop even has a spell check feature — not bad for a program that’s
designed to work with photos, eh?

Even if you don’t have the high-end video features found in Photoshop CS4
Extended, you can certainly supplement your video-editing program with
Photoshop C54 (even if Photoshop can’t open and play movies you capture
with your video camera). From Adobe Premiere (or other professional video
programs), you can export a series of frames in the FilmStrip format, which

you can open and edit in Photoshop.

Photoshop CS4 and Photoshop CS4 Extended

Although there have been different versions
of Photoshop for years (Photoshop versus
Photoshop LE versus Photoshop Elements), as
with the prior release of Photoshop, Adobe is
offering two different versions of Photoshop
CS4. Photoshop CS4 and Photoshop CS4
Extended both have all of Photoshop’s powerful
image-editing, vector-drawing, painting, and
type capabilities. Photoshop CS4 Extended also
includes some very specialized, highly techni-
cal features for use in science, research, and
video editing, and for use with 3D modeling pro-
grams. (These features are introduced in
Chapter 17.)

So, if you have Photoshop CS4 rather than
Photoshop CS4 Extended, should you feel
cheated or like a second-class citizen? Nope!
Unless you specifically need those extended
features, there’s no real reason to purchase
them. But what if you got Photoshop CS4
Extended as part of a Creative Suite or Adobe
Bundle package of software — did you pay for

something you don't need? Well, sort-of-yeah-
but-not-really. The folks who're really paying
extra for the extended features are those who
purchase Photoshop CS4 Extended as a stand-
alone program. The additional cost they pay
funds the research and development of the
extended features.

So why didn't | get to choose between
Photoshop CS4 and Photoshop CS4 Extended
when | ordered my Bundle or Suite? Buying
software shouldn’t be as complicated as, say,
ordering a cup of coffee. (Caf, de-caf, half-caf?
Latte, espresso, cappuccino? White, brown, or
raw sugar? Cream, half-and-half, milk, or skim?
Small, medium, large, super, or el grosso
maxmo?) It could get quite confusing. Imagine
trying to wade through all of the thousands of
products if Adobe marketed every possible
combination as a separate Bundle or Suite or
Studio! You'd spend so much time trying to find
your perfect bundle, you'd never get to use the
software.
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Figure 1-5: You can use Photoshop to create cards, posters, and brochures.

If you don’t have specialized software

Admittedly, Photoshop CS4 just plain can’t do some things. It won’t make you
a good cup of coffee. It can’t press your trousers. It doesn’t vacuum under the
couch. It isn’t even a substitute for iTunes, Microsoft Excel, or Netscape
Navigator — it just doesn’t do those things.

However, there are a number of things for which Photoshop isn’t designed
that you can do in a pinch. If you don’t have InDesign, you can still lay out the
pages of a newsletter, magazine, or even a book, one page at a time. (With
Bridge’s Ouput panel, you can even generate a multipage PDF document from
your individual pages.) If you don’t have Dreamweaver or GoLive, you can
use Photoshop to create a Web site, one page at a time, sliced and optimized
and even with animated GIFs. You also have tools that you can use to simu-
late 3D in Photoshop CS4, such as Vanishing Point (see Chapter 10).

Page layout in Photoshop isn’t particularly difficult for a one-page piece or
even a trifold brochure. Photoshop has a very capable type engine, consider-
ing the program is designed to push pixels rather than play with paragraphs.
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Photoshop even shows you a sample of each typeface in the Font menu.
Choose from five sizes of preview (shown in Figure 1-6) in Photoshop’s
Preferences=>Type menu. However, you can’t link Photoshop’s type contain-
ers, so a substantial addition or subtraction at the top of the first column
requires manually recomposing all of the following columns. After all, among
the biggest advantages of a dedicated page layout program are the continuity
(using a master page or layout) and flow from page to page. If you work with
layout regularly, use InDesign.
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Figure 1-6: Font previews in five delicious flavors!

Dreamweaver is a state-of-the-art Web design tool, with good interoperability
with Photoshop. However, if you don’t have Dreamweaver and you desper-
ately need to create a Web page, Photoshop comes to your rescue. After
laying out your page and creating your slices, use the Save for Web & Devices
command to generate an HTML document (your Web page) and a folder filled
with the images that form the page (see Figure 1-7). One of the advantages to
creating a Web page in Dreamweaver rather than Photoshop is HTML text.
(Using Photoshop, all the text on your Web pages is saved as graphic files.
HTML text not only produces smaller Web pages for faster download, but it’s
resizable in the Web browser.)
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Figure 1-7: You can create an entire Web page in Photoshop.

Viewing Photoshop’s Parts and Processes

In many respects, Photoshop CS4 is just another computer program — you
launch the program, open files, save files, and quit the program quite nor-
mally. Many common functions have common keyboard shortcuts. You
enlarge, shrink, minimize, and close windows as you do in other programs.

Reviewing basic computer operations

Chapter 3 looks at Photoshop-specific aspects of working with floating
panels, menus and submenus, and tools from the Options bar, but [ want to
take just a little time to review some fundamental computer concepts.

Launching Photoshop

You can launch Photoshop (start the program) by double-clicking an image
file or through the Applications folder (Mac) or the Start menu (Windows).
Mac users can drag the Photoshop program icon (the actual program itself)
to the Dock to make it available for one-click startup. You can find the file
named Adobe Photoshop CS4 inside the Adobe Photoshop CS4 folder, inside
the main Applications folder. (Chapter 3 shows you the Photoshop interface
and how to get around in the program.)

@“\NG! Never open an image into Photoshop from removable media (CD, DVD, your
S digital camera or its Flash card, Zip disks, jump drives, and the like) or from a
network drive. Always copy the file to a local hard drive, open from that drive,
save back to the drive, and then copy the file to its next destination. You can
open from internal hard drives or external hard drives, but to avoid the risk of
losing your work (or the entire image file) because of a problem reading from
or writing to removable media, always copy to a local hard drive.
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Working with images

Within Photoshop, you work with individual image files. Each image is
recorded on the hard drive in a specific file format. Photoshop opens just
about any image consisting of pixels as well as some file formats that do not.
(File formats are discussed in Chapter 2.) Remember that to change a file’s
format, you open the file in Photoshop and use the Save As command to
create a new file. And, although theoretically not always necessary on the
Mac, I suggest that you always include the file extension at the end of the file-
name. If Photoshop won’t open an image, it might be in a file format that
Photoshop can’t read. It cannot, for example, open an Excel spreadsheet or a
Microsoft Word DOC file because those aren’t image formats — and
Photoshop is, as you know, an image-editing program. If you have a brand-
new digital camera and Photoshop won’t open its Raw images, check for an
update to the Adobe Camera Raw plug-in at

www . adobe . com/products/photoshop/cameraraw.html

You will find installation instructions for the update there. (Make sure to read
and follow the installation instructions exactly.)

Saving your files

You must use the Save or Save As command to preserve changes to your
images. And after you save and close an image, those changes are irre-
versible. When working with an important image, consider these three tips:

1~ Work on a copy of the image file. Unless you're working with a digital
photo in the Raw format (discussed in Chapter 7), make a copy of your
image file as a backup before changing it in Photoshop. The backup
ensures that should something go horribly wrong, you can start over.
(You never actually change a Raw photo — Photoshop can’t rewrite the
original file — so you’re always, in effect, working on a copy.)

1 Open as a Smart Object. Rather than choosing Filer>Open, make it a
habit to choose File>Open As Smart Object. When working with Smart
Objects, you can scale or transform multiple times without continually
degrading the image quality, and you can work with Smart Filters, too!

1~ Save your work as PSD, too. Especially if your image has layers, save it
in Photoshop’s PSD file format (complete with all the layers) before
using Save As to create a final copy in another format. If you don’t save a
copy with layers, going back to make one little change can cost hours of
work.

If you attempt to close an image or quit Photoshop without saving your work
first, you get a gentle reminder asking whether you want to save, close with-
out saving, or cancel the close/quit (as shown in Figure 1-8).
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Keyboard shortcuts PRI

Keyboard shortcuts are customiz- P 1321 e before closmgr T ot
able in Photoshop (check out

Chapter 3), but some of the basic e —
shortcuts are the same as those you

use in other programs. You open,
copy, paste, save, close, and quit just §\ Save changes to the dobe Ehotoshon document

*C:\..1893663 jpg” before dlosing?

as you do in Microsoft Word, your
e-mail program, and just about any
other software. I suggest that you
keep these shortcuts unchanged, Figure 1-8: Photoshop reminds you if you
even if you do some other shortcut  haven't saved changes to an image.
customization.
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Photoshop’s incredible selective Undo

Here’s one major difference between Photoshop and other programs. Almost
all programs have some form of Undo, enabling you to reverse the most
recent command or action (or mistake). Like many programs, Photoshop
uses the 88+Z/Ctrl+Z shortcut for Undo/Redo and the 88+Option+Z/Ctrl+Alt+Z
shortcut for Step Backward, which allows you to undo a series of steps (but
remember that you can change those shortcuts, as described in Chapter 3).
Photoshop also has, however, a couple of great features that let you partially
undo.

Painting to undo with the History Brush

You can use Photoshop’s History Brush to partially undo just about any filter,
adjustment, or tool by painting. You select the History Brush, choose a his-
tory state (a stage in the image development) to which you want to revert,
and then paint over areas of the image that you want to change back to the
earlier state.

You can undo as far back in the editing process as you want, with a couple of
limitations: The History panel (where you select the state to which you want
to revert) holds only a limited number of history states. In the Photoshop
Preferences=>General pane, you can specify how many states you want
Photoshop to remember (to a maximum of 1,000). Keep in mind that storing
lots of history states takes up computer memory that you might need for pro-
cessing filters and adjustments. That can slow things down. The default of 20
history states is good for most projects, but when using painting tools or
other procedures that involve lots of repetitive steps (such as touching up
with the Dodge, Burn, or Clone Stamp tools), a larger number (perhaps as
high as 60) is generally a better idea.
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The second limitation is pixel dimensions. If you make changes to the image’s
actual size (in pixels) with the Crop tool or the Image Size or Canvas Size
commands, you cannot revert to prior steps with the History Brush. You can
choose as a source any history state that comes after the image’s pixel
dimensions change but none that come before.

Here’s one example of using the History Brush as a creative tool. You open a
copy of a photograph in Photoshop. You edit as necessary. You use the Black
and White adjustment on the image to make it appear to be grayscale. In the
History panel, you click in the left column next to the step immediately prior
to Black and White to designate that as the source state, the appearance of
the image to which you want to revert. You select the History Brush and
paint over specific areas of the image to return them to the original (color)
appearance (see Figure 1-9). There you have it — a grayscale image with
areas of color, compliments of the History Brush!

O O M T CRW_1942.CRW @ 16.7% (RGB/16)

® O © | CRW_1942 copy @ 66.7% (RGB/8)

El Duplicate Image

T:;‘ Efl Reduce Noise

I 1 Despeckle

Image Size
El_uﬁﬁér_pﬁ;é
%W
By HstoryBsh
[ h[Ey History rush

B =] B o

1667% | (B |

Figure 1-9: Painting to undo with the History Brush.
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Reducing to undo
with the Fade
command

Immediately after
applying a filter or
adjustment or using
most of Photoshop’s
tools, you can choose
Edit>Fade and change
the opacity or blending
mode with which the
previous step was per-
formed. You might, for
example, apply a sharp-
ening filter and then
choose Edit>Fade

Opacity:
Unsharp Mask to B . (e
Change the blending Mode:  Normal @ # Previ

mode from Normal

to Luminosity.
(Sharpening only the
luminosity of your
image, whether with
this technique or in the
Lab color mode, prevents unwanted color shifts along edges in your images.
Color modes are discussed in Chapter 6.) Or you might apply the Motion Blur
filter and then choose Edit=>Fade Motion Blur (yes, the name of the command
actually changes for you) to reduce the opacity of the blur to 75%. That gives
you the appearance of a back-and-forth motion while leaving the subject
more readily recognizable (see Figure 1-10).

Figure 1-10: Compare the original blur with a reduction using
the Fade command.

Installing Photoshop: Need to know

If you haven’t yet installed Photoshop CS4 (or the Adobe Creative Suite), here
are a few points to keep in mind:

1+~ Install only into the default location. Photoshop is a resource-intensive
program. Installing it into the default location ([harddrive]=>Applications
on a Mac and C: \Program Files for Windows) ensures that it has
access to the operating system and hardware as necessary. Installing
into any other location or attempting to run Photoshop across a net-
work can lead to frustrating problems and loss of work in progress.

1~ Disable all spyware and antivirus software before installing. Antivirus
software can intercept certain installation procedures, deeming them to
be hazardous to your computer’s health. That can lead to malfunctions,
crashes, lost work, frustration, and what I like to call Computer Flying
Across Room Syndrome. If you use antivirus software (and if you use
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Windows, you’d better!), turn it off before installing any program, espe-
cially one as complex as Photoshop. You might find the antivirus pro-
gram’s icon in the Windows taskbar; or you might need to go to the Start
menu, use All Programs to locate the antivirus software, and disable it.
On Mac, check the Dock. And don’t forget to restart your antivirus soft-
ware afterward! If you already installed Photoshop and antivirus soft-
ware was running at the time, I urge you to uninstall and reinstall.
(Reinsert the Photoshop CS4 CD and launch the installer to use the built-
in uninstall feature.)

v~ If you use autobackup software, shut it down, too. Never run auto-
backup software when installing software. Like antivirus software, it can
also lead to problems by interfering with the installer.

1~ Connect to the Internet and activate right away. It’s best to run the
Photoshop installer while your computer is connected to the Internet.
That enables Photoshop’s activation process to happen right away,
making sure you can get started as soon as the installer finishes.

v~ If you have third-party plug-ins, install them elsewhere. Third-party
plug-ins — those filters and other Photoshop add-ons that you buy from
companies other than Adobe — can be installed into a folder outside the
Photoshop folder. You can then make an alias (Mac) or shortcut
(Windows) to that folder and drag the alias/shortcut to Photoshop’s
Plug-Ins folder. (If you have a multibutton mouse, right-click the folder to
create an alias/shortcut; Control+click if you're still using a one-button
mouse.) Why install outside the Photoshop folder? Should you ever
need to (gasp!) reinstall Photoshop, you won’t need to reinstall all your
third-party plug-ins. Just create a new alias/shortcut and move it into
Photoshop’s new Plug-Ins folder.

1 Check for plug-in updates. Go to the manufacturer’s Web site for each
of your third-party plug-ins and check for updates. This is especially
important if you're using an Intel-based Mac. Unless the plug-ins have
been updated (“Universal”), they won’t run. There’s a workaround, how-
ever. In the Finder, go to [harddrive]=>Applications=>Adobe Photoshop
CS4. Right-click or Control+click on the program icon and choose Get
Info. In the Get Info window, select the option Open Using Rosetta.
Photoshop will run more slowly, but you’ll have your un-updated third-
party plug-ins available. When the plug-ins are finally updated (or you
decide speed is more important), re-open Get Info and deselect the Open
Using Rosetta box.

v~ If you have lots of plug-ins, create sets. Plug-ins require RAM (com-
puter memory that Photoshop uses to process your editing commands).
If you have lots of plug-ins, consider dividing them into groups accord-
ing to how and when you use them. Sort (or install) them into separate
folders. (Hint: Plug-ins that you use in many situations can be installed
into multiple folders.) When you need to load a specific set, do so
through the Photoshop Preferences=>Plug-Ins pane by designating a
second plug-ins folder and relaunching Photoshop.
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1~ If you love fonts, use a font management utility. If you have hundreds
of fonts (over the years, I've somehow managed to collect upward of
7,500 fonts), use a font-management utility to create sets of fonts accord-
ing to style and activate only those sets that you need at any given time.
Too many active fonts can choke the Photoshop type engine, slowing
performance. The Mac OS has Font Book built right in, or you can use
the excellent Suitcase Fusion from Extensis (www.extensis.com).
Extensis also offers Suitcase for Windows.
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Knowing Just Enough
about Digital Images

In This Chapter

Understanding digital images
Discovering resolution

Exploring the many file formats of Photoshop

In the early days of photography, some less-advanced cultures viewed a
photo with great suspicion and even fear. Was that an actual person,
trapped in the paper? Did taking a photo steal a person’s soul? You know that
a camera doesn’t trap anyone inside the paper — and you can be pretty sure
about the stolen soul issue — but how much does the average shooter know
about digital images? And how much do you need to know about
digital images to work effectively in Photoshop?

The answers to those two questions are “Not as much
as he/she should” and “Not as much as you might
fear.” In this chapter, I give you some basic informa-
tion about how digital images exist in Photoshop, a
real understanding of that critical term resolution,
and an overview of the different ways that you can
save your images. But most important, I help you
understand the very nature of digital images by
explaining the world of pixels.

Welcome to the Philosophy Chapter!
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What Exactly Is a Digital Image?

Whether you take a picture with a digital camera or use a scanner to bring

a photo (or other artwork) into Photoshop, you are digitizing the image.

That is, digit not as in a finger or toe, but as in a number. Computers do
everything — absolutely everything — by processing numbers, and the basic
language of computers is binary code. Whether it’s a photo of a Tahitian
sunset, a client’s name in a database, or the latest box score on the Internet,
your computer works on it in binary code. In a nutshell, binary code uses a
series of zeros and ones (that’s where the numbers part comes into play) to
record information.

So what does binary code have to do
with the wedding photos that you
took this weekend or the masterpiece
you must print for your thesis pro-
ject? An image in Photoshop consists
of tiny squares of color called pixels
(pixel is short for picture element),

as you can see in the close-up to the
right in Figure 2-1. The computer
records and processes each pixel in
binary code. These pixels replicate a
photo the same way that tiles in a
mosaic reproduce a painting.

Figure 2-1: That's not really Hugo the Bulldog;
it's a bunch of tiny, colored squares.

A tile in a mosaic isn’t face or sky or grass; rather, it’s beige or blue or green.
The tiles individually have no relationship to the image as a whole; rather,
they require an association with the surrounding tiles to give them purpose,
to make them part of the picture. Without the rest of the tiles, a single tile has
no meaning.

Likewise, a single pixel in a digital image is simply a square of color. It doesn’t
become a meaningful part of your digital image until it’s surrounded by

other pixels of the same or different color, creating a unified whole — a
comprehensible picture. How you manipulate those pixels, from the time you
capture the image digitally until you output the image to paper or the Web,
determines how successfully your pixels will represent your image, your art-
work, your dream.

The True Nature of Pixels

Here are some basic truths about pixels that you really need to know.
Although reading this section probably can’t improve your love life, let you
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speak with ghosts, or give you the winning lottery number, it can help you
understand what’s happening to your image as you work with it in
Photoshop.

+~ Each pixel is independent. You might think that you see a car or a circle
or a tree or Uncle Bob in an image, but the image is actually only a
bunch of little colored squares. Although you can read about various
ways to work with groups of pixels throughout this book, each pixel
exists unto itself.

1~ Each pixel is square (except on TV). Really! Each pixel in a digital image
is square except when you’re creating images for television, which uses
nonsquare pixels. (That’s a rather specialized field, which I very briefly
address in Chapter 3.) It’s important that you understand the square-
ness of pixels because you sometimes have to deal with those pointy
little corners.

1~ Each pixel can be exactly one color. That color can change as you edit
or alter the image, but each pixel consists entirely of a single color —
there’s no such thing as a two-tone pixel. Figure 2-2, at 3,200 percent
zoom, shows each pixel distinctly.

@ @ @ BightStPark-03.ps...

Figure 2-2: Each pixel is monotone, containing a single color throughout the pixel.

~ Smaller is better (generally speaking). The smaller each pixel, the
better the detail in an image. (However, when preparing images for the
Web, you need smaller images that invariably have less detail.) If you
capture an image of a dog in a park with 2 million pixels and capture the
same shot with only 30,000 pixels, it’s pretty obvious which image will
better show the individual blades of grass and the fur. Take a look at
Figure 2-3 for an example of this critical concept.
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Smaller pixels also help hide those nasty corners of pixels that are some-
times visible along curves and diagonal lines. When the corners of pixels
are noticeable and degrade the image, you call it a bad case of the jaggies.

1~ Every picture created with pixels is rectangular. Some images might
appear to be round, or star-shaped, or missing a hole from the middle,
but they aren’t unless you print them out and grab your scissors. The
image file itself is rectangular, even if it appears round. There are actu-
ally pixels in those seemingly empty areas; the pixels are, however,
transparent.

Figure 2-3: More pixels (top) means better detail.

How Many Pixels Can Dance
on the Head of a Pin?

You hear the term resolution a lot when working with digital images. Digital
cameras have so-many megapixels of resolution, inkjet printers have so-much
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by so-much resolution; to work in Photoshop CS4, your monitor must have a
resolution of at least 1,024 x 768 pixels; when printing your images, you must
use 300 pixels per inch (ppi) as your resolution (wrong!), but your Web
images must have a resolution of 72 ppi (again wrong!); and don’t forget your
New Year’s resolution!

Resolution revelations

In this wonderful world of digital imaging, you see resolution used in four
basic ways:

1~ Image resolution: /mage resolution is the size of your image’s individual
pixels when you print. I go into greater detail about this concept in the
upcoming section, “Picking an image resolution.”

1~ Camera resolution: Digital cameras capture each image in a specific
number of pixels. Check your camera’s user guide or open one of the
images in Photoshop and choose Imager>Image Size. Take a look at the
number of pixels that your camera records for the width and for the
height. Multiply the numbers together, divide by one million, and round
off the result. (If you're in the camera maker’s marketing department,
make sure that you round up.) That’s the megapixel (MP) rating for the
camera. Use it as a general guideline when shopping. If you create Web
graphics or snapshot-size prints, 3 or 4 MP is fine. For large prints, you
need at least 6 MP.

1 Monitor resolution: Monitor resolution determines how many pixels are
visible on-screen. Whether you use a Mac or a PC, you set the monitor
resolution at the system level (as shown in Figure 2-4). When you use a
higher monitor resolution, you get a larger workspace, but each pixel is
smaller, which might make some jobs tougher. Experiment to find a
monitor resolution that works just right for you.

e Mac: Click the blue Apple menu in the upper-left corner of the
screen and choose System Preferences. Then click Displays. (Some
Apple monitors have a button on the bezel that automatically
opens the window for you.)

e Windows: Choose Start~>Control Panel and then double-click
Display. Click the Settings tab to see what monitor resolutions are
available.

1~ Printer resolution: Unlike the three preceding terms, printer resolution
doesn’t involve pixels. Rather, a printer resolution tells you how many
tiny droplets of ink are sprayed on the paper. Remember that it takes
several droplets to reproduce a single image pixel — you certainly don’t
need an image resolution anywhere close to the printer’s resolution!
(See the following section for more on this.)
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Figure 2-4: Set a Mac's resolution through the System Preferences (left), a PC’s resolution
through the Control Panel (right).

Resolving image resolution

Image resolution is nothing more than an instruction to a printing

device about how large to reproduce each pixel. On-screen, when working

in Photoshop, your image has no resolution at all. An image that’s 3,000
pixels wide and 2,400 pixels tall looks and acts exactly the same in Photoshop
whether you have the image resolution at 300 ppi or 72 ppi. Same number

of pixels, right? (The one real exception to this rule is type — text is usually
measured in points in Photoshop, and that measurement is directly tied

to the print size of your document. Type and text are discussed in

Chapter 13.)

You can always check — or change — a picture’s resolution by choosing
Photoshop Image=>Image Size. The Image Size dialog box (which you can see
in Figure 2-5) has two separate but related sets of information about your
image. At the top, you see information about the actual image itself, in the
Pixel Dimensions area. Below, in the Document Size area, you see instructions
for a printing device — that “size” pertains only to printing and has no
impact on what you do in Photoshop.
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You'll find it very handy to change the pixel dimensions and the print size at
the same time in the Image Size dialog box. And, much to the delight of math-
challenged folks, the Image Size feature does most of the calculations. For
example, with the Constrain Proportions option selected, you enter a new
Width and Photoshop calculates the new Height automatically!

Image Size

— Pixel Dimensions: 20.6M

Width: [3000 | [pixels F8) ]@
Height: [2400 [pixels 4] [E——
2 ‘ ‘ - ( Auto.. )
— Document Size:
Width: |10 | [inches % ]@
Height: ‘E ‘ ! inches ﬁ
Resolution: ‘300 ‘ pixels finch %
EScaIe Styles
E Constrain Proportions
E Resample Image:
" Bicubic (best for smooth gradients) W‘]

Figure 2-5: Atthe top, real information about your image. Below, merely printing instructions.

Changing the size of your artwork with the Image Size command

You have a number of ways to change the size of your photos and other art.
In Chapter 4, I introduce you to cropping (chopping off part of the artwork to
make it fit a certain size or to improve its overall appearance and impact).
You can use Photoshop’s Image Size command to change the image dimen-
sions or printing instructions without altering the composition, which is the
visual arrangement of the image or artwork. All the content of the original
image is there, just at a different size. Of course, as you can see in Figure 2-6,
if you reduce the size of an image too much, some of that original content can
become virtually unrecognizable.

29
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Figure 2-6: As the zoomed-in smaller image shows, you can reduce an

image too much.

If you know the specific pixel dimen- Iimage Size
sions that you need for the final ~— Pixel Dimensions: 18.0M (was 18.0M)- )
image — say for a Web page — you width: 3072 | [pixels %) i (" Cancel )
can simply type a new number in one Height: [2048 | [pixels ) fr—
of the upper fields in the Image Size — Document Size:
dialog box and click OK. In most Width:[12.709 | (inches 1% To
cases, you select all three check Height:[.533 | [inches __T%
boxes at the bottom of the dialog Resolution: [240 | Cpixelsinch %)
box, enter your desired print width # Scale Styles
or height (letting Photoshop calcu- M Constrain Proportions

. . Ekesample Image:
late the Otl:ler dlmen§lon)’ ente.r )’01‘1r |  Nearest Neighbor (preserve hard edges)
desired print resolution, and click Bilinear :

Bicubic (best for smooth gradients) N

OK. Of course, you probably want a Bicubic Smoother (best for enlargement)

Bicubic Sharper (best for reduction)

little more control over the process,
don’t you? Figure 2-7 gives you a
closer look at the Image Size dialog  Figure 2-7: Your choices can have a substantial
box. impact on the appearance of your final image.

In the lower part of the Image Size dialog box, you have three decisions to
make. The first is rather easy: If you're resizing an image that uses layer
styles (see Chapter 12), you want to select the Scale Styles check box to pre-
serve the image’s appearance as it shrinks or grows. In a nutshell, layer styles
(such as shadows, glows, and bevels) are applied to a layer at a specific size.
You can scale the image without changing those sizes, or you can scale the
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image and change the style sizes proportionally. Not scaling layer styles can
dramatically alter the appearance of a resized image, as you can see in Figure
2-8. A slight bevel combined with a small drop shadow produces a subtle 3D
effect in the original (upper) image. Below, when the image is scaled down to
1/4 the original size without scaling the effects, your chips change to chumps,
and the artwork is ruined.

Figure 2-8: Scaling an image without scaling its layer styles can ruin your image.

The middle check box, Constrain
Proportions, should almost always
remain selected. Some exceptions
might come up, but you normally
want to preserve an image’s aspect
ratio (the relationship between
height and width) when resizing

to prevent distorting the image.
Figure 2-9 shows you what can
happen when you scale one dimen-
sion without constraining the
image’s proportions.

Figure 2-9: Resizing an image without constrain-
ing proportions. Interesting, yes, but useful?
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The third check box, Resample Image, is the one that most often requires the
attention of that gray matter within your skull. Not only do you need to
decide whether you want to resample the image (change its pixel dimen-
sions), but you also need to decide how you want to resample. Refer to Figure
2-7 to see that you have five different ways to calculate the change (called

resampling algorithms).

Before I talk about those choices,
let me explain what happens when
the Resample Image box is left
deselected. The top portion of the
Image Size dialog box becomes
unavailable — you can no longer
make changes in the Pixel Dimension
fields (as you see in Figure 2-10).
The information is there, but it
won’t change. When you clear the
Resample Image check box, you
protect the original pixels, prevent-
ing any change to the image itself.

So what’s left? When using Image
Size without resampling, you're

Image Size

[ Pixel Dimensions: 18.0M ( oK )
Width: 3072 pixels =Cariceia
= Height: 2048 7pixels \W,\
— Document Size: ———
width: 128 | [inches ¥}
Height: [8.533 linches  [¥) }@
Resolution: |240 mmh_-ﬂ

Figure 2-10: Clear the Resample Image check
box to change print size, not pixel dimensions.

simply changing the instructions recorded in the image for your printing
device. When you enter one dimension, either width or height, Photoshop
does the math and fills in both the other dimension and the new resolution.

Take a look at Figure 2-11. I cleared
the Resample Image check box and
entered 10 and inches for my new
print width in order to print this
image to a letter-size (8.5 x 11
inches) sheet of paper. Photoshop
fills in the new height (6.667 inches)
and a new resolution (307.2 ppi). But
what if [ want an 8 x 10 print? If I
enter 8 and inches for the height,
Photoshop recalculates the width to
12 inches and enters a resolution of
256 ppi. If  want a true 8 x 10, [ have
to crop some of the image because

a digital photo and an 8 x 10 have
different aspect ratios. (You can read
more about that in Chapter 4.)

Image Size

[ Pixel Dimensions: 18.0M

—o—)

Width: 3072 pixels ([ Cancel

(_ Cancel )
Height: 2048 pixels
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— Document Size:

inches ! 1 }
B

ar

ar

Width: |10
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[WECRER

Resample Image:
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Figure 2-11: Enter a value, and Photoshop
recalculates the fields automatically.
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To resample or to crop: That is the question

To better understand the difference between resampling an image and cropping an image,
consider this situation:

1. A painter paints a picture. He or she paints
it at whatever size he or she thinks is appro-
priate. (Or, perhaps, on the only piece of
canvas he or she can afford on that partic-
ular day.)

2. A patron likes the artwork, but the painting
is too large for the frame that works best
with the dining room table. Yeah, patrons
can be like that, can't they?

3. The patron asks the artist to make the
painting fit the frame.

4. The artist decides between cropping and
resampling. He or she can grab a pair of
scissors and cut off some of the painting
(cropping), or painstakingly re-create the
painting from scratch at a smaller size.
Thankfully, Photoshop does the “repaint-
ing” for you, using Image Size with its
resampling algorithms.

5. The artist charges the patron for the extra
work. (Don’t forget this final, crucial step!)

Cropping cuts away part of the image to meet a target size. Resampling retains all the image but
shrinks or enlarges it to meet the target size.

Okay then, back to the subject of resampling! When you resample an image
(change the pixel dimensions), Photoshop takes the image and maps it to the
new size, attempting to preserve the image’s appearances as much as possi-
ble at the new size, using the new number of pixels. Of course, if you take an
image that’s more than 3,000 pixels wide and resample it to 300 pixels wide,
you're going to lose some of the detail. (Remember what happened to Hugo
the Bulldog earlier in this chapter in Figure 2-3!)
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Choosing a resampling method

After you decide to change the pixel dimensions of your image via the Image
Size command, you need to select one of the five resampling algorithms (take
another peek at Figure 2-7). Table 2-1 sums up my advice on choosing the
right one.

If you'll be resizing a number of images in the same way, either upsampling or
downsampling, open Photoshop’s Preferences=>General and select the opti-
mal resampling method in the Image Interpolation menu. That algorithm then
becomes the default in Image Size, saving you the trouble of changing the
algorithm each time.

Keep in mind that the resampling method that you select in the Preferences
is also used for the Edit>Transform commands, which you use to scale,
rotate, and otherwise alter individual elements within your artwork. (You can

read about the Transform commands in Chapter 10.)

Table 2-1 Selecting a Resampling Algorithm
Algorithm Name  Use It For Results
Nearest Neighbor  Artwork containing large areas Maintains pixel color
of solid color like a pie chart or
a simple logo; avoid using with
photos
Bilinear Artwork having horizontal and Maintains the sharpness
vertical lines and blocks of color,  of your edges
such as Web page buttons; avoid
using with photos
Bicubic General-purpose resampling for ~ Calculates the average of

minor changes in image size

surrounding pixels when
generating a new pixel

Bicubic Smoother

Increasing the size of photo-
graphic images or artwork with
gradients and gradual shifts

in color

Gives the most pleasing
result when increasing
the number of pixels
(upsampling)

Bicubic Sharper

For reducing the number of pixels
in a photo (downsampling), also
can be used when upsampling
beyond 200%

Maintains the crispness
of your image




Chapter 2: Knowing Just Enough about Digital Images

Content-aware scaling

New in Photoshop CS4 is the Edit=>Content-Aware Scale command. Designed to be used when
an image needs to be resampled to a new aspect ratio but cant be cropped, it tries (very hard)
to keep the subject of the photo undistorted while stretching or shrinking the background.
Here's how to use it:

1. Open an image or make a selection. Make 4. Edit->Content-Aware Scale. Drag the

a selection if you need to scale only part of
an image. If you need to resize the entire
image, don't make any selection.

anchor points in the center of the four sides
of the bounding box to resize to fill the new
canvas, and then press Return/Enter. Hold

down the Option/Alt key to scale from the
center. If you're resizing an image of one or
more people, click the button to the rightin
the Options bar to protect skin tones.

2. Convert the Background layer. If your
image has a layer named Background,
double-click the layer name in the Layers
palette and rename the layer. You can't use
Context-Aware Scale on a flattened image. 5. Flatten (optional). If desired, use the

3. Imager>Canvas Size. If increasing the pixel ke SRR (e OiFn:.

dimensions, resize the canvas as required.
If you're reducing the size of the image,
skip this step.

I Wiy | BRB mffocom |[A|v[Eoaps || wfiooor |[§]HEner || Amount[ioox o) Protect [None = W | [©] ]
@ ) =i ME-WhitePass-2.psd @ 12.5% (R.. @ O O) ME-WhitePass-2 copy 2 @ 12.5% (La...
e ; o ]

") ME-WhitePass-2 copy @ 12.5% (Lay..

2% 6 125% | @)

In this example, the original image is to the left. In the middle, the image has been resampled
from 6.67 x 10 inches to 8 x 10 inches using Image Size (with Constrain Proportions deselected).
To the right, Content-Aware Scale does a much better job — in this particular case — of scal-
ing the image while minimizing distortion of the subject.

Is Content-Aware Scale a substitute for properly composing in-camera before shooting?
Absolutely not! Is it preferable to cropping to a new aspect ratio? Rarely. Is it an incredibly
powerful tool for certain difficult challenges? Now we're talking!

Picking an image resolution

After you have the concept of resampling under your belt, how do you
know what size you should be resampling to? How many pixels do you
need? Here are your general guidelines:
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1~ Photos for your inkjet printer: Inkjet printers are stochastic printing
devices: That is, they use a series of droplets to replicate each pixel in
your image, as shown in Figure 2-12. In theory, the optimal image resolu-
tion is 1/3 of the printer’s rated
resolution. For example, a
printer rated at 720 ppi works
best with images at 240 ppi. For
a 1,440 ppi printer, the formula
calls for an image resolution of
480 ppi (and that goes for the
2,880 x 1,440 printers, too).
However, most folks find that
regardless of the printer’s

rating, they never peed an Figure 2-12: The close-up to the left shows
image resolution higher than inkjet printer droplets and to the right, pixels.
300 ppi.

P If you're printing something that will only be viewed at a distance, such

as a banner to be hung above the crowd or a poster that hangs on a
wall, you can print at a substantially lower resolution to save ink and
print faster. Banners, for example, can often be printed with a resolution
of 100 ppi.

1~ Web images: Ignore resolution. Ignore the entire Document Size area of
the Image Size dialog box. Consider only the image’s pixel dimensions.
Determine what area of the Web page the image will occupy and then
resize to exactly those pixel dimensions.

1~ Page layout programs and commercial printing: If your image is to be
placed into a page layout program’s document and sent to a commercial
printing facility, you need to know the line screen frequency (the resolu-
tion, so to speak) of the printing press on which the job will be run.
Ask the print shop or the person handling the page layout. Your image
resolution should be either exactly 1.5 times or exactly twice the line
screen frequency. (You shouldn’t notice any difference in the final
printed product with either resolution.)

1~ PowerPoint presentations and word processing documents: Generally
speaking, 72 ppi is appropriate for images that you place into a presenta-
tion or Word document. You should resize to the exact dimensions of the
area on the page or slide that the image fills.

File Formats: Which Do You Need?

After working with your image in Photoshop, you need to save the changes.
Choosing Filem>Save updates the current file on your hard drive, maintaining
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the current file format when possi-
ble. If you added a feature to the file
that isn’t supported by the original
file format, Photoshop automatically
opens the Save As dialog box and
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Save hs

Suve As: [Uniitind-1.je5 1=
Where: | G Desktoa )
Format. | IPEG 2]

Use Adobe Diaiog | 54w

................. AT
&
Caor

shows you which features are not s o
supported by the selected file e el
format. In Figure 2-13, the lower part e
of the Save As dialog box shows you —_—
the yellow warning triangles that
identify options being used in the
image that are not available when
saving as a JPEG.

Figure 2-13: Photoshop shows you which
image features are not available in your
selected file format.

You can go ahead and save the image in that format, but your file will no
longer contain those unsupported features. In the example shown in Figure
2-13, I can click the Save button and create a JPEG file, but that JPEG won’t
have the alpha channel (a saved selection) or the spot channel (a custom
printing color); and it will be flattened to a single layer. If I want to retain
those features in the file, I need to choose a different file format, such as
Photoshop’s own PSD format. (Read more about alpha channels in Chapter 8
and about spot channels in Chapter 6.)

No matter which of the file formats you choose, if you add layers, type,
adjustment layers, channels, or paths to your image, keep the original as an
unflattened/unmerged (all the layers are preserved) Photoshop (PSD) or
layered TIFF file. In the future, should you ever need to make changes to the
image or duplicate an effect in the image, you won’t need to start from
scratch.

Formats for digital photos

If you print your images yourself at home or the office, you can stick with the
original format or use the PSD Photoshop format. If you send the photos to
the local camera shop (or discount store) for printing, stick with JPEG — or,
if they accept it, TIFF. Here are the pros and cons of the major formats that
you should consider for photos:

+~ PSD: Photoshop’s native file format is great for saving your images with
the most flexibility. Because the PSD format supports all of Photoshop’s
features, you don’t need to flatten your images — and keeping your
layers lets you make changes later. If your file size is very large (4MB
or larger), make a TIFF or JPEG copy before printing, flattening all the
layers. Don’t send PSD files to the local shop for prints.
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v~ TIFF: Although the TIFF file

format (as you use it in e —
Photoshop) can save your i =

"o

layers and most other
Photoshop features, make sure
to choose LayerswFlatten Image

Pinel Grder

before sending files out for Siuiming arcs) Sdote Mingen
) Per Channel i ) Including layers w 1l inereasn file
printing. Layered TIFF files gen- S m Co
erally are compatible only with e
programs in the Creative Suite. If s e s S
you don’t flatten the image prior e compression
to saving as TIFF or if you elect i e st s
to include layers when saving as | =2t mdsneacon
TIFF, Photoshop presents you
with a gentle reminder, as Figure 2-14: Flatten layers before saving a TIFF

shown in Figure 2-14. for use in other programs.

v JPG: JPEG, as it’s called, is actually a file compression scheme rather
than a file format, but that’s not important. What is important is that
JPEG throws away some of your image data when it saves the file. Save
important images in PSD or TIFF and use JPEG only for copies. When
should you use JPEG? When sending images to a photo lab that doesn’t
accept TIFF files and when sending images (perhaps by e-mail or on CD)
to people who don’t have Photoshop. Unlike PSD and TIFF, you can open
JPEG images in a Web browser and print from there — and so can
Granny, and Cousin Jim, and that overseas soldier you adopted. When
saving JPEGs, the lower the Quality setting you choose in the JPEG
Options dialog box, the smaller the file but also the more damage to the
image. | discuss saving as JPEG in more detail in the sidebar, “Resaving
images in the JPEG format.”

~ PDF: It’s easy to overlook Adobe’s PDF format when talking about
photos, but you should consider using this format. Although the local
photo lab probably won’t accept it, it’s a great format for sharing your
pictures with folks who don’t have Photoshop. Unlike JPEG, your images
won'’t be degraded when saving as PDF; and like JPEG, just about anyone
with a computer can view the files. (Adobe Reader, which you can use
with PDFs, is found on just about every computer now, just like Web
browsers for JPEG.) Keep in mind, however, that PDF files are larger
than JPEGs.

1 Large Document Format (PSB): Really, really, really big pictures — over
30,000 pixels wide or long or both — need to be saved in the PSB file
format. Will you ever need this format? Consider that 30,000 pixels at a
photo-quality resolution of 300 ppi is 100 inches long. At a resolution of
85 ppi, more appropriate for a long banner to hang in a hallway, you're
talking about artwork that stretches almost 30 feet! Can your printer do
that? If not, you probably don’t need the PSB file format.
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You could theoretically use a number of other available formats, such as DCS,
PNG, and Photoshop Raw, but there’s no real need with the more common
and more versatile formats about which you just read.

If you're working with photos from your digital camera and you want to save
them as JPEG but that format isn’t available in the Save As dialog box, con-
vert the image to 8-bit color with Image~>Mode=>8-Bits/Channel. If you shot
the image in Raw (or TIFF) and need to save as JPEG, you’ll have to convert
to 8-bit color because JPEG doesn’t support 16-bit color.

Formats for Web graphics

Generally speaking, you use Photoshop’s Save for Web & Devices command
rather than Save As to generate copies of your images for use on a Web site
or for use with cellphones, PDAs, and other such devices. Here are the three
file formats that you need for the Web:

1 JPG: Use JPEG for photos. Remember to
resize the photo so that it fits on a Web page.
When selecting a Quality setting, you need
to balance image appearance with file size.

A smaller file downloads (and displays in a
Web browser) faster, but a larger file generally
looks better. If you reduce the Quality setting
until just before the image doesn’t look great,
you’ve hit the sweet spot — the compromise
between file size and image quality.

v~ GIF: GIF is more appropriate for items like
Web buttons and banners (such as those
shown in Figure 2-15) than it is for photos. If
you save a photo that’s more than perhaps
100 x 100 pixels in size, you might see some
degradation of the image quality as similar
colors become one color. When you save an
image as GIF, it can contain no more than
256 distinct colors. JPEG and the other
common file formats can have thousands

of different colors. Figure 2-15: Use GIF for Web
»* PNG: PNG comes in two types: PNG-8 (which  interface items.

is a substitute for GIF) and PNG-24 (which is a

substitute for JPEG). PNG has a couple of advantages for Web designers,

such as support for transparency, but not all Web browsers can display

PNG graphics. Generally speaking, it’s safer to use JPEG and GIF.
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Formats for commercial printing

You’re the Photoshop master of your office. Everyone knows that you under-
stand everything about digital images. So you're the right person to create
the company’s new brochure. Except you're a photographer. Or you're a Web
designer. Or you're actually pretty new to Photoshop. And you don’t have a
clue about preparing images for a commercial printing press.

Here’s what you need to know about file formats for those CMYK
(cyan/magenta/yellow/black) color images that you're sending to the print
shop:

v~ TIFF: TIFF is generally a solid choice. Use TIFF for photographic images
that don’t contain any type layers.

1~ EPS: Choose EPS if your image has type. Don’t flatten or merge the type
layers before using Save As to create the EPS. In the EPS options, make
sure to select the Include Vector Data check box to ensure that your
type prints perfectly.

If you reopen an EPS file in Photoshop, your type layers get merged.
Don’t! Instead, make sure to save your original file as PSD and, should
you need to make changes, open the PSD and create a new EPS file when
you're done editing.

v~ PDF: PDF offers the same disadvantage (don’t reopen in Photoshop) as
the EPS file format. But it also offers support for spot color channels,
alpha channels, and paths — options not supported by EPS. (Spot
channels are used with custom colors, and alpha channels store informa-
tion about transparency in the image.) If your file uses any of these
features, choose PDF over EPS, if your print shop accepts PDFs.

When saving as PDF, the PDF Options dialog box offers you Preserve
Photoshop Editing Capabilities. If you select the option, the PDF file will
reopen in Photoshop CS4 with layers and editable type. However, this
option isn’t compatible with Photoshop CS and earlier, and it can cause
problems in a page layout program other than InDesign.

1~ PSD: Use PSD only if you're adding the image file to a project in Adobe
InDesign. Don’t send PSD files to a print shop.

v DCS: DCS 2.0 is a variation of the EPS file format that supports spot
color channels and alpha channels. Use it primarily with QuarkXPress.

Formats for PowerPoint and Word

If the final destination of your image is PowerPoint or Word, use the PNG file
format. If your image has areas of transparency in it, PNG is definitely the way
to go. (Read about the two types of PNG files in “Formats for Web graphics,”
earlier in this chapter.)
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Resaving images in the JPEG format

JPEG uses a /ossy compression scheme: That is,
as part of the compression process, it actually
permanently throws away some data when you
save your image. The lower the Quality setting,
the more image degradation occurs. Take a look
at the figure here. The original image is on the
left. In the middle is the same image saved in
JPEG format with high quality and then on the
right with low quality. Take a look at the cheek
and the area between the top row of beads and
the chin. See what | mean by degradation?

If you save by using JPEG a second time, even
more data is thrown away. Every time you save,
your image quality suffers. Yes, indeed, you might
sometimes need to open a JPEG image, make
some changes, and save as JPEG again (per-
haps for the Web, perhaps to share with non-
Photoshop friends and family). To minimize
damage to the image, either use the highest set-
ting (12) for the Quality setting or (if you know it)
the exact same setting used last in Photoshop.

© O O 8 ©Ps003008.tif @ 300%(RG... | O M &

© PS003008 copy.jpg @ 30

§ @ PS003008 copyl.jpg @3... |

@] 4r

vz = /]
© 1997 PhotoSpin, PhotoSpin image #PS003008

And what about all that neat clip art that you have on your hard drive? How

do you use those images when Photoshop won’t open the vector-based

WMF and EMF clip art files? Here’s how you get clip art into Photoshop, quick

and easy:

1. Open a new document in Word (or a comparable word processing

program).
2. Add the clip art.

In Word, choose Insert>Picturer>Clip Art (or your word processor’s
comparable command). Click directly on the artwork and drag the
lower-right corner to resize it to the dimensions that you need in
Photoshop. (The artwork comes into Photoshop at 300 ppi.)
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3. Choose Edit=>Copy.

. Switch to your Photoshop

. Choose Edit~>Paste. e

7| FROM CLIPART TO CAMERA

THE

This copies the image to the
Clipboard (the computer’s
memory) in Word.

document.

By e vy

You have your clip art, ready to

use in Photoshop! Use the Edit<> Figure 2-16: Copy vector artwork from Word
Transform commands to scale,  and paste into Photoshop.

rotate, and otherwise fit the clip

art into your design. (See Figure 2-16.)
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Taking the Chef's Tour of
Your Photoshop Kitchen

In This Chapter
Understanding the general guidelines for working in Photoshop
Working more efficiently with customization
Determining your preferences and color settings
Troubleshooting Photoshop

Iknow you're hungry to dive right in and start mixing up some master-
pieces, but before you fire up the stove, look around the Photoshop
kitchen. Get to know your spoons from your ladles, your pots from your
pans, figure out how to turn on the blender . . . that sort of thing.

In this chapter, rather than going through all the Photoshop
menus, panels, and tools (which would take several
hundred very boring pages), I show you some basic
operational concepts. (But don’t worry — you can
read about how to use specific commands and tools
throughout the book, in the chapters most appropri-
ate for them.) Here you discover such things as how
to spot which menu commands have dialog boxes,
what the little symbol in the upper-right corner of a
panel does, and which tools don’t use the Options
bar. You also read about customizing your Photoshop
environment for faster and more efficient work. Next I
show you how to set up Photoshop’s Preferences and
Color Settings. And to wrap up the chapter — perhaps the
most important section in this entire book — I explain what to
do when Photoshop doesn’t seem to be working properly.

A
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Food for Thought: How Things Work

\\3

A good understanding of certain fundamental operations and features in
Photoshop provides you with the background that you need in order to
follow the recipes or get creative and whip up some delicious artwork.

And don’t forget about Photoshop’s Tool Tips. If you don’t know what some-
thing or some option does, park your cursor over it for a couple of seconds,
and Photoshop provides its information in a little box.

Ordering from the menus

When you’re working in Photoshop, you see a horizontal list of menus spread
across the very top (Mac) or near the top (Windows) of the screen: File, Edit,
Image, Layer, Select, Filter, View, Window, and Help. (If you also see the
Analysis and 3D menus, you have Photoshop CS4 Extended.) On the Mac, the
program also has a menu named Photoshop, just to the left of the File menu.

As with most programs, you click the # Photoshop File Edit % Liyer Select F:l!er View Window  Help
name of a menu to reveal its com- pr— .
mands. For both Mac and Windows, TR or
you can click and hold down the e %
mouse button until you're over the A ——
command you want; or, you can click e A3
and release, move the cursor, and - ki

A N uplicate, Flip Canvas Horizontal
then click again. Some commands, s e e i it

such as Crop and Reveal All, are
executed immediately after you
choose them. When a command
name in the menu is followed by an Figure 3-1: Some commands have submenus,

ellipsis (. . .) — the Image Size and some have dialog boxes.
command shown in Figure 3-1, for

example — you know that a dialog box will open so that you can input vari-
ables and make decisions. A triangle to the right of a command name, such as
that which you see next to Image Rotation, indicates a submenu. If you click
the command name, another menu appears to the right. The cryptic set of
symbols to the right of the Image Size command is the keyboard shortcut for
opening the command’s dialog box. (I show you how to assign keyboard
shortcuts later, in the section “Sugar and spice, shortcuts are nice.”)

As you read in the upcoming section, “Clearing the table: Custom work-
spaces,” Photoshop menus are customizable — you don’t have to see com-
mands that you never use. You can also color-code your menu commands,
making it easier to spot those that you need regularly.
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When a specific command appears grayed out in the menu (in gray type
rather than black), that command isn’t available. Some commands, such as
Reveal All in Figure 3-1, are available only under specific circumstances, such
as part of the image being hidden with the Crop tool. When working with
Photoshop’s creative filters, you'll find that many aren’t available unless
you’re working with an 8-bit RGB (red/green/blue) image. (Color modes and
bit depth are discussed in Chapter 6; filters are explored in Chapter 15.)

Your platter full of panels

Photoshop, like the other programs of the Adobe Creative Suite, uses floating
panels. The panels, many of which you see along the right edge of your
screen, usually appear on top of (float over) your image window. The image
window can hide any panels docked to the side when the image window is
floating free on screen. (Panels can hide other panels, too.) The Options bar
across the top of the work area and the Toolbox (technically the “Tools
panel”) along the left edge of the screen are also panels.

Panels contain Photoshop features that you might need to access regularly
enough that using a menu command is inconvenient. (I can’t imagine having
to mouse to a menu command every time [ want to change tools or select a
specific layer!) You don’t always need to have your panels visible. In
Photoshop, press the Tab key to hide all the panels or press Shift+Tab to hide
all but the Toolbox and the Options bar. With fewer panels visible, you pro-
vide more room for your image. You can selectively hide and show panels via
the Window menu.

Photoshop uses expanding/collapsing panel docks. As shown to the right in
Figure 3-2, clicking the double-arrow button at the top of a stack of panels col-
lapses that stack to a tidy group of icons. The Color, Adjustments, and Layers
panels are fully visible. The Swatches, Styles, Masks, Channels, and Paths
panels — “nested” with the three visible panels — can be made visible by
clicking on the panel tab. The collapsed Navigator, Histogram, and Info
panels all together occupy only a tiny fraction of the screen, those three but-
tons to the left of the Color panel. In Photoshop’s Preferences (discussed
later in this chapter), you can even elect to have each docked palette auto-
matically collapse when you’re done working with it.

By clicking and dragging a panel’s tab when the panel isn’t collapsed, you can
move it to another grouping or pull it out of its grouping and away from the
edge of the screen. You might, for example, want to drag the Clone Source
panel away from its buddies to make it more easily accessible while perform-
ing a complex clone operation. (The Clone Source panel is used with the
Clone Stamp tool. You can specify up to four different source locations and
easily switch among them.)

b5
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Figure 3-2: Nesting and collapsing panels opens up the work area.

Many of the panels are resizable. Like
an image window, you drag the
lower-right corner of the panel to
expand or contract it. Almost all the
Photoshop panels have a panel menu
from which you select various
options. (The Toolbox and Options ggi: ——

bar don’t have menus.) You open the

panel menu by clicking the small

button in the upper-right corner of Figure 3-3: Access a panel’s menu by clicking
the panel, as shown in Figure 3-3. the button below the double-arrow. (Clicking
The panel menu contains such the double-arrow expands or collapses the
options as thumbnail size (for exam- panel group).

ple, the Layers, Channels, and Paths

panels); how to display items in the panel (Swatches, Styles, and Brushes
among others); or even the size and content of the panel (Info and
Histogram).

HISTOGRAM

+ Compact View
Expanded View
All Channels View

You might have noticed in Figure 3-2 that the Photoshop Toolbox is one tall
skinny column along the left edge of the screen to free up even more work-
space. If you prefer a shorter, squatter two-column Toolbox, click the
Expand/Collapse button (the double arrow) at the top of the column.
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The content of
some panels

Preset Manager

Preset T P
changes automat- B e T "] (Coone
ically as you work " E o Lo wlal2 ZIEL Coan)
with your image. 55 71;3 e = s.}:;, . _,_Su 2;0 s?u ﬁ :
Add a layer’ and | 2: ?7 Custom Shapes %7 4 36 | 44 | 60 | 14 | 26 | 33

& i Tools #8 * i
tl;le Layers panel 42 | 55 7m'2§r 192 % % % @ s

n e = :
SHOWS a new | 39 .t? 11 | 48 [ 32 | 55 | 100 7.5 4-5

layer. Save a
selection, and the
Channels panel
shows a new
alpha channel. If
you drag a shape
tool, the Layers
panel gets a new
layer, and the
Paths panel Figure 3-4: Use the Preset Manager to control the content of a

shows the layer’s number of panels.

vector mask. You

control some other panels by loading and deleting content through the panel
menus or with the Edit>Preset Manager command. Use the Preset Manager
(as shown in Figure 3-4) to save sets of your custom bits and pieces as well as
to load and delete items from the panels.

In addition to the content of the Brushes, Swatches, Styles, and Tool Presets
panels, you use the Preset Manager with a number of pickers. Pickers are sort
of mini-panels, available only with certain tools or features. The Gradient and
Custom Shape pickers are accessed through the Options bar when those
tools are in use. The Pattern picker is found in the Fill dialog box, the Layer
Style dialog box, and (with some tools) in the Options bar. The Contour
picker is used with six of the effects in the Layer Style dialog box.

When you create custom layer styles, brushes, gradients, and the like, use
the Preset Manager to protect your work. Create sets of the items and save
those sets with the Preset Manager. Then remember to save copies of the
sets someplace on your hard drive outside the Photoshop folder so that you
don’t accidentally delete them if you ever (oh, no!) have to reinstall
Photoshop. Remember that new content of your panels is stored only in
Photoshop’s Preferences file (introduced later in this chapter) until you
create and save sets.

The tools of your trade

You control the behavior of Photoshop’s tools through the Options bar. With
the exception of a few path-related tools (Direct Selection, Add Anchor Point,
Delete Anchor Point, and Convert Point), every tool in Photoshop has
options. The Options bar changes as you switch tools. In some cases, the
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Options bar changes while you work with the tool. In the case of the Crop
tool, as shown in Figure 3-5, you have one set of options before you drag the
tool and another set after establishing the bounding box.

Figure 3-5: The Options bar changes when you have an active crop marquee.

The behavior of some tools changes when you add one or more modifier keys
(88, Shift, and Option for the Mac; Ctrl, Shift, and Alt for Windows). As an
example of how modifier keys can affect tool behavior, consider the
Rectangular Marquee and Elliptical Marquee tools:

+~ Hold down the Shift key while dragging. Normally the marquee selec-
tion tools are freeform — you drag however you like. When you hold
down the Shift key while dragging, on the other hand, you constrain
the proportions of the selection to a square or circle (rather than
a rectangle or ellipse).

* Hold down the Option/Alt key while dragging. When you hold down
the Option/Alt key while dragging a marquee selection tool, the selection
is centered on the point where you first clicked. Rather than being a
corner of a selection, that starting point is the center of the selection.

1~ Hold down the Shift and Option/Alt keys while dragging. You can
select from the center while constraining proportions by using the Shift
and Option/Alt keys together.
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1~ Use the Shift key to add to an existing selection. If you already have an
active selection in your image, Shift+dragging a selection tool adds to
that selection. (Press Shift before you click and drag.)

1~ Use the Option/Alt key to sub-
tract from an existing selec-
tion. When you have an existing
selection and you hold down
the Option/Alt key, you can drag
to subtract from the selection.
Note in Figure 3-6 that the selec-
tion tool’s cursor shows a small
minus sign when subtracting
from a selection.

 “Double-clutch” with the Shift
or Option/Alt key. You can even
constrain proportions or select
from the center and add to or subtract from a selection. Press the Shift
key (to add to the existing selection) or the Option/Alt key (to subtract
from the existing selection). Click and start dragging the marquee
selection tool. While continuing to hold down the mouse button, release
the modifier key and press and hold Shift (to constrain proportions),
Option/Alt (to center the selection), or both; then continue to drag your
selection tool. You might want to use this technique, for example, when
creating a donut-shaped selection. Drag the initial circular selection
and then subtract a smaller circular selection from the center of the
initial circle.

Figure 3-6: Use the Option/Alt key with a
selection tool to subtract from a selection.

Don’t be afraid to experiment with modifier keys while working with tools.
After all, you always have the Undo command (88+Z/Ctrl+Z) at hand!

Get Cookin’ with Customization

Customizing Photoshop not only helps you work faster and more efficiently,
but it can also help you work more precisely and prevent tragic errors.
Consider using a Crop tool preset to create a 5 x 7 print at 300 pixels per inch
(ppi). Such a preset will always produce exactly those dimensions, every
single time. Setting up the Crop tool each time you need a 5 x 7 at 300 ppi
doesn’t just waste time: It also opens the door for time-consuming or project-
wrecking typos. (“Oops! I guess I made a mistake — this image is 5 x 7 at

only 30 pixels per inch!”)

Clearing the table: Custom workspaces

One of the easiest ways to work more efficiently is to see your image better.
Generally speaking, bigger is better, so the more room you have on the
monitor to display your artwork, the better you can zoom in and do precise
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work. The easiest way to gain workspace? Press the Tab key to hide
Photoshop’s panels. Pressing Shift+Tab hides all the panels except the
Options bar and the Toolbox.

Keep in mind that it’s best to use 100% zoom when evaluating your image for
banding or moiré and when applying filters. Any other zoom factor is a simu-
lation of the image’s appearance. If you have a computer and video card that
support OpenGL drawing (check the computer’s User Guide or call your tech
support folks), you have much better on-screen display. But 100% zoom is
safest when making critical decisions.

You can also drag the panels that you need regularly to a custom group of
panels. To move a panel, drag it by the tab and “nest” it with other panels.
And don’t forget that the major panels have keyboard shortcuts assigned to
show and hide. Although keyboard shortcuts are customizable (as you can
read later in this chapter), here are the primary panels’ assigned F keys, the
function keys that appear at the top of your keyboard:

1 Actions: Option/Alt+F9
+~ Brushes: F5

1~ Color: F6

+~ Info: F8

v~ Layers: F7

Any panels nested with the panel that you show/hide are also shown and
hidden. And don’t forget that you can always restore all panels to their
default locations by choosing Windowr>Workspacer>Essentials (Default).

The most efficient way to customize your work area is to create and save spe-
cialized workspaces. Arrange the panels exactly as you need them for a par-
ticular job you do regularly, then choose Window=>Workspacer>Save
Workspace (in the Windows menu, visible panels are indicated with a check-
mark), and name the workspace for that type of job. Then you can make a
specialized workspace for each type of work you do. For example, perhaps
when you do color correction, you need to see the Histogram panel (in the
expanded view), the Info panel, and the Channels panel. Arrange those panels
how you need them and then hide the rest, saving the workspace named as
Color Correction. Or, perhaps when you create illustrations in Photoshop, you
need to see the Layers and Paths panels at the same time. Drag one out of the
group to separate it, position them both where convenient, and save the
workspace as lllustration.

To access a saved workspace, choose Window=>Workspace and select it
from the list at the top of the menu, as shown in Figure 3-7. You can see some
preset custom workspaces in the middle sections of the menu, as well.
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You can also save the current state
of the customizable keyboard short-
cuts and menus in your workspace.
Although streamlining the menus for
the specific work you're doing is a
great idea, it’s probably not such a
great idea to have more than one set
of custom keyboard shortcuts. The
time it takes to remember which
shortcuts go with the current work-
space (or to undo a mistake caused
by the wrong shortcut) is time
wasted.

To customize Photoshop’s menus,
choose Edit=>Menus, which opens
the Keyboard Shortcuts and Menus
dialog box. (Alternatively, choose
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Figure 3-7: Select a workspace from the menu
to instantly rearrange your panels.

Edit->Keyboard Shortcuts and click the Menus tab.) Here you can find every
menu command listed. You also have the option of hiding a command or
assigning a custom color to make it easier to identify in the menu. You might,
for example, hide the artistic filters that you never use, and color-code the
others according to how you like or use them (see Figure 3-8).
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Color Menu ltems.

1) Te add codor 1o a menu iem, click in the Color column.
2) To trn off menu colors, go to the General Preference panel and uncheck Show Menu Colors.

Figure 3-8: You can hide menu commands and color-code the visible commands.
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In addition to the application menu commands (from the menus at the top of
the screen), you can switch the Menus For pop-up to Panel menus and cus-
tomize those menus, too. Don’t forget to save your customized menu arrange-
ments with the button directly to the right of the Settings pop-up. Your saved
menu set will appear in that Settings pop-up for easy access.

Sugar and spice, shortcuts are nice

The Photoshop keyboard shortcuts can save a bunch of time. Rather than
mousing to the Toolbox to select the Brush tool, just press the B key. To open
the Levels dialog box, press 3+L/Ctrl+L instead of mousing to the Image
menu, down to the Adjustments submenu, and then over and down to Levels.

Photoshop has customizable keyboard shortcuts. Because the default set of
shortcuts is pretty standard — not only throughout the Adobe Creative Suite
but also with other major programs — you’re probably best served by
making only a few changes. Open Keyboard Shortcuts (shown in Figure 3-9)
through the Edit menu to make one major change and then any changes for
personal preferences. Change 88+Z/Ctrl+Z to use Step Backward. In most pro-
grams, pressing 38+Z/Ctrl+Z keeps undoing — reverting through a series of
previous actions in the program. In Photoshop, however, that shortcut tog-
gles an Undo/Redo function; that is, press once to undo and press a second
time to reverse the undo. Bah! Make Photoshop conform to the undo-undo-
undo behavior common to other programs. In Keyboard Shortcuts, under
Edit, change 8+Z/Ctrl+Z to Step Backward and then use

38 +Option+Z/Ctrl+Alt+Z to toggle between Undo and Redo.

Keybourd Shortcuts and Menvs
Kevbaard Shormuns AT [
Ser: | Photoshop Defaults = ] H e A [ Cancel
Shartcuts For: :ﬂpp‘l‘bca;lun'ﬁ:!ﬁu =]
Agplrcation Menu Command shortcut ( Accept )
¥ Photoshop m J‘T.
¥ File
¥ Edic
Undo/Redo x4z { Add Sharteut )
& { Delete Shorteur |
Step Forward Shift+ 242
" e o —
Step Backward ®+Z | Summarize...
Fade... Shilt+ 34 F i
Cut KX

B+ is already in use and will be removed from Edit = Undo/Redo if accepted.

(" Accent and Go To Canflict ) ( Undo Changes )

Figure 3-9: Assign custom keyboard shortcuts to speed your work.
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Spoons can’t chop: Creating tool presets

One of the keys to efficient, accurate work in Photoshop is using the right
tool for the job. The Patch tool, for example, copies texture only. If you need
to cover a spot on a client’s face, changing both texture and color, you need
the Clone Stamp tool rather than the Patch tool. (You can read about how the
tools work throughout this book.)

You can ensure that you're using not =g ‘= s o wTe T

only the correct tool but also the cor-
rect settings for that tool by creating
tool presets, which store your set-
tings from the Options bar. You can
then select the preset tool (and, of
course, that’s where the catchy name
comes from) from the Tool Presets  Figyre 3-10: Tool presets help you work
panel or from the left end of the faster and more accurately.

Options bar, as shown in Figure 3-10.
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Although just about any tool is a good candidate for tool presets, some are
just plain naturals. Consider, if you will, the Crop tool. As [ explain in Chapter
4, a photo from a high-end digital camera has an aspect ratio (relationship
between width and height of the image) of 2:3, and common print and frame
aspect ratios include 4:5 for 8 x 10 prints; 5:7; and 13:19 for large prints.
(Some lower-cost cameras shoot in different aspect ratios.) You'll often find
aneed to crop an image to a specific size to meet your printing requirements.
And, don’t forget resolution — printing in the correct size at the wrong
resolution is simply a waste of paper and ink! Set up a number of Crop tool
presets for your typical print sizes and relax, knowing that you’ll always be
cropping correctly.

Another logical candidate for tool presets is the Type tool. When you con-
sider all the options for the Type tool in not only the Options bar but also in
the Character and Paragraph panels, you have quite a bit to select and track.
To ensure consistent text from project to project, consider creating tool
presets for each project, including (as appropriate) headline and body text,
special effects and accent type, and even your copyright information.

Using the Preset Manager (opened through the Edit menu), you can drag the
tools presets up and down to rearrange them. Sort them in a logical order
or move the presets you use most often to the top of the panel. The changes
are for both the Tool Presets panel and the picker at the left end of the
Options bar.
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Season to Taste: The Photoshop Settings

3

The program-level Preferences and the Color Settings flavor all your work in
Photoshop. The options that you choose in Photoshop’s Preferences (or
simply the Prefs) control many facets of the program’s basic behavior.
Choices made in the Color Settings dialog box determine how your work
looks, both on-screen and in print. And when you get down to brass tacks,
that’s what it’s all about — the appearance of your artwork.

Standing orders: Setting the Preferences

Photoshop’s Preferences file stores a whole lot of information about how you
use the program. Whether you prefer to measure in inches or pixels, how you
like the grid and guides displayed, what size thumbnails you prefer in your
panels, which font you used last — all sorts of data is maintained in the Prefs.
Much of the info in the Preferences is picked up automatically as you work
(such as the size and color mode of the last new document you created,
whether the Character panel was visible when you last shut down the pro-
gram, and which tool options were selected in the Options bar), but you must
actively select a number of options in the Preferences dialog box, as shown in
Figure 3-11.

Preferences

Color Picker: ~Adobe [
Image Interpolation: Bicubic (best for smooth gradients) r‘?'! ( Cancel )
— Options ( Prev
_| Auto-Update Open Documents EAnimaied Zoom ( Next
_I Beep When Done E Zoom Resizes Windows
M Dynamic Color Sliders " Zoom with Scroll Wheel
@ Export Clipboard @ Zoom Clicked Point to Center

™ Use Shift Key for Tool Switch ™ Enable Flick Panning
E Resize Image During Paste/Place

= E History Log
Save Log Items To: @ Metadata
O Text File

) Both

Edit Log Items: Detailed \»‘8

(' Reset All Warning Dialogs ',\

Figure 3-11: Use Photoshop’s Preferences to establish many program behaviors.

Your custom styles, brushes, Actions, and the like are recorded only in
Photoshop’s Preferences until you actually save them to your hard drive.
That makes them vulnerable to accidental loss. Use the Actions panel menu
command Save Action to save sets of Actions (not individual Actions) and
use the Preset Manager (under the Edit menu) to save sets of your other bits
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and pieces. And make sure to save them in a safe location outside the
Photoshop folder — you wouldn’t want to accidentally delete your custom
items if you should ever have to (oh, no/) reinstall Photoshop, would you?

Open the Prefs on a Mac with the keyboard shortcut 8+K or choose
Photoshop=>Preferences to select one of the ten specific subsets of
Preferences to change. The shortcut for Windows users is Ctrl+K, and the
Preferences submenu is under the Edit menu. The default settings are
perfectly acceptable (after all, they are the defaults for a reason), but the
following sections cover some changes to the Prefs to consider, listed by
the section of the Preferences dialog box in which you find them.

Preferences->General

If you’ll be doing a lot of resizing and scaling in Photoshop, consider changing
the Image Interpolation method. Use Bicubic Smoother if you'll be increasing
pixel dimensions regularly; select Bicubic Sharper when downsizing.

The History Log maintains a record of what you've done to a specific image.
You can record when you opened and saved a file with the Sessions option, a
summary of what you did with the Concise option, or you can keep track of
every command, every feature, and every setting you used with the Detailed
option! And the log can be recorded to a text file or stored in an image’s
metadata for retrieval with Photoshop’s Filer>File Info command.

One option not selected by default that you may find very handy is Zoom
Clicked Point to Center. When you click with the Zoom tool, this option
automatically centers the view on the point where you clicked.

If the options Animated Zoom and Enable Flick Panning are grayed out, your
computer doesn’t support OpenGL drawing. If you do see these options,
they’re worth a try — zooming in and out is smooth and a short, quick jerk
of the Hand tool can send a zoomed-in view shooting across the screen.

Also note the button named Reset All Warning Dialogs at the bottom of the
General pane. Many of Photoshop’s handy reminder messages include a
Don’t Show Again option. If you someday decide that you do indeed need to
start seeing one or more of those reminders again, open the Prefs and click
this button.

Preferences-lnterface
The Interface panel of the Preferences offers several options of note:
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* Screen Modes: You can easily customize the look of Photoshop’s three
screen modes.

~ Show Channels in Color: When only one channel is active in the
Channels panel, it normally shows as a grayscale representation of the
image. If you prefer to have the active channel appear in its own color,
select this option. [ do suggest to you, however, that after you get
comfortable working with individual channels, the default grayscale is
more accurate and easier to see.

1~ Show Menu Colors: As | discuss earlier in this chapter, you can assign
colors to specific commands in the Photoshop menus. That might make
it easier for you to quickly spot and select often-used commands. Use
this option to disable the color coding without having to deselect each
assigned color.

1~ Show Tool Tips: Pause the cursor over just about any tool or option in
Photoshop and a little yellow box appears, telling you what that feature
does. This is a great feature while you’re learning about Photoshop, but
might be distracting after you master the program. Disable the Tool Tips
if you decide you no longer need or want to see them.

1~ Auto-Collapse Iconic Panels: If you prefer an uncluttered workplace,
here’s a great option for you! When selected, panels in icon mode (click
the upper bar of a group of panels) collapse to buttons. To open a panel,
you click its button. When Auto-Collapse is selected, the selected panel
automatically closes when you click elsewhere in Photoshop. If you need
to keep a specific panel open while you work (perhaps Histogram or
Info), drag it out of its group and away from the edge of the screen, and
it will stay open until you close it.

1~ Auto-Show Hidden Panels: Position the cursor over a collapsed panel
and it springs open.

* Remember Panel Locations: Photoshop, by default, remembers the
visibility and location on-screen of all panels when you quit the program.
The next time you open the program, the panels are just where you
left them. If you find that you often leave panels scattered willy-nilly all
over the screen and must choose Windowr>Workspacer>Reset Panel
Locations before you can get any serious work done, consider deselect-
ing this option. (You might also want to deselect the option on shared
machines and in school or lab environments where the default appear-
ance of Photoshop is desired each time the program is started.)

 Open Documents as Tabs: Photoshop, by default, opens each document
as a tab across the top of the work area. You click on a tab to bring that
image to the front. If you find that you're constantly dragging tabs off to
create floating windows, deselect this option in the Preferences.
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Preferencesc>File Handling

Image previews add a little to the file size, but in most cases, you want to
include the preview. On Macs, you have the option of including a file exten-
sion or not (or having Photoshop ask you each and every time). Even if you
don’t plan on sharing files with a Windows machine, I strongly recommend
that you always include the file extension in the filename by selecting the
Always option. Likewise, | suggest that you always maximize PSD and PSB file
compatibility. This ensures that your Photoshop files can be opened (with as
many features intact as possible) in earlier versions of the program and that
they’ll function properly with other programs in the Creative Suite. If you're
in a work group situation (with two or more people working on a single
project), [ urge you to use Version Cue (part of the Creative Suite) to manage
work files. It’s a truly great way to avoid singing the “Which Version Is
Current?” blues.

New in Photoshop CS4 is direct access to the Camera Raw Preferences
through Photoshop’s Preferences. That’s where you can decide whether or
not you want to open JPEG and TIFF files in Adobe Camera Raw. (Camera
Raw format is the subject of Chapter 7.)

Preferences=>Performance

The Performance panel contains options related to how Photoshop runs on
your computer.

1~ Memory Usage: If you have 2GB or less of RAM, leave the memory allo-
cation set to the default (70% for Mac, 55% on Windows). If you have
more than 2GB of RAM, try bumping the memory allocation to 100%. If
things seem slower rather than faster, back off the memory allocation to
perhaps 85%.

v Scratch Disks: Photoshop’s scratch disks are hard drive space used to
support the memory. Use only internal hard drives as scratch disks —
never an external drive, a network drive, or removable media! If you
have multiple internal hard drives, consider a dedicated partition
(perhaps 15-50GB) on the second drive — not the drive on which the
operating system is installed. Name the partition Scratch and use it
exclusively as a scratch disk for Photoshop (and perhaps Adobe
Illustrator). If you have a couple of extra internal drives, each can have
a scratch partition. (On a Windows computer, you might see a message
warning you that the scratch disk and the Windows paging file, which
serves the same basic purpose at the system level, are on the same
drive. If you have only one internal hard drive, ignore the message.) To
re-order the scratch disks, click on the scratch disk in the list and then,
rather than dragging, use the arrows keys to the right (as shown in
Figure 3-12).
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Figure 3-12: Re-order the scratch disks with the arrow buttons.

1~ History States: This field determines how many entries (up to 1,000)
appear in the History panel. Storing more history states provides more
flexibility, but at a cost — storing too many history states uses up all
your available memory and slows Photoshop to a crawl. Generally
speaking, 20 or 30 is a good number. If, however, you do a lot of opera-
tions that use what I call “little clicks,” such as painting or dodging/burn-
ing with short strokes, that History Panel fills up quickly. For such
operations, a setting of perhaps 50 or even 60 is more appropriate.

1~ Cache Levels: The image cache stores low-resolution copies of your
image to speed on-screen display at various zoom levels. Although this
process speeds up screen redraw, the price is accuracy. Unless your
video card has trouble driving your monitor at your selected resolution
and color depth, you might be better served by Cache Levels: 1. That
gives the most accurate picture of your work. (But remember to make
critical decisions at 100% zoom, where one image pixel equals one
screen pixel.)

1 GPU Settings: This area displays information about your computer’s
video card. If your system has the capability, you'll see a check box for
Enable OpenGL Drawing. This provide smoother, more accurate views at
all zoom levels and other enhancements, including the capability to
rotate the image on screen — not rotate the canvas, but rotate just the
on-screen image. And that’s too cool for words when painting a complex
layer mask!

Preferences=>Cursors

Photoshop offers you a couple of ways to display cursors for painting tools.
You can show the tool icon (Standard), a small crosshair (Precise), or a repre-
sentation of the tool’s brush tip, indicating the size and shape of the brush
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(Brush Size). With soft-edged brushes, the brush size cursor shows where the
tool will be applied at 50% strength or higher. Alternatively, select the Full
Size Brush Tip option, which always shows the full extent of the brush tip,
regardless of the Hardness setting.

You also have the option of adding a
crosshair in the middle of either
brush-size cursor. The crosshair
option is great for keeping a brush
centered along an edge or path, and
it just about eliminates the need for
the Precise cursor option. As you
can see in Figure 3-13, when working
with a soft brush, showing all the
pixels that are changed even a little  Figure 3-13: When working with a low Hardness
(to the right) might not give you an  setting, Normal Brush Tip is usually best.
accurate view of your work. (The

Normal Brush Tip cursor is shown at the top center and with the Show
Crosshair in Brush Tip option to the lower left.)

When you'’re sure that you have a brush-size cursor selected in the
Preferences but Photoshop shows you the precise cursor, check the
CapsLock key. Pressing CapsLock toggles the painting cursors between
precise and brush size.

Also found in the Cursors panel is the Brush Preview color. Click the color
swatch to open the Color Picker and assign a color to use when dynamically
resizing your brushes. (If you don’t have OpenGL drawing capability, the
brushes can still be resized, but the color preview will not be visible.) With a
brush-using tool active, press and hold down the Option+Control keys on
Mac and drag; on Windows, Alt-right-click and drag to resize the brush — on
the fly! Want to change the brush hardness? On the Mac, hold down the

38 +Control+Option and drag; on Windows, hold down Alt+Shift, and then
right-click and drag. Drag out to make the brush larger or harder; drag in to
make the brush smaller or softer.

Preferences=>Transparency & Gamut

If you find the gray-and-white checkerboard pattern distracting in images
with transparency, you can set Grid Size to None, which gives you a plain
white background in transparent areas of your artwork. If you work in
grayscale regularly, you might want to change the color of the transparency
grid to something that contrasts with your image; perhaps pale blue and
pale yellow.
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Preferences=>Units & Rulers

If you create Web graphics rather than print images, you probably want to
change the unit of measure from Inches to Pixels. Keep in mind that you

can change the unit of measure on the fly by right-clicking the rulers in your
image (which you show and hide with the shortcut 8+R/Ctrl+R). If you regu-
larly print at a resolution other than 300 ppi, you might also want to adjust
the default resolution for print-size new documents.

Preferences=>Guides, Grid & Slices

Photoshop offers Smart Guides, which appear and disappear automatically as
you drag the content of one layer into and out of alignment with the content
of other layers. Smart Guides

(magenta in color by default) show home

when the content of the layer you're

dragging aligns perfectly with the
edges or center of other layers’ con-
tent. See Figure 3-14. (Show/hide
Smart Guides through the Figure 3-14: The magenta guides show how the
Viewr>Show menu.) layer aligns with other layers.

The one thing you might want to change in this panel of the Preferences is
the Show Slice Numbers option. The slice numbers appear in the upper-left
corner of each slice when you’re subdividing Web graphics. Unless you
intend to edit the images individually later, you probably don’t need to know
which slice is which, so slice numbers are generally not necessary. Clear the
check box to remove the distractions.

Preferencesc>Plug-Ins

If you have third-party plug-ins, filters, and such that you purchased sepa-
rately for use in Photoshop, consider using a second folder for the plug-ins,
outside the Photoshop folder, and designate that folder as the Additional
Plug-Ins Folder in the Preferences. Having your extra plug-ins outside the
Photoshop folder means you won’t have to reinstall them if you have to
replace Photoshop. If any of those plug-ins date to Photoshop 5 — and still
work — you might need to enter the Photoshop 5 serial number as a legacy
so that the plug-ins recognize the new version.

Preferences->Type

Photoshop has a panel in the Preferences that you can use to select some
type-related options. Photoshop shows the font menu in each font’s name in
the actual typeface, and you can specify the size of that preview here.
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Ensuring consistency: Color Settings

If one term strikes fear deep in the heart of a typical Photoshop user, it’s color
management. Few aspects of the program are so misunderstood. Yet without
wise color management decisions, your images won’t print accurately. For
most Photoshop users, color management can be implemented with a few
key choices in the Edit=>Color Settings dialog box (shown in Figure 3-15),
which can then be saved for future use:

1~ Select an RGB work- ot setngs —
ing space. Open the o =
Color Settings dialog e g lr =
box (under the Edit oo e ===
menu) and select e ;:; e
your RGB working P ———
space — the color o s e s 8
space in which you At T
edit and create. If you e R T —
primarily create Web e e =
graphics, send your Gncer) (50
images to a photo lab B Sscsuiioosenlomdl T

for printing, or print Nkt s s [
with an inkjet printer
that uses only four
ink colors (cyan,
magenta, yellow, and
black), choose sRGB  Figure 3-15: Choose wisely in the Color Settings dialog box
as your color space.  for gptimal printing.

If you print to an

inkjet printer that uses six or more inks or you prepare artwork that will
be converted to a CMYK color space, choose Adobe RGB. (If you have
hardware and software to create a custom profile for your computer’s
monitor, use that profile at the system level so that it’s available to

all programs.)

1~ Elect to convert images to your working space. In the Color
Management Policies area of the Color Settings dialog box, choose
RGB: Convert to Working RGB. This ensures that the images you see
onscreen actually use your working profile.

1 Turn off the mismatch warnings. Clear the check boxes for those
annoying and time-wasting warnings that pop up on-screen any time
you open an image with a profile other than your working space. You're
intentionally converting to your working space — you don’t need to
reaffirm the decision every time.

01
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1 CMYK and Grayscale settings: CMYK (cyan/magenta/yellow/black)
color mode is used exclusively with images intended for output on
commercial printing presses and some color laser printers. (Don’t be
fooled by the inks you purchase for your inkjet printer — the printer’s
driver expects to convert from RGB, so sending CMYK color to an inkjet
will produce substandard output.) Likewise, you’ll use Grayscale very
rarely. If, in fact, you have an inkjet printer that is capable of printing
grayscale (such as the magnificent Epson R2400), you still want to have
an RGB image and let the printer’s print driver handle the grayscale con-
version. If, however, you are preparing an image for output on a commer-
cial press (in CMYK or Grayscale color mode), speak directly with the
person who will place the image into the page layout or with the print
shop to find out what settings to use for that particular job.

When it’s time to print, you’ll get the most accurate and pleasing color prints
when you let Photoshop (rather than the printer) control color. In the Print
dialog box’s Color Management section, choose Document to keep the source
space as your working space. In the Options area, choose Color Handling:
Photoshop Manages Colors and select the printer’s own profile for the
specific paper on which you’re printing as the Printer Profile. Use Relative
Colorimetric as the rending intent and leave the Black Point Compensation
check box marked. After you click the Print button, you see the printer’s
Print dialog box. Makes sure that the correct paper is specified and that the
printer’s color management is set to Off.

The preceding guidelines are appropriate for most, but not all, Photoshop
users. You might fall into a special category. If you exclusively create Web
graphics, in the Color Settings dialog box, choose Settings: Color Management
Off. In the Save For Web & Devices dialog box, to the upper right of the pre-
view area, choose Uncompensated Color. When saving images in the JPEG file
format, don’t embed ICC profiles. (/CC profiles make specific adjustments to
the appearance of your images to compensate for vagaries of the hardware. I
discuss color profiles in Chapter 4.) When you eliminate color profiles from
the equation, you’re creating Web graphics that any Web browser can show
properly (or, more accurately, “as properly as the viewer’s uncalibrated
monitor can display”).

If color in your images needs to be absolutely perfect because merely
accurate won’t do, consider purchasing hardware and software to calibrate
and profile all the devices in your workflow. GretagMacbeth and X-Rite
(www .xrite.com), ColorVision (www. spyder.datacolor.com), and
PANTONE (www . pantone . com) are three sources to explore.

When Good Programs Go Bad: Fixing Photoshop

Sometimes things happen. Bad things. Tools don’t work right. Simple com-
mands take ages to execute. Photoshop (gasp!) crashes! Don’t give up, and
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please don’t toss the machine through the window. (Hey, [ might be walking
past at the time.) Start with the easy fixes and work your way up as
necessary.

1~ Check the panels and selection. If a tool isn’t working as expected or
isn’t working at all, check whether you're inadvertently preventing it
from doing its job. See whether you have an active selection elsewhere
in the image or press 38+D/Ctrl+D to deselect. Look at the Layers panel:
Are you working on the correct layer? Is the layer itself active or a layer
mask? Is there no higher layer hiding the area in which you're trying
to work? Check the Channels panel: Are the color channels active?
At the left end of the Options bar, right-click (multibutton mouse) or
Control+click (single-button mouse) the tool icon and select Reset Tool.
Open a flattened 8-bit RGB image and try the tool or technique in that
image. If it works there, the problem isn’t Photoshop but rather the
specific image. Check the Imager>Mode menu to ensure you have an
appropriate color mode and bit depth.

1~ Reset Photoshop’s Preferences file to the defaults. Before replacing
the Prefs, open Photoshop’s Preset Manager (through the Edit menu)
and save any custom styles, gradients, brushes, and so forth. Save them
in a safe place, outside the Photoshop folder. Open the Actions panel
and save any sets of custom Actions with the panel menu Save Actions
command. (Remember that you must click a set of Actions — not an
individual Action — to use Save Actions.) Open the Preferences and
Color Settings and make notes about any special settings you’re using.
Quit Photoshop and restart the program with the 8+Option+Shift
keys pressed (Mac); or in Windows, position your fingers over the
Ctrl+Alt+Shift keys and immediately after launching the program (not
before), press and hold down the three keys. When asked whether you
want to delete the Settings file, release the modifier keys and confirm
the deletion; then allow Photoshop to finish starting. Reset your
Preferences and Color Settings and reload your custom bits and pieces.

1~ Reinstall Photoshop. If replacing the Prefs doesn’t solve the problem,
try reinstalling Photoshop. Save all your custom items (as described
earlier) and then uninstall Photoshop. Insert the Photoshop DVD and
launch the installer, then opt to uninstall. After uninstalling, restart your
computer (not always necessary, but a good practice) and reinstall.

If reinstalling Photoshop doesn’t solve the problem, the source might be at
the operating system level or perhaps a hardware problem. Call in the big
guns by contacting Adobe tech support:

www . adobe . com/support/phonenumbers/main.html
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Getting Images into and
out of Photoshop

In This Chapter

Mommy, where do pictures come from?
Keeping track of your images
Putting pictures on paper

Sharing your work

ou could, theoretically, open a new empty Photoshop file, paint in it,

save the file, and drive from house to house to show the artwork on
your computer to friends and family. However, you have lots of ways to share
your images that are much easier. You can print them, post them on
your Web site, or even e-mail them. And e-mailing an image file
across the country is much more convenient (and, of
course, more eco-friendly) than driving hither and yon
with your computer in the trunk.

In this chapter, | show you how to get images into
Photoshop from your digital camera and your scan-
ner and then how to keep those images organized
on your hard drive and CDs/DVDs. I discuss the
basics of printing your images on inkjet printers
(and alternatives) and tell you some things you need
to know to make sure you get the prints you expect.
[ also explain how to prepare images for sending

by e-mail.

Bringing Images into Photoshop

Artwork in Photoshop originates in one of three ways:
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»* You open an image with either the operating system’s Open dialog box
or the Adobe Open dialog box (as shown in Figure 4-1). To switch
between versions of the dialog box, click the button in the lower-left
corner.

» You import an image (typically through a scanning device).

1 You create an image from scratch by choosing Filem>New.

~ Gown
4+ 8 B DS & @

: A B
B s [ D o ien CETTI—— . 5w ov

8 ou b . Sorpimg ¥ Livwe Compr.aed

- Lasd  Whage 12 104
- L B e
W mossmarse
ACEL Pug-trt = St Otects a8
I Devetan * W reen W vanating Pt gas
2 e

i H - == . . —

— Lhase A Resdadle Documenn #
i o
[ y Ur Adsie Doy | fermat  Praceibon am 8]

._e Fin e - "Dowsr_
g aitn s e Dy MyMebwo  Flerolbps Al Fomsts v [ )
a o @ a
Pl -
Pdior M
il Sem:
[mcmnaey | [ | | Lan Adcbe Disog.

Figure 4-1: You can switch between the 0S and Adobe versions of the Open dialog box with
the button in the lower-left corner.

You can open an image into Photoshop by choosing File=>Open, through
Adobe Bridge, or by double-clicking the image file. If you double-click a file
and Photoshop doesn’t launch or the wrong program launches, you need to
associate the file format with Photoshop:
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1~ Adobe Bridge file association

a. Open Bridge’s Preferences with the shortcut 38+K/Ctrl+K.

b. In the column to the left, click File Type Associations.

c. In the lower right, click the Reset to Default Associations button.
1 Mac file association

a. In the Mac Finder, Control+click (one-button mouse) or right-click
(multibutton mouse) a file of the type that you want to open in
Photoshop.

b. From the contextual menu, choose Get Info.

c. In the Get Info dialog box, expand the Opens With area, choose
Photoshop CS4 from the pop-up menu, and click Change All.

d. (Optional) Repeat for any additional file formats.

If you double-click a file and Photoshop launches but the image
doesn’t open, you've likely made a change to the Mac OS and need
to reinstall Photoshop.

1 Windows file association

a. In Windows Explorer/My Computer, right-click a file of the type
that you want to change.

b. From the contextual menu, choose Properties.

c. To the right of Open With, click the Change button, choose
Photoshop CS4, and click OK.

d. Click OK again to close the Properties dialog box.

e. (Optional) Repeat for any additional file formats.

Downloading from your digital camera

You can use the software that comes with your digital camera to transfer
photographs from it to your computer’s hard drive. Or, if you have the hard-
ware, you can remove your camera’s memory card, memory stick, or other
media from the camera and use a card reader, which is a small device
designed to read camera storage media. Transferring via the Mac Finder or
Windows Explorer is generally much faster than and usually just as reliable
as transferring using the camera manufacturer’s software. Adobe Bridge also
offers the Filer>Get Photos from Camera command, which offers the options
of organizing with subfolders, renaming, and automatically converting to the
DNG file format.
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Never open an image into Photoshop directly from a camera, Flash card, or
CD/DVD. Doing so can slow down your work, and you also risk losing your
work if Photoshop isn’t able to immediately and efficiently read the original
file while you work. And, of course, you can’t save from Photoshop back to
most removable media, so you need to create a new file (on a writable drive)
anyway. Open images from a network drive only when working with Adobe’s
Version Cue, the Adobe Creative Suite’s project management software.

After the images are safely stored on Embedded Profile Mismatch
your local hard drive (OI' a high— The document “IMG_1400PG" has an embedded color profile
. that does not match the current RGB working space.
speed external hard drive), you can : e
. . Embedded: sRGE IECR1966-2.1
open them in PhOtOShOp by using Working: Adobe RGE (1998)
one of the three methods that I — What would you like 1o do?

. . . [ use the embedded profile Ginstead of the working spacel
describe earlier in the chapter. @ Corivert ducinient's eolors ot worklig spnce
Depending on yOUl’ COlor Settings, 7 Discard the embedded profile (don't ealar manage)
you might see a warning that the o) (G

image’s color profile and the profile
that you selected as your RGB work-
ing space don’t match. Photoshop Figure 4-2: When color profiles don't match,
asks you what you want to do (see  you have to make a choice.

Figure 4-2). Generally speaking, you

want to convert to your working space so that you see the most accurate
color on your monitor. You might want to preserve the embedded profile if
you’ll be returning the image to the originating computer after looking at or
working on it. The third option disregards all color profiles and works with
uncorrected color. This is a good choice when working with images that
you’ll later use with a non-color-managed program, such as a Web browser
or presentation program. (Without color management, you see the image
as it will appear in the other program.) You can disable the color mismatch
warnings in Photoshop’s Color Settings dialog box.

When opening an image that includes text, you might also get a message
warning you that the type layers need to be updated. Generally speaking, you
want to update them unless the image contains fonts that aren’t available on
your computer.

Scanning prints

You place a photo (face down) on the glass of your scanner. You push a
button. It automatically appears on your computer screen. That’s scanning at
its most basic. If your scanner’s software installed a Photoshop-compatible
plug-in into the Import/Export folder inside Photoshop’s Plug-Ins folder, you
can scan from within Photoshop. (The File=>Import menu will show your
scanner by name.)
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Purchasing commercial images

Some projects require images that you cant run
out and shoot yourself. Say, for example, that
you're preparing a poster or brochure about a
ski trip to Japan. In your office or studio. In the
United States. In July. Pretty tough to shoot what
you need, eh? Turn to stock photography. You
can purchase or license stock images (photos,
illustrations, video, and even audio) from a wide
variety of sources, including Internet-based
services and collections on CD/DVD. In fact, |
use images from PhotoSpin.com in a variety of
places in this book.

When you consider using stock images, keep in
mind the difference between royalty-free and
rights-managed images. Royalty-free images
are yours to use as you see fit (within the terms

of your agreement— no resale as stock photos,
no defamatory or pornographic use, and so on).
You can use the images when you need them, as
often as you need them. Rights-managed
images, on the other hand, are licensed for a
specific use, in specific media, for a specified
time. Rights-managed artwork does have one
advantage over royalty-free: Because usage is
controlled, you can license exclusive rights to
the image for that period of time so that the
image you use won't appear in some competi-
tor’s advertising at the same time. Royalty-free
images, on the other hand, are available to
anyone who pays for them, and usage is not
controlled.

Determining scan resolution

Before scanning an image, you need to make some decisions:

» How you want to use the image

»* What its final size will be

1 What resolution you need

By determining how many pixels you need beforehand, you eliminate the

need to resize the image in Photoshop (and the resulting image degradation).

Many scanner interface windows let you input the final size and resolution

you need right in the scan window. If you find the need to calculate scan reso-

lution manually, here’s how:

1. Determine the required pixel dimensions.

e For print: If you’ll be printing the image, determine the size at
which you want to print (in inches) and the resolution at which
you want to print (typically 300 ppi [pixels per inch] is a good
choice). Multiply the print width and height by the resolution to
determine pixel dimensions.

e For the Web: If the image is destined for your Web site, determine

how much of your page the image will occupy (in pixels).
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2. Measure the original.

Before placing it on the scanner’s glass, measure the original image. If
you're using only part of the image, measure that part. (Be careful not to
scratch the original with your ruler!)

3. Do the math.

Divide your required pixel dimensions (Step 1) by the physical dimen-
sions of the original (Step 2). The result is your scan resolution. (If you
get different numbers for the width and height, use the larger and expect
to do some cropping in Photoshop.)

Many flatbed scanners (scanners designed for use with documents and
photos) have transparency adapters that let you scan film and slides. However,
if you have a lot of negatives or slides to scan or if the best possible quality is
required, consider a dedicated film scanner from Nikon, Minolta, or Kodak.

Preventing moiré patterns

Unless you spent thousands of dollars on your scanner, you probably want to
forget about the scanner software’s color and tonal correction capabilities —
Photoshop gives you more control. However, here is one thing that scanner
software does much better than Photoshop, and it’s a capability that you
should use when appropriate: moiré (pronounced, roughly, mwah-RAY)
reduction. A moiré pattern is a visible rosette pattern created by the pattern
of dots placed by the printing press to reproduce color.

When you need to scan a color image
or artwork that comes from a book,
magazine, or newspaper (or other
material printed on an offset printing
press, such as product packaging or
signs), you want to use the scanner’s
software to reduce moiré. When you
let the scanner know the pattern is
there, the scanner’s software com-
pensates for the pattern and smoothes the scanned image (as you can see
in Figure 4-3).

Figure 4-3: Scanning without (left) and with
the scanner’s moiré reduction option.

The moiré reduction feature in your scanner’s software might not be immedi-
ately recognizable. It might be labeled Descreening, or it could be a choice
between Color (Photo) and Color (Document). As always, refer to your hard-
ware’s User Guide for specific guidance.

If rescanning is out of the question and you have a moiré pattern to reduce in
Photoshop, blur the image enough to disguise the problem, and then paint
with the History Brush to restore areas of critical detail in the image.
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Here’s an important announcement from The Department of an Ounce of
Prevention is Worth a Pound of Cure: A minute or two spent cleaning the scan-
ner could save hours of touch-up in Photoshop. Before doing any scanning,
use a can of compressed air to make sure that the scanner’s glass is clean
and free of dust. Likewise, check the inside of the scanner’s lid. (What good
does it do to clean the glass if dust from the lid is going to contaminate it
again as soon as you close it?) If necessary, eliminate fingerprints or smears
with appropriate glass cleaner. (Check the scanner’s User Guide for cleaning
instructions and be careful when using liquid glass cleaner with an electrical
device! I like to use the same premoistened wipes | use for my eyeglasses.)

You can use a burst of compressed air on the original image, too, before
placing it on the glass. Just be careful — hold the can of air some distance
away from the photo and spray at an angle so that you don’t damage it.

Keeping Your Images Organized

Because digital photography doesn’t have a per-shot cost (as does shooting
film), people certainly have a tendency to shoot more. And more. And more.
Experimental shots, this-might-be-interesting shots, special effects shots, and
(at least in my case) the same shot over and over and over again. They build
up on your hard drive.

It’s pretty easy to stay organized after you choose a system. The hard part is
actually deleting those digital photos that you really don’t need to keep —
you know, out-of-focus, shot at a bad angle, Aunt Betsy’s eyes were closed
and mouth was open, the 400th shot of the dogs sleeping all curled up, the
401st shot of the dogs sleeping all curled up, and the like. It takes discipline!
(Or an optical drive that can burn CDs and/or DVDs.)

Creating a folder structure

I generally recommend using a subject-based organization scheme, such as
the one shown in Figure 4-4. For example, inside the main folder named
DigitalPhotos, you might have subfolders named Vacations, Work-Related,
Holidays_2008, and FamilyPortraits. (Notice that none of the folder names
use empty spaces or characters other than letters, numbers, a dash, and an
underscore — that minimizes the possibility that Photoshop or another
program won’t be able to find a file.) Within the Vacations subfolder, you
might have more subfolders with names such as DisneyWorld_2008, Paris-
Spring_2007, and Paris-Autumn_2007.

/1
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Figure 4-4: Organize with subfolders.

Don’t overload your folders! If you find that your computer is slowing down
when it tries to display the content of a folder, you have too many files in the
folder. Create a second folder of the same name and add -01 and -02 to the
folder names. Generally speaking, 500MB is probably as large as you want in
a single folder.

\\3

You can use your computer’s CD/DVD drive (if it has the capability) to burn
folders of images to disc. This not only provides you with a reliable backup
(assuming you store the discs correctly and handle them carefully), but it can
free up space on your hard drive. Your folder/subfolder structure can also be
used when creating your discs.

Using Adobe Bridge

Adobe Bridge, the asset-management program for Photoshop and the
Creative Suite, is installed at the same time you install Photoshop or the
Creative Suite. Bridge has its own folder on your hard drive, inside the
Applications folder on the Mac and in C:\Program Files for Windows. You can
open Bridge independently, or you can use the Photoshop Filem>Browse com-
mand to launch Bridge, which you see in Figure 4-5. If you choose
Preferences=>General in Photoshop, you can elect to have Bridge launch
automatically whenever you start Photoshop.



[SESN:)

[ 4-Flowers

Chapter 4: Getting Images into and out of Photoshop

B «+ ~

FAVORITES

o~

|+ By~ oa»-\

ESSENTIALS
| EE- | Y-

1%/ computer > [1500GE > [ Photos } | I Colorado-0704 > [ I 4-Flowers »

> | [or 5.

SortbyRating » v | 0 7 | pwv i @

H Bridge Home
! Computer
f_ﬁ PeterBauer
E Desktop
ﬂj Documents
Jl.tj Pictures

Drag Favorites Here...

FILTER

) Mo Label

Blue 1 8
O Green 5 SO4MB  —
8 "‘.{":"P" ; 150100 | Untagged RGB
ellow ]
No Rating 3 3 ) Filename CRW_1522.dng
Document Type DNG image
Date File Modified Today, 02 AM
File Size 5.04 ME

Dimensions 3072 x 2048
Dimensions (in inches) 12.8"x 8.5"
Bit Depth 16
Color Mode RGE
Color Profile Untagged

55 items, 92 hidden, 1 selected - 5.04 MB

Figure 4-5: Adobe Bridge is a separate program for managing and organizing your image files.

Here are a few tips for working with Adobe Bridge:

1~ Use keywords and categories. Using the Keywords tab in the upper-
right of the Bridge window (as shown in Figure 4-6), you can assign key-
words and categories to images. Keywords and categories are descriptive
terms that you assign to individual images. Down the road, you can
use the FileFind command to find all images with a specific assigned
keyword.

1~ Select multiple images in Bridge. You can have multiple images active
by clicking and Shift+clicking (or 88+clicking/Ctrl+clicking) on the image
previews. You might want to select multiple images and then assign the
same keywords to all the selected images at once.

1~ Use labels, ratings, and filters. Under the Label menu (which you see in
Figure 4-7), you can assign a star rating to each image and assign colors
to organize by subject or project. Use the Viewr>Sort menu to arrange
images in the thumbnails area of Bridge according to either the label or
the rating. In the lower-left of the default workspace, you find the Filter
tab. Use that feature to locate specific files by showing as thumbnails
only those files that meet the selected criteria. Want to find a specific
JPEG file? Click on that format in the Filter tab to hide the thumbnails of
all non-JPEG files.
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1~ Add folders to the Favorites.
You invariably will visit some
folders on a regular basis.
Choose Filem>Add to Favorites to
get back to that folder faster
and more easily. In the upper-
left corner of the Bridge
window, click the Favorites tab
for one-click access. Keep in
mind, too, that you can add a
folder to the Favorites while
working on a specific project,
and then choose FilecbRemove
from Favorites when the project
is finished.

~ Change your view and work-
space. Use the View menu to
customize what the Bridge
window shows, and use the
Window=>Workspace menu to
determine how it is displayed.
You might find that Compact
Mode fits your needs better in
some circumstances than does
Full Mode. And don’t overlook

Assigned Keywords: Colorado; Crested Butte: Flora
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Figure 4-6: Assign keywords and categories

to help organize (and locate) images.

Bridge’s Slideshow feature — it can be a

great way to show off your work!

Lm Tools Window Help |

Rating

1~ Use Stacks to organize images. Select simi- No Rating %0
lar images or variations on the same shot Reject %"
and use Bridge’s menu command * %1
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Increase Rating 3.

thumbnail to see each image in the stack; Label

unstack with the Stack=>Ungroup from Stack
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v Zoom with the Loupe. Click in the Preview
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workspace) to zoom in. Drag the cursor to
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Select #6
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Review *9
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inspect the preview up close and personal.

Figure 4-7: Use star ratings
and labels as reminders and
to sort your images.
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Renaming image files easily

All right, then, you've arranged a hierarchy of folders and subfolders. You've
sorted your images into those folders. You've assigned rank and label to the
images. However, you still have no idea which is which in the File=>Open
Recent menu. Filenames

such as _MG_1907.CR2 Such Benes

and PB270091.3pg dON't | meereeroan e
tell you much about the iy ik i

image content, do they?

Use Bridge’s Tools=Batch s —— .
Rename command (as Rl i TR 08
shown in Figure 4-8) to ik Ll
assign more meaningful i o S L O

(and informative) names S s e

to your files. Select con- e e i e

tent from each field from e

the pop-up menu or type

in a field. Click the + Fi 8 Use Batch R an inf )
button to the right to add  T19ure 4-8: Use Batch Rename to assign informative names

more elements or vari- tofiles.

ables to each name.

So that each of your original images gets a unique name, you must include a
variable when using Batch Rename. (If you did try to rename all the images in
a folder to say, picture. jpg, you would end up with only one image file in
the destination folder — each would overwrite the previous.) Therefore,
when using Batch Rename, you must choose one of the variables for one of
the fields via the pop-up menu, be it the original document name or a
sequence number/letter.

Also keep in mind that you shouldn’t type a period (.) into any field. That
character should be used only before the file extension. And, as a wonderful
keep-us-from-creating-problems-for-ourselves improvement, Batch Rename
automatically adds the file extension for you.

Printing Your Images

In the very recent past, the subject of printing images from Photoshop
required a huge number of pages. Thankfully, improvements in hardware and
software make printing much easier. Monitors are well calibrated out of the
box, printers reproduce color more accurately, and inks and papers last for
decades. Yes, things have come a long way in a short time. But before you
click the Print button, you should make sure that your image is ready to
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print. Will it fit properly on the page and in the frame? Are the pixels small
enough that they blend evenly into the overall picture? Will the colors you
envision be the colors that appear on paper?

Croppmq toa spec:flc aspect ratio

Aspect ratio is the relationship between the width and height of your image.
An image in landscape aspect ratio is wider than it is tall, and an image in
portrait aspect ratio is taller than it is wide. Although digital cameras capture
in a variety of aspect ratios, including 3:4 and 4:5, SLR (single lens reflex)
cameras typically use a 3:2 aspect ratio: One side is 1.5 times the size of the
adjoining sides. Typical print (and picture frame) sizes are 8 x 10 inches (a
4:5 aspect ratio), 5 x 7 inches (5:7), 4 x 6 inches (3:2), and 3 x 5 inches (3:5).
In Figure 4-9, the 3:2 aspect ratio is outlined in green, 5:7 is shown in yellow,
and 4:5 is red.

Although an 8 x 10 print is physically larger than a 4 x 6 print, it may print
less of your original image because of cropping. The 4 x 6 print, with a 3:2
aspect ratio, includes all the original image; the 8 x 10 print (with its 4:5
aspect ratio) is missing 2 full inches of the image’s longer dimension. To
print 8 inches wide and retain the entire image, you’d be printing at 8 x 12.
Of course, if your camera captures in a 4:5 aspect ratio, the problem is
reversed — the original image fits perfectly into an 8 x 10 print, but won’t
fill a 4 x 6 print without cropping.

Figure 4-9: Different print sizes encompass different amounts of your image.
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In Photoshop, you can change the aspect ratio of your image with the Canvas
Size command (if one dimension is already correctly sized), the Crop tool, or
the Rectangular Marquee tool with the Image=>Crop command. The Crop tool
can resample your image to the exact print dimensions and resolution in one
step, but you generally need to use the Image Size command when changing
aspect ratio with Canvas Size or the Rectangular Marquee.

With the Crop tool selected, you can enter specific dimensions and a target
resolution on the Options bar. Drag the tool, position and adjust the bound-
ing box, and then press Return/Enter to execute the crop. Whatever is within
the bounding box is resampled to the exact size that you specify on the
Options bar. (Remember to click the Clear button on the Options bar after-
ward to restore the Crop tool to its normal behavior.)

When cropping, Photoshop uses the resampling algorithm that you specify in
Preferences>General as the Image Interpolation method. For best results,
choose Bicubic Smoother when increasing an image’s size and Bicubic
Sharper when decreasing the size.

When creating a cropping selection with the Rectangular Marquee tool, you
can change the tool’s Style pop-up menu (on the Options bar) from Normal to
Fixed Ratio or Fixed Size. Generally speaking, use Fixed Ratio (as shown in
Figure 4-10) and drag the marquee to encompass that part of the image you
want to retain. When the selection marquee is how and where you want it,
choose Imager>Crop.
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Figure 4-10: Use the Fixed Ratio option for a specific width-height relationship.
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Keep in mind that the Image=>Crop command doesn’t resample the image —
you've just changed the aspect ratio so far — so you need to also choose
Image=Image Size (which is discussed in Chapter 2).

Remembering resolution

Chapter 2 presents you with an in-depth look at resolution as it pertains to
digital imaging. As a quick refresher, keep these points in mind when thinking
about printing your images:

1~ Images themselves have no resolution. Whether in your camera, on
your hard drive, or open in Photoshop, your images consist only of tiny
colored squares called pixels. The image looks and acts the same within
Photoshop (except for adding type), regardless of resolution. An image
3,000 x 2,000 pixels at 300 ppi is handled in Photoshop exactly as an
image 3,000 x 2,000 pixels at 72 ppi.

1~ Resolution is an instruction to a printing device. The resolution value
that you assign to an image in your digital camera or in Photoshop’s
Image Size dialog box is recorded with the image strictly as an instruc-
tion to the output device.

1~ Resolution measures the size of individual pixels. A resolution of 300
ppi really means that each pixel will print at a size exactly 1/300 of an
inch square. Likewise, 72 ppi equates to each pixel printing at 1/72 of
an inch square. Some folks might find this reasoning uncomfortable
(although they can deny neither the mathematics nor the logic). Should
you run across such an individual, feel free to ask this question: “What
if an image’s resolution is 300 pixels per inch, but the image is only 299
pixels wide?” Then smile and buy the next round of beverages.

1~ Web images use only pixel dimensions. Web browsers aren’t capable
of reading the resolution information embedded in your simple graphics
by Photoshop. Each image is displayed in the Web browser strictly
according to the number of pixels in the image.

Controlling color using File<Print

In the past few years, reproducing accurate color from monitor to printer

has become much easier. Although the process of color management still
strikes fear into the hearts of many, the actual need for complex hardware
and software to control color is greatly reduced. Why? Simply because com-
puter manufacturers recognized that we, the consumers, wanted better color.
(Okay, maybe it was all the video gamers who got the attention.) Monitors
ship from the factory calibrated and accurate. Printers use smaller droplets
and better inks. Software does a better job of communicating color.
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For most Photoshop users, accurate color is important. After spending hours
tweaking an image’s appearance on-screen, surely you want the print to look
exactly like the monitor. Here’s how to get that great color:

1. When you’re ready to output your image, choose File>Print in
Photoshop.

Alarge, one-stop-shopping Print dialog box opens (see Figure 4-11).

o

15 b s s . [ P

ey PR 0 |

Figure 4-11: Photoshop’s Print dialog box offers resizing and color management options.

2. Select your printer and the number of copies you want to print.

You can also elect to scale the image to fit the paper rather than printing
at the image’s actual size.

3. Click the Page Setup button to specify your page size.
4. Set up color management.

¢ In the Color Management section of the dialog box, make sure that
the Print option is set to Document rather than Proof. Choose your
options.

¢ In the Color Handling pop-up menu, select Photoshop Manages
Colors.

¢ In the Printer Profile pop-up menu, choose the printer’s profile for
the paper on which you’re printing.

e For Rendering Intent, choose Relative Colorimetric and select the
Black Point Compensation check box.

Optional: In the upper-right, click the Color Management button and
switch the pop-up menu to Output. In this area, you can — if desired —
add such printable options as crop marks, labels and descriptions,
backgrounds, and borders.
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5. When you’re ready, click the Print button.

Clicking the Print button closes the dialog box and moves you to the
printer’s own Print dialog box.

6. Disable the printer’s color management.

Because you’re doing all your color management in Photoshop, you
want to disable all printer-level color management in the printer’s own
Print dialog box. (Check your printer’s User Guide for specific instruc-
tions.) You'll also want to make sure that the same paper specified in
Photoshop is selected in the printer’s Print dialog box.

7. Print.

Clicking the Print button in the printer’s dialog box sends the image to
the printer and starts the actual process of putting ink on paper.
“&N\BEB
& Don’t forget that Bridge offers you a couple of different ways to save paper
(and time and money) by printing multiple images on a single sheet of paper.
See Chapter 16 for full information.

Considering color management solutions

If your prints don’t match your monitor, first evaluate your monitor’s set-
tings. Open an image with known color values (you know what the image
should look like) in a non-color-managed program. You might, for example,
open Microsoft Word and choose Insert=>Picturew>From File to add the image
Ducky.tif from the Samples folder (inside the Photoshop folder) to a blank
document. Use the monitor’s controls to make that image look the best possi-
ble, and then print. If the image prints accurately, great — you're all set.

If the monitor looks great but the print is strange, first try cleaning and cali-
brating the print head, then print from Photoshop. And take another look at
the Print dialog box to make sure that you're selecting the proper paper and
color settings. (Again, refer to the User Guide for your printer for specific
instructions.)

If your work (or play) requires extreme color fidelity, a number of companies
offer hardware and software that regulate color. You can create custom
profiles for monitors, printers, and even scanners and digital cameras.
Although not inexpensive, skillful handling of these tools (in accordance with
the User Guides!) not only results in better prints, but also reduces the
amount of aw-shucks wasted paper and ink from bad output. If you fall into
this category, explore the current offerings from X-Rite (www.xrite.com),
PANTONE (www . pantone. com), and Datacolor (www.datacolor.com).
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Check your color (Mac only)

The Mac OS includes a great little program
called DigitalColor Meter. You'll find it in the
Utilities folder (choose ApplicationscoUtilities).
Open DigitalColor Meter and position the
window in the lower part of your screen. Open
Photoshop. Open the Swatches panel. Create a
new document, any size, any resolution, RGB
color mode. Click on the first swatch in the
Swatches panel and use the shortcut
Option+Delete to fill the selection with red.
Move the cursor onto the red-filled selection. If
your selected monitor profile is accurate and
your monitor is working properly, DigitalColor
Meter will show RGB values of 255/0/0 (see the
figure here). Choose and fill the selection with
each of the next five swatches, measuring each
with DigitalColor Meter. You should see Yellow:
255/255/0; Green: 0/255/0; Cyan: 0/255/255; Blue:
0/0/255; and Magenta: 255/0/255.

If you have an Apple Cinema Display or an
Apple Studio Display and DigitalColor Meter
tells you something’s not quite right, try

the simple solution. Open Apple's System
Preferences and click Displays. On the Color
tab, select Adobe RGB as the system-level color
profile and then close System Preferences. In
Photoshop’s Color Settings dialog box, select
Adobe RGB as the RGB Working Space. Open
DigitalColor Meter again and test the swatches

once more.

8680 DigitalColor Meter

"RGB As Actual Value, 8-bit ¥ s

Apple Studio Display

Aperture Size
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Keep in mind that all the color management hardware and software in the
world doesn’t do you a bit of good if you're not controlling your environment.
If your work requires perfect color — not good, but perfect — you need to
take some additional steps. In the office or studio, you need to regulate ambi-
ent light so that you have a consistent color-viewing situation, day in and day
out, rain or shine, summer and winter. If you have windows, you need shades
or drapes that you can close before doing color-critical work. The walls visi-
ble behind the monitor and the immediate work area should be neutral in
color. (And that means no brightly colored sticky notes on the bezel of your
monitor!) You probably need a hood for your monitor and perhaps a D50

(or D65) viewing station in which to evaluate your prints under optimal
lighting conditions.

Printing alternatives

Odds are that you use an inkjet printer to put your photos on paper.
Although inkjet printers are the most popular and perhaps the most practi-
cal, you do have alternatives. If, for example, your work consists of brochures
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and flyers rather than photos, a color laser printer might better fit your
needs. The initial cost is generally

higher than all except wide-format s

inkjets, but the cost per page is river (pawczson @)
much lower. Color laser printers gen- fresecs Suamiurd L
erally don’t print photographs as e
well as a mid- to high-end inkjet, and

the prints aren’t archival (they won’t Pt Qs Ehaneed 1400600 451 2
last for a whole lot of years without T =
fading), but such prints might be just Outpus Order: | Face Up 9

fine for sharing snapshots among

friends and family. The print options

for a color laser printer (such as the D () (R (A G ) (@D
Print dialog box you see in Figure
4-12) differ from an inkjet’s options.
Check the User Guide for the specific Figure 4-12: Color laser printer options differ
printer to set up your job correctly.  from those for inkjet printers.

Dye sublimation printers use rolls of film impregnated with dyes to repro-
duce prints. Prices for these printers range from less than $200 to several
thousand dollars. The quality and longevity of the prints is generally tied to
the price.

Here’s another output alternative available to virtually all Photoshop users.
Burn your images in JPEG format (highest quality, 300 ppi) onto a CD and
take the CD to the local photo lab. Alternatively, use an online service with
which you upload your JPEGs to the service’s Web service to order prints.
(Check with the lab or service to see if you need to use the sRGB color profile
for your images.) You'll get back glossy or matte prints at the size(s)
requested. And the cost per print can be substantially less than using your
inkjet printer. The local photo lab is often a great alternative for stacks of
vacation photos and family reunion shots that need to be sent to a whole
passel of kin.

Unless your inkjet printer is specifically designed to generate grayscale
images, you might want to use the photo lab for such prints. Inkjet printers
designed with grayscale in mind output using black ink plus one or more sup-
plemental light-black or gray inks to increase the tonal range and ensure ade-
quate detail in your shadows. Inkjets that aren’t designed to print grayscale
can either print using only black ink (which severely limits the detail and
tonal range), or they use rich black (black ink supplemented with the addi-
tional color inks), which invariably leads to some color tint or color cast in
the supposedly neutral grayscale images. It’s the nature of the beast — ink
droplets are placed near each other, not on top of each other, which leads

to the visible tinting of a grayscale image when printed on an inkjet using
colored inks. Check the User Guide for your printer: If it doesn’t provide
specific guidance for printing grayscale, send your black-and-white images

to the local photo lab for output.
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Sharing Your Images
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Photoshop and Bridge offer a number of nifty ways to make it easy to share
your images with others. You can simply send a folder of JPEG files to a friend
or client with instructions to double-click each one to view the images.
However, there are certainly more elegant ways to showcase your talents.

Creating PDFs and Web sites

Portable Document Format (PDF), the native file format of Adobe Acrobat,
has become an incredibly useful and near-universal format. It’s hard to find a
computer that doesn’t have Adobe Reader (free software to open and view
PDF files) or another PDF-capable program (such as the Mac’s Preview), and
that helps make PDF a wonderful format for sharing or distributing your
images.

You can use Bridge’s Output panel to create PDF presentations and multi-
page PDFs to send to others for review or to simply show off your magnifi-
cent imagery. You can also create stand-alone Web sites to post to a Web
server using the Output panel. You'll find more information on these sharing
features in Chapter 16.

E—mallmq your images

Remember, too, that you can send images via e-mail. Keep in mind, however,
if you like these folks enough to send them your images, you probably want
to keep their friendship. And to that end, you want to be a responsible
e-mailer — you don’t want to send out an e-mail attachment so large that it
disrupts service for the recipient. (“Hi Marge. You know those images from
your vacation that you e-mailed me on Tuesday? They’re still trying to down-
load. Yeah, today is Saturday. Anyway, why don’t I drive up to Maine and look
at the snapshots — it’s probably faster than waiting for the e-mail.”)

As a general rule, your attached images should rarely if ever total more than
1MB in size (unless you verify through direct communication that everyone
on your To: list can handle large attachments). Each image should be no
more than 550 pixels tall so that it can be viewed in a Web browser on any
screen. You can certainly use your computer’s compression utility — Stufflt
(Mac) or WinZip (Windows) — to compress one or more images before
sending. But if you do compress your attached images, make sure to include
instructions to save the compressed file to the hard drive and double-click
to expand.
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Part i

Easy Enhancements
for Digital Images

The 5th Wave By Rich Tennant

“Hey- let’s put scanned photos of
ourselves through a ripple £ilter and see
if we can make ourselves look weird.”




In this part . . .

S)me photos can be printed straight from
the camera without ever seeing the light
of Photoshop. However, most images need at
least some adjustment, and many need a /ot of
adjustment. Here’s where you discover how to
work magic on your images.

The range of brightness from black to white is
critical for most images. In Chapter 5, you read
how to maximize and adjust that tonal range in
your photos, and how to maximize your use of the
Histogram palette. And there’s more to a great
photo than shadows and highlights. Chapter 6
looks at adjusting the color in your images,
making them look as natural as possible. More
and more digital photographers are switching
to the Raw file format because of the control it
provides over the final image. Read Chapter 7
for the Raw lowdown.

Sometimes only part of an image needs to

be adjusted. The key to making precise adjust-
ments, as you can read in Chapter 8, is to tell
Photoshop where to work with selections and
masks. Chapter 9 examines many of the most
common problems in Photoshop (and what to
do about them). You can read about eliminating
red-eye, reducing wrinkles, whitening teeth, and
minimizing digital noise.
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Adding Dark Shadows and
Sparkling Highlights

In This Chapter

Discovering tonality

Making the easy Auto repairs

Making adjustments with Levels and Curves
Using advanced tonality correction

It’s the difference between an Ansel Adams print and the snapshot of your
grandfather as a boy. It’s the difference between high-definition TV and the
local public access channel’s broadcast. It’s the difference between a Ferrari
and a minivan. It’s that thing — that special something — that tells you

that you're seeing the real deal, the genuine article, all that it can
be. And it’s something that you can do for your images.

When an image really pops — when it jumps off the
page at you — it’s generally because the shadows are
dark, the highlights are light, and the colors are rich.
I'm sure it’s no surprise to you that Photoshop can
handle the job. (That’s one of the reasons why you
bought the program, right?)

In this chapter, I introduce you to the concept of
tonality, which is the range of brightness in your
image. | also introduce to you the various commands
that Photoshop offers for you to adjust your image’s
tonality. A couple of tools even give you pin-point control
of shadows and highlights. And along the way, I offer you a
look at the Histogram panel — what it tells you, what it doesn’t tell
you, and how to use it best.
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Most photos look better with a little tweaking. For pictures that look good to
begin with, you might still want to perk them up a little with a tonal adjust-
ment. Making the shadows a little darker and the highlights a bit lighter
increases your image’s perceived tonal range, which is sort of the distance
between black and white. Take a look at Figure 5-1. It’s a pleasant enough snap-
shot, with decent composition and an interesting subject. But it lacks pizzazz.

With Photoshop, you can darken the
shadows and lighten the rest of the
image to make it more interesting. By
intensifying the difference between
what the eye sees as dark and what
the eye sees as light in the image,
you add some semblance of depth to
this simple picture. Comparing
Figure 5-1 with Figure 5-2, you can
see that one basic tonal adjustment
can also make the colors seem richer
and even produce a perceived
increase in detail or sharpness.

Figure 5-1: A nice snapshot, but not art.

You might hear a number of words
used for the same concept: the
lightness and darkness of your image.
Tonality, luminosity, and even bright-
ness can be used virtually interchange-
ably when you’re talking about the
general subject. However, you gener-
ally use brightness when talking about
specific pixels and tonality when refer-
ring to the image as a whole.

Figure 5-2: One simple tonal adjustment

HiStoqrams Simp(ified darkens, lightens, enriches color, and brings

out detail.

In most photographs of general
subject matter, your eye sees the darkest neutral (gray) tone as black and the
lightest neutral as white. (If the darkest color is obviously purple and the
lightest a bright yellow, you probably wouldn’t classify the photo’s subject as
“general.”) In a given image, the shadow under the shoe might be just a dark
gray, and the shirt looks like it might need some bleach, but your mind (in
cooperation with your eye) compensates to some degree and lets you see
black and white.
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For a more accurate look at the tonal range of your image, Photoshop offers
the Histogram panel, which displays the distribution of the pixels in your
image at various luminosity values. The darker pixels (shadows) are stacked
at the left end, the lighter pixels (highlights) are stacked at the right end, and
the rest of the brightness values (midtones) are stacked between. The taller a
column in the histogram, the more pixels at that luminosity value. Figure 5-3
shows an image with what some folks would call a near-perfect histogram dis-
tribution because of the beautiful bell curve centered in the graph.

But don’t be seduced by a histogram distribution! Not every properly exposed
image has such a bell curve. Many perfect images have wildly different his-
tograms. The correct distribution in the histogram depends on two things: the
image content and the artistic aims of the artist.

Consider, if you will, an image that consists primarily of white pixels, perhaps
a beautiful Alpine snow scene or an ugly creepy-crawly thing on porcelain (as
you can see in Figure 5-4). Either image has a histogram skewed dramatically
to the right — what you call a high-key image. Nothing is wrong with the
image (despite the histogram); it just happens to have a huge number of
light-colored pixels.

Figure 5-3: This image has a very even distribution of pixels through the midtones.
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Likewise, a low-key image has a pre-
ponderance of dark pixels, which
skews the histogram to the left. Just
about any night scene has a very
large number of very dark pixels,
pulling the distribution to the left in
the histogram. But many night scenes
also include lights, which produce a
spike at the far right end.

Keep in mind, too, that the heights of
the individual columns in the his-
togram area are relative: The tallest
goes all the way to the top of the
box, and the others are scaled
accordingly. For example, an image
on a black background —say, a ]arge Figure 5-4: The histogram is skewed to the
black background — might have so right because of the many white pixels. Or
many pixels in the left-most column  maybe it's trying to escape the spider.

that the other columns in the image

appear tiny and almost unreadable, like the histogram shown in Figure 5-5.

If the histogram is skewed to one end or the other, making it hard to read, you
can make a selection within the image and the histogram updates to show
information for only the selected area. (Read about making selections in
Chapter 8.) If the image has multiple layers or adjustment layers, the little
pop-up menu below the histogram (when in Expanded View mode) enables
you to specify what layer to calculate.

If you see a little warning triangle to
the upper-right of the histogram data
in the panel, you're not necessarily
seeing accurate information. The
histogram is using information from
the image cache rather than the
image. Click the triangle to update
the histogram. And, if you choose
Preferences=>Performance, you can
set the Image Cache to 1 to ensure
accurate onscreen display and
histograms.

Figure 5-5: Too many pixels in the left-most
column make the distribution for the
midtones hard to see.

Sometimes a histogram seems to tell
you absolutely nothing worthwhile.
For example, take the histogram in
Figure 5-6. The image doesn’t have a
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bell curve distribution, with a gentle sloping to either side of the center peak.
It’s not a high-key image because the pixels aren’t mashed together at the
right. The image is somewhat low-key, but the histogram doesn’t have a huge
stack at the left end. It does tell you, however, that there are three distinct
ranges of tonality in which you find most of the image’s pixels.

Using the menu, opened with the button in the HISTOCRAM
upper-right corner of the Histogram panel, you can
change the panel’s configuration. (So far in this
chapter, I show the Compact View.) In this case,
switching to the All Channels View, which shows
you a histogram for each color channel, helps solve
The Mystery of the Wacky Histogram, especially when

seen with the image itself, as shown in Figure 5-7. Figure 5-6: The histogram
The image contains a large number of pixels of a sometimes speaks to you
rather consistent color. If you mixed that color in in riddles.

the kitchen, the recipe would call for one part red,
two parts green, and four parts blue.

Mean: 69.02 Lavel:
St Dev: 46.72 Count:
Median: 56 Parcentile:

pixsls: 393216 Cache Level: 1

Figure 5-7: The All Channels View shows individual histograms for each color channel.
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As you read later in this chapter (in the section “Level-headed you!”), you can
use the histogram to help avoid degrading your image while making adjust-
ments, and (as you can read in Chapter 7) it’s very important for working
with the Camera Raw plug-in. But don’t forget about your eyeballs — you
don’t need the Histogram panel to spot a low-key or high-key image.

Using Photoshop’s Auto Corrections

Adjusting the tonality of your image can be as simple as selecting one of the
Auto commands from Photoshop’s Image menu. With many photos, the tonal-
ity (and even the color) jump to just the right look for your image. No muss,
no fuss — just a great-looking picture with a single command.

If you need to do something special with the image
(for example, create an unusual effect) or if the
image is in bad shape to begin with, the Auto com-
mands might not be your best bet. But remember
this: It never hurts to try an Auto command first.
At worst, you use the Undo command, and you’ve
wasted only a couple of seconds and a pair of key-
strokes.

From least sophisticated to most, here are your
three Auto correction choices:

1~ Auto Contrast: Auto Contrast makes the dark
pixels darker and the light pixels lighter, and it
tries to avoid introducing any color shift (an
overall change in the color appearance). The
same adjustment is applied to all three of
your image’s color channels. You can use Auto
Contrast with an image in which the colors
already look good and you perhaps just need
a bit of a boost to the contrast.

v~ Auto Tone: Each of your image’s color chan-
nels gets its own adjustment, maximizing the
tonal range in the channel. If one of the color
channels has very little to contribute to the
original image, a color cast (an unwanted tint, as
shown in Figure 5-8) might be introduced. Auto
Tone is fine for most images that look good
already and don’t need to have exact colors.

1~ Auto Color: Rather than using a single brightest
pixel and a single darkest pixel to determine  Figure 5-8: The same photo,
what should be white and what should be black, ith and without an orange
Auto Color averages a few pixels at each end.  ¢glor cast.
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That averaging prevents one single stray pixel from throwing off the calcu-
lation used to adjust your image. Auto Color is great for most typical
images. You might need that Undo command, however, on some photos
with very brightly colored objects or images that have extreme color casts.

Levels and Curves and Vou
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Sometimes you need (or simply want) more control than what’s offered by
the Auto commands. You might have a more demanding problem or a more
expansive artistic vision. You might need to make major corrections or create
stupendous effects. Photoshop, not surprisingly, offers that sort of control
over your image. In fact (and also not surprisingly), you have several ways at
your disposal to manipulate the tonality of your images. Two of the most
commonly used are Levels and Curves, both found in the Adjustments panel
(see Chapter 3) and the Imager>Adjustments menu.

Before I introduce you to those two commands, let me quickly explain and dis-
miss a couple of other available options. Since the early days of Photoshop,
the Brightness/Contrast command has lurked among the Image=>Adjustments
commands. In fact, it was the image adjustment command way back when.
Now, however, the feature is somewhat lacking in control and sophistication
and is perhaps of most use when fine-tuning an alpha channel or layer mask.
Although its behavior is vastly improved from the early days, it is still a two-
slider adjustment. But if you're an old-timer and absolutely love that old-time
behavior of the Brightness/Contrast adjustment, click on the Use Legacy box
to restore the older adjustment performance. (Alpha channels are discussed
in Chapter 8, and layer masks appear in Chapter 10.) In both alpha channels
and layer masks, you use a grayscale representation to identify specific areas
of your image. Brightness/Contrast is perfectly adequate for many adjust-
ments that you might make to those channels.

Also of limited use is the Equalize adjustment. It finds the lightest pixel in the
image and calls that white and also finds the darkest pixel and calls that
black. The rest of the pixels in the image are distributed between those
values, creating an extended tonal range. In practice, you’ll find that the
adjustment results in extreme highlights and extreme shadows, with a rather
garish image overall as well as a lack of details in the midtones.

Always keep in mind that you don’t have to make changes to the entire image.
If only part of an image needs repair, make a selection of that area before open-
ing the particular adjustment dialog box you want to use. (Read about making
selections to isolate areas of your image in Chapter 8.) Say, for example, that
you take a beautiful photo of a room in your house — “beautiful” except that
the view out the window is far too bright. Isolate the window with a selection,
and then use one of your image adjustment commands to tone it down.
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Level-headed you!

The Imager>Adjustmentst>Levels command (88+L/Ctrl+L), or adding a Levels
adjustment layer (discussed in Chapter 8), gives you control over shadows,
highlights, and your image’s overall tonality individually. Using a slider with
three controls, you adjust the picture both to suit your eye, and with an eye
on a histogram for reference. You even have numeric fields in which you can
type exact values, should you find the need.

To perform the basic Levels correction, spreading the image’s tonality over the
full range of values available, you simply drag the slider controls under the his-
togram in the Levels dialog box inward until they’re under the point where the
histogram begins to rise in a mountain shape. Ignore those little flat tails that
extend outward — they represent individual stray pixels — and drag the little
pointers under columns that are at least a few pixels tall. The histogram in the
Levels dialog box (as shown in Figure 5-9) is for reference as you make
changes. Note, however, that while you work in Levels, the Histogram panel
updates, showing you the “after” in black, with the “before” histogram in color.

Dragging the middle slider to the right moves the bulk of the histogram
toward the left, indicating that the overall appearance of the image is slightly
darker. Dragging the middle slider to the left lightens the overall image.

Levels
Preset: | Custom F%-’] (—i’
T
— Channel:  RGB e
Input Levels: @
e
Options...
227
gPreview

&
[11a | [237 ]

feg' HISTOGRAM

_A.
bl

Figure 5-9: Compare the Levels histogram and the Histogram panel.
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Defining white and black

The Options button in the Levels (and Curves)
dialog box opens a door through which you
might never need to walk. However, should your
path lead you to that door, | want you to know
what lies behind. Neither pit nor tiger awaits
you, only the possibility of controlling your high-
lights and shadows — or making a total mess of
your image, of course. (Adobe does a good job
of hiding those it-could-cost-me-a-fortune-if-1-
screw-it-up features.) The Options button gives
you control over the behavior of the Auto button
(in both Levels and Curves), but | suggest that
you |leave the defaults alone. Even more impor-
tant, the Options button lets you define what
colors Photoshop should use for the lightest
pixels and for the darkest pixels. That's right:
White and black are not always the same.

Generally speaking, if you print to an inkjet, you
want the full tonal range of the printer, so you
should leave white and black set to the

extremes, as far apart as possible. However, if
you're creating gallery prints, you might want to
change the definition of “white” from RGB
255/255/255 to RGB 245/245/245 to ensure that
you produce 100 percent ink coverage, with no
paper showing through in the highlights. You
can use a Levels adjustment or adjustment
layer, dragging the lower-right slider control to
the left to 245.

If you want to make semi-permanent changes
to your highlight and shadow values (you can
always restore the defaults later), perhaps in
response to a request from a print shop, open
Levels (or Curves), click the Options button,
click the highlight (white) color swatch to open
the Color Picker, and then input the suggested
values. Click OK and then repeat for the shadow
swatch. Make sure to click the buttons that
retain the values as your defaults as you 0K
your way back out of all those dialog boxes.

A\

Also note the lower Output Levels slider in Figure 5-9. You generally use that
only when preparing an image for a commercial printing press that requires
you to compress the image’s tonal range or when preparing to create a gallery
print with a high-end inkjet printer. Otherwise, ignore that slider and its two
fields except for special effects. And make a mental note of that pop-up menu
at the top of the Levels dialog box — you can apply Levels to each color chan-
nel of your image individually, changing this tonal adjustment tool to a color
correction feature. (Fixing the color in your image is covered in Chapter 6.)

When you’re working in Levels (or just about any dialog box), remember that
holding down the Option/Alt key changes the Cancel button to Reset. When
you click Reset, all values in the dialog box are restored to the defaults, let-
ting you start over without having to cancel and reselect the command.

Earlier in this chapter, I mention that you can use the Histogram panel to
avoid introducing problems into the image. Note in Figure 5-9 that the
Histogram panel shows slight gaps appearing among the darker columns in
front. Technically called posterization, these gaps represent tonal values that
are being squished together into a single value. The pixels at one brightness
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level are being shifted to the next higher or the next lower value, leaving that
empty column in the Histogram. Is this a problem? No, as long as you don’t
see wide gaps, representing a number of consecutive tonal values not in use.
(Extensive posterization ruins the subtle transitions between colors in your
image.) And that’s why you want to keep an eye on the Histogram panel — to
make sure you're not creating wide gaps in the histogram and noticeable
posterization in

your image.

HISTOCRAM

Here is an easy
way to minimize
that posteriza-
tion, one that lets
you make your
Levels adjust-

ment but keep a - =
pretty histogram. | %P -

—_—
@ ( Cancel

Mode: | Luminosity @ EP >
review

Fade

Immediately after
using Levels,
choose Edit=
Fade Levels and
change the
blending mode
from Normal to
Luminosity. As you see in Figure 5-10, the posterization goes away with a min-
imal change in the effect of the Levels adjustment. Remember that the Fade
command is available only immediately after applying an adjustment (or filter
or tool) — you can’t even use the Save command between. (Read more about
the Fade command in Chapter 15.)

Figure 5-10: Change the Levels adjustment blending mode to Luminosity
with the Fade dialog box.

Tonal corrections with the eyedroppers

The Levels dialog box (and the Curves dialog box, too) offers another way to
make tonal corrections to your image — sort of a half-automated technique,
using the three eyedroppers in the right side of the dialog box. Open your
image, open the Levels dialog box, and correct both tonality and color in
your image with three little clicks:

1. Click the left eyedropper on something that should be black.

This might be a shadow, a piece of clothing, or the tire of a car.
Generally, you click something in the image that’s already quite dark.

2. Click the right eyedropper on something that should be white.

A cloud, the bride’s dress, perhaps an eye . . . all are likely targets for the
highlight eyedropper. You usually click something that’s already quite light.
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3. Click the middle eyedropper on something that should be gray.

Click something that should be neutral in color (should be, not already is).
It doesn’t have to be mid gray, just something that should be neutral. This
reduces or eliminates any unwanted color cast in the image. If you don’t
like the result, click somewhere else in the image. Keep clicking until the
colors in the image look right.

In Figure 5-11, the shadow under the bridge, the splash of water, and the
weathered wood of the bridge itself provide excellent targets for the three
eyedroppers.

Here’s another
way to adjust
color using
Levels. Duplicate

Levels

the image layer Preset: | None =] (__CN‘_)
and apply the e %)
Blur~>Average gt Levels %)l :
filter. The layer (“Ontions... ) par—iiidipe
becomes a solid r L7

color. Open the k | # Preview

Levels dialog box. b1 [Loo ] [s5 |

Click in the layer Output Levels: |

with the middle f— \stOI

eyedropper and

click OK. Delete

that blurred layer.
This technique Figure 5-11: Use the eyedroppers in Levels to set the black and white

doesn’t work with points; then neutralize your image’s colors.
every image (such as extremely bright, super-saturated images), but it does a
great job on most.

Adjusting your curves without dieting

One step up from Levels in complexity, and about five steps ahead in terms of
image control, is Image~>Adjustments=>Curves (8+M/Ctrl+M). The Curves
dialog box has a pair of slider controls (similar to the left and right sliders in
Levels) to easily control the endpoints of your shadows and highlights. The
curve line itself gives you control over various parts of the tonal range inde-
pendently. Curves also offers eyedroppers for tonal and color correction.
They’re used the same way you use the eyedroppers in Levels.

At the very beginning of this chapter, | show you how a simple tonal adjustment
can add some drama and some interest to a rather bland image. Figure 5-12
shows you the simple Curves adjustment that I applied to that image.
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Dragging the curve downward in the shadows makes them darker; dragging
upward for the highlights makes them brighter. The midtones (that section of
the tonal range between shadows and highlights) also gets lightened a bit in
this adjustment.

When you first
open the Curves
dialog box, you
see a graph with
a diagonal line
running from an
anchor point in
the lower left to
another in the
upper right. You
can click and
drag that line up
or down (not
sideways) to add
anchor points
and make changes
in the curve (and Figure 5-12: A simple S-curve adjustment makes the image more

in your image).  dramatic.

By default, the

shadows are in the lower left, so dragging down darkens, and dragging up
lightens. (In the Curves Display Options area, switching from Light to
Pigment/Ink will reverse the shadows/highlights. Use this option when prepar-
ing CMYK images for page layout programs.) You can add more than a dozen
anchor points to the curve — although you generally need only between one
and three new points.

Most snapshots can benefit from a slight tweak in Curves. Click at the inter-
section of the first vertical and horizontal gridlines in the lower left (the
quarter tones) and drag down slightly. The Input field should read 64, and the
Output field should be somewhere between 55 and 60 for a shot that looks
pretty good to start. Next, click at the intersection of the grid lines in the
upper right (the three-quarter tones) and drag up slightly. The Input field should
show 192, and the Output field can be anywhere from 195 to 205. This is called
a basic S-curve.

Both the Curves and Levels dialog boxes offer you the Load and Save options
using the menu button to the right of the Preset menu. If there’s a correction
that you’ll use more than once or a correction that needs to be precise time
after time, use Save. Then, later, you can click Load to apply that adjustment
to another image. If, for example, you used the wrong setting in your camera
while taking a series of shots all under the same lighting conditions, they
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probably all need the same correction. Make the adjustment once, save it,
and then apply it to the other images with the Load button.

If you want to correct a specific area in the image, move the cursor into the
image window (where it appears as the Eyedropper tool). Hold down the
mouse button and you'll see a circle on the curve, telling you where those
pixels fall in the tonal range. To add an anchor point there, 8+click/Ctrl+click
in the image.

Curves now offers the option to adjust the curve by clicking and dragging
right in the image window. Activate the on-screen adjustment option by click-
ing the button to the lower-left of the grid in the Curves dialog box or to the
upper-left of the grid when adding a Curves adjustment through the Adjustments
panel (both shown in Figure 5-13). With the on-screen adjustment option
active, click in the image window on an area that needs improvement and
drag upward to lighten or downward to darken. The adjustment is applied to
the entire image or selection, not just the area where you click. (Working
with the Adjustments panel is discussed in Chapter 8.)

{
= |
Preset: | Custom ) E Geos
~Channel: [RGB 8] —— (" cancel )
7 Smaoth

( Auo ) #
{ Options._.. f;

E Preview

Output:
36

-
Input:

40 # # # [showClipping

E] Curve Display Options

&

2 Light (0-255) p==gy
Show Amount of: () Light ( ) ]
() Pigment/ink %
Show: ™ Channel Overlays ™ Baseline
EHismgram Elmerse:tl‘nn Line

Figure 5-13: The on-screen adjustment option is available both in the Curves dialog box and
when adding a Curves adjustment layer.
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When your curve has multiple
anchor points, the active anchor ADJUSTMENTS

point shows as a fllled.—ln square. Crirves T =
Deselected anchor points are hollow
squares. For precision, you can use ; - P

. RGE 4 |
the arrow keys to move the active Ii!I".' j O,

anchor point, or you can type spe-
cific values in the Input field (start-
ing position for the anchor point)
and Output field (where you want
the anchor point to go).

~ -

e

Option+click/Alt+click in the grid
area to toggle between a 4 x 4 grid
and a 10 x 10 grid. And, rather than
clicking and dragging on the curve, ;
you can activate the Pencil tool

(shown in Figure 5-14) and draw 2m

your curve by hand. When hand- E Smooth the curve values
drawing your curve, the Smooth i
button is available, too, to ensure
that the transitions in your tonal
adjustments aren’t too severe.

<a= oTE
« Figure 5-14: You can increase the number of
Grabbing Even More grid nes: handy when drauing acurve
Control

<MBER
@\*

The Image=>Adjustments menu in Photoshop includes a couple more
extremely powerful ways to work with tonality in your images. You can use
the Shadow/Highlight adjustment to isolate and change whatever range of
dark and light pixels you want. By specifying what range of tonal values that
you want to be considered dark or light, you control how broadly or narrowly
your change is applied. The Exposure feature lets you change the overall
tonality of the image, much as if you'd taken the photo with a different
camera setting. And don’t forget about making spot corrections with the
Dodge and Burn tools!

The Shadow/Highlight and Exposure adjustments are not the same as work-
ing with Raw images in the Camera Raw plug-in (see Chapter 7). Camera Raw
works with unprocessed image data, the so-called digital negative. Using
Photoshop’s Adjustment commands, you're working with image data that has
already been manipulated in the camera, in Photoshop, or both. When work-
ing with unprocessed data in Camera Raw, you truly have control over the
exposure, the shadows, the highlights, and much more.
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The Shadow/Highlight adjustment is not available as an adjustment layer.
Changes that you make with the Shadow/Highlight feature are a permanent
part of your image.

Using Shadow/Highlight

The Shadow/Highlight adjustment is designed to rescue two specific sorts of
images — you’ve seen them (and maybe taken them): The background is per-
fectly exposed, and the subject in the foreground is in horrible shadow. Or,
equally bad, the background looks great, but the subject is washed out by a
strong flash. (See both examples in Figure 5-15.) By controlling the shadows
and highlights separately from the rest of the image, this feature helps you
restore more balance to the image.

......

Shadows Highlights

Shadows. - Cwm)
Highlights il Amount o L4
Amunt: 0 x | - — Lomeel
a o Praview Load__,
Highlsghts =
 Show Mare Options P i Ix Save.
| EPreview
I Show More Options.

Figure 5-15: Shadow/Highlight does a rather good job with these very common problems.

The default settings in Shadow/Highlight are intended to repair backlighting
problems, as you see on the left in Figure 5-15. When the foreground lacks
detail because of flash (as you can see in the top dog image on the right),
minimize changes to the shadows and drag the Highlights slider to the right.
And, as shown in Figure 5-16, with Show More Options selected,
Shadows/Highlights gives you incredible control over images that have prob-
lems at both ends of the tonal range.

\‘&N\BER In the Shadows/Highlights dialog box, the Shadows slider lightens the darker
5y areas of your image, and the Highlights slider darkens the lighter areas.
Generally, you'll use one slider or the other to fix a specific problem in an
image, but you can use both if you need to lighten shadows and tone down
highlights in the same image.
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oo Shadows /Highlights
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@ Show More Options

Figure 5-16: Some images need help for both shadows and highlights.

When you enable the Show More Options check box, Shadow/Highlight has a
rather intimidating set of controls. Not to worry! It’s actually pretty simple:

» Amount: For both Shadows and Highlights, the Amount slider is how much
of a correction you're making. This is the nuts and bolts of the Shadow/
Highlight adjustment. For a backlit subject, you’ll use the Shadows slider
a lot and not the Highlights slider. When working with a washed-out sub-
ject, you’ll probably move the Shadows slider to 0% and work with the
Highlights slider.

1~ Tonal Width: Use the Tonal Width sliders to specify how much of the
image’s tonal range you want to include as shadows or highlights. If you
drag either Tonal Width slider to 100%, you're working on the entire
tonal range of the image — not a particularly appropriate job for Shadow/
Highlight (use Curves instead). The default of 50% is rather too high
most of the time. Instead, start your adjustment with a range of perhaps
20% and fine-tune from there.
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+~ Radius: You adjust the Radius sliders to tell Shadow/Highlight which
pixels should be identified as being in the shadow or highlight. With too
low of a Radius setting, an individual black pixel stuck in the middle of a
light area in your image might get classified as a shadow area. Too high
of a setting has a tendency to apply the adjustment to the entire image.
Generally speaking, start with a Radius of perhaps 10 pixels for very
small images and 30 pixels for large digital photos. After adjusting your
Amount and Tonal Width sliders, move the Radius slider back and forth
while watching some of the smaller patches of shadow or highlight
(whichever you're correcting) to make sure that those areas are being
included in the adjustment.

1 Color Correction/Brightness: This slider changes its name to match your
image’s color mode. When working with a color image, you see Color
Correction. When you apply Shadow/Highlight to a grayscale image, the
slider’s name changes to Brightness. Don’t bother with this slider until
you make your Amount adjustment. In a color image, lightening the shad-
ows or darkening the highlights shows the actual color of the pixels in
those areas. Use this slider to increase (drag to the right) or decrease
(drag to the left) the saturation of those pixels. Remember that Color
Correction works only on the pixels that you identify with the Tonal
Width and Radius sliders. (If you set both sets of Tonal Width and Radius
sliders to 0%, Color Correction has no effect on the image at all.) When
you correct a grayscale image, on the other hand, the Brightness slider
affects all pixels except those that are already pure white or pure black.

1~ Midtone Contrast: You can increase or decrease the contrast through-
out the image with the Midtone Contrast slider. Much like clicking in the
middle of the curve in the Curves dialog box and dragging up or down,
you adjust the whole range of your image, including the shadows and
highlights. When the overall appearance of your image needs improve-
ment, start with Midtone Contrast and then work with your shadows
and highlights individually.

v~ Clip: Most of the time, you don’t want to change the clipping values.
Clipping takes pixels that are almost black and forces them to pure black,
or it takes pixels that are almost white and forces them to pure white.
Clipping your shadows or highlights reduces those subtle differences in
color that provide the detail in the shadows and highlights. When would
you want to clip shadows or highlights? When you don’t care about
detail in those areas of your image and need more contrast through the
midtones.
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Changing exposure after the fact

Photoshop also offers the Exposure feature in the Imager>Adjustments menu.
It simulates how the image would have looked if you changed the exposure
setting on your camera before clicking the shutter. Think of it as an across-
the-board adjustment of tonality in the image or within a selection in the

image. As you can see in Figure 5-17, even a minor adjustment can have a
major impact on the image!

@ @ @ Interior-00L.tif @ 12.5% (RCB/16#)

Figure 5-17: With the Exposure adjustment, a little change goes a long way!

Earlier in this chapter, I mention that sometimes you want to apply an adjust-
ment to only part of an image. The windows in Figure 5-17 certainly qualify!
To best repair this image, [ made a selection of the windows, improved their
exposure, inverted the selection (select the areas of the image other than the

windows), and corrected the room separately. (Chapter 8 has all the info on
making selections.)

The Exposure dialog box offers a couple of additional controls, too. The
Offset and Gamma Correction sliders are designed primarily to work with
very high-bit images (the special 32-bit/channel high dynamic range images),
and you likely will find them too sensitive to be of much use for most images.
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Exposure is a rather specialized tool, and you probably won’t find it nearly as
user friendly or effective as Curves and Shadow/Highlight. If you do actually
work with 32-bit/channel images, take it for a test drive; you might decide
that it fills a need.

Using Photoshop’s toning tools

You have a couple more ways to work with tonality in Photoshop — the toning
tools. These two brush-using tools let you paint corrections on your image,
giving you incredible control over the appearance. Select the Burn tool to
darken or the Dodge tool to lighten. Select a brush tip in the Options bar and
drag the tool in your image to apply the correction. (You can read about con-
trolling the brush-using tools and that incredibly complex Brushes panel in
Chapter 14.) In Figure 5-18, you see the Burn tool darkening a specific area of
the fence on the right.

& . Brush: 5'5 o Range:  Midtones -¢] Exposure: 20% |8 % [J [ use Legacy

&

© @ @ IMG_O183.tif @ 100% (RGB/8#)

Fle Mo 8BsS g 00

./ .’ ..% .(?

m—t | | e
CIEIR

Figure 5-18: “Painting” the fence with the Burn tool. Where is Tom Sawyer when | need him?
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® The Dodge tool is great for minimiz- 2
ing (without removing) shadows in »
an image. You'll find it particularly \
useful for reducing wrinkles in faces %
and other such jobs that require ;f;
lightening specific areas of an image. %
Figure 5-19 compares the original i
(left) with a working copy in which !
I'm using the Dodge tool to reduce iz
the appearance of the wrinkles. By b
reducing rather than eliminating Figure 5-19: Use the Dodge tool to minimize
those wrinkles completely, [ retain  yyrinkles without removing them.

the character of the man’s face as
well as prevent that phony, just-out-of-plastic-surgery look.

WBER For most of the work that you do with the Dodge and Burn tools, the

default Exposure setting of 50% is way too strong. In the Options bar,

reduce the Exposure to about 15-20% for most work. And unless you're
specifically working on lightening shadows or toning down highlights, set the
tools’ Range to Midtones in the Options bar.
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Making Color Look Natural

In This Chapter

Seeing reds, greens, and in-betweens
Sailing with the Photoshop color correction armada
Fixing flesh tones

In the end (and the middle and the beginning), your image in Photoshop is
nothing but little squares of color. Each square — each pixel — can be
exactly one color. Which color for which square is up to you. I'll say it again:
There is no car or circle or tree or Uncle Bob in your Photoshop image — just
a bunch of little squares of color.

In this chapter, I explain how those squares of color are formulated, how

Photoshop works with those formulations, and — most important — how

you can manipulate the colors of those squares. Toward the end of )

the chapter, you read about one of the biggest color-related 3 t " T
challenges in Photoshop: achieving accurate skin color. Lok, R |

What Is Color in Photoshop?

Photoshop works with digital images (including
digital photos, images that have been digitized with
a scanner, and artwork that you create from scratch
in Photoshop). The digits are the computer code
used to record the image’s information. The number
of pixels, the color of each pixel, and any associated
information are all recorded in a series of zeros and ones
on your hard drive. Color, therefore, is nothing more than
numbers — at least as far as Photoshop is concerned. For you
and me, however, color is far more than binary code on a hard
drive. It’s the image, the artwork, the message. The artwork is the color, and
color is the artwork, pixel by pixel.
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Color modes, models, and depths

Photoshop records the color of each pixel in your image in any of several
different ways. Every pixel in any given image has all color recorded in a
single color mode, which is the actual color format for the image file. While
working with your image, however, you can define specific colors in any of a
variety of color models, which are sort of the formula or recipes with which
you mix color. And an image can have only one color depth, which is the limi-
tation on the number of colors in an image.

Before I get into too many details, you need to understand one of the basic con-
cepts of color: gamut. Consider gamut to be the range of colors that can be theo-
retically reproduced in a specific color mode or with a specific color profile. A
wide gamut, therefore, has many more colors available than does a limited
gamut. Those extra colors are generally the brighter, more vibrant colors . . . the
ones that make an image come alive. The red/green/blue (RGB) color mode gen-
erally offers you a wider range of colors than does cyan/magenta/yellow/black
(CMYK). See, for example, the comparison in Figure 6-1. And keep in mind that
the specific color profile (the working space that you select; see Chapter 4) also
has an impact on the colors in your image.

ane 8 Flowers-RGB.tif @ 33.3% (RGB/8)

Figure 6-1: A wide-gamut image (on the left) and the same picture with a smaller gamut.
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Which color mode should you choose?

If you’ll be printing to an inkjet printer, sending photos to a lab for prints, or
posting your image on the Web, you need RGB color mode. (Despite the CMYK
inks that you load into your inkjet printer, the printer’s software expects and
must receive RGB color data.) If you're prepping an image for inclusion in a
page layout document destined for a commercial offset press, you need CMYK.
You select the image’s color mode from the Imager>"Mode menu. That’s the
simple summary. Here’s a bit more detail, presented in the order in which
you're likely to need the various color modes:

 RGB: RGB is the color mode for digital photos, computer monitors, the
World Wide Web, and inkjet printers. All colors are recorded as propor-
tions of the three component colors, red, green, and blue. RGB color is
recorded in the three color channels (described a bit later in this chapter).
RGB is an additive color mode — that is, the more of each component
color you add, the closer
you get to white.

 CMYK: CMYK is used pri-
marily for printing on a com-
mercial offset press, but you
might need it for a color
laser printer or a high-end
inkjet printer with which you
use a RIP (raster image
processor, which is a special-
ized bit of hardware or soft-
ware that lets your inkjet
pretend it’s a printing press).
CMYK is the color mode of
magazines, books, and other
mass-produced printed material, such as the example in Figure 6-2.
CMYK is a subtractive color mode — that is, the less of each component
color you have, the closer you are to white.

Figure 6-2: You typically use CMYK images for
bulk-print materials.

v Grayscale: When most people talk about a black-and-white photo, they
really mean grayscale. The image does contain black and white but also
a wide range of grays in between. You might use grayscale mode for
Web-based images or for prints. Keep in mind that unless your inkjet
printer is designed to reproduce grayscale images with black and gray
inks (or black and light-black inks), you probably won’t be happy with
grayscale output. Using just one black ink doesn’t reproduce the full
range of grays in the image. Using the color inks adds a tint to the image.
You do have an alternative for grayscale images: Send them to the local
photo lab for printing.

+ Indexed Color: Using a color table, or a list of up to 256 specific colors,
Indexed Color mode is for the Web. You save GIF and perhaps PNG-8

109



’ ’ 0 Part ll: Easy Enhancements for Digital Images

images in Indexed Color, but only those file formats require such a lim-
ited number of colors. Things like buttons on your Web page, which need
only a couple of colors, should be created as GIFs using Indexed Color
mode. That keeps the file size down, reducing the amount of space the
image requires on your Web server and also speeding the download time
(how long it takes for the image to appear on your site-visitor’s monitor).

v~ Lab: Also known as L*a*b and CIELAB (and pronounced either lab, as
the dog or a research facility, or verbally spelled out, as el-ay-be), this is
a color mode that you might use when producing certain special effects
or using certain techniques in Photoshop, but it’s not one in which you’ll
save your final artwork. The three channels in a (or “an”) Lab image are

e Lightness, which records the brightness of each pixel
¢ g, which records the color of the pixel on a green-to-red axis
¢ b, which records each pixel’s color value on a blue-to-yellow axis

You shouldn’t print Lab images on an inkjet or post them on your Web
site. You might see (not in this book!) a tip that you should convert your
RGB or CMYK images to Lab mode before using one of Photoshop’s
Sharpen filters. Bah! Apply the Unsharp Mask filter, choose Edit=>Fade
Unsharp Mask, and change the blending mode from Normal to Luminosity.
Same result, less work, and less potential for degradation of your image.

+* Duotone: Duotone (including tritone and quadtone) is a very specialized
color mode, exclusively for commercial printing, that uses only two (or
three or four) inks spread throughout your image. Although that might
sound good for an inkjet printer, in fact, Duotone is not an acceptable
color mode for inkjets. Duotone images require that specific premixed
inks are poured into the presses, which isn’t something that you can do
to your inkjet.

1 Multichannel: Like Duotone, the Multichannel color mode is restricted
to commercial printing because it depends on specific premixed colors
of ink that are applied to the paper. Unlike Duotone, in which the inks
are generally spread across the page, Multichannel images use certain
inks in certain areas. You might need Multichannel mode when creating
a logo for a client.

~ Bitmap: Bitmap color mode is true
black and white (as you see in
Figure 6-3). Each pixel is either black or
white. The placement of the black and
white pixels produces shading, but the
image doesn’t really have any gray
pixels. You might use Bitmap mode to
create images for some wireless
devices, use on the Web, or commercial
print, but that’s about it.

Figure 6-3: Bitmap images contain
only black and white pixels; no grays,
no colors.
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Converting between color modes or gamuts (done with the Imagem>Mode
menu) can reduce the quality of your image by compressing different colors
into a single color value. You would not, for example, want to convert from
RGB (which has a comparatively large number of colors available) to CMYK
(with a more restricted color gamut) and then back to RGB. After colors are
compressed by a conversion, you can’t restore their original values by con-
verting back to a wider gamut.

Does a color model make a difference?

Although the image itself has a single color mode, you can use any of the
available color models when defining a color in Photoshop. Say, for example,
that you're preparing to use the Brush tool to paint some artistic elements
for your latest project. The project is in RGB mode because you’ll be printing
it with your inkjet printer. You can use the Color panel to define your fore-
ground color any way you please — RGB, CMYK, Grayscale, Lab, or even HSB
(hue/saturation/brightness, which isn’t available as a color mode, just a color
model). It doesn’t matter how you set up the Color panel, which you do
through the panel’s menu, as shown
in Figure 6-4. When you add the color
to your image, Photoshop uses the
nearest RGB (or CMYK) equivalent.

Grayscale Slider
+ RGB Sliders
HSB Sliders
CMYK Sliders
Lab Sliders

j255 |

e 2l |
I_—‘E—= =152 |

AN & m— a0z |

. . - — | 7
Notice that the Color panel menu in . b Color Sliders
Figure 6-4 doesn’t list Duotone or Copy Color as HTML
Multichannel. Those are color modes + RGE Spectrum
only, not color models. A couple of CMYK Spectrum

Crayscale Ramp

other things to note about working B

with the Color panel: The warning tri-

R, . Make Ramp Web Saf
angle visible in Figure 6-4 in the i

lower-left corner of the panel indi- closs
. Close Tab Group
cates that the selected color is out- —

side the CMYK color gamut. (Clicking
the swatch to the right would select
the nearest equivalent color. If, that

is, you were actually working in CMYK
mode.) Also note that the background swatch is selected in the panel, high-
lighted with a black outline — click the foreground swatch to make changes
to the foreground color.

Figure 6-4: Choose your preferred color model
from the Color panel menu.

Why should you worry about color depth?

Color depth is the actual number of different colors that you have available.
(Remember that each pixel can be only one color at any time.) When you work
in 8-bit/channel color, simply called 8-bit color, each of the component colors is
recorded with exactly 8 bits of information in the computer file. (At the begin-
ning of this chapter, [ mention digits. These are the actual numbers — the
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zeros and ones recorded on the hard drive to track each pixel’s color.) In an
8-bit RGB image, each pixel’s color is recorded with three strings of eight
characters. When you work with 16-bit/channel, or 16-bit color, each of the
component colors is recorded with 16 characters. The larger numbers mean
more possible ways to record each color, which means more possible varia-
tions of color, as well as files that take up more space on your hard drive.

What that means to you, in practical terms, is possibly a better-looking image
when working in 16-bit color. You’ll have smoother transitions between colors
throughout your image, no banding in gradients (those annoying areas in a
gradient where you can actually see one color stop and the next color start),
and no splotchy shadows. Posterization, which I explain in Chapter 5, is the
degradation of your image’s appearance when similar colors are forced to the
same color, making transitions between colors more abrupt. Many tonal and
color corrections that produce posterization in your 8-bit images won’t harm
a 16-bit image in the least. Take a look at Figure 6-5. To the left, a Levels
adjustment is increasing a 16-bit image’s tonal range. When the same adjust-
ment is applied to an 8-bit version of the image, some rather substantial pos-
terization becomes visible in the Histogram panel (represented by the gaps in
the histogram).

HISTOGRAM HISTOGRAM

il b

Figure 6-5: Compare the Histogram panels to see posterization (right).

So, should you use 16-bit color all the time? No. You can’t post a 16-bit image
on the Web, and 16-bit color is rarely used for CMYK images. Digital photos
taken in JPEG format are 8-bit because that file format doesn’t support 16-bit
color. And with most inkjet printers, you won’t see any improvement in the
final print. You might, however, see a dramatic increase in printing time
because there’s twice as much image data to process.

If you shoot in 16-bit color, whether TIFF or Raw, it makes sense to process
the image in 16-bit color. When the image is perfect, you might want to con-
vert a copy of the file to 8-bit color for printing (Image=>Moder>8-Bits/
Channel). You might find some situations in which you’ll convert an 8-bit
image to 16-bit. Switching from 8-bit to 16-bit doesn’t help you avoid posteri-
zation, but it might reduce banding if you add a sizable gradient.
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One other note on color depth: Photoshop can work with 32-bit/channel
images. These monstrous files are called high dynamic range (HDR) images
and are typically constructed by combining different exposures of the same
photo. In Photoshop, you can work with two or more exposures in the Merge
to HDR feature (presented in Chapter 10). You probably will never be called
upon to create an HDR image for any of the esoteric 3D or video programs
that use them, but you might find some benefit in combining multiple expo-
sures of a difficult shot. Afterward, so that you have a file of reasonable size
and access to more of Photoshop’s features, use the Imager>Mode menu to
convert to 16-bit color or even 8-bit color.

Recording color in your image

All your image’s color data is saved in the Channels panel. When you’re work-
ing with RGB or CMYK images, each color channel holds information for one
of the component colors (red/green/blue or cyan/magenta/yellow/black). Each
channel is a grayscale version of the image as a whole, using shades of gray,
from white to black, to indicate where that channel’s color appears (and how
strongly) in the image. In RGB images, the lighter the pixel in a channel, the
more of that color. When you work with a CMYK image, the light-dark in a chan-
nel is reversed, with darker areas showing where more of that color is applied.

Making Color Adjustments in Photoshop

WING/

Sometimes you have an image that needs some help in the color department.
It might have been shot with an incorrect camera setting, it might have a
color cast (an unwanted tint of a specific color), or it might just be dull and
dingy. Photoshop provides you with an incredible array of commands and
tools to make the colors in your images look just right. You'll hear the term
color correction being tossed about, but not all images have incorrect color.
Some have very good color that can be great color. Instead of color correc-
tion, 1like to think in terms of color improvement. And just about every image
can use a little tweaking to improve its color.

How do you know when the color is right? Your primary tool for the job is in
your head. Literally. Make your decisions based primarily on what your eyes
tell you. Sure, you can check the Info panel and the Histogram panel to make
sure that your shadows are black and your highlights are white, but adjust
your images until they look good to you — until you're satisfied with the color.

That little bomb symbol to the left of this paragraph is a little scary, but it
does get your attention, doesn’t it? This isn’t a your-computer-will-blow-up
sort of warning but more of a you-don’t-want-to-waste-your-time-and-effort
warning. Do your tonal adjustments before you start working with the
image’s colors. Go through the procedures in Chapter 5 first and then use the
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techniques here. Why? If you get perfect hue and saturation and then start
making tonal adjustments, you're likely to knock your colors out of whack
again. And, of course, there’s also the possibility that adjusting your image’s
tonality will make the colors look perfect!

Watching the Histogram and Info panels

As you work with your various color adjustments in Photoshop, a couple of
panels can help you track the changes you're making. The Info and Histogram
panels are, by default, nested in the upper-right corner of your screen. (You
can also show or hide them through Photoshop’s Window menu.) You might
want to drag one or the other out of the nested set so that both are visible at
the same time. (Click the panel’s tab and drag it away.) Keeping an eye on your
Info and Histogram panels while you're dragging sliders and entering numbers
into various fields can help you spot potential problems as they develop.

The Histogram is useful for tracking changes in the distribution of pixels at
various tonal ranges. You can read more about it in Chapter 5. The Info panel,
while you've got an adjustment dialog box open, shows you “before” and
“after” color values. Wherever you move the cursor in the image window (it
will appear as the Eyedropper tool), the Info panel shows you the result of
the adjustment — the consequences of your action, so to speak. You can also
hold down the Shift key to change to the Color Sampler tool. Clicking in the
image with the Color Sampler adds up to four markers in the image. The
color values under those markers appear in the Info panel and, like the

cursor location, show before/after values as you’'re making changes (see
Figure 6-6).
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Figure 6-6: Each of the crosshairs in the image is tracked in the Info panel.
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“Here, Spot!” What is a spot color?

Spot colors in your image are printed by using
premixed inks of exactly that color. (I'm talking
commercial printing press here, not your run-of-
the-mill inkjet printer.) To properly prepare a spot
color for press, it needs to be in its own spot
channel, which is a separate color channel in
which you show where and how the ink will be
applied. (Channels in your image are eventually
used to create the actual printing plates that pick
up ink and put it on paper.) Because spot chan-
nels are used with CMYK images, dark repre-
sents more. Where you need the spot color at
100% strength, paint directly in the spot channel
with black. In areas where you want only a light
tint of the spot color, use a light gray.

You create your spot channel by selecting the
Spot Channel command from the Channels

panel menu. Click the color swatch in the New
Spot Channel dialog box to open the color
libraries. (If you see the regular Color Picker,
click the Color Libraries button.) Select the
appropriate book (collection of colors; see the
figure here) for your project, and then select
your color. Click OK in the New Spot Channel
dialog box to accept the color, do not change
the name of the spot channel, and then click OK.
You can now paint or copy/paste into that new
channel.

When saving images with spot channels, you
can use the PSD file format (if the image will be
placed into an InDesign document), PDF, TIFF, or
DCS 2.0. Check with the person handling the
layout or the print shop to see which is required.

New Spot Channel
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PANTONE color bridge CMYK PC
PANTONE color bridge CMYK UP
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Color: ﬁ‘
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Choosing color adjustment commands

Photoshop offers over a dozen different commands that you can use to
improve the appearance of your images, all of which are easily accessed
through the Imager>Adjustments menu (as you see in Figure 6-7). Some have
specialized purposes, and some are extremely versatile, but all are worth

understanding so that you

. Image
choose the most appropriate ﬂ =
feature for the problem staring — £
Brightness/Contrast...
at you from the screen. Most — o %L
(but not all) of the commands Auto Contrast  XRHL | e s
that I discuss here can be added Suihlon =
to your images as an adjustment mageSze..  SHU | Huesawration..  %U
: . Color Balance... ¥*B
layer, which gives you added Transform Canvas P Black & White... O3B
flexibility. (Adjustment layers Photo Filter...
. . s Trim... Channel Mixer...
are discussed in detail in
Invert 1
Chapter 8.) xg:‘iﬁ:a“g'e Posterize...
A T /A Calculations... g?;s?::!(:nap
uto lone/Auto Selective Color...
Contrast/Auto Color S
ariations...
The three “auto” adjustments, s il
found in the Image menu rather Renlace Calor...
Equalize

than Imager>Adjustments, are

one-click solutions to many
image problems. Auto Color,
the most powerful of the three,
is perhaps the simplest way to
improve both color and tonality (the darkness of the shadows and the bright-
ness of the highlights). Select the command, and Photoshop automatically
finds the lightest and darkest pixels in the image. Then, on a channel-by-
channel basis, it redistributes the values of the remaining pixels. For more
information on Auto Color and the related Auto Contrast and Auto Tone
commands, see Chapter 5.

Figure 6-7: Photoshop’s flexibility is truly evident in
the Image=>Adjustments menu.

Brightness/Contrast

The Brightness/Contrast adjustment works with the tonality of an image rather
than color. While making adjustments to the tonal range may improve the over-
all appearance of your photo, don’t rely on this feature for color adjustment.

Levels

The Levels adjustment, which is discussed in detail in Chapter 5, uses three
slider controls to individually adjust the shadows, highlights, and overall
tonality of your image. It’s generally used to control the brightness/darkness
of the image by making changes to the RGB (or CMYK) channel, but it can be
used for color correction by adjusting the color channels individually.
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Curves

The Curves command is also discussed at length in Chapter 5. However, for
color correction (rather than tonal adjustment), you want to work on each
channel individually, choosing each in turn from the pop-up menu at the top
of the Curves dialog box (see Figure 6-8).

Although working on each channel with Curves can be very effective, it can
also be rather time consuming, with lots of flipping back and forth among the
channels as one adjustment makes another channel correction look like a
bad decision. While it may be inconvenient, Curves is a very powerful color
correction tool.

Note, in Figure 6-8, the Preset pop-up menu at the top of the Curves dialog
box. In that menu, you’ll find some ready-made Curves adjustments that — if
they don’t solve the problem immediately — give you some pretty good start-
ing points. In addition to color correction presets such as Darker, Lighter,
Increase Contrast, and Strong Contrast, you'll find special effects like Cross
Process (developing film in the wrong chemicals — intentionally) and Color
Negative (which, unfortunately, creates the appearance of a scanned negative
rather than removing the orange from an actual scanned negative).

Curves

Preset: Custom _:‘ E‘ m
Channel: " Blue - ( Cancel )
B ]

Auto
(_Options... )
@Frewew
Output:
196

. &
Input:
225 A A # [ showClipping

m Curve Display Options

Figure 6-8: Correct each channel individually with Curves to adjust color in your image.
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Exposure

The Exposure adjustment, discussed in Chapter 5, is a tonal adjustment that
simulates a change in the camera’s exposure setting when taking a photo.

Vibrance

New in Photoshop CS4, the Vibrance adjustment gives you control over both
vibrance (the saturation of near-neutral colors) and saturation (the satura-
tion of colors throughout the image). You can increase Vibrance to make the
near-neutral colors most saturated, or you can reduce Vibrance to make
those colors even more neutral, while increasing Saturation to make the
brighter colors in your image stand out even more.

Hue/Saturation

Often overlooked and rarely exploited to the fullest, Hue/Saturation is a very
powerful tool. Using the three sliders together, you can adjust the hue to
eliminate a color cast, increase saturation so that your colors appear richer
and more vibrant, and adjust lightness to improve your image’s tonality. (See
Figure 6-9.) Keep in mind that when you adjust something that’s very dark,
start with the Lightness slider so that you can evaluate the other changes
(Hue and Saturation) properly. Remember, too, that you can apply
Hue/Saturation (like a number of other adjustments) to a specific range of
colors in the image, selected in the pop-up menu at the top of the dialog box.

Using the pop-up menu at the top, you can elect to apply an adjustment to
only a certain part of the color in your image. Once a color is selected, the
eyedroppers become active, to add to or subtract from the range of color
being adjusted, and sliders become active between the gradients at the
bottom, giving you yet another way to control the range of color being
adjusted.

New in Photoshop CS4 and visible in Figure 6-9 is the Adjustments panel,
which you now use to add adjustment layers to your images. (It’s discussed
in more depth in Chapter 8.) The content of the panel offers the same options
as the Imager>Adjustments=>Hue/Saturation dialog box, but the Preview
check box is replaced by the eyeball icon you see in the lower-left in Figure
6-9, which toggles the visibility of the new adjustment layer on and off. That,
in effect, offers the same before/after preview as the Preview check box. Use
the Adjustments panel to add adjustment layers for Brightness/Contrast,
Levels, Curves, Exposure, Vibrance, Color Balance, Black & White, Photo
Filter, Channel Mixer, Invert, Posterize, Threshold, Gradient Map, and
Selective Color, in addition to, of course, Hue Saturation.
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Figure 6-9: Hue/Saturation can cure three problems at once.

Color Balance

The Color Balance command (as shown in Figure 6-10) presents you with
three sliders that you use to make changes to the balance between your color
opposites. If the image is too blue, you drag the third slider away from Blue
and toward Yellow. (This is also a great way to remember which colors are
opposite pairs!)

You can control the highlights, midtones, and shadows of your image individ-
ually by using radio buttons at the bottom of the Color Balance dialog box.
And, in almost all cases, you’ll want to leave the Preserve Luminosity check
box marked so that the brightness of the individual pixels is retained.

You can also use Color Balance to throw an image out of whack for special
effects or (getting back to the adjustment’s roots) compensating for a color
cast being introduced by the printing device.
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Figure 6-10: Color Balance gives you direct control over opposites.

Black & White

The Black & White adjustment creates outstanding grayscale copies of your
color images. This feature provides even more control than using Channel
Mixer with the Monochrome box checked. As you can see in Figure 6-11, you
can control the amount of each major range of color used to create the
grayscale copy. In this particular example, the original consists primarily of
greens and browns, so the top three sliders are key. Reducing Reds and
increasing Yellows both lightens the browns and greens and increases con-
trast among the brown tones.

® Note the Tint check box near the bottom of the dialog box. With Tint
selected, you can easily create sepia or Duotone looks for your images. If
you’ll be printing on an inkjet printer (rather than sending the file to your
photo lab), be sure to use a Black & White adjustment layer rather than the
menu command. Your inkjet printer may introduce an unwanted color shift. If
s0, you can reopen the adjustment layer and work with the Hue and
Saturation sliders to compensate.
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Figure 6-11: Black & White enables you to determine grayscale tones by mixing color values.

Photo Filter

The Photoshop Photo Filter is actually an image adjustment rather than a
filter. The filter in the name refers to those actual photographic filters that
you screw onto the end of a lens. This adjustment is a great way to correct
problems with temperature in an image — the perceived warmth or coldness
of an image. When the camera takes a picture under unexpected lighting con-
ditions, a color problem is apparent. (Say, for example, that the camera is set to
Daylight when shooting indoors.) When an image is too blue, it’s too cool; con-
versely, an image that’s orangey is too warm. (Remember that these are per-
ceptual evaluations — blue light is technically hotter than yellow or red light.)

In Photo Filter, you select a preset filter from a pop-up menu or select a color
of your choice. As you can see in Figure 6-12, both preset filters and custom
colors can be effective in neutralizing a color cast. (You could, of course, also
use these filters to add a color cast . . . if you wanted to, that is.)

Channel Mixer

Designed to repair a defective channel in an image, Channel Mixer lets you
use sliders to replace some or all of the intensity of one color channel with
content from the others. Should you come across an image with damage in
one channel, you can certainly use the Channel Mixer adjustment to work on
it (with some degree of success). You reduce the value of the target channel
by dragging the slider to the left. You then drag one or both of the other slid-
ers toward the right. Generally speaking, you want to add an amount (com-
bined between the two other channels) just about equal to what you subtract
from the target channel.
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Figure 6-12: Neutralize a color cast with a filter of the opposite color in Photo Filter.

If you drag a slider to the left past 0 (zero), you invert the content of the
channel. You can produce some incredible (and incredibly weird) effects with
this technique, partially inverting one or two channels. When you get a
chance, give it a try. Using the Monochrome check box in Channel Mixer
gives you an alternative to Black & White for a controlled grayscale effect.

Invert

More creative than corrective, the Invert command (no dialog box) simply
reverses the colors in your image or the selected area. Although inverting
areas of an image (like desaturating) can draw attention to the subject of the
image, it’s an edgier technique and generally requires touch-up after invert-
ing. You'll find that any specular highlight — a pure-white area (mainly
reflections) — becomes a distracting black spot.

Posterize

The Posterize command forces your image’s broad range of colors into a few
selected colors (as shown in Figure 6-13). You automatically get black and
white, and then a limited number of additional colors, based on the content
of the original. You pick the number of colors that you want to use, and
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Photoshop picks which
colors to use. You can use as
few as two colors (plus black
and white) or as many as
255, which pretty much gives
you your original image.
Posterize can create a rather
pleasing rendering of a
photo with very few colors.

When experimenting with
Posterize, click in the Levels
field and use the up- and
down-arrow keys to preview
different numbers of colors.
Start low and work your way
up. If you see something that
you like, you can stop or you
can keep going and come
back to that number later —
the image will look exactly
the same when you try that
number again.

Threshold

Threshold converts each
pixel to either black or white
(no colors, no grays). You
adjust the border between

black and white with a slider Posterie

or by entering a value in the m—

Threshold Level box. For an Levels, B @
eye-catching special effect, i oy
open a color image and make o Preview

a selection of the back-
ground (or the subject!) and

apply Threshold, mixing color gig, e 6.13: Reduce colors with Posterize for a special
and black and white. effect.

Sometimes, when adjusting color in an image, you need to find the darkest
and lightest pixels in an image (for use with the eyedroppers in the Curves
dialog box, for example). Open Threshold, drag the slider all the way to the
left, then slowly back to the right. The first black spot you see is the darkest
in the image. Add a color sampler (so you can find the spot again) by
Shift+clicking in the image. Drag the slider all the way to the right and then
slowly back to the left to find and mark the lightest pixels. After placing your
color samplers, click Cancel.
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Gradient Map

Again, more creative than corrective, the Gradient Map feature re-creates
your image by using a gradient. The leftmost color stop (the anchor points
where a gradient color is assigned) in the gradient is mapped to the shadows,
the right-most to the highlights, and any color stops in between are appropri-
ately assigned to the rest of the tonal range. In Figure 6-14, you can see how a
two-color gradient (upper left) lacks detail compared with the four-color
gradient being created for the lower image.

Generally speaking, you use darker colors for the color stops on the left and
lighter colors for the color stops on the right (although you can create
extremely interesting effects by mixing things up). Using a black-to-white
gradient produces a grayscale image.

To edit the gradient, simply click directly on the sample gradient in the Gradient
Map dialog box. Click to add color stops, drag to move color stops, and click
the color swatch near the bottom to change the color of the selected stop.
(You can find more detailed information on creating and working with
gradients in Chapter 14.)

®00 % GAP-Fountain copy 2 @ 25% (RGB/8#)
» g Gradient Map

Gradient Used for Grayscale Mapping 5
( cancel )
M Preview
CGradient Options
| Dither
[ Reverse
Gradient Editor
— Presets ® o )
FEFERFLRE | oo
AIVPY) o)
Save.. |
Name: |Custnm ‘  New
~ Gradient Type: | Solid 4]
Smoothness %
) L
= ° @ & & a

Stops
Opacity % Locatior * Delete
color: [Ml®  location:[25 |% ( Delete )

33.33% ||  Doc 5.52M/5.52M

Figure 6-14: Using more colors in your gradient produces more detail.
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Selective Color

Although designed to help you compensate for the vagaries of printing
presses, Selective Color can do other great things for you! The command’s
dialog box, shown in Figure 6-15, has a pop-up menu that offers the six basic
colors of Photoshop, as well as Whites, Neutrals, and Blacks. You select
which range of colors to adjust and then drag the sliders. You can work on
one set of colors, switch to another and make adjustments, switch to another,
and so on without having to click OK in between. For example, you can adjust
the reds in the image and leave the blues untouched, or you can adjust the
reds and then tweak the blues without having to exit the dialog box.

When you have reasonably small adjustments to make, select the Relative
radio button at the bottom. If you have substantial changes — rather radical
alterations — select the Absolute radio button.

[ Reds
0 O O T BricksinTheWall copy @ 1. [ vellows
M Greens

O 0 © B BricksinTheWall.tif @ 12.5

[ cyans e Color
M Blues
4 [ Magentas
oEr o)

| M Blacks | & Preview
Cyan: ‘To—— %
e

- Colors:

Magenta 17 %
=
Yellow. [#18 |%
gems B
Black: 10 %
———————

Method: @) Relative () Absolute

125% | A 12.5% | @ Z

Figure 6-15: Tweaking the Neutrals can adjust the overall appearance of an image.

Shadow/Highlight

The Shadow/Highlight adjustment is discussed at length in Chapter 5 as a
tonal-correction tool, the job for which it was designed. However, keep in
mind that the Shadow/Highlight dialog box also includes the Color Correction
slider. After you lighten shadows or tone down highlights, you can increase
or decrease the saturation of the colors in the adjusted areas of your image
with the Color Correction slider.

Variations

Variations is a semi-automated way to make adjustments to your image’s
color and tonal range. It’s discussed in detail later in this chapter.

125



’ 26 Part ll: Easy Enhancements for Digital Images

Desaturate

The Photoshop Desaturate command creates a grayscale representation of a
color image without changing the color mode. However, with no dialog box or
adjustments, it doesn’t offer the control you get by using Black & White.

Mateh Color

Now this is a feature to savor! There you are, adding Cousin Joe to the family
reunion photo because he wasn’t bailed out in time, and you see that the
lighting is all kinds of different and he sticks out like a sore thumb (or bum).
Or you return from a major shoot only to find that something wasn’t set cor-
rectly in the camera, and all your images have a nasty color cast.

Match Color lets you adjust one image to another (and you can even use
selections to identify areas to adjust or areas of the images to use as the
basis for adjustment), but keep in mind that you get better results with
images that are already rather similar. You can also fix one shot and use that
shot as a standard by which others are corrected. (Like most image adjust-
ments, you can record a change in an Action and use Photoshop’s Batch com-
mand to apply that adjustment to a series of images. Read more about
Actions in Chapter 16.) Take a look at Figure 6-16 to see the Match Color
dialog box.

®0O0 SmallBoats-01.psd @ 12.5% (RGB/16#) oot

[

SmallBoats-02 copy

Match Color

— Destination Image i oK ;

Target: SmallBoats-02.psd (RGB/16) £
# Ignore Selection when Applying Adjustment [ Cancel )

— Image Optiens E Preview
Luminance 100
Color Intensity 100

Fade 0

I Neutralize

— Image Statistics

# Use Selection in Source to Calculate Colors

™ Use Selection in Target to Calculate Adjustment

Source: | SmallBoats-01... @
Layer: ( Background E
Load Statistics... )

(" save Statistics... )

Doc: 46.8M/46.5M

Figure 6-16: The targetimage’s original colors are visible in the small window to the
upper-right.
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Because the Match Color dialog box is such a powerful tool, it’s worth taking
at look at what’s going on there:

1~ Ignore Selection when Applying Adjustment: If you have an active
selection in the target layer or image (for calculating the adjustment, see
the upcoming bullet on that) and you want the adjustment to be applied
to the entire target, select this check box. If the box is left clear, the
adjustment is applied only within the selection. Note that you can use
selections to apply Match Color to only a portion of your image, such as
flesh tones, or you can adjust sections of the image one at a time.

+* Luminance: After the preview shows in your image window, you can
tone down or brighten up the target area with the Luminance slider.

1~ Color Intensity: Think of this slider as a saturation adjustment.
+~ Fade: Using Fade lets you blend the adjustment, reducing its intensity.

~ Neutralize: If a color cast is introduced by the adjustment, selecting the
Neutralize check box might eliminate it.

1~ Use Selection in Source to Calculate Colors: You can make a selection
in the image to which you’re trying to match (the source) and use the
colors within that selection as the basis for the Match Color calculation.

1~ Use Selection in Target to Calculate Adjustment: You can make another
selection in the target layer or image that presents Match Color with a
sample of those pixels to use for calculating the adjustment.

1 Source: The Source pop-up menu lists all the open images that can be
used as a basis for adjustment. Only images of the same color mode and
color depth get listed. Think of source as the image whose colors you're
trying to match. (The selected image or the active layer within an image
is what you're adjusting.)

1~ Layer: When a multilayer image is selected in the Source pop-up menu,
you can designate which layer (or a merged copy of the layers) is the
actual source.

1~ Load Statistics/Save Statistics: If you're doing a series of images and you
want to speed things up, click the Save Statistics button to record the
adjustment you’re making and then use the Load Statistics button with
other images.

In Figure 6-16, an area of water is selected in the target image and a compara-
ble area of water is selected in the source image. (The selection in the source
image is visible in Figure 6-16 for illustrative purposes only — a selection in
an inactive image window isn’t normally visible.) With the two selections, |
tell Match Color to adjust the target image based on the difference between
the water color in the two images. Using selections prevents any skewing of
the adjustment that would be caused by the colors in the sail (source image)
and the trees (target image). But with the Ignore Selection When Applying
Adjustment check box enabled as well, | make sure the entire target image is
adjusted, not just the areas within the selection.

127



’ 28 Part ll: Easy Enhancements for Digital Images

3

Replace Color

Sort of a cross between the Select>Color Range command (see Chapter 8)
and the Hue/Saturation adjustment, Replace Color is a great tool for swap-
ping out one color for another. It’s truly great in a production environment
where, for example, a certain blouse is available in several colors. Shoot one
color and then use Replace Color to produce the additional product shots.

The Replace Color dialog box, as shown in Figure 6-17, has two separate
parts: Selection and Replacement. Click with the left eyedropper in either the
preview area or in the image windows and adjust the Fuzziness slider (how
much variation counts as “selected”) to make your initial selection. Use the
middle eyedropper to add colors or shades of your initial color, and use the
right eyedropper to subtract from the selection. Choose only variations of
one color. Then drag those Hue, Saturation, and Lightness sliders in the
Replacement section of the dialog box to produce your new look.

Rather than switching eyedroppers back and forth, use the left eyedropper
and the Shift key (to add) or the Option/Alt key (to subtract). You can also
hold down the Shift key and drag through an area to select all the colors in
the area. If you accidentally select some colors you don’t want, release the
Shift key and click once to start over.

Replace Color

_Selec(lon (T)
I Multiple Color Clusters 1
(_ Cancel )
£ Color: . ( Load...
Save...
Fuzziness: 57
™ preview

@ Selection ) Image

Replacement

Hue: +35

Saturation: +4 Result ’

Lightness: +1

Doc: 3.05M/3.05M L3

Figure 6-17: Make a selection and change the selection’s hue, saturation, and lightness.
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New in Photoshop CS4’s Replace Color is the Multiple Color Clusters check
box (to the upper-left in Figure 6-17). When this option is active, Replace
Color looks at each range of color you add to the selection as a separate
entity. This enables much better technical control over the colors selected,
but may not be appropriate for most uses of Replace Color, in which you gen-
erally want smooth and complete transformation of all of the selected colors.

Equalize

When you select the Equalize adjustment, Photoshop finds the darkest pixel
in the image and maps it to black, maps the lightest pixel to white, and dis-
tributes the rest of the tonal values between. You can pretty much skip
Equalize — use Auto Color instead.

Working with Variations

The Variations feature, which you find in the Image>Adjustments menu, is a
semi-automated way to make color and tonal adjustments to your images.
You open the image, open Variations, and then click which version looks
better (see Figure 6-18).

® shadows ( ok )

O Midtones
C Highlights
O saturation ( toad.. )

(_ Cancel )

fine  Coarse
rl—
# show Clipping

(Csave.. )

Figure 6-18: You use Variations to click your way to a perfect picture.
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Much like getting new eyeglasses, using Variations is a matter of “Which
looks better, this or this?” When you click one of the images, it moves to the
Current Pick position, and a new set of variations is automatically generated.
The blue areas that you see in some of the options in Figure 6-18 indicate
areas where colors will be clipped — forced into black in the shadows or to
white in the highlights — which results in a loss of detail in the image. You
can disable that feature by clearing the Show Clipping check box in the upper
right. Also note that you can adjust the shadows, midtones, and highlights
independently, and you can also control (to some degree) the amount of vari-
ation from sample to sample.

Start with the Fine/Coarse slider set somewhere in the middle and get reason-
ably close to a great image, correcting midtones, shadows, highlights, and
then saturation. Now drag that slider to the Fine setting and zero in on a
perfect image.

Manual corrections in individual channels

Sometimes different areas of an image require different corrections or adjust-
ments. You can, for example, “paint” corrections into specific areas of a chan-
nel by using the toning tools in Photoshop’s Toolbox. The image in Figure 6-19
has a distinct problem (okay, well, maybe a few problems). In the lower left is a
light-green blob that needs to be eliminated if there’s any chance of salvaging
this photo. By using the Burn tool on one channel at a time, you can darken
that specific area of each channel — each channel according to its needs.

On the left, you can see the distinct light area in the thumbnail of each chan-
nel. On the right, after using the Burn tool, those lighter areas are gone, and
so is the, the . . . what could it have been? Was it perhaps swamp gas?
Ectoplasm? A UFO? Anyway, it’s gone now, and the tabloids won’t pay mil-
lions of dollars for the photo.

In addition to the Burn tool, you can use the Dodge, Blur, Sharpen, and
Smudge tools. You can use the Brush tool and paint with black, white, or
gray. You can use Levels or Curves on an individual channel or even a selec-
tion within one or more channels. When fine-tuning (or salvaging) an image,
don’t be afraid to work in one channel at a time, perfecting that channel’s
contribution to the overall image.

Take another look at the two Channels panels shown in Figure 6-19. Obviously
that’s a composite image because there’s only one Channels panel in Photoshop,
right? On the right, the Green channel is active (you can tell because it’s high-
lighted), and only the Green channel is visible (only it shows the eyeball icon
to the left). The other channels are invisible, and you see only the grayscale
representation from the Green channel in the image window. On the left, how-
ever, only the Red channel is active, but all the channels are visible. Any
change I make to that image in that state is applied only to the Red channel.
But because all channels are visible, | can see the overall impact on my image.
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Figure 6-19: The problem is only in one area of each channel, but you can fix it manually.

<P Sometimes you want only one channel visible, such as when you're trying to
balance the tonal range throughout the channel, for example. But most of the
time, you want to see what’s going on in the image as a whole. Click the one
channel (or Shift+click two channels) in which you need to work. Then click
in the left column next to the composite channel at the top to make all chan-
nels visible.

The People Factor: Flesh Tone Formulas

One of the toughest and yet most important jobs in Photoshop is making sure
that skin looks right. People come in a wide variety of colors and shades and
tints, and all people vary in color in different places on their bodies and at
different times of the year. (The top and bottom of your forearm are likely dif-
ferent colors, and the difference is generally much greater in summer than in
winter.) There are even some exceptions to those broad generalities. Making
skin tones look great is often a major, yet often critical, challenge.



’32 Part ll: Easy Enhancements for Digital Images

WBER
‘x&
&

When you have skin in your image, it’s generally part of the focus of the image —
the person whom you’re photographing. And even when a person isn’t the sub-
ject of the image, skin attracts attention in the image. The eye naturally goes to
people in just about any image (perhaps not first, but eventually).

You'll also find that unnatural variations in skin color are very noticeable.
Consider how often you think to yourself that someone looks a little pale, or
flushed, or sunburned, or tanned, or just plain sick. You're making that judg-
ment call based to a large degree on the appearance of the skin.

Keeping in mind that the numbers shown in Figure 6-20 are general guidelines
and that real people vary quite a bit, I've prepared for you some target values
for skin tones. Use these formulas loosely when using the techniques in this
chapter to adjust the color in your images, keeping in mind the individual
you photographed and the lighting at the time.

Flesh Tone Formulas

Pale Caucasian  Dark Caucasian Afro-American Asian

Highlights| c:4 - M7 - v:15-K0 | C11-M:35-Y:42-K0 | C5-M:14-Y22-K0 | C3-M:11-Y:13-K0

Midtones| C14-M:35-Y:35-K0 | C:14-M:38-Y:49-K0 C:12- M:35-Y42-K0

Shadows

Figure 6-20: These are guidelines only, not absolute values!

Note that the numbers are CMYK, even for use with RGB images. Open the Info
panel menu, choose Panel Options, and set the Second Color Readout to
CMYK. Remember, too, that you can use the Color Sampler tool to add place-
holders in the image, monitoring the changes that you’re making in the Info
panel. Set the color sampler readings to CMYK in the Info panel itself by click-
ing the eyedropper symbol to the left of the color mode listed for each sampler.

Promise me that you’ll keep in mind that these numbers are for reference
only, okay? Your individual image determines what the correct adjustment
should be. You can use these numbers as a starting point, but trust your eyes
and evaluate your image as you work.



The Adobe Camera Raw Plug-In

In This Chapter
Taking advantage of the Raw file format
Evaluating your Raw capabilities

Using the Camera Raw plug-in

Fere was a time, not so long ago in people years (but a couple of genera-
tions ago in computer years), when capturing digital photos in a Raw file
format required you to spend tens of thousands of dollars. The wonderful
thing about the Raw file format is that you use it to record unprocessed
image data, which gives you incredible control over the final appearance of
your image. These days, however, cameras that cost only a few hundred dol-
lars can capture images “in the Raw.” If you don’t have a Raw-capable camera
now, after reading this chapter, you might decide that you need to have Raw
capability.

In this chapter, I explain how Raw differs from other image
file formats and why those differences can be important.
[ show you how to determine whether you have what
you need to capture in Raw and whether Photoshop
CS4’s Adobe Camera Raw 5 plug-in is capable of han-
dling your camera’s image files. Most of the rest of
the chapter looks at the Camera Raw interface and
what all those sliders do for you and your image.

Understanding the Raw Facts

The Raw file format at its heart is nothing but unprocessed
image data. It comes in a number of variations — one or several
for each camera manufacturer, it seems. Each has its own file exten-
sion (such as .crw, .cr2, or .nef), and many have their own special features
that are totally incompatible with each other. And those camera manufacturers
love to tinker with their proprietary formats, changing them regularly. But
each of the formats, at the basic level, is Raw. (Check your camera’s User
Guide to see whether it’s capable of recording image data in a format other
than JPEG or TIFF. If so, it’s probably a variation of Raw.)
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Thankfully, Adobe updates the Camera Raw plug-in for Photoshop (as shown
in Figure 7-1) on a regular basis, adding the capability to work with the
newest cameras shortly after they’re available. (Plug-ins, like Camera Raw
and most of Photoshop’s filters, extend the program’s capabilities. Updating
your plug-ins regularly ensures you have the greatest capabilities.) Be
warned, however, that purchasing a new camera model the day it comes on
the market might mean using the camera’s own software for a while until
Camera Raw is updated.

In the Camera Raw window in Figure 7-1, notice the thumbnails stacked to the
left. Select multiple Raw images in the Photoshop Filem>Open dialog box or in
Bridge and they all open in Camera Raw together. Click a thumbnail to work
on that particular image. If you open images that all need a similar correc-
tion, adjust one and then click the Select All and Synchronize buttons in the
upper-left corner.
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Figure 7-1: The impressive Camera Raw window, explained fully in this chapter.
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What's the big deal about Raw?

Cameras that record images using the Raw format save unprocessed image
data. When recording as TIFF or JPEG, the camera manipulates the image

A
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data, processing it in a variety of ways. So what’s the big deal with prepro-
cessing — Raw — image data? Assuming that you're as hungry for food as for
knowledge, I'll use a cooking analogy.

Say you purchase frozen lasagna and heat it up in your microwave oven. It
probably tastes good and fulfills your needs (“Food!”). However, the chef who
designed this prepared meal and the good folks who churn it out use a spe-
cific recipe designed to appeal to a large number of people, hopefully offend-
ing very few. When you reheat your lasagna in the microwave, you have some
choices. For example, you decide how warm to make it (generally following
the package’s reheating instructions). Or, you can add some salt and pepper
to season to taste, or perhaps dump on the hot sauce.

What you can’t do with that frozen lasagna is take out some of the salt or fat
in it from the recipe designed by the chef and prepared by the good folks.
You can’t substitute olive oil for butter. You can’t cut back on the garlic a bit
(just in case your date goes well). You're pretty much restricted by what the
original chef and his good folks prepared. Sure, you could pour a half-bottle
of blue food coloring over it, creating a special effect, but you're not likely to
turn that microwavable lasagna into a gourmet dinner. So if you're just
hungry and your demands aren’t too severe, no problem — shoot JPEG (the
digital photo equivalent of a microwave meal).

The gourmet dinner is what Raw is all about! If you consider yourself a
gourmet chef of the camera, creating art from virtually nothing, Raw is the
format for you. Avoid the limitations put on your image editing by prepro-
cessing and dive right in with the greatest flexibility. (And you don’t even
have to go down to the farmers’ market for fresh tomatoes.)

Working in Raw

There’s one critical difference between working with Raw images and working
with JPEGs or TIFFs: You never actually make changes to the Raw file. Instead,
you record your adjustments in the image’s metadata (non-image data recorded
with the image data) or in a sidecar file (a separate file in which Photoshop
records any information that can’t be recorded in the metadata). Because
adjustments are recorded separately rather than applied to the images, the orig-
inal image data remains unchanged, waiting for you to create again and again, all
from the same unprocessed, undegraded image data.

QNING/ Sidecar files have the same name as the image file, but they use the . xmp file
Sy extension. Keep each sidecar file in the same folder as the image with which
it is associated. If you move the image file without taking the sidecar file
along for the ride, the information stored in the sidecar file won’t be available
when you reopen the image file.
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The DNG file format

In late 2004, Adobe Systems, Inc., announced a
new open standard (meaning that anybody can
use it without licensing fees) for Raw photos.
The DNG, or digital negative, file format adheres
to the basic Raw formulation but does allow for
growth. The aim is to ensure that years from
now, you'll still be able to open and process the
images you shot yesterday. (Unfortunately,
changes in camera-specific versions of Raw
already make some early Raw photos inacces-
sible by today’s software — and that's just the

tip of the iceberg!) Adobe promises to continue
support for backward-compatible DNG file pro-
cessing in the future and makes the Adobe
Digital Negative Converter software, as shown
here, available for free. Although the hope is
that camera manufacturers will adopt DNG as
their cameras’ version of Raw, only time will tell.
(Note that even if you convert copies of your
images to DNG, Adobe recommends that you
keep the original Raw files, justin case.)
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When capturing in Raw, you can basically ignore all the camera’s settings
other than aperture, shutter speed, ISO, and (of course) focus. Everything
else can be adjusted in the Camera Raw plug-in. However, because Raw
devotes significantly more resources to recording highlights than shadows,
it’s not a bad idea to concentrate on those highlights when shooting. When
the highlights are great to start with, you can reallocate some of the image’s
tonal range to the deprived shadows, thus reducing unwanted digital noise

and increasing detail.
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Keep in mind that in addition to the Photoshop Camera Raw plug-in, you also
have available the software that came with your camera. (And you might
even have additional software packages available, such as Aperture from
Apple and Adobe Lightroom, depending on what camera make and model
you use.) Which package is best? As usual, “best” is a relative term. For exam-
ple, Nikon’s proprietary software does a great job with sharpness when pro-
cessing .nef files, but it lacks some of Camera Raw’s features. If sharpness is
your overriding requirement, you might prefer the Nikon software.
(Remember that your Raw file can’t be processed by both the camera’s soft-
ware and then by Camera Raw, but you can process the data with either and
then further refine your image in Photoshop itself.)

Photoshop’s Save As dialog box offers you the option of the Photoshop Raw
file format. Photoshop Raw is not compatible with the Camera Raw plug-in
and does not provide you with the benefits of using the Raw format with your
digital camera. It is, however, necessary for certain high-end graphics and
animation programs into which someone, somewhere, sometimes places
images from Photoshop.

Do Vou Have What It Takes?

To capture images in the Raw format requires only a camera that shoots Raw. To
work with those images in Photoshop, however, you need both a camera and
software that can process the Raw files. To work with images in the Camera Raw
plug-in, you need a camera on the supported cameras list for Camera Raw —
and, of course, Photoshop with Camera Raw. Adobe updates the Camera Raw
plug-in regularly to ensure compatibility with the latest cameras as well as with
the latest nit-picky changes that camera manufacturers have made to their pro-
prietary versions of Raw. Check for the latest Camera Raw update and list of
supported cameras here (and don’t forget to read the installation instructions
very carefully):

www . adobe.com/products/photoshop/cameraraw.html

Working with images in the Raw format requires one other thing that you
might not have: additional time. Opening the Camera Raw plug-in, making the
necessary adjustments to your image, and then transferring the image into
Photoshop all take time. Granted, making changes in Camera Raw eliminates
the need for many of the adjustments that you’d be making in Photoshop, but
working in Camera Raw could seem to be slower. (Actually, depending on
your system, Camera Raw might speed things up because tonal adjustment,
color correction, sharpening, and noise reduction are all in one place —
there’s no waiting for adjustments and filters to be applied and then for the
next dialog box to open.)
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Camera Raw with JPEG and TIFF

Camera Raw also offers the capability to work
with JPEG and TIFF in the Camera Raw dialog
box. Although not a substitute for shooting Raw
(JPEG and TIFF image data has already been
processed by the camera), it's a huge step for-
ward in terms of flexibility. When you do your
initial processing in Camera Raw, the adjust-
ments are recorded as instructions in the file
metadata rather than actually making changes
to the pixels in your image. You can later go back
and make changes to those adjustments — the
changes are applied to the original pixel data

fresh and clean rather than making changes to
changes.

To open a JPEG or TIFF File in Camera Raw,
choose Filec>0pen, select the file, and then at
the bottom of the Open dialog box, change the
Format pop-up menu (Mac) or the Files of Type
menu (Windows) from JPEG or TIFF to Camera
Raw and click the Open button. If you want to
use Camera Raw for JPEG files regularly, go to
the Photoshop Preferencesr>File Handling and
select the option Prefer Adobe Camera Raw for
JPEG Files.

Working in the Camera Raw Plug-In

The cornerstone of Photoshop’s Raw capability is the Camera Raw plug-in.
Although you can open an image from Adobe Bridge, the file management
program installed with Photoshop (see Chapter 4), directly into Photoshop,
doing so assumes that you want to use the adjustments already recorded in

the image’s metadata. After an image is open in Photoshop itself, you manipu-

late the pixels directly, rather than manipulating the metadata. When you
work in the Camera Raw plug-in, you never change the image itself, only the
adjustments recorded in the file’s metadata (or in a sidecar file).

As shown earlier in Figure 7-1, the Camera Raw window is filled with tools
and sliders. Even though you might not work with all the Camera Raw fea-
tures, here’s the lowdown on the features there.

Tools and preview options

In the upper-left corner of the Camera Raw window are a couple of new tools
(as shown in Figure 7-2). In addition to the Zoom, Hand, White Balance, Color
Sampler, Crop, Straighten, Spot Removal, and Red Eye Removal tools, you

also now have the Adjustment Brush and the Graduated Filter tools. To the

right of the tools are buttons to open Camera Raw’s Preferences and two

rotation buttons.
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The Zoom and Hand tools functlon. ‘ _RGF¥ B2 [Z=Za =0 ‘
as you would expect — they zoom in

and out and reposition a zoomed-in
image in the window. Click with the
White Balance tool on something in
the image that should be gray (not something that is already gray, but that
should be gray) to automatically adjust the Temperature and Tint sliders. It’s
a one-click way to neutralize any color cast and correct the color balance. If
you get an unexpected result, click elsewhere. And, of course, afterward you
can still tweak the Temperature and Tint sliders as desired.

Figure 7-2: Camera Raw now offers 10 tools for
perfecting your images.

When you add color samplers (a maximum of nine) to the image preview
area (click with the Color Sampler tool), their values are displayed below the
tools, as you see in Figure 7-3. When you haven’t added color samplers, that
area is collapsed, leaving more room for the preview area. Color samplers in
Camera Raw function the same as they do in Photoshop (see Chapter 6).
Color samplers are visible earlier in Figure 7-1 as numbered targets in the
preview area, strategically located in three locations on the blimp and one in
the sky. You can use the Color Sampler tool to drag existing color samplers
to new locations or delete them by Option/Alt+clicking on the sampler.

With any but the Retouch and Red
Eye Removal tools active, the Clear RGP E 2| [£=[2]18] [=[2]Z]

Samplers button will delete all 2k [EEs ‘ i | P rrm——
existing color samplers. Remember, B8 E 26 iy
too, that the position of the cursor

can function as an additional color Figure 7-3: Color Samplers let you monitor
sampler — the RGB values are shown color in specific locations of the image while
below the histogram. you work.

Color samplers are great for making sure that you don’t blow out your high-
lights (make them pure white) or clog your shadows (turn them pure black).
Click with the Color Sampler tool to add a color sampler to both a highlight
area and a shadow area, and then place your remaining color samplers in
strategic areas. (I like to place a color sampler in an area of the image that
should be neutral, preferably mid-gray, and a color sampler in the most
critical area of the image’s subject.)

Click and hold down the mouse button to select an aspect ratio (relationship
between width and height) for the Crop tool, as shown in Figure 7-4. Drag

the Crop tool to create a bounding box, which will automatically adjust to
Landscape or Portrait orientation as you drag. You can then adjust the size of
the bounding box by dragging its anchor points. You can also rotate an image
while cropping: Position the tool just outside the bounding box and drag to
rotate. If you drag the Straighten tool along a line in the image that should be
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horizontal or vertical, perhaps the intersection of
two walls or the horizon, a crop bounding box is rﬁj Pt
created with that alignment. L3

PARIVAL]

Mormal

When you have the Crop tool’s bounding box just 1to 1
right and you’ve finished adjusting the image’s

appearance, click the Open or Done button. A
Should you change your mind about cropping, 3to4
click the Crop tool, hold down the mouse button 4105

to show the menu, and select Clear Crop. Or you S5to7
can eliminate the bounding box by pressing

Delete (Mac) or Backspace (Windows). Custom...

The Retouch tool gives you the ability to make wIE
minor corrections right in the Camera Raw dialog inShe
box. As shown in Figure 7-5, it offers capabilities
similar to the Healing Brush and the Clone Stamp, Figure 7-4: The Crop tool can
including a new Opacity slider. However, the ensure perfect aspect ratio.
Retouch tool’s behavior is quite different. To use

the Retouch tool, follow these steps:

1. Click the area you want to heal
or clone over.

g: --- /5.6 1/400s
ISO 100 55-200@60 mm

Spot Removal
Heal

Typ{ v Clone E

Radius 2

2. Drag to expand the tool’s
diameter.

Opacity 100

You can also set the diameter
using the Radius slider.

. Figure 7-5: Camera Raw's Retouch tool offers
3. Position the source (green) and healing and cloning modes.

destination (red) circles.

When you release the mouse button after setting the tool’s diameter, a
pair of circles appears. Click within the green circle and drag it over the
element from which you want to clone or heal. You can also drag the red
circle to fine-tune the location of the destination. You can click the edge
of either circle and drag to resize them both (or use the Radius slider).

4. Repeat, accept, or clear.

Clicking outside the circles accepts the change and starts the next heal-
ing/cloning process. Changing tools and continuing with your adjust-
ments accepts the changes. Clicking the Clear All button (just to the left
of Camera Raw’s histogram) deletes the changes you made with the
Retouch tool.
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To use the Red Eye Reduction tool, drag a rectan-
gle around the entire eye, including some sur-
rounding skin (see Figure 7-6). It automatically
tries to hunt down and eliminate any suspicious
red eye in the rectangle. You might need to adjust
the Pupil Size and Darken sliders to fine-tune the
adjustment.

Figure 7-6: Minimize the
New in Camera Raw 5 is the capability of localized haunted red eye effect right in
adjustments. Select the Adjustment Brush (shown (amera Raw.
in Figure 7-7), drag the sliders, and paint in the
image. You can paint a number of different adjustments (use the New button)
or paint the same adjustment in different areas (use the Add button). And
remember that these adjustments are only recorded in the metadata, and
therefore can be changed any time down the road. It’s not quite the same
as duplicating layers and using layer masks in Photoshop, but a great
step forward!

Also new to Camera Raw 5 is the Graduate Filter tool. Set the adjustment
in the area to the right, and then drag the tool in the image window. The
adjustment is applied at full strength in the area before your first click, and
gradually faded through the area where you dragged (see Figure 7-8). You
can add more than one graduated adjustment if necessary.

éf G fi22 15s
8 IS0 100 55-200@55 mm

Adjustment Brush

(O New @ Add () Erase

& Exposure +0.05 | @
Brightness -55
@
Contrast [
®
| S —
Saturation +31
L ]
Clarity 0
®
e —
Sharpness. [
L ]
® cor ®
Size 8
=

Feather 56

Flow, 50

Density 100

[T Auto Mask [ showMask [ |

Clear All

[ show Pins

Figure 7-7: Camera Raw: No longer just global adjustments!
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i=a /22 1/5s
IS0 100 55-200@55 mm

Graduated Filter

O New 8 Edit

= Exposure +0.05 | &
& EBrightness -63 &
& Contrast o +
= Saturation +46 +
= Clarity o +

& Sharpness

& Color

E Show Overlay ( Clear Al

CRW_1256.CRW

Figure 7-8: Like using a graduated filter when shooting, but with more control!

To the right of the tools are Camera Raw’s buttons to quickly open Camera
Raw’s Preferences (the same as using the keyboard shortcut 88+K/Ctrl+K)
and to rotate the image in 90 degree increments in either direction.

Here are some changes to the Preferences that you might want to consider:

1~ Save settings in sidecar files. Okay, so this one is already the default,
but it’s a good one. When Camera Raw can’t record data directly to the
image file’s metadata, you can either save everything in one central
location — which means you lose everything if that database is damaged
or lost — or each image you adjust can have its own . xmp file to hold
your adjustments.

1~ Set defaults for each camera. If you shoot with more than one camera
(and remember that Camera Raw can now work with JPEG images, as
explained in the “Camera Raw with JPEG and TIFF” sidebar in this
chapter) use separate defaults for each of them. Saving a new camera
default is discussed later in this chapter, in the “Workflow options and
presets” section.

1~ Update DNG previews. If you work with Adobe’s DNG Converter and
make DNG copies of your images, doesn’t it make sense that you’d want
the latest adjustments reflected in the file’s preview? (The JPEG preview
is used by your computer’s operating system and other programs that
can’t read DNG files.) And those previews might as well be full-size, eh?
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You'll also find options in Camera Raw’s Preferences for opening JPEG and
TIFF files into Camera Raw. Keep in mind that once you open an image in
either format using Camera Raw, you’ll have to go through Camera Raw
every time you open that image. If you ever decide you don’t want to open
a particular image through Camera Raw again, use Photoshop’s Save As
command to create a new copy of the picture.

The histogram

Because of the unprocessed nature of Raw images, the histogram you see in
the top-right corner of the Camera Raw window (also shown in Figure 7-9) is
generally far more important than the Histogram
panel in Photoshop itself. By keeping an eye on
the histogram while you adjust sliders, you can
ensure that you're not blowing out the highlights
(when the very right end of the histogram starts
crawling up the edge) or clogging the shadows
(the left edge gets too tall). The RGB values that
you see just above the histogram represent the  Figure 7-9: Consult the

values of the pixel directly under the cursor histogram to make sure you
when the cursor is in the preview area of the don’t wreck your highlights
window. and shadows.

The histogram in Camera Raw shows you not only the distribution of tonal
values but also the distribution by channel. In Figure 7-9, you can see that the
Blue channel has a lot of dark pixels: The blue column climbs the left edge of
the histogram. This could indicate any of a number of situations. However,
because you also see a generally good distribution of blue throughout the
histogram (in part shown by the areas of white, which indicate that all three
channels have comparable values), you can be pretty sure that the column of
blue to the left simply indicates a lot of bright yellow in the image. (Blue and
yellow are color opposites in RGB.) As always, remember that what you see
in the preview area — what your eyes tell you — trumps any information
from a histogram.

To toggle a preview of any “clipping” in your image, click the triangles in
the upper-left (shadows) and upper-right (highlights) of the histogram.
Anyplace where the shadows are being forced to pure black, losing detail
that you could retain, you see a solid blue overlay. Anywhere that the high-
lights are being blown out to pure white, again losing valuable detail, you
see a solid red overlay. (Fix this clipping problem using the Exposure, Blacks,
Brightness, and Fill Light sliders, as explained later in this chapter.) You
can hide these gamut warnings by again clicking the triangles. The triangles
change color to tell you what’s wrong or which colors are causing the
problem. You might want to hide the overlays when creating special effects.
(I readily admit that I often intentionally clog shadows and blow out high-
lights to produce special effects and to focus attention on the subject of
my photos.)
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The preview area

As shown earlier in Figure 7-1, the bulk of the Camera Raw window is filled
with the image preview, giving you the best possible view of your work.
Remember that you can drag the lower-right corner of the Camera Raw
window to resize it. The preview area benefits/suffers from the changes that
you make as you enlarge/shrink the window. To the lower left are a pop-up
menu with preset zoom factors as well as a pair of buttons to zoom in or out.
(Don’t forget about the Zoom tool!) Unlike Photoshop, Camera Raw’s maxi-
mum zoom percentage is 400%.

Above the top-right corner of the preview area is the Preview check box,
which you can toggle off and on to see the difference between the current
adjustments and the original (or earlier adjustments made in Camera Raw).
To the right of the Preview check box is a handy button that expands Camera
Raw to Full Screen mode. The only Camera Raw-related information that dis-
appears is the name of the camera from which the images came. Note to Mac
users: In Full Screen mode, you may not have access to the hidden Dock.
Simply click the button again to toggle back to Normal mode or use the Mac’s
shortcut 38+Tab to switch programs. (Pressing the F key also toggles to and
from Full Screen mode.)

Workflow options and presets

Just below the preview area in Camera Raw is a line of information in blue.
That tells you the current color space, color depth, pixel dimensions, and
resolution. Click that line to open the Workflow Options dialog box.

Here are your workflow options:

1~ Space: Camera Raw offers only four color spaces — Adobe RGB,
ColorMatch RGB, ProPhoto RGB, and sRGB. Color spaces (read about
them in Chapter 6) determine which colors are available in an image.

Using the ProPhoto RGB color space gives you the widest gamut (the
largest number of possible colors), which minimizes the chance of
colors getting squished into each other as you work with your image. If
your image has extreme colors, use ProPhoto and 16-bit color in Camera
Raw, and then, if your printer can’t handle ProPhoto as a color space,
choose Edit=>Assign Profile to change to your required profile (Adobe
RGB for inkjet printers or sRGB for images being sent to a photo lab).
Select Relative Colorimetric as the rending intent.

~ Depth: Because a greater color depth means more possible variations in
color, generally you want to select 16-bit color and either keep the image
in that color depth or switch to 8-bit color later in Photoshop by choos-
ing Imager>Moder>8-Bits/Channel. Use 8-bit color for any image that
must be saved in JPEG format (including Web images), for CMYK
(cyan/magenta/yellow/black) images, or when the file size overwhelms
your printer. You might also opt for 8-bit color if storage space is limited.
(Chapter 6 includes a detailed explanation of color depth.)
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v~ Size: You can choose from among six pixel dimensions for your image

in Camera Raw. The camera’s native pixel dimensions for the image is
the default, but you can also downsize to 50% or 67%, or upsize to 133%,
167%, or 200%. Camera Raw uses a variation of the Bicubic Sharper
algorithm for resampling (calculating the colors of the new pixels). Your
options may differ, depending on the camera you use and the profile
selected for that camera.

1~ Resolution: Resolution is simply an instruction to a printing device

about what size to make each pixel. It can be assigned in Camera Raw or
later in Photoshop’s Image Size dialog box (with Resample unselected).
If your camera embeds a resolution that Camera Raw can read, it will be
used. Generally speaking, 300 ppi is an appropriate resolution for images
that will be printed.

* Open in Photoshop as Smart Objects: This option enables you to

automatically open your Raw image into Photoshop as a Smart Object.
Smart Objects, which are discussed in Chapter 10, can be scaled and

transformed multiple times with
minimal degradation of the image
quality. And, as explained in
Chapter 15, you can apply Smart
Filters — re-editable filters — to
Smart Objects.

On the subject of workflow, let me also
suggest how you can save loads

of time when working with Camera
Raw: Create your own defaults and use
saved settings. Figure 7-10 shows the
menu commands available to you.
(Not all commands are available all the
time.) The most important is perhaps
Save New Camera Raw Defaults.

Here’s my recommendation:

1. Open one of your typical images.

Basic

5l

Temperature

5500

i N
~ | v Image Settings
White Balance: [ As Shot B

Camera Raw Defaults
Previous Conversion

Tint

Custom Settings

Auto
Exposure

Default

Recovery

Export Settings to XMP

Fill Light

Blacks

Load Settings...

Brightness

Save Settings...

Contrast

Save New Camera Raw Defaults

Reset Camera Raw Defaults

Figure 7-10: Camera Raw permits you to save,

export, and import settings, as well as
establish custom default settings.

Open an image that’s well exposed and typical for what and how you
shoot. Don’t open some wild image that’s three-quarters wrecked and in

need of emergency surgery.

2. Adjust the image to make it look perfect.

The various adjustments are discussed in the following sections. Make
all the necessary adjustments, including noise reduction and camera

calibration if required.

3. Save as your new defaults.

Open the menu and select Save As New Camera Raw Defaults.

145
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Now when you open one of your images into Camera Raw, you’ll already have
a good correction established and you’ll need to tweak the settings only a bit
to adjust for the peculiarities and vagaries of that particular shot.

Remember, too, that you can save settings for each individual shoot by using
the Save Settings command. Say, for example, that you shot on-location under
difficult lighting circumstances. Rather than adjusting each image, adjust one,
save the settings, and load (or apply) those settings for each additional
image from that shoot that needs to be processed.

The Basic panel

When it comes to actually correcting your images [Glzp ==l @ =
in Camera Raw, the meat-and-potatoes portionis | X bsic
the Basic panel. Click on the leftmost of the eight | whiesaince Csom )
tabs directly below the histogram area to open Temperature 6500 |
the Basic panel, which is shown in Figure 7-11.

Tint +11

Here are some general guidelines for working in Auto  Default
the Basic panel (but remember that each image Anesuc 0.00
has its own particular requirements): Jesaen 0
Fill Light 0
1 Adjust the white point. Generally, you adjust Cl;iacks .
j the white point (the Temperature and the ‘:Tghm“ =

Tint sliders) by clicking with the White
Balance tool (which looks like the
Eyedropper tool, shown here in the margin)
in some area that should be neutral and
close to white. If the image doesn’t look
right, click elsewhere or manually adjust the
Temperature and Tint sliders.

Contrast +25

Clarity 0

Vibrance o

Saturation o

Figure 7-11: The Basic panel is
where you do the bulk of your
image correction.

1~ Adjust the Exposure. Drag the Exposure
slider right or left to spread the histogram
across most of the space available.
(Remember, these are general guidelines for
typical images, not “rules.”)

+ Fine-tune the shadows and highlights. Use the Brightness and Blacks
sliders to spread the histogram toward the right and left ends. The
Recovery slider can bring back some of the depth in the upper part of
the tonal range (bright areas, but not as bright as the highlights), and
the Fill Light slider lightens the midtones.

+~ Fine-tune the contrast. Drag the Contrast slider to the right to increase
contrast or to the left to flatten out the image’s contrast.

1~ Make the image “pop” with the Clarity slider. Drag the Clarity slider to
the right to increase the contrast among neighboring areas of color.
Somewhat akin to sharpening, this slider can do a great job of adding life
to most images.
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1~ Tweak the colors. Using the Vibrance slider in conjunction with the

Saturation slider, adjust the appearance of the color in your image. Note,

too, the Convert to Grayscale button. You can use that button or the
one in the HSL/Grayscale tab — they both change when you select or

deselect either.

Vibrance and Saturation

Both the Vibrance and the Saturation sliders in
Camera Raw adjust the intensity of colors in
your image. So what's the difference? The
Saturation slider changes all color in the image,
whereas the Vibrance slider works its magic
primarily on those pixels that are least satu-
rated. To see how this works, open an image in
Camera Raw and adjust the sliders to make the
image look great. Drag the Saturation slider all
the way to the left. Grayscale, right? Move
the Saturation slider all the way to the right.

Over-saturated, right? Drag the Vibrance slider
slowly to the right while keeping an eye on
areas of the image that are close-to-but-
not-quite gray. Watch how they increase in sat-
uration, gradually going from near gray to
almost colorful. Now here's the coolest trick of
all: With Saturation still at +100, drag the
Vibrance slider all the way to the left, to —100.
Starting with an appropriate image, this can be
a very interesting effect.

A\\S
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Double-click any slider control to reset that slider to its default value. This

works not only for sliders in the Basic panel, but also for sliders anywhere in

Camera Raw.

As you work, the best adjustments are those that make the image look

great to you and meet your creative goals. The order of adjustments and
the histogram suggestions here are not appropriate for all images. Let your

artistic sense be your guide.




’ 48 Part ll: Easy Enhancements for Digital Images

Adjusting the tone curve

The second tab in Camera Raw, just to the right of the Basic tab, presents you
with a pair of ways to adjust the histogram using curves (see Figure 7-12). On
the Tone Curve tab, you have two more tabs: Parametric and Point. The first
thing to know about the Tone Curve adjustments is that they are in addition
to changes you make in the Basic tab. All changes are cumulative — dragging
sliders in the Parametric panel, for example, won’t change the sliders on the
Basic tab.

In the Parametric panel, you adjust four sliders to control various parts of the
tonal range. The three sliders immediately below the curve itself govern the
pivot points around which the sliders bend the curve. The two outer sliders
govern what part of the tonal range is affected by the Shadows and Highlights
sliders, and the middle slider controls the relationship between the Darks
and Lights sliders.

QOAMEE S = QAMEE NS =
* Tone Curve = Tone Curve =
| Parametric | Point | | Parametric Poimk_ )|
Curve: | Medium Contrast :i
e
e
o
rd
F
o
o
-
&
2
[
A
[ [ [

Highlights 0

Lights 0 Input: Output:
Darks i

Shadows 0

Figure 7-12: You make changes to tonality in the Tone Curve tab.
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The Point panel of the Tone Curve tab is quite similar to the Curves adjust-
ment in Photoshop: Click the curve to add an anchor point; drag up and
down to adjust that part of the tonal range. You can add up to 14 separate
points to the curve. Click an anchor point to make it active (it appears as a
solid point rather than hollow) and you can use the Input and Output fields
to adjust the point numerically, or use the arrow keys to change the

point’s location.

So, you might ask yourself, “Should I use the Basic tab, the Tone Curve tab, or
both?” And the answer is “Yes, you should use the Basic tab, or the Tone
Curve tab, or both.” You might find that you’re more comfortable using one
curve or the other rather than the Blacks, Brightness, and Contrast sliders in
the Basic tab. Or you might find that for one particular image you want to
make large adjustments with one set of sliders and fine-tune with the other.

But how do the adjustments compare? An increase of 10 in the Contrast
slider in the Basic tab is approximately comparable to a parametric curves
adjustment of Lights plus-4 and Darks minus-5. A parametric curve adjust-
ment of Highlights plus-15 and Shadows minus-15 is roughly comparable to
Blacks 5 and Brightness 4 on the Basic tab. You might find that using the
Blacks slider (in the Basic tab) has a heavier influence on the darkest shad-
ows and less influence on the midtones than working with the Shadows slider
in Parametric panel of Tone Curve. Likewise, you might find the Brightness
slider a bit more concentrated in the lightest highlights than the Highlights
slider. But most of all, you might find that using both sets of sliders gives you
incredible control over the tonal range in your image!

The Detail panel

Six sliders on the Detail tab control sharpness and noise in your image. [
suggest that as soon as you click the Detail tab, you zoom in to 200% or even
400% on an area of shadow in your image and drag the sliders all the way to
the left, setting them to 0 (zero). Rather than working from the top down, as
you do in most Camera Raw panels, I generally suggest reducing noise before
sharpening. (Remember, too, that you can click the Preferences button above
the preview to change the behavior of the Sharpening sliders so that they
sharpen the preview only.)

Drag the Color Noise Reduction slider slowly to the right until all
red/green/blue specks in the shadows disappear. Next, drag the Luminance
Smoothing slider to the right until the bright specks in your shadows are
reduced but not so far to the right that detail in your image is damaged.
Figure 7-13 shows a before-and-after comparison of an image shot at ISO 1600.
(For most cameras, any ISO setting above 400 is likely to produce a large
amount of digital noise.)
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Noise Reduction

Luminance

Calor

Noise Reduction

Luminance

Color

7

Figure 7-13: Reducing noise and smoothing luminance can greatly improve shadow areas.

Sharpening in Camera Raw has developed so much that it’s actually perhaps
better than sharpening in Photoshop. Rather than a single slider, you now
have four sliders with which to perfect your images:

1 Amount. The Amount slider is the basic how-much-sharpening-am-I-
adding slider. You might consider “sharpening” to be creating bright and
dark “halos” along edges in the image. Amount refers to the brightness
of those halos. The slider ranges from zero to 150.

1~ Radius. The Radius slider controls the width of the “halos” along the
edges. Higher is wider, up to a maximum of 3 pixels.

1~ Detail. Use the Detail slider to control how large an edge has to be
to get included in the sharpening process. Leave it at zero and only
major edges in the image are sharpened. Drag the slider all the way to
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the right, to 100, and everything in the image gets sharpened, every
pore, each grain of sand — even the remains of any digital noise you
want to hide.

1 Masking. The Masking slider, used in conjunction with the Detail slider,
can help protect the smallest detail in the image from becoming over-
sharpened and garish. The farther to the right you drag the slider, the
more tiny detail is excluded.

« Here’s the coolest part: Hold down the Option/Alt key while dragging any
of the Sharpening sliders and you’ll see a grayscale preview of what you're
actually doing to your image!

Figure 7-14 shows three views of the same image: The unsharpened original
(top); the Sharpening sliders set to Amount-85, Radius—1.0, Detail-55, and
Masking-5 (middle); the preview of the Detail adjustment (bottom).

— Unsharpened

Some
— sharpening
adjustment

Preview
— of a Detail
adjustment

Figure 7-14: Hold down the Option/Alt key while dragging to preview the sharpening.
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HSL, grayscale, and split toning

Working with options in three tabs, Camera Raw’s HSL/Grayscale feature
gives you incredible control over hue, saturation, and luminance of specific
color ranges in your image. Need to perk up the reds in your image? Not a
problem — boost the Reds slider in Saturation and Luminance! Yellows a bit
too garish? Tone ’em down with the Yellows slider. Maybe the green grass
looks a bit yellow. Drag the Greens slider halfway to the right in the Hue tab.
You can control each of the eight major color ranges independently (as
shown in Figure 7-15).

A fourth panel, Grayscale Mix, appears only when the Convert to Grayscale

box is selected. With the Convert to Grayscale option selected, you control

the contribution of each range of color to the final grayscale image. Use the
Basic tab’s Exposure, Blacks, Brightness, and Contrast sliders to control the
overall appearance of the image.

The Saturation tab also enables you to create partial grayscale images quite
easily. Drag some sliders to the left to make those areas of color grayscale;
drag others to the right to enhance the remaining colors. Figure 7-15 shows
an excellent candidate for this partial-grayscale technique.

4
HSL / Grayscale

" Convert to Grayscale
Hue | Saturation |Luminance
Default

Reds

Dranges

Yellows

Creens

Aguas
[,

Elues

Purples

Magentas

Figure 7-15: Grayscale greenery contrasts nicely with highly saturated blooms.
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The Split Toning tab is generally used in conjunction with the Convert to
Grayscale options in the Basic and HSL/Grayscale tabs. (Although you can
use it to make adjustments to highlights or shadows, you would generally
remove or introduce a color cast in the Basic tab with the Temperature and
Tint sliders.) Think of split toning as creating a sepia or Duotone version of
an image. As you can see in Figure 7-16, you have separate controls for
adjusting the highlights and shadows. Select a different hue for each and
adjust the saturation independently. The Balance slider allows you to control
what part of the tonal range is considered highlight or shadow.

To create a sepia effect, start with a value of 40 in both of the Highlights
fields and perhaps +30 for Balance. Use a Shadow saturation value of 0 (and
because saturation is set to 0, it doesn’t matter what value you select for the
Hue slider). Remember, too, that you can select the same hue for both
Highlights and Shadows to create a monochrome effect.

D A 4 = Eril e =S
Split Toning

Highlights
Hue 240

Saturation 45

Balance +4

Shadows

Hue a1
=¥

Saturation 50

Figure 7-16: A photo of a bland building in front of an overcast sky is improved with split toning.

Compensating with Lens Correction

Use the Lens tab’s controls (as shown in Figure 7-17) to compensate for
certain undesirable characteristics of your lens. Zoom in on an area of angled
lines in an image — perhaps tree branches in front of a bright sky — and
look for colorful halos or fringes along edges. Use the Chromatic Aberration

153



’ 5 4 Part ll: Easy Enhancements for Digital Images

sliders to minimize the fringe. Be patient and careful — often there will be
one precise pair of settings that eliminates the problem. (And keep in mind
that while refraction of light through water or ice isn’t the same as chromatic
aberration, these sliders are sometimes helpful in minimizing those colored

halos, as well.)

Figure 7-17: Original to the left, corrected image to the right.

9 Aa == n8

Lens Corrections

it

Chromatic Aberration

Fix Red/Cyan Fringe -23

Fix Blue/Yellow Fringe -3

oetrnge

Lens Vignetting

Amount ]

Midpoint

Post Crop Vignetting

Amount o

Midpaint

Roundness

Feather

Use the Vignetting sliders to eliminate darkness around the edges of the
image or, perhaps, to introduce either darkness or lightness as a special
effect. (The Lens Vignetting section is used with an uncropped image;
the Post Crop Vignetting section applies a vignette to only the cropped

area of the image.) When the
Amount slider has a value other
than 0, the additional sliders are
active, which lets you set the
diameter of the vignette and, for
post-crop vignettes, the round-
ness and feathering. In Figure 7-18,
the original image is shown at the
top. Below, you see what happens
when you drag the Amount slider
to the left for a dark effect and to
the right to lighten the corners of

the shot, smoothing the appear- Figure 7-18: Drag the Amount slider to the left
ance of the sky. to darken corners, to the right to lighten.
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The two vignetting features can be used in conjunction with each other on
un-cropped images. And if you drag the Feathering slider all the way to the
left, you can experiment with frame effects, adjusting the Roundness slider

as desired.

Customizing camera profiles and the Presets tab

You might want to use the Calibrate tab to compensate for what you perceive
to be regular and consistent deviation in your particular camera’s behavior.

You might, under some circumstances,
want to use the sliders on the
Calibration tab (see Figure 7-19) to
reduce a color cast, an unwanted color
tint in the image. Use very small adjust-
ments! Generally, though, you’ll skip
the Calibration tab completely.

If your particular camera model has
had multiple profiles created, you'll see
them listed in the pop-up menu at the
top. The image open in Camera Raw
when Figure 7-19 was captured is from a
camera whose profile was last updated
for Adobe Camera Raw 4.4, so the cur-
rent profile is actually selected, despite
the fact that this is Camera Raw 5.

Camera Raw’s new Presets tab (the tab
to the far right) simply stores a conve-
nient list of your saved presets. Any
time you use the Save Settings com-
mand from the menu to the right of the
tabbed area, your preset is added to
the list for convenient one-click appli-
cation. To use save settings, open an
image in Camera Raw, open the Presets
panel, click the profile, and click Open
Image/Open Object or Done.

The Camera Raw buttons

S AN ==k

Camera Calibration

Camera Profile

Name: | ACR 4.4 |
Shadows
Tint 0
Red Primary
Hue 0
Saturation 0

Green Primary

Hue 0

Saturation 0
Blue Primary

Hue 0

Saturation 0

Figure 7-19: The Calibrate sliders might be
useful for correcting a color cast.

In the lower-left and lower-right corners of Camera Raw are four buttons,
three of which have hidden features that you access by pressing the

Option/Alt key:
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1~ Save Image . . ./Save Image: After making your adjustments, click the
Save Image . . . button to open the DNG Converter dialog box and save a
copy of the image as a DNG file. Option/Alt+click to bypass the DNG
Options dialog box and simply save the image as a DNG file. When you
close the Camera Raw window, the image is saved automatically. (For
more on the DNG file format and the DNG Options dialog box, see the
sidebar, “The DNG file format,” earlier in this chapter.)

1 Open Image/Open Copy (or Open Object/Open Copy): After making
your adjustments, click Open to update the file’s metadata and open the
image in Photoshop itself. Holding down Option/Alt changes the button
to Open Copy, which opens the image without updating the metadata.
You might use Open Copy when creating a second version of the image
while preserving your exactingly precise original adjustments.
(Remember that a simple change in the Workflow Options — which you
open by clicking the blue information line under the preview — enables
you to automatically open an image from Camera Raw into Photoshop as
a Smart Object.)

1~ Cancel/Reset: Clicking Cancel closes the Camera Raw window without
making any changes to the image’s metadata. Holding down the
Option/Alt key changes the button to Reset, which restores the settings
seen when you first opened the image in Camera Raw.

 Done: The Done button, with or without the Option/Alt key, simply
updates the image’s metadata with the adjustments you’'ve made and
closes Camera Raw without opening the image.



Fine-Tuning Your Fixes

In This Chapter

Telling Photoshop where to work with selections

Masking for layer visibility and to protect parts of your image

Keeping your options open with adjustment layers

Flere you are, repainting the bedroom — all by yourself, saving money,
being productive — and it’s time to do the windows. Now, you probably
don’t want to paint over the glass, right? Just the frame, the sash, the sill,
those little whatch-ya-call-its between the panes, right? (Okay, technically
the dividers between the panes are called muntins.) There are several ways
you can avoid painting the glass. You can use a little brush and paint very
carefully. You can use a larger brush, paint faster, and scrape the excess from
the glass afterward. You can grab the masking tape, protect the glass,

and paint as sloppily as you like — when the tape comes off, the
glass is paint-free.

Those are unbelievably similar to the choices that you
have in Photoshop when you need to work on only a
part of your image. You can zoom in and use tools,
dragging the cursor over only those pixels that you
want to change (just like using a tiny paintbrush).
You can use the History Brush feature (which I
introduce in Chapter 1) to restore parts of the image
to the original state (like scraping the glass). You
can isolate the area of the image you want to change
with a selection (much like protecting the rest of the
image with masking tape).

In this chapter, you read about getting ready to make
changes to your image rather than actually making those
changes. You can isolate groups of pixels in your image in a variety of
ways. For example, you can select pixels that are in the same part of the
image (regardless of color), or you can select pixels that are the same color
(regardless of location in the image). This is power: the ability to tell
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Photoshop exactly which pixels you want to alter. After you make that selec-
tion, you can manipulate the pixels in a variety of ways — everything from
making color and tonal adjustments to working with Photoshop’s creative
filters to simply copying them so you can paste them into another image.

[ discuss “taping the glass” first by making selections and then by using
masks — channels that actually store selection information. After that, I tell
you about working with adjustment layers, which are special layers that help
you apply certain color and tonal adjustments without actually changing any
pixels in the image. An adjustment layer even lets you restrict the change to
one or several layers in the image.

What Is a Selection?

When you make a selection in your image, you're simply isolating some of the
pixels, picking them (selecting them) so that you can do something to those
pixels without doing it to all the pixels in your image. Photoshop shows you
what part of the image is within the selection with a flashing dashed line.
(Now that you’re part of the Photoshop Inner Circle, you call that selection
boundary the marching ants.)

Say, for example, that part of your image looks great, but part of the image
looks, well, just plain wrong. Figure 8-1 is an excellent example.

Figure 8-1: Sometimes only part of the image needs changes.
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By making a selection and applying an adjustment, I can make this image look
much, much better. Of course, you might choose to make a different selection
and apply a different adjustment, but you can see what I chose to do in the
lower-left of Figure 8-2. By selecting the rails (in this case, with the Polygon
Lasso tool, which I explain later in this chapter), | isolate those areas from
the rest of the image, enabling me to change the color of those pixels without
changing anything else. (Rather than selecting and darkening the rails to
make them appear to be in front of a glow, I could have selected the lighter
area and created a uniform sky color. But this is visually more interesting.)

O 0 O & ChirpingAtSunrise.tif @ 33.3% (RCB/8#)

= ChirpingAtSunrise-1.tif @ 150% (RCB/8#)
S

| ChirpingAtSunrise-2 @ 50% (RGB/B#)

Preset: | Custom H‘] @
e
’ ( Cancel )

Saturation: -14

Lightness: -60
——

| Colorize

f )3 /? EvaiEw

50% [] Doc: 1.96M/2.16M

Figure 8-2: The selection (shown to the right) restricts the change to some parts of the image.

The tonal and color adjustments that I discuss in Chapters 5 and 6 are often
applied to an image as a whole. You can, however, apply them to specific
areas of an image. Much of the rest of the work that you do in Photoshop is
not global in nature, but rather is done to only restricted areas of your image.
You use selections to do that restricting.

You can also use selections for a variety of other jobs in Photoshop. One

of the most common is copying from one image and pasting into another.
You can see one example in Figure 8-3. The subject of one image (upper left)
is selected. You can see a close-up of the selection to the right. Choosing
Edit=>Copy copies the selected pixels to the Clipboard. You can then switch
to another image and use the Edit=>Paste command to drop those pixels into
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a second image (lower left). You can adjust the size by choosing Edit=>
Transform=>Scale, adjust the position by dragging with the Move tool, and
perhaps add some shadows by using the Brush tool. The job is ready for
whatever nefarious purpose you might have in mind!

Any pixel in your image can be selected, deselected, or partially selected. For
example, if you have a selection and fill it with red, the selected pixels turn
red, the deselected pixels don’t change, and the partially selected pixels get a
red tint. How much tint depends on the level of selection. (Photoshop gener-
ally uses 8-bit grayscale for selections, so there are 256 different levels of
“selected.”)

@ @ @ sSpider-AlphaChannels.psd @ 12.5% (RCB/8)

| 8 | 1024 pixals x 768 pixels (300 ppi) u

Figure 8-3: Make a selection, copy, switch to another image, and paste.

Feathering and Anti-Aliasing

You need to keep in mind a couple of very important terms as you read

about the various tools and commands with which you make selections. Both
feathering and anti-aliasing make the edges of your selections softer by using
partially transparent or differently colored pixels. That, in turn, helps blend
whatever you're doing to that selection into the rest of the image.
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Don’t forget that all pixels in your image are square, aligned in neat,

orderly rows and columns. (That’s the raster in raster artwork.) When you
create a curve or diagonal in your artwork, the corners of the pixels stick
out. Feathering and anti-aliasing disguise that ragged edge. You can also use
feathering to create larger, softer selections with a faded edge. Generally
speaking, use anti-aliasing to keep edges looking neat and use feathering to
create a soft, faded selection.

Nothing illustrates the power of feathering quite like a simple black-on-
white demonstration, as you see in Figure 8-4. In the upper-left, | made an
unfeathered selection and filled it with black. To the upper-right, the filled
selection is exactly the same size but has a 2-pixel feather. Below, [ used a
15-pixel feather when making the selection.

Note that there’s feathering on both sides of the selection border. And don’t
be fooled by the amount that you enter in the Feather field on the Options
bar — that’s a general guideline, not a precise value. A 15-pixel feather for the
Elliptical Marquee tool might give you 50 or 60 partially transparent pixels,
half on either side of the selection border. Even a 1-pixel feather gives you a
selection with several “soft” pixels on either side.

- “mUntitled-2 @ 200% (RGB/8)

] Doc: 2.25M/1.92M »

005
Cim

Figure 8-4: A close-up look at no feathering, feathering, and /ots of feathering.
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Anti-aliasing is similar to feathering
in that it softens edges: It’s designed
to hide the corners of pixels along
curves and in diagonal lines. You use
anti-aliasing with type (as I explain in
Chapter 13). You'll often find that
anti-aliasing is all you need to keep
the edges of your selections pretty;
feathering isn’t required. Anti-
aliasing is a yes/no option, with no
numeric field to worry about. Figure
8-5 compares a diagonal with no anti-
aliasing, with anti-aliasing, and with a
1-pixel feather.

(-X-1-] X Unaitied-2 @ 600K (Layer 1. RCE/E)

4o & TecnviEies b

Figure 8-5: Anti-aliasing helps smooth the

At 100 percent zoom (to the upper appearance of curves and diagonals.

left), the first line looks bumpy along the edges (it has a case of the jaggies,
you would complain to a friend or co-worker). The lower line looks soft and
mushy, out of focus. And the middle line? To quote Goldilocks, “It’s just
right!” When zoomed to 600 percent, you can really see those jaggies and that
softening. And in the middle, you see that the anti-aliasing uses light gray

and mid-gray pixels interspersed along the edge among the black pixels.

At 100 percent zoom (upper left), your eye is fooled into seeing a straight
black edge.

Generally speaking, use anti-aliasing with just about every selection (other
than rectangular or square), and use feathering when you want to really
soften the edges to create a special effect.

Making Your Selections with Tools

Photoshop offers you nine tools whose whole purpose in life is to help you
make selections. You also use those tools to alter your selections by adding
to, subtracting from, and intersecting with an existing selection. The nine
selection tools are divided into three groups:

»* Four marquee tools

v Three lasso tools

+* The Quick Selection tool and the Magic Wand

Marquee selection tools

You have four marquee selection tools, although you’ll generally use only two
of them. Figure 8-6 shows the marquee selection tools, along with each tool’s
Options bar configuration.
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Figure 8-6: Marquee selection tools come in four flavors, two of which are tasty.

You drag the very useful Rectangular Marquee and Elliptical Marquee tools
to make selections. Click and drag in any direction to make your selection.
After you start dragging, hold down the Shift key (while still dragging) to
constrain proportions. When you constrain the proportions of a selection,
you create a square or circle rather than a rectangle or an ellipse. If you
start dragging a selection and press the Option (Mac)/Alt (Windows) key, the
selection centers itself on the point where you click. The Shift and Option/
Alt keys can be used together. Holding down the Shift key before you click
and drag adds the selection to any existing selection. Holding down the
Option/Alt key before dragging subtracts the new selection from any existing
selection.

The Single Row Marquee and Single Column Marquee tools are simply clicked
at the point where you want a 1-pixel selection, running from side to side or
from top to bottom. These tools create selections that extend the full width
or full height of your image. You might use these tools to create a gridlike
selection that you can fill with color. Or you might never use them at all.

Take another glance at the Options bars in Figure 8-6. The four buttons to the
left in the Options bar, which you can use with any of the tools, determine
how the tool interacts with an existing selection.

1~ New Selection: When you select the first button, any selection that you
make replaces an active selection (deselecting any previous selection).
If, with a selection tool, you click inside an active selection when the
first option is active, you can drag that selection in your image without
moving any pixels. When you haven’t already made a selection, these
tools always make a new selection, regardless of which button is active.
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v Add To: When you have an active selection and need to add to that
selection, use the second button or simply press and hold down the
Shift key while dragging.

1~ Subtract From: When you have a selection and need to deselect part of
it, use the third button. Say, for example, that you make a round selec-
tion and want to chop out the middle to make a donut shape. Click the
third button and then drag within the original selection to deselect the
donut hole.

~ Intersect With: You have a selection, but you want to keep only part of
the selection. You could set your selection tool to subtract from the
existing selection, or you could intersect with that original selection and
deselect a number of areas at once.

Figure 8-7 presents a visual explanation of how all four buttons work. On the
left, you see the selected option for the active marquee selection tool. Next is
an original selection. In the third column, you see another selection being
made (with the selection tool dragged from the lower right to the upper left).
Finally, on the right, you see the result of combining the two selections.

In the bottommost example, you could do a whole series of subtractions from
the existing selection to chop off the “points,” but using the intersect option
takes care of the job with a single drag.

While you're dragging a selection with the Rectangular Marquee or the
Elliptical Marquee tool, you can hold down the mouse button and press and
hold the spacebar to reposition the marquee. When you have it where you
want it, release the spacebar and continue to drag.

Take another look at the four views of the Options bar shown earlier in
Figure 8-6. Take note of these variations among them:

v~ Anti-aliasing isn’t available for the Rectangular Marquee tool. That’s
because all four edges of the selection will align perfectly with the edges
of the pixels — no need to disguise corners of pixels. (You can, of
course, soften the selection with feathering.)

~ Both the Rectangular Marquee and the Elliptical Marquee tools offer the
options of Normal (unconstrained, just drag as necessary), Fixed Aspect
Ratio (the relationship between width and height you specify in the
Options bar is maintained as you drag), and Fixed Size (just click in the
upper-left corner of your intended selection).
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* The Single Row Marquee and Single Column Marquee tools offer the four
buttons to determine how the tool will interact with an existing selection
and the Feather field. Although feathering a 1-pixel wide or tall selection
seems a little strange. . .

OoF = |

|

Figure 8-7: The buttons at the left on the Options bar control selection interaction.

Lasso selection tools

Three lasso selection tools are available in Photoshop CS4. On the Options
bar, all three of the lasso selection tools offer you the same basic features
that you find in the marquee selection tools, as you can see in Figure 8-8. You
can add to, subtract from, or intersect with an existing selection. You also
have the feathering and anti-aliasing options available. The Magnetic Lasso
tool offers three additional settings that help determine how it identifies
edges as you drag.
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Controlled selections

Lurking within the Options bar Style drop-down
menu are two options worth noting: Fixed
Aspect Ratio and Fixed Size. Using the Fixed
Aspect Ratio option with the Rectangular
Marquee or the Elliptical Marquee tool forces
the selection to the height and width relation-
ship that you specify in the Options bar. This is
great for composing an image that you need at
a specific size, say to fit in a standard picture
frame. The selection tool won't resize the
image for you, but you can make the selection
and choose Image=>Crop and then choose
Image=>Ilmage Size to resize to your required
dimensions and resolution. (Read about resizing
and cropping your images in Chapter 4.)

The Fixed Size option changes the behavior of
the tools. After you enter an exact width and
height in the Options bar, position the cursor in
the upper-left corner of the area that you want
to select and click once — the selection is cre-
ated to the lower right of that point. Don’t worry
about being exact because you can drag the
selection marquee into position afterward.
(You'll want to have the leftmost of the four but-
tons on the Options bar selected to reposition
your selection.) And take a look at the button
between the Width and Height fields on the
Options bar: When you're using the Fixed
Aspect Ratio or Fixed Size styles, click that
button to swap the values in the two fields.

u g Lasse Tool i
Y Polygonal Lasse Tool L
g;l;. Magnetic Lasso Tool L

Fosvr 55| S | (oo )

[+3mss

Feather: [0 px o Anti-alias | i: Refine Edge. )

[=7mrs

Feather: [0 px o Anti-alias | Width: (10 px | Contrast: [10% Fraquency: |57 ‘ |

g et R SO NN SN 7

Figure 8-8: The basic options for the lasso selection tools match those for the marquee

selection tools.
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So what makes lasso tools different from a marquee tool? Read on to find out:

1~ Lasso tool: The Lasso tool is a true freeform tool; that is, you click and
drag it wherever you want the selection to go. You can drag around
and return to the starting point, or you can release the mouse button
anywhere, and your selection is finished along a straight line from that
point to the spot where you start your selection. If you press and hold
the Option/Alt key while dragging, you’ll temporarily switch to the
Polygon Lasso tool.

1~ Polygon Lasso tool: Rather than dragging, you click-click-click to make
straight selection segments, at any angle, for any distance. When you
position the cursor directly over your starting point, a little circle
appears to the lower right of the cursor to indicate that you're back to
the start. Or simply double-click to finish the selection. If you press and
hold the Option/Alt key while dragging, you’ll temporarily switch to the
regular Lasso tool, which lets you drag your selection any way you want.
Using the Option/Alt key lets you switch back and forth between the
freeform drag of the Lasso tool and the perfectly straight selection bor-
ders of the Polygon Lasso tool.

1~ Magnetic Lasso tool: When you need to select around a subject that has
good contrast with its background, the Magnetic Lasso tool can do a
great job. The perfect candidate for this tool is a simple object on a very
plain background. You can, however, use it with just about any image
where the edges of the area you want to select differ substantially from
the rest of the image. Click and drag the tool along the edge of your sub-
ject. If the tool misses the edge, back up and drag along the edge again.
If the edge makes a sudden change in direction, click to add an anchor
point. If the tool places an anchor point in the wrong spot, back up and
then press Delete/Backspace to remove the point. (By the way, if you
have a Wacom pressure-sensitive tablet hooked up, you can set the
Magnetic Lasso tool to vary its width according to pen pressure. Use the
button just to the right of the Frequency field on the Options bar.)

The Magnetic Lasso tool works by identifying the difference in color
along the edges, using all available color channels. From the Options
bar, use the Width field to tell the tool how wide of an area it can look in
to find an edge. The Edge Contrast field tells the tool how much the edge
must differ while searching. Use the Frequency field to choose the
number of anchor points the tool sets while outlining the selection.

The Quick Selection tool

Consider the Quick Selection tool to be sort of a Magic-Wand-in-a-brush. You
drag the tool through an area of color and, based on the color variations
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under the brush and the brush size, 8] | e | S S e o | (i)
the tool automatically selects similar |
colors in the surrounding area. Keep
in mind that you can adjust the
brush size as you work by using the
square bracket keys, [ and ]. (When
working with a Wacom tablet, this
tool works great with brush size set
to pen pressure.) With just a little
practice, you'll likely find the Quick
Selection tool to be quite simple

to use, even for rather complex
selections (see Figure 8-9).

rossrckunps S nalons §

Figure 8-9: Drag through an area of color to

The Maql‘c Wand t00l select the pixels under the brush and nearby

pixels of similar color.
The Magic Wand tool selects pixels

similar in color to the pixel on which you click with the tool. Like the other
selection commands, you can add to, subtract from, or intersect with an
existing selection, and you can select anti-aliasing. Tolerance determines how
closely pixels must match your target color to be included in the selection.
When you enable the Contiguous check box and then click a spot, only pixels
connected to the spot by pixels of the same color are selected. The Sample
All Layers option lets you make a selection of similarly colored pixels on
every visible layer in your image, not just the currently active layer.

When you use a low Tolerance setting, you select only those pixels in the
image that are very similar to the pixel on which you click. A high Tolerance
setting gives you a much wider range of color, which might or might not be
appropriate for the selection you’re making.

Refine Edge
If you look at the various pictures of the Options bar earlier in this chapter,

you might notice the Refine Edge button to the right. Refine Edge (shown in
Figure 8-10) helps you fine-tune your selections by adjusting the edges.

Here’s what you need to know about each of the options in Refine Edge:

1~ Radius: When you’re trying to select an area with soft or fuzzy edges,
increasing the Radius value can help better define the edge of the
selected area of color.

1~ Contrast: When soft or fuzzy edges of an area of color produce a speck-
ling of unwanted color, increasing Contrast is in order. When you boost
the Contrast value, Refine Edge tries to exclude pixels whose color
varies too much from the area being selected.
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+* Smooth: Sometimes the edge of

Refine Edge

a selected area is too jagged to . .
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value a bit is like anti-aliasing o , — (_Cancel )

the edge. Using higher values Contrast: o 1% ( Default )
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Select>Modify=>Feather, P ’ ,
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edges of the selection by blur- Fe;fhe"' P px

ring. Use Feather for an overall = _
softening of the edges; use Canractiixpand: =g %
Radius to fine-tune the selection -

when the area being selected

has fuzzy edges. 2EIE 2~
1~ Contract/Expand: Rather than =
simply contracting or expanding Et”“""’t"’"
the selection (as with Select= i bt CAES A Yoy A T Mg
Modify=~>Expand/Contract),
think of this slider as fine-tuning
the adjustment you're making in
Refine Edge. If all of the other
sliders are set to zero, Figure 8-10: Refine Edge reminds you what
Contract/Expand does nothing  each feature offers in the Description area.
to the selection.

P The row of buttons below Contract/Expand changes the preview in your
image window. Let me suggest that you get used to swapping around the pre-
view as you work. The left button shows you the selection border in your
image. The second button gives you the same red overlay that you see when
working in Quick Mask mode (discussed later in this chapter). The third and
fourth buttons are great for previewing any light or dark artifacts along the
edges. Use the button to the far right to get an excellent view of the softness
(feathering) of your selection edge.

VYour Selection Commands

You have 17 menu commands at your service when selecting pixels in your
artwork. Some, like those near the top of the Select menu, are rather simple
and aptly named. See Figure 8-11 for a list of the Select commands. (The All
Layers, Deselect Layers, and Similar Layers commands are not used to select
pixels, but rather to change the activation of layers in the Layers panel.)
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The primary selection o
commands nesdien oty

Reselect 38D
The commands near the top of Inverse el

the Select menu are features that
you're likely to use regularly. (Okay,
maybe not the Reselect command.)

Memorizing their keyboard shortcuts Color Range...
a.nd using them regularly is a Refine Edge.. 3R |
timesaver. Modify b Border...
Smooth...
1~ Select All (%+A/Ctrl+A): Sel Simil i
elect (38+A/Ctrl+A): Select Similar S
All dpes ex.actly what the name Transform Selection Feather... "C3D
implies — it makes a selection [ —

Load Selection...

of all the pixels in your image on E L Ve

the active layer (or in an active
layer mask).

1~ Deselect (88+D/Ctrl+D): Use the
Deselect command to make sure
that no pixels are selected. This
is a handy command when it
seems that a filter or adjust-
ment command isn’t working. There could be an unnoticed selection in
the image, preventing the command from appearing how — or where —
you expect.

1~ Reselect (88+Shift+D/Ctrl+Shift+D): This is a great little command for
those times when you’re making a complex selection, and a little slip
accidentally deselects. Just use Reselect to restore the most recent
selection. Or use the Undo command.

Figure 8-11: The Deselect and Reselect
commands are shown as available for
illustrative purposes only— normally one or
the other would be grayed out in the menu.

1~ Inverse (88+Shift+I/Ctrl+Shift+I): The Inverse command reverses the
selection. What was selected is deselected, and what wasn’t selected
becomes selected. (Don’t forget to include the Shift key — without it,
you invert the colors in your image rather than your selection!)

The Color Range command

In its own little group, right in the middle of the Select menu, is the incredibly
powerful Color Range command. Rather than dragging the Quick Selection
tool or Shift+clicking with the Magic Wand, you can select by color quickly
and easily with the Color Range command. In Figure 8-12, I clicked and
dragged through some orange areas in the image with the middle Eyedropper
tool. You can also click once with the left eyedropper and use the other
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eyedroppers to add and subtract colors from the selection. The Fuzziness
slider near the top of the dialog box determines how close a color must be to
those through which you dragged to be included in the selection.

Here are a couple of ways that you can get a better look at your selection as
you create it. In Figure 8-13, you see the options available from the Selection
Preview menu. The Grayscale (upper left) and Black Matte (upper right) do a
good job of showing that the background will be partially selected if you click
OK. You can lower the Fuzziness or use the eyedropper on the right to click
in those areas of the fence that shouldn’t be selected. The White Matte (lower
left) does an excellent job of showing that the tips of some leaves below the
blooms will also be selected. (Ignore that and Option+drag/Alt+drag with the
Lasso tool later to deselect that area.) Because of the color of this image’s
subject, the red Quick Mask preview (lower right) is almost worthless for

this image, although it is often good with other images that don’t have red
and orange.

The pop-up menu at the top of the Color Range dialog box lets you pick
among the RGB (red/green/blue) and CMY (cyan/magenta/yellow) colors, as
well as the image’s highlights, midtones, or shadows, and even any out-of-
gamut colors in the image (colors that can’t be reproduced within the
selected color space). When you choose one of the presets from the top
menu, the Fuzziness slider isn’t available, limiting that feature’s value.

Coler Range

Select: | #* Sampled Colors »B‘

" Multiple Color Clusters 1

- (" Cancel
Fuzziness: Is2_ |

o ( Load.. )
Spatial Tolerance " save... y )
il - P4

linvert

@ selection ) Image

Figure 8-12: The Color Range feature selects by color.
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Figure 8-13: Color Range offers four ways to preview.

Selection modification commands

The next group of commands in the Select menu actually holds six separate
commands, including Refine Edge (discussed earlier in this chapter), and the
five Modify commands, each of which has a single numeric field:

1 Border: Tucked away within the Modify submenu, the Border command
creates a selection of your chosen width centered on the marching ants
that you see as the original selection’s edges. The resulting selection can
be filled to create a border, or you may opt to delete the pixels within
the border to clean up the edges of the selected area of color.

» Smooth: When you click with the Magic Wand to make a selection of an
area of color, you might see all kinds of tiny 1- or 2-pixel areas within
the selection that are not selected. Perhaps those few pixels were just a
bit out of the Tolerance range for the tool. No worry! Use the Smooth
command and a 1- or 2-pixel radius to snatch up those stray, deselected
pixels. The Smooth command can also eliminate jagged edges along the
outside of your selection.

~ Expand: The Expand command moves the selection border outward a
specified number of pixels. Be careful, though, because if your original
selection includes sharp corners or points, using Expand rounds them
off. (In the Paths panel, convert your selection to a path, scale the
path, and convert the path back to a selection. See Chapter 11 for info
on paths.)
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1 Contract: The Contract command shrinks your selection by the amount
specified.

1~ Feather: Feathering, which I discuss earlier in this chapter, softens the
edges of a selection. Normally when cutting and pasting a selection or
moving a selection within an image, you want to feather a pixel or two.

As you make your way down the Select menu, you’ll come across the Grow
and Similar commands, which are somewhat like the Magic Wand with
Contiguous (Grow) and without Contiguous (Similar) selected on the Options
bar. (In fact, they use the Magic Wand’s Tolerance setting.) Grow adds to your
selection any adjacent pixels of the appropriate color, and Similar looks
throughout the entire image for similarly colored pixels. Use Grow and
Similar when your initial selection consists primarily of a single color. Using
these commands with a selection that contains lots of different colors
generally results in most of your image being selected.

Transforming the shape of selections

As you work with selections, you might find times when the selection capabil-
ity doesn’t match your need. For example, the Elliptical Marquee tool can cer-
tainly make oval selections, but those ovals are either vertical or horizontal.
What if you need an oval selection at an angle? That’s where the
Selectt>Transform command comes into play. Make your initial selection,
choose the Transform Selection command, and then manipulate the selection
to fit your needs, as shown in Figure 8-14.

Here’s what you see in Figure 8-14:

1~ Top left: This is the original selection.

+~ Top center: Click an anchor point on any side of the bounding box and
drag to change the height or width of the selection.

~ Top right: Position the cursor outside the bounding box and drag
to rotate.

v~ Middle left: Drag any corner anchor point to manipulate the selection’s
width and height at the same time.

1~ Middle center: Hold down the Shift key while dragging a corner anchor
point to avoid distorting the selection while changing size.

1~ Middle right: Hold down the Option/Alt key while dragging a corner
anchor point, and you end up scaling the image based on that cross-
hair in the center of the bounding box. (You can drag that crosshair
anywhere, even outside the bounding box, to change the point of
transformation.) You can use the Shift key with Option/Alt, too.

1~ Bottom left: Hold down the 88/Ctrl key and drag any side anchor point
to skew.

173
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1 Bottom center: Hold down the 38/Ctrl key and drag a corner anchor
point to distort.

1~ Bottom right: If you 3/Ctrl+drag two or four corner anchor points, you
can add perspective to the selection. I might, for example, fill this trans-
formed selection with color, move the selection, scale it down a bit, fill
again, and repeat a number of times to create a series of paw prints
marching into the distance.

Figure 8-14: The many faces of transformations.

The mask-related selection commands

At the bottom of the Select menu, you see a pair of commands that you use to
store your selections for future use and to actually reuse them. When you
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save a selection, you create an alpha channel in the image. The alpha chan-
nel, like a color channel, is a grayscale representation of the image. White
areas in the alpha channel represent areas that are selected when the chan-
nel is loaded as a selection. Black areas in the channel show you deselected
areas. Gray represents feathering and other partially selected pixels.

[ discuss channels in greater depth in the next section of this chapter. While
you're exploring selection commands, the key points to remember are that
you can use the Save Selection command to save any selection as an alpha
channel, and then later you can use the Load Selection command to reacti-
vate the selection without having to re-create it from scratch.

Masks: Not Just for Halloween Anymore

In Photoshop, a mask is a channel (in the Channels panel) that stores
information about a selection or about layer visibility. When you talk about
selections saved as masks, you can refer to them as alpha channels. Any time
you make a complex selection, consider saving it as an alpha channel, just in
case. So what exactly counts as complex? That depends on how much time
you have on your hands. If it takes me more than a minute or two to do any-
thing in Photoshop, I want to save it. And what counts as just in case? You
might need to return to the image at some later date to make changes, you
might need to shut down for the day, or maybe you’ll even (fingers crossed
against!) have a crash. Save your selections, just in case. . .

Saving and loading selections

Creating an alpha channel from a selection is as simple as choosing Select>
Save Selection and selecting a name for the new channel. If you have more
than one document of exactly the same pixel dimensions open in Photoshop,
you can select any of the available documents for the new channel. If you
already saved a selection as an alpha channel, you can elect to have the two
selections interact in a single channel. As you see in Figure 8-15, the Operation
choices parallel those that you find on the Options bar when working with
selection tools: You can replace the selected channel, add to the existing chan-
nel, subtract from the existing channel, or intersect with that existing channel.

When you need to work with a saved selection, choose Selectr>Load
Selection or simply 8 +click/Ctrl+click the alpha channel’s thumbnail in the
Channels panel — either activates the selection.

The Load Selection dialog box offers the same key features that you see for
Save Selection. (Refer to Figure 8-15.) When loading a selection, you can add
to, subtract from, or intersect with an active selection. You can also invert a
selection when loading by selecting the Invert check box. Using that check
box produces the same result as loading the selection and choosing
Select=>Inverse, but it’s faster and easier.



’ 76 Part ll: Easy Enhancements for Digital Images

Editing an alpha channel

Alpha channels, like color channels, are grayscale representations. As such,
you can edit them like you would any grayscale image. Click the channel in
the Channels panel to make it active and visible. You see it in the image
window as a grayscale (or black and white) representation of the saved selec-
tion. If you want to see the image while you work on the channel, click in the
left column (the eyeball column) to the left of the RGB (or CMYK) channel.
The alpha channel then appears as a red overlay on top of the image. Figure
8-16 shows you what the screen looks like with just the alpha channel visible
(left) and how it appears when the alpha channel is active and the RGB
channel is also visible. Also take a look at the difference in the Channels
panel. See the eyeball column on the left?

RGE e
Red ®1
Green #I

Blua #1

Save Selection

St |

Document: -OBﬁng,psd _:!
[ Cancel )
5 | &)
Channe!: [T
New =
Name:l
Operation

" Replace Channel
® Add to Channel
T Subtract from Channel

Intersect with Channel

Figure 8-15: When you already have an alpha channel, the new selection can modify it.
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Figure 8-16: You can see just the alpha channel itself (left) or as a red overlay (right).

Here are some of the things that you might want to do to an active alpha
channel:

+~ Blur the alpha channel. Blurring an alpha channel (Filter=>Blur com-
mands) is much like feathering a selection — it softens the edges. One of
the big differences is that you can see a preview of the blur, which is
much better than guessing how much feathering you need while drag-
ging a selection tool.

1~ Sharpen the alpha channel. Sharpening a saved selection
(Filter=>Sharpen commands) makes the edges cleaner and more precise.

1~ Paint in the alpha channel. Painting with the Brush tool using black,
white, and gray in the channel changes the selection. Paint with white to
add areas to the saved selection; paint with black to remove areas from
the selection; paint with shades of gray to partially select areas of the
image. You can edit an alpha channel with the Brush tool very precisely,
adding and eliminating stray pixels, as well as creating precise edges.

1~ Use Levels or Curves on the alpha channel. If the saved selection
has feathering or other areas of partial selection (grays in the alpha
channel), you can manipulate them with a Levels or Curves adjustment
(from the Imager>Adjustments menu). The Levels adjustment is
particularly appropriate for controlling the feathering along an edge.

1~ Apply one or more filters to an alpha channel. Use artistic filters on a
saved selection to create special effects, such as borders and frames.
Chapter 15 covers filters.
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Working in Quick Mask mode

Okay, so you want to make a selection, save it as an alpha channel, make
the alpha channel active, click the eyeball column to make the RGB channel
visible so you can see what you're doing, paint in and apply filters to the
alpha channel, make the RGB channel active, load the alpha channel as a
selection, and, well, do something creative with it. Whew! How about an
easier way to do the same thing?

With Photoshop’s Quick Mask mode, you make a basic selection, press Q

on the keyboard to enter Quick Mask mode, edit the selection as if it were a
mask, and then press Q again. Heck, you don’t even have to start with a selec-
tion! In Quick Mask mode, your mask appears on-screen as a red overlay, just
like an alpha channel appears when the RGB channel is visible (as you can
see in Figure 8-16). Paint, apply filters or adjustments, or make selections —
anything you can do to a grayscale image, you can do in Quick Mask mode.

If you're more comfortable with the Brush tool than the Lasso tool, you might
want to use Quick Mask mode to make all your selections. You might find it
faster and easier to “paint” a selection in Quick Mask mode than to drag a
selection with a lasso tool or use the selection commands. Enter Quick Mask
mode, paint the mask, exit Quick Mask mode, and you have your selection.
You can also enter and exit Quick Mask mode by
clicking the button at the bottom of the Toolbox.

Quick Mask Options

— Color Indicates:

Double-clicking the button opens the Quick Mask © Masked Areas S—
Options dialog box (as shown in Figure 8-17). You S o =
can reverse the behavior of the overlay, making it E=

show selected areas instead of the deselected |. Opacty: |0 | %

areas, and you can change the color and opacity

of the overlay. (Hop back to Figure 8-13 to see

how hard it is to see the edges of the orange Figure 8-17: You can change
blooms with the red overlay. Changing the over-  the opacity and color of the

lay to, say, blue would solve that problem.) Quick Mask overlay.

By default, you paint with black in Quick Mask mode over areas that you
don’t want selected, paint with white over areas that you do want selected,
and paint with shades of gray over areas that you want partially selected.

Adding masks to layers and Smart Objects

When your image has multiple layers (as I discuss in Chapter 10), including
Smart Objects, you can partially hide the content of the layer or Smart Object
with layer masks. Layer masks and alpha channels have much in common:
Layer masks are selections saved as channels, you can paint in the layer
mask, you can apply filters and adjustment to the layer mask, and so on. Just
keep in mind that a layer mask appears in the Channels panel only when you
select its layer in the Layers panel. (In the Layers panel, you'll see the layer



<MBER

mask thumbnail to the right of the layer’s thumbnail.) If you want to edit a
layer mask, click its thumbnail in the Layers panel and then edit it as you
would an alpha channel. Remember to click the layer thumbnail afterward to
reactivate the layer itself.

The easiest way to add a layer mask is to make a selection of the pixels that
you want visible on that layer and then click the Add Layer Mask button at
the bottom of the Layers panel (third button from the left). You can also
make a selection and choose Layer=>Layer Mask->Reveal Selection or Layer=
Add Layer Maskr>Hide Selection. That menu also offers Reveal All and Hide
All as well as commands to disable (hide) or delete the layer mask. You can
also apply the layer mask, which deletes any hidden pixels on that layer.

A layer named Background (in italics) in the Layers panel can’t have any
transparent areas, so you can’t add a layer mask. Not a problem! Simply
double-click the layer name in the Layers panel and rename the layer. That
converts it to a regular layer, which would be more than happy to accept
your layer mask.

In the Layers panel, a layer mask is linked to the layer — that is, if you drag
the layer, the mask moves right along with it. And, new in Photoshop CS54, a
mask is automatically linked to a Smart Object. You can unlink/relink the
mask and layer or Smart Object by clicking the icon/space between their
thumbnails in the Layers panel.

Masking with vector paths

A layer or Smart Object can also be masked with a vector path. (Paths are
explained in Chapter 11.) Vector masks have very precise edges, and you

can edit them as a path with the Direct Selection tool. A layer (other than a
Background layer) can have both a regular pixel-based layer mask and a
vector mask. To show up in your artwork, pixels on that layer must be within
both the layer mask and the vector mask. When a layer has both a layer mask
and a vector mask, the vector mask thumbnail appears to the right in the
Layers panel.

Adjustment Layers: Controlling Changes

Photoshop gives you the capability of making tonal and color adjustments
that you can later refine, change, or delete. Most of the adjustment com-
mands (discussed in Chapters 5 and 6) are available as adjustment layers. An
adjustment layer applies the selected change to color or tonality just as the
comparable command would, but using an adjustment layer offers a few
major advantages:

Chapter 8: Fine-Tuning Your Fixes 1 79
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1 Adjustable adjustments: You can reopen an adjustment layer’s dialog
box at any time to change the settings.

1~ Reversible adjustments: You can delete an adjustment layer, removing
the change from your image.

1~ Hidden adjustments: Click the eyeball column to the left of the adjust-
ment layer in the Layers panel to temporarily hide that change.

1~ Tweakable adjustments: You can change the opacity and blending mode
of adjustment layers to fine-tune the effect.

v~ Limitable adjustments: You can add layer masks and vector masks to
your adjustment layers to restrict their effect to only some of the pixels
below. And you can later edit the masks as necessary.

Because of the added flexibility, you'll generally want to use adjustment
layers rather than adjustment commands in your images. Of course, you still
need the Imager>Adjustments menu for those several commands that can’t
be added through an adjustment layer.

Adding an adjustment layer

Photoshop CS4 introduces the Adjustments panel (to the left in Figure 8-18), a
quick and easy way to add adjustment layers to your images. Open the panel,
select a preset or, for a custom adjustment, click on the button for the type of
adjustment layer you want to add. The Adjustment panel changes to a small
version of that particular adjustment’s dialog box, presenting you with the
same options you have when using the Image=>Adjustments menu.

At the bottom of the panel are several buttons:

1 Add another adjustment layer: Click the left-pointing arrow and another
adjustment layer will be added above the layer you just completed.

1~ Toggle adjustment layer visibility: Click on the eyeball button to hide
the current adjustment layer; click again to show it. Use this button to
preview the adjustment as you work.

1~ Reset adjustment: Click the curled arrow button toward the right to
reset the current adjustment to the default settings.

1~ Delete adjustment layer: Click the Trash icon to the far right at the
bottom of the Adjustment panel to delete the current adjustment layer.

When working in the Adjustments panel, 38+Z/Ctrl+Z will reset the
Adjustments panel to the defaults. Add the Option /Alt key and the shortcut
functions like Undo, reversing only the last change made.
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Figure 8-18: Adjustment layers can be added through the Layers panel.

You can also add an adjustment layer through the menu at the bottom of the
Layers panel (click the fourth button from the left) and then move the cursor
to the type of adjustment layer that you want to add (to the right in Figure
8-18) or through the Layer~>New Adjustment Layer submenu. The choices are
the same. When you select the particular adjustment that you want to add
from the bottom of the Layers panel, that specific adjustment dialog box
opens. (Selecting the adjustment through the Layers menu presents you with
the New Layer dialog box first.)

The top three options in the menu that you open from the Layers panel are
fill layers — layers completely filled with a color, gradient, or pattern. You can
add a new empty layer and choose Edit=Fill to do the same thing, or you can
add such a layer through the Layer=>New Fill Layer menu. (Note that these
three options are not available through the Adjustment panel.)

Limiting your adjustments

When your image has multiple layers and you want to apply an adjustment
layer to only one layer, the new adjustment layer must be clipped —
restricted to the one layer immediately below it in the Layers panel. (That’s
the layer that’s active when you add the adjustment layer.) You can clip it to
the layer below by Option+clicking/Alt+clicking the line between the two
layers in the Layers panel (which is also how you unclip a pair of layers).
When working in the Adjustments panel, click the button between the arrow
and the eyeball in the lower-left to clip the new adjustment layer to the layer
below. Figure 8-19 shows the difference between a clipped adjustment layer
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(left) and an unclipped adjustment layer (right). When unclipped, the adjust-
ment is applied to all the layers below rather than to the one layer immedi-
ately below. When adding an adjustment layer through the Layers menu,
select the option Use Previous Layer to Create Clipping Mask.
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Figure 8-19: Restrict an adjustment to one layer by clipping it to the layer.

On the left side of Figure 8-19, the Hue/Saturation adjustment is applied only
to the upper layer — the layer named Symbol. On the right, the adjustment
layer isn’t clipped, so it changes both the Symbol layer and the Background
layer. By the way, the thumbnail in the Layers panel shows the Symbol layer’s
original copper color prior to the addition of the Hue/Saturation adjustment
layer. Among the beauties of using adjustment layers is the joy you might

feel when the client says, “Yup, you were right — let’s go back to the

original design.”

In the Layers panel on the left in Figure 8-19, you can see the so-called
“wedding rings” icon between the adjustment layer and the layer named
Symbol immediately below. That’s the icon that you see when Option+
clicking/Alt+clicking to clip (or unclip) layers.

But what if you want an adjustment layer to change, say, three of the layers in
your image? Create a layer group from the layers (click the New Group button
at the bottom of the Layers panel and drag the layers into the Group icon in
the panel), add the adjustment layer within the group, and change the layer
group’s blending mode from Pass Through to Normal at the top of the Layers
panel. The adjustment layer, within the layer group and at the top of the
layer group, is applied to all your layers in the group and only the layers in
that group.
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“&N\BEH Because they’re layers, you can use a layer mask to apply the adjustment
& layer to only part of your layer. You may find it easier to make a selection
of the area where you want the adjustment before selecting the adjustment
layer — the mask will be automatically created from the selection.
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Common Problems
and Their Cures

In This Chapter

Perfecting portraits of people

Hushing the noise in your images

Editing your digital landscape

Sometimes you take perfect photos of imperfect people, and sometimes
you take imperfect photos of, well, imperfect people. (Even the top
models benefit from a little Photoshopping.) Although capturing absolute
reality is the goal of some artists and most photojournalists, the people in
your photos probably prefer to look as good as you (and Photoshop) can
make them look.

In this chapter, I present you with some basic techniques
for curing many of the most common problems that you
encounter as a photographer. I show you how to
remove that spooky red-eye effect that appears when
your camera’s flash reflects off the blood vessels in
the back of a subject’s eyes. I also show you tricks
for removing wrinkles, whitening teeth, and tighten-
ing waistlines. Digital noise (those distracting red,
green, and blue pixels scattered in your image’s
shadows) is easy to minimize when you use the
tricks here. At the end of the chapter, [ cover how to
remove some larger problems from images, such as
distracting objects and ex-boyfriends. Throughout this
chapter, I use real-world examples — the types of photos
with which you’re most likely to work. (After all, you probably
don’t get to shoot beautiful models all the time.)
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Making People Prettier
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You can do lots of things in Photoshop to improve your images, but few are
appreciated as much as fixing a person’s photographed flaws (the appear-
ance kind, not their bad habits). Whether it’s a studio portrait or a snapshot,
the people in your images generally can benefit from a little touching up.

Although you can theoretically make almost anyone look truly beautiful and
glamorous using Photoshop, remember to balance improving with reality.
Always work on a copy of your image. I also recommend saving separate
copies at different stages during the editing process. The client might say
that he wants the braces removed from his teeth, but after you present the
finished product, he might just (gasp!) change his mind.

Getting the red out . . . digitally

When a subject looks directly into the camera and the camera-mounted flash
fires, the result is often red-eye. This result is caused when light (such as a
flash) bounces off the blood vessels

BT ‘ Puph Size:[sq |8} Darken Amount: (555 [#) |
L 5 — il

at the back of an eye, and it gives the

subject a spooky vampire look.
Among the many ways to minimize
this problem is with the Red Eye
tool. Zoom in and click once with the

tool to watch the red disappear, leav-
ing the natural highlights and a per-
fect eye. As you see in Figure 9-1, the
default settings are good for typical  Figure 9-1: Click with the Red Eye tool to
cases of red-eye. replace red with natural-looking black.

The Red Eye tool finds red and not
green. For green-eye (in photos of
animals), for too-bright white reflec-
tions from eyes, and for those times
when you’re not happy with the per-
formance of the Red Eye tool, use
the Brush tool (as you see in Figure
9-2). Set the foreground color to
black; in the Options bar, select the
Luminosity blending mode and an
Opacity of about 50%. Use a brush
diameter just slightly larger than the pupil and a brush hardness of about
75%. Click once and evaluate the result; if necessary, reduce the Opacity to
20% and click again.

Figure 9-2: When the Red Eye tool won't
work, use the Brush tool.
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Here’s one more red-eye/green-eye trick: Use the Sponge tool to desaturate,
followed by the Burn tool (Midtones, 25% exposure). You'll find the Sponge
tool nested in the Toolbox with the Dodge and Burn tools.

The digital fountain of youth

At the end of Chapter 5, I show an example of using the Dodge tool to fade
wrinkles without removing them completely. Photoshop, being a complex
and capable animal, has lots of other ways to minimize or eliminate wrinkles.
Among the most powerful tools for this job are the Healing Brush, the Patch
tool, and the Clone Stamp.

Both the Healing Brush and the Patch tool work by copying texture from one
area to another. You can, for example, copy smooth skin onto a wrinkled area,
smoothing the wrinkles while retaining the area’s general tonality and color.
To work with the Healing Brush, Option+click (Mac)/Alt+click (Windows) the
area from which you want to copy, and then click and drag over the area that
you're fixing. When you select the Aligned option from the Options bar, you
maintain the relationship between the point from which you’re healing and
the area over which you drag. No matter where you move the cursor, the
source point stays the same distance and direction. When repairing areas of a
face, however, you might find it easier to clear the Aligned check box. Every
time you release the mouse button, you start over from the same source
point. By using short strokes, you can heal from the same source area to any
area of your image.

To work with the Patch tool, make a selection with the Patch tool (or using
any of Photoshop’s selection techniques) and then drag with the Patch tool.
Depending on which option you select from the Options bar, you can either
select and drag the damaged area to a good area (select Source from the
Options bar), or you can select a good area and drag to the damaged area
(select Destination). You can use both the Healing Brush and the Patch tool
to apply a predefined pattern, too. That can be handy for adding a texture
where one doesn’t already exist in your image.

Like the Healing Brush, you Option+click/Alt+click with the Clone Stamp to
set the area from which you’re copying and then paint over an area to make a
change. The Healing Brush copies texture, but the Clone Stamp copies pixels,
completely replacing the area over which you drag. (That is, of course, sub-
ject to the blending mode and opacity that you select from the Options bar.)
Like the Healing Brush, the Clone Stamp offers the Aligned option. Figure 9-3
shows a comparison of wrinkle reduction using the Clone Stamp (set to
Normal and 100 Opacity) and using the Healing Brush. (If you use the Clone
Stamp to repair skin, reduce the opacity and make sure to select a source
area that has similar skin color and lighting.)

187
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©2001 PhotoSpin, PhotoSpin image #0550019
Figure 9-3: The clone Stamp (lower left) covers wrinkles, whereas the Healing Brush (lower
right) melts them away.

Dieting digitally

You can certainly use the Clone
Stamp tool to reduce a bit of a bulge
at the waistline or below an upper
arm, but you might find it easier (and
more natural looking) to make a
selection and rotate the outer edge
inward a bit. Take a look at Figure
9-4. Although this subject hardly has  Figure 9-4: Rotate a selection to pinch in a waist.
what you’d call a “spare tire,” that bit

of extra sticking out above her skirt

isn’t particularly flattering. Make a selection with the Lasso tool that includes
some of the background and some skin (or shirt or dress). Copy the selection
to a new layer with 88+J/Ctrl+J. Press 8+T/Ctrl+T to enter Free Transform

(or choose Editw>Transform=>Rotate). Drag the point of rotation (the little
crosshair symbol in the middle of the bounding box) to the top of the bound-
ing box, and then position the cursor slightly outside the bounding box and
drag to rotate. When you're satisfied, press Return/Enter to accept the
transformation and merge the layers with 88+E/Ctrl+E. (With complex back-
grounds, you might need to do a little cloning to even things out.)
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When working with double chins, your best bet is usually to minimize rather
than eliminate. Putting a skinny neck under a fleshy face looks unnatural. You
can certainly tuck in the sides of the second chin a bit by using the rotate
method, but rely on the Burn tool to darken. By darkening the excess flesh
under the chin, you make it appear to be in shadow — and, therefore, under
the actual chin (see Figure 9-5). Use the Dodge tool (if necessary) to hide any
creases or wrinkles associated with
the excess chin. Redefine a natural-
looking jaw line and chin — but once
again, remember that the result must
not only look natural, but it must
also be acceptable to the client.

Figure 9-5: Burning and dodging can reduce
even a very prominent double chin.

When working with the Burn and
Dodge tools, don’t forget to reduce
the Exposure setting in the Options
bar — 15% to 20% is plenty strong for this type of work. You'll also want to
juggle between Highlights and Midtones (the Range setting in the Options
bar) when creating an artificial shadow on a double chin with the Burn tool.
Zoom in when doing this sort of work, but also open a second window via
Windowr>Arrange=>New Window for [filename] to keep an eye on the overall
impact of your changes.

You can use the Filtere>Liquify feature to push, pull, twist, pucker, bloat, and
otherwise manipulate pixels into the shape and position you need. There’s
really nothing more powerful when it comes to reconfiguring a figure. In
Figure 9-6, you see how leveling off a beltline in Liquify is sometimes all that’s
needed to restore that trim-man-she-married look. And a little touch-up with
the Healing Brush or Dodge and Burn tools can eliminate the wrinkles in

the shirt, helping improve the overall appearance of the image by reducing
distraction. (Chapter 15 has full info on using Liquify.)

De-glaring glasses

Although hindsight is usually 20/20, many people need spectacles.
Unfortunately, those eyeglasses can be a photographer’s nightmare! The
reflections off glass are usually specular highlights — that is, areas of pure
white with absolutely no detail in them. To properly evaluate flash reflections
in eyeglasses, open the Info panel and move the cursor through the area. If
you see a noticeable variation among the RGB values in the Info panel, you
might be able to restore the area with the Burn tool.

If the Info panel shows RGB values of 255/255/255 or close to it, the area

has no detail. Zoom in close and use the Clone Stamp tool to copy over the
area from another part of the image. In severe cases of glare, you might need
to copy from another photo of the same person. When possible (say, in a
portrait sitting), try to take one shot of the subject without eyeglasses, just
in case.
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Liquify (BeltLine.tif @ 200%)
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Figure 9-6: Use Liquify to make major adjustments to figures.

Whitening teeth

Teeth generally aren’t truly white (unless somebody has spent a lof of time
and money getting ready for a portfolio shoot). Instead, you see shades of
ivory and yellow in teeth, but they don’t necessarily have to be unattractive
or distracting shades of yellow. The Sponge tool is great for desaturating
teeth, moving them from yellow to gray. Use the Dodge tool to lighten teeth.
From the Options bar, set the tool to Midtones (not Highlights) and an
Exposure of perhaps 30% for front teeth. Paint over each tooth individually,
making sure that you don’t eliminate the shadows that differentiate the indi-
vidual teeth. Then switch to Shadows and lighten those molars visible in
back. Don’t overdo it — remember that folks who don’t make their living in
Hollywood or on TV generally don’t

have snow-white teeth. Figure 9-7 d d 3 z
shows normal people teeth, S
“improved” normal people teeth,

and Hollywood teeth. Balance your Figure 9-7: Coffee, cigarettes, and caps; Dodge
judgment with the client’s needs. tool digital correction; show-biz-white teeth.
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Reducing Noise in Your Images

Moving from the darkroom to digital can save you thousands of dollars in
film and processing costs (not to mention a reduction in environmental
degradation) but has added a new set of challenges to the art and business of
photography. Perhaps foremost among the problems presented by digital
photography is noise. Those pesky red, green, and blue (or light and dark)
specks in an image can ruin a digital photo. Noise is generally most promi-
nent in shadow areas and against dark colors in your images.

If your camera lets you select an ISO setting, you can help minimize digital
noise in your photos by using a low ISO. Sometimes you do need to shoot the
equivalent of faster film, such as at sporting events. However, when you have
a choice, use a low ISO to minimize noise. Using a tripod can help, too!

Decreasing digital noise

You'll find the Reduce Noise filter under the Filter=>Noise menu. As you see in
Figure 9-8, it does a very good job of neutralizing the random red, green, and
blue pixels while preserving detail in the image.

Notice that Reduce Noise also offers a Remove JPEG Artifact option. When
saving in the JPEG file format, you compromise between image quality and
smaller file size. The smaller the file, the greater the likelihood of compres-
sion damage to your image. That damage generally shows itself as visible
lines between blocks of pixels measuring eight pixels square.

Reduce Noise

|

==

{ Cancel )

] Preview
@ gasic  Advanced

~ Settings: | Default T{ —|Eﬁ -

Strength: |5 |

Preserve Details: 119 ‘%

Reduce Color Noise: |67 %
o

Sharpen Details: |0 |%

[ Remove JPEG Artifact

300% | @] 1600 pixels x 1200

=] 200% =

Figure 9-8: The Reduce Noise filter keeps your image sharp while eliminating RGB noise.
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You'll also find the Color Replacement tool very handy for noise reduction,
especially in areas of rather uniform color. Option+click/Alt+click right in the
area to set the foreground color; then simply paint away the digital noise. As
you move from area to area in your image, Option+click/Alt+click to pick up a
new foreground color.

Eliminating luminance noise

In addition to the red, green, and blue specks of digital noise, you might face
luminance noise, which is the bright and dark specks sprinkled throughout
your photo. Under the Filter=>Noise menu, you can find the Despeckle com-
mand. No dialog box appears and you have no options to choose from: You
simply run the filter two or three
times. For more challenging noise,
try Photoshop’s Blur=>Smart Blur
filter. For supreme control over blur-
ring, Smart Blur even lets you enter
fractions for both the Radius and
Threshold values (as shown in Figure
9-9). Sometimes the difference
between a 1.5-pixel blur and a 2-pixel
blur is the salvation of the fine detail
in your image.

Figure 9-9: The Smart Blur filter is a good
choice for luminance noise reduction.

Fooling Around with
Mother Nature

Sometimes a very nice photo has something in it that you want gone . . . a
piece of litter, telephone lines in the distance, a building that distracts from
the composition, or perhaps a person whose memory you’d like to erase.
Other times, everything in the image is fine, but the image looks wrong
because of the angle at which it was taken. Photoshop offers you quite a vari-
ety of tools and techniques for cutting out, copying over, cleaning up, and
even correcting perspective.

Removing the unwanted from photos

Perhaps the easiest way to remove something from an image is to crop the
photo: that is, cut off that part of the picture. This technique is easy enough
if that piece of litter or whatever happens to be at the edge of the image and
cropping won’t ruin your composition. However, when you must cover up
rather than crop out, consider both cloning and copy/paste.
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One of the keys to using the Clone Stamp tool is keeping an eye on your work.
Zoom in close so you can work precisely, but choose Windowr>Arranger>New
Window for [filename]. Keep that second window zoomed out and off to the
side so you can monitor your progress while you work. I also like to keep a
copy of the original image open for reference. You can make a copy of the file
with the Imager>Duplicate command or by clicking the left button at the
bottom of the History panel. In Figure 9-10, you see the original image to the
upper-left, the zoomed-in work image below, and a zoomed-out second
window for the work image. (The Navigator panel shows you what part of the
zoomed-in image is visible.) The unwanted bicycle is easily removed.

266 B IMG_1447.tif @ 12.5% (RGB/8) | ® O O R IMG_1447 copy @ 12.5% {Layer 1, RGB/8)

NAVIGATOR.

| 66.67% 3072 pixels x 2048 pixels (180 ... [» |

Figure 9-10: Use the Clone Stamp to remove unwanted bits and pieces.

Here are some tips for working effectively with the Clone Stamp tool:

1~ Work on a separate layer. Before cloning, click the New Layer button at
the bottom of the Layers panel and set the Sample menu to All Layers in
the Options bar. By cloning to the new layer, you protect yourself from
irreversible errors (you can always erase part of the upper layer), and
you can show/hide your work layer to check progress. If the image
already has multiple layers and you want to clone from only one, hide
the other layers in the Layers panel by clicking the eyeball icons in the
left column.
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v~ If color or pattern is uniform, clone near. If, for example, you're remov-
ing a power line in a beautiful blue sky, clone from right above and
below the power line so that you get the best possible color match. For
delicate jobs or larger items, you can clone by halves — clone half from
one side and the other half from the other side.

1 To avoid a recognizable pattern, clone far. In Figure 9-10, I cloned over
the bicycle handles in the lower-right corner of the image from a variety
of places to avoid creating any recognizable replicas of nearby flowers
or rocks. You should, however, try to clone from areas that are approxi-
mately the same distance from the lens as the area over which you're
cloning. If you clone from the far distance into the foreground, you’ll have
a recognizable size mismatch and perhaps a focal difference, as well.

1~ To copy areas or objects, use Aligned. In Figure 9-10, I copied patches
of wildflowers, grass, and rock. By using the Aligned option, the relation-
ship between the point from which I sampled and the point to which I
cloned remained constant when I released the mouse button. To pick a
new source point, I Option+clicked/Alt+clicked elsewhere in the image.

1~ To repeat a pattern or texture, don’t use Aligned. If you have a specific
object, texture, or pattern that you want to replicate in more than one
area, you can clear the Aligned check box on the Options bar. Every time
you release the mouse button, the source point returns to the exact spot
where you Option+clicked/Alt+clicked. You can copy the same part of
the image into as many different places as you choose.

+” You can vary the tool’s opacity and blending mode. Generally speak-
ing, when you want to hide something in the image, use the Normal
blending mode and 100% opacity. However, you can also clone with
other blending modes and reduce opacity to subdue rather than hide
and, of course, for fun special effects.

1 Adjust your brush size on the fly. Pressing the left and right brackets
keys (to the right of P on the standard English keyboard) decreases and
increases the brush diameter without having to open the Brushes panel.

1~ Check the brush’s hardness and spacing settings. To get the smoothest
result for general cloning, reduce the brush’s Hardness setting to about
25%, allowing edges to blend. There are times, however, when you'’ll
need a more distinct edge to the brush, but you’ll rarely need to clone
with a brush set harder than perhaps 90%. In the full-size Brushes panel,
I generally set the Spacing (in Brush Tip Shape) to 1% for cloning to
ensure the edge is as smooth as possible.

The Spot Healing Brush works much like the Healing Brush to repair
and replace texture. However, instead of designating a source point by
Option-+clicking/Alt+clicking, the Spot Healing Brush samples from the
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immediate surrounding area, which makes it perfect for repairing little
irregularities in an area of rather consistent texture. The Spot Healing Brush
could, for example, do a fine job with individual flowers and small rocks
shown earlier in Figure 9-10, but it’s not up to the task of hiding a bicycle or
a steer.

Larger challenges sometime require more drastic measures, such as dupli-
cate layers and layer masks. Take a look at Figure 9-11. At the top left, you see
the “before” photo: at the top right, the “after” image. Below are images from
three key steps in the process.

Here are the steps [ took to remove the boy from the group photo:

1. Decide what needs to go and how best to cover it.

In this case, the young man is no longer welcome in the group photo. The
easiest way to remove him (without using scissors and leaving an empty
hole) is to move the two young women on the right over to the left.

©2002 PhotoSpin, PhotoSpin image #0800034
Figure 9-11: A new layer with a layer mask and — POOF — he’s gone!

195
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2. Make a selection of the area that you’ll use to cover.

I used a large rectangular selection that included everything to the right
of the young man.

3. Copy to a new layer.

Use the keyboard shortcut 88+J/Ctrl+J to copy the selection to a
new layer.

4. Position the new layer.

Use the Move tool to slide the new layer over the top of the area you
want to remove.

5. Add a layer mask.

Click the Add Layer Mask button at the bottom of the Layers panel and
then paint with black in the layer mask to hide areas of the upper layer.
As you can see in the lower left in Figure 9-11, the upper layer covers
areas of the lower layer that need to show (such as the man’s head), cre-
ating an unnatural shadow pattern. The layer mask in the lower-center
image exposes as much of the lower layer as possible, leaving the upper
layer visible only where necessary to show the two young women and
their shadows as well as to hide the people on the lower layer.

6. Look for and adjust anomalies.

In the lower center of Figure 9-11, you see that one woman’s foot should
be in the man’s shadow. | added a new layer, made a selection of the area
that should be in shadow, filled with the color of the toes that are
already in shadow, and then used the Multiply blending mode and the
Opacity slider to match the original shadow. (See the lower-right image
in Figure 9-11.)

7. Crop.

Glancing again at the lower-center image in Figure 9-11, you see the area
that needs to be cropped, off to the right. Using a rectangular selection
of everything [ want to save and the Image~>Crop command, the alter-
ation is complete.

You can use a similar technique to move something in your image to a

new location. As shown in Figure 9-12, copy the entire image, reposition it,
use a layer mask to hide parts of the upper layer, and clone to remove any-
thing not needed on the exposed areas of the lower layer. In Figure 9-12, the
background layer is copied and moved upward (after using the Image=>
Canvas Size command to expand the canvas), and a layer mask hides every-
thing except the boy, his racket, and the ball. On the lower layer, the boy is
cloned out. (The look of surprise from the boy in the red hat in the back-
ground is simply a fortuitous coincidence that seems to add credibility to the
adjusted image.)
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@ @ @ Johnny-Tennis11.jpg @ 66.7% (RGB/8
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Figure 9-12: One small step for Photoshop, one giant leap for mankind!

Eliminating the lean: Fixing perspective

When you take a photograph at an angle, perhaps shooting upward at a build-
ing, you get foreshortening, with the distant part of the subject shrinking.
Photoshop’s Distort=>Lens Correction filter does a great job of fixing perspec-
tive. Drag the Vertical Perspective slider to the left to correct images shot
from below, or to the right for shots from above. In Lens Correction, you can
also adjust horizontal perspective, barrel distortion (when the center of the
image bulges out), pin cushioning (when the center of the image bulges in),
chromatic aberration (blue/yellow or red/cyan fringing along edges), and add
a vignette. Note the two options at the bottom. As shown in Figure 9-13, by
default, adjusted areas are transparent, which requires you to crop the image
afterward. You can avoid this — in some cases — by setting Edge to Edge
Extension, which duplicates the last edge pixel to fill the void, or to
Background Color. Alternatively, use the Scale slider to resize your image to
fill the canvas.

You can also use Photoshop’s Edit=>Transform=>Perspective command, but
that usually produces some foreshortening of the image, requiring you to
scale it upward a bit afterward. The Crop tool can also fix perspective. Mark
the Perspective check box on the Options bar before dragging a bounding
box. For best results, position the four corners of the bounding box on visible
corners of something in the image that should be rectangular or square; drag
the side handles outward to expand the bounding box to encompass your
image. Press Return/Enter when you’re done.
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Figure 9-13: Lens Correction does a fine job of correcting perspective.

Rotating images precisely

Buried under the Eyedropper in the Photoshop Toolbox is the little-known
Ruler tool. Generally, you use it in conjunction with the Info panel to find
distances and angles in your image. You can also use it to make sure that you
apply the exact amount of rotation needed for your image. Select the Ruler
tool, drag it along any line in your image that should be vertical or horizontal
and then choose Image~>Transform Canvast>Arbitrary. The angle of the Ruler
tool will already be waiting for you in the dialog box, so you need only click
OK to precisely rotate your image.

One final thought for this chapter: When you come across an image that
requires more fixing than you have time for, or one with such severe lumi-
nance noise that smoothing removes too much detail, or just a problem
photo in general, head for the Filter Gallery. It’s amazing how many flaws you
can hide with a few artistic effects. Creating an artistic rendering of an image
is often preferable to deleting a lousy photo. Blur away the noise and add a
canvas texture with the Texturizer filter. Blown out highlights? Try the
Colored Pencil filter. (Read more about the Filter Gallery in Chapter 15.)
When faced with lemons, think of the Filter Gallery as your own personal
lemonade stand.
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hotoshop is far more than just a pixel-pushing

image editor. More than merely perfecting
excellent photography, you can create art in
Photoshop. And Photoshop includes a very power-
ful painting engine. You need to understand the
extremely complex Brushes palette and painting
tools, all covered here.

Chapter 10 introduces you to compositing
(combining images into a piece of artwork)
and working with layers. You also see how to
use color channels as the basis for selections,
enabling you to move elements from one image
to another. Chapter 11 introduces you to
Photoshop’s shape layers and vector paths,
which are illustration tools used to add
specific elements.

In Chapter 12, [ show you how to work with the
Styles palette and how to create your own custom
styles — and make sure you don’t lose them by
mistake! Chapter 13 looks at the many tools,
palettes, and commands you have available in
Photoshop to add text and type. Chapter 14 intro-
duces you to painting in Photoshop. Chapter 15
introduces you to those filters you need on a near-
daily basis, and then shows you how to work in
the Filter Gallery and in Liquify.




Combining Images

In This Chapter

Putting pieces together with layers

Integrating with blending modes and opacity
Masking for complex selection problems
Keeping it in perspective with Vanishing Point
Automating with Photomerge and Merge to HDR

A pharaoh’s head on a lion body. A lion with the head, talons, and wings
of an eagle. As evidenced by the sphinx and the mythological griffin,
compositing elements has been around a lot longer than Photoshop, but
Photoshop certainly makes it easier! Take part of one image, drop it onto
another image, and sell the composite to the tabloids for thousands of
dollars. (One of the more infamous misuses of Photoshop occurred

during the 2004 U.S. presidential campaign, with the publication
of a fake photo of candidate John Kerry with actress and
antiwar activist Jane Fonda.) Photoshop offers you
incredible power — use it wisely!

In this chapter, I show you some basic techniques for
compositing (combining two or more images into a
single picture), how to use channels to select part of
an image for compositing, the Vanishing Point fea-
ture, and then wrap up the chapter with a look at a
couple of automated features for combining images.

Compositing Images: 1+ 1 =1

You make a selection in one image, copy, switch to another
image, and paste. There you have it — the basic composite! Pretty simple,
isn’t it? Whether you're putting together two images or creating complex art-
work involving dozens of elements, the trick is making the composited image
look natural. The key techniques are blending the edges of your selections
and matching color among the elements.
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Understanding layers

When you put together images, you work with layers. Think of layers in
Photoshop as stackable elements, each of which holds part of your image.
Where an upper layer is transparent, the lower layers show through. Where
the upper layer has pixels that aren’t transparent, those pixels either block or
interact with pixels on the lower layer. (You control that interaction with
blending modes and opacity, explained later in this chapter.)

Take a look at Figure 10-1 (which reveals how Figure 13-2 is created). The
Layers panel shows the individual layers and their content. The individual
elements come together to create a single image.

Figure 10-1:

Elements on different layers form a single image.
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You can manipulate the content of each layer independently — moving,
resizing, erasing, painting, or adjusting color and tonality — to suit your
needs and artistic vision. Remember to click a layer in the Layers panel to
make that layer active for editing. You can link two or more layers so that
they maintain their positions relative to each other as you move them.
(88/Ctrl+click to select the layers; then click the Link button at the bottom of
the Layers panel — a Link symbol appears to the right of linked layers when
active in the layers panel.) Linked layers can be moved together without
knocking them out of alignment.

The left column in the Layers panel, known as the eyeball column (for an
obvious reason) allows you to hide a layer, making the content of the layer
invisible. The pixels are still there; they’re just not visible. Click the eyeball
icon to hide the layer and then click the empty space in the left column to
make the layer visible again. You can hide and show adjustment layers, too,
which lets you see their impact on the image. (Read about adjustment layers
in Chapter 8.)

One key concept about layers is well illustrated in Figure 10-1. The higher a
layer is in the stacking order (the order of layers in the panel from the top
down), the more “in front” it will be. The layers Clouds-Dark and Clouds-Light
are on top of everything in the image. The layer Man is in front of everything
except the clouds. Because of the stacking order, the man appears to be
walking on top of the musical notes, and the notes appear to be on top of the
compact disc.

You can also create groups, which are two or more layers packaged together

in the Layers panel so that you can work with them together. As you can see

in the Layers panel in Figure 10-1, you can have nested groups: a group within
a group. The group named Background Items includes another group, named
Sun, as well as several layers that aren’t part of the Sun subgroup.

Why you should use Smart Objects

Smart Objects provide even more flexibility in Photoshop. When working
with Smart Objects, you preserve your editing options without risk to the
image quality. For example, you can transform a Smart Object as often as you
like because each time you rotate or scale or otherwise manipulate a Smart
Object, Photoshop goes back to the original pixels and resamples again. This
prevents the sort of image degradation you would see if you were to shrink
and enlarge a regular layer’s content numerous times.

When working with Smart Objects, you can apply a filter to a selection in
Photoshop and then later go back and change the filter settings or even
remove the filter entirely. But this feature is available only when you're
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working with Smart Objects. Again, it goes back to Photoshop’s ability to
return to the original source pixels when working with Smart Objects. (Filters
are discussed in Chapter 15.) In the Layers panel, Smart Filters very much
resemble layer styles: You can click an eyeball icon to temporarily hide a
filter’s effect, and you can double-click the filter name to re-open the dialog
box so that you can make changes (see Figure 10-2).

LAYERS

" Normal [ -:] Opacity: ,IGIJ'A.iT"
tock: ]| y[4+]@] F|||:;'m:|_'i!
I | B
= !@ IrishGuard @ fxa
1 )
W Effects

5 Inner Shadow
@ Bevel and Emboss
@ Suoke

r L e
E"rieﬁijce_NsE-W
W Smart Sharpan

|
| IRISH PRIDE frla

W Effects

@ Outer Glow
W Beval and Emboss
B Stroke

9: | |:| Background 2

Figure 10-2: Filters applied to the Smart Object are listed under Smart Filters.

You can make a selection of part of a Smart Object before applying a filter,
which creates a mask that restricts the filter to certain areas of the Smart
Object (visible in Figure 10-2 as a mask thumbnail to the left of the words
“Smart Filter.”) Note, too, that a Smart Object can have both Smart Filters and
a layer style.

When you choose File>Place, a Smart Object is automatically created. To
create a Smart Object from an existing layer (even a background layer),
choose Layer=>Smart Objects=>Convert to Smart Object.

Using the basic blending modes

The pop-up menu at the top-left corner of the Layers panel offers more than
two dozen different blending modes. A layer’s blending mode determines how
the pixels on that layer interact with the visible pixels on the layers below.
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\‘&N\BEB Because a layer named Background can’t have any layers below it, you can’t
5y change the blending mode of background layers. Convert a background layer
to a regular layer by changing the layer’s name in the Layers panel. Simply
double-click a layer name in the layers panel and type to rename the layer.

In Figure 10-3, the black-white and rainbow strips of gradients overlaid on the
garden photo below each use the blending mode shown by the text outline.
(You can see the original gradients in the Normal stripe.) Normal, Multiply,
Screen, Overlay, and Luminosity are the blending modes you’re most likely to
use regularly.
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Figure 10-3: Blending modes control the interaction between the gradients and the photo.

QQ,N\BER When working with layer blending modes, always keep in mind that you can

5y use the Layers panel’s Opacity and Fill sliders to help determine the layer’s
visibility and appearance. The Opacity slider controls the visibility of the
layer’s content and any layer style applied to the layer. The Fill slider controls
the visibility of the layer content without hiding any layer style. For a practical
example of the difference between the two sliders, take a look at Chapter 18.
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The Layers panel blending mode pop-up menu is divided into six sections,
based loosely on how the pixels on the upper layer affect the pixels on the
lower layer. Here’s a quick look at how you use the key layer blending modes:

+* Normal: Photoshop picks Normal by default. Pixels on the upper layer
completely hide the pixels on the lower layers (subject, of course, to the
Opacity and the Fill settings). Use Normal to show the content of the
layer without any interaction with lower layers.

1 Multiply: The Multiply blending mode darkens where your upper layer
is dark and ignores white. Use Multiply when you want the upper layer
to darken but not obscure the lower layer and also for shadows and
dark glow effects.

~ Screen: The Screen blending mode — the opposite of Multiply — uses
lighter pixels to lighten the pixels below. Use it for highlights and light-
colored glows.

v Overlay: Overlay works like a combination of Multiply and Screen. Use it
when you’re working with an upper layer that includes both dark and
light pixels that you want to interact with pixels on layers below.

1~ Soft Light: Soft Light is a subtle blending mode. Like Overlay, where your
upper layer’s pixels are dark, the lower layer is darkened; where they're
light, the lower layer is lightened. Soft Light is like adding a diffused
spotlight to the lower layer — useful for adding a little drama to the
lower layer.

v~ Hard Light: The Hard Light blending mode is much like a more vivid ver-
sion of Soft Light. Use it to add a lot more drama to the lower layer. Hard
Light works well with colors that aren’t overwhelmingly bright.

~ Difference: Where the upper layer (using the Difference blending mode)
and the lower layer are exactly the same, you see black. Where the two
layers are different, you see brightness or color. For example, use
Difference (temporarily) when trying to align two overlapping photos. Set
the upper layer to Difference, move the upper layer until the areas of
overlap show black, and then switch the upper layer’s blending mode
back to Normal.

1~ Color: When the upper layer is set to Color, the lower layer’s brightness
and saturation are retained, and the upper layer’s color is used. If you
want to create a color picture from a grayscale picture, convert the
image to RGB (Image>Mode>RGB), add a new layer, change the upper
layer’s blending mode to Color, and paint on the upper layer (as shown
in Figure 10-4).
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+* Luminosity: When the upper
layer is set to Luminosity, the
color and saturation of the
lower layer are retained, and
the brightness (luminosity) of
the upper layer is applied.
Because the luminosity (dark
and light) generally provides
texture, use this blending mode
to produce detail in the lower
layer.

Photoshop also offers two pairs of
blending modes that you might find
useful, but confusing. The Lighten
and Lighter COlOI’ blending mOdeS ©2004 PhotoSpin, PhotoSpin image #1410053
both compare the pixel on the upper  igyre 10-4: Paint on a layer setto Color to
layer to the pixel directly below it on ygtain the detail of the layer below.

the lower layer and choose the

lighter color value. The Lighten blending mode looks at each color channel.
For example, if the upper pixel’s RGB values are 200/180/75 and the lower
pixel’s RGB colors are 175/240/90, the resulting color in your image is RGB
200/240/90 (the lighter — higher RGB value — of each of the three channels).
Using the Lighter Color blending mode for the upper layer, on the other hand,
would result in the lower layer’s color being used — RGB 175/240/90 is lighter
overall than RGB 200/180/75. While Lighten looks at each channel indepen-
dently, Lighter Color simply uses the overall lightness. The Darken and
Darker Color blending modes work similarly, but choose the darker values.

Opacity, transparency, and layer masks
Blending modes help determine how pixels on an upper layer interact with
pixels on a lower layer, but those upper pixels have to be visible before they
can do any interacting at all. When looking at any pixel on a layer, you have
to consider four factors about transparency:

1 Whether the pixel has any color to start with

v The Opacity value

1 The Fill value

1 Whether there’s a layer mask
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When you add a layer and paint on it, for example,
you color some of the pixels yet leave other pixels
transparent. (Every layer in every image is com-
pletely filled with pixels, whether visible or not.) If
nothing is done to color some pixels, they remain
transparent, and the lower layers can be seen
through that part of your upper layer. In Fig-

ure 10-5, the words upper layer are on a separate
layer above the layer containing the words LOWER
LAYER. Where the upper layer has transparent
pixels, the lower layer shows through.

SOMBER Figure 10-5: Where you see
& A layer named Background in the Layers panel can the lower layer, the upper layer
have no transparent pixels. is transparent.

Lowering the Opacity or the Fill slider in the

Layers panel (or the Layer Style dialog box) makes all visible pixels on the
layer partially transparent: The pixels on layers below can be seen through
the upper layer’s pixels. (The Opacity slider controls the pixels on the layer
and any layer style; the Fill slider works only on the pixels, not the layer
style.)

Chapter 8 discusses layer masks and vector masks. Remember that any pixel
inside the mask is visible, and any pixel outside the mask is transparent,
regardless of whether it has color. But, as you can guess, any transparent
pixels inside the mask remain transparent.

Creatmq C( ipping groups

This being Photoshop, here is yet another way to restrict the visibility of
pixels on an upper layer: clipping groups. Clipping an upper layer to the layer
below, in effect, creates a mask for the upper layer. The opacity of the pixels
on the lower layer is applied to the pixels on your upper layer. Where the
lower layer is transparent, the upper layer (regardless of original content)
becomes transparent. In the Layers panel, Option+click (Mac)/Alt+click
(Windows) the line between two layers to clip the upper layer to the lower.
When you hold down the Option/Alt key, the cursor turns into the wedding
rings icon, shown between the top two layers in Figure 10-6.

After you Option+click/Alt+click the line between Layer 0 and the layer named
GARDENS, the upper layer is visible only within the text on the lower layer.
The upper layer is indented to the right in the Layers panel, with a downward-
pointing arrow, to let you know that it’s clipped to the layer below. Note that
the upper layer’s thumbnail in the Layers panel shows the entire layer, not
just the visible area. To unclip a layer, Option+click/Alt+click again on the line
between the two layers in the Layers panel. Also note in Figure 10-6 that the
layer style is applied to the lower layer rather than the upper layer.
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Figure 10-6: Option+click or Alt+click the line between two layers to clip the upper
to the lower.

Photoshop lets you show the layer thumbnails in two ways. Normally, the
entire layer, including all areas of transparency, shows in the thumbnail.
Although that gives you a good indication of how large or small the particular
layer’s content is in the image, layers with little content have little to show in
the thumbnail. By using the Panel Options (from the Layers panel menu) or
Control+clicking/right-clicking the empty area below the layers in the panel,
you can elect to show a thumbnail that includes only nontransparent areas of
the layer. Little things fill the thumbnail, but they also appear out of propor-
tion to the other thumbnails. Your choice.

Making composited elements look natural

One of the keys to compositing two images is a slight fade to the edges of the
element you're adding to the original image. That fade, called feathering,
makes the edges of the image appear to fall off into the distance very slightly
rather than having a sharply defined edge that sticks out like a sore thumb.
(See Chapter 8 for full information on feathering.) You have a number of ways
to feather a selection, including the following:

209
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1 Use the Feathering field on the Options bar
before you use a selection tool.

1~ Use the Refine Edge button in the Options
bar or the Select>Refine Edge command
after making your selection.

1 Choose Select>Modify=>Feather after you
make a selection.

1~ Apply a slight blur to a saved selection’s
alpha channel in the Layers panel (or to a
layer mask).

Matching color between two layers is also criti-
cal for a natural appearance. Take a look at
Chapter 6 for full information on Match Color
and Photoshop’s other color adjustment
capabilities.

You also need to be aware of perspective and
scale. When an element in your composited image
seems to be too large or too small or when it
seems to be facing the wrong way or standing on
air, rely on the Edite>Transform commands.
Although the Scale and Rotate commands are self-
explanatory, Figure 10-7 shows visually how you
can use the other Transform commands, such as
Skew, Perspective, and Warp. Drag the bounding  Figure 10-7: Drag anchor points
box anchor points to transform the selected to transform.

pixels.

The Edit>Transform=>Warp com-
mand adds a simple mesh over the
content of the layer or selection. You
click and drag the direction lines for
the corners of the mesh and at the
intersection of mesh lines to distort
your artwork. As you see in Fig-

ure 10-8, the Warp distortion gives
you a level of control second only to
Photoshop’s Liquify feature (dis-
cussed in Chapter 15). You can also
use Warp with paths and shape
layers.

Figure 10-8: Use the Warp transformation to
distort layers or selections.



Making Complex Selections

In order to combine elements from separate images into a single piece of art-
work, you sometimes need to make very complex selections. That’s often
best done with an alpha channel, which can then be made into an active
selection with the aptly-named Select=>Load Selection command. Among the
alpha channel creation techniques available to you are

1~ Save a selection: If you already have a selection, perhaps created with
the Lasso tool of the Selectr>Color Range command, you can use the
Selectr>Save Selection command to create an alpha channel. This saved
selection can then be edited as necessary by painting, or can be com-
bined with another selection or additional alpha channels.

~ Duplicate a quick mask: Press Q to enter Quick Mask mode, paint your

quick mask (as described in Chapter 8), and then — before exiting Quick

Mask mode — drag the Quick Mask channel to the New Channel button
at the bottom of the Channels panel to duplicate it.

+~ Paint from scratch: Click the New Channel button at the bottom of the
Channels panel, and paint with black, white, and shades of gray. White
will be included in the selection, black will be excluded from the selec-
tion, and gray indicates partial selection.

1 Duplicate an existing channel as the basis for a mask: You can also
examine the color channels to see which provides the best contrast
between the subject and the background, drag that channel to the New
Channel button, and then adjust the duplicate channel.

Duplicating a color channel is often the most effective way to extract a com-

plex subject from a complex background. Here’s one way to approach the
task:

1. Examine each channel individually to see which offers the most con-
trast between subject and background.

Open the Channels panel and click on each color channel, one at a time,
to see which presents the best contrast.

® Don’t forget that you have 10 color channels — that’s right, 710 channels —

from which to choose! In addition to the Red, Green, and Blue channels in
your image, you can use the Image=>Duplicate command and then convert
the copy to CMYK or Lab mode. One of the CMYK channels often offers
much better contrast between subject and background than do the RGB

Chapter 10: Combining Images
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channels. In Lab mode, the a and b channels are also worth a try. And
after creating your alpha channel, you don’t even need to switch back to
RGB mode.

2. Duplicate the selected channel.

Drag the color channel of your choice to the New Channel button at the
bottom of the Channels panel to create an alpha channel from it.

3. Maximize the contrast between subject and background.

Ideally, you’ll end up with a subject that’s completely white and a back-
ground that’s completely black. (If your alpha channel shows a dark sub-
ject and a light background, simply use 8 +I/Ctrl+I or the command
Image=>AdjustmentsInvert.) Generally speaking, the first place to start
maximizing the contrast is Levels. Drag the end sliders way in under the
middle of the histogram, and then adjust the middle slider. After clicking
OK, you may want to use Levels again. After Levels has done most of the
work, grab the Brush tool and clean up any additional areas, painting
directly in the channel with black and white.

As you adjust your duplicated channel, pay attention to the edge between the
subject and background. Don’t worry about areas away from the edge —
those are easy to clean up with the Brush. It’s that narrow band that sepa-
rates the subject and background that’s critical.

Figure 10-9 illustrates the steps. To the left, the Red channel shows decent
contrast between the subject and background, the Green less so, and the
Blue channel is useless for this particular image (too much yellow in the
background). After you create a duplicate and convert to CMYK mode, it’s
apparent that both the Cyan and Black channels are even better starting
points than the Red channel. After duplicating the Black channel and using
Levels twice, the alpha channel is in pretty good shape (top center). After a
few swipes with the Brush using black and then again using white, the alpha
channel is ready (top right). Switch back to the RGB copy, use Select=>Load
Selection and load the Black copy channel, and there’s a perfect selection of
the flower!

While no longer part of Photoshop, if you were comfortable using the Extract
feature in earlier versions of Photoshop, don’t despair. It is still available as
an optional plug-in. You can download it from www . adobe . com.
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Figure 10-9: Duplicating a color channel is often the fastest way to a great alpha channel.

Vanishing Point

When combining images to create a scene, you might find a need to add tex-
ture or a pattern along what is supposed to be a three-dimensional object.
You might, for example, add a product box to a photo of a kitchen and need
to add a logo to the front of the box. Or maybe you will create a room, per-
haps in a castle high on a hill, and you’ll need to add a realistic stone texture
to the walls. Use the Vanishing Point feature to “map” a pattern to angled
surfaces, such as walls, floors, buildings, and boxes. Vanishing Point, using
information that you provide, automatically determines the correct angle,
scale, and perspective. (Vanishing Point is rather complex, so for simple jobs,
you might want to stick with the Paste and Edit>Transform commands.)
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To use Vanishing Point, you follow a specific sequence of steps:

1. Copy your pattern.

Open whatever pattern file (or texture or color or logo or whatever)
you’re going to add to the walls or sides in your image, make a selection,
and then choose Edit=>Copy. You can now close the pattern file.

2. Make a selection in your working image.

Identify where you want the pattern to be applied. If you’re working with
walls, for example, make a selection that includes the walls but doesn’t
include windows and doors.

3. Open Vanishing Point (Filter=>Vanishing Point).

The Vanishing Point window opens, displaying your image.

4. Create planes on your image in the Vanishing Point window.

a.

b.

Select the Create Plane tool (the second tool from the top on the
left edge of the window).

Click on your image where you want to place the three corners of
your plane and then move the cursor to the fourth corner.

You see the plane extending along the last two sides.

. Click the fourth corner to create the plane.

If the plane is yellow or red rather than blue, it’s not aligned prop-
erly. Drag the corners of the plane to realign them, using the Edit
Plane tool (the top tool on the left). Drag the side anchor points out-
ward to expand the plane’s mesh to cover the whole wall or side.

. Create perpendicular planes by holding down the 8/Ctrl key and

dragging the side anchor point at the point where the two planes
should meet. If the second plane should be at an angle other than
90 degrees to the first plane, Option+drag/Alt+drag one of the
anchor points to rotate the grid.

If the second plane’s angle is off a little, drag one of the corner
anchor points to adjust it. In Figure 10-10, you see two perpendicu-
lar planes.

5. Paste your pattern.

a.

Press 88+V/Ctrl+V to paste your pattern into Vanishing Point.

Your pattern is pasted into the upper-left corner of the Vanishing
Point window.

. Select the Marquee tool (third from the top) and drag the pattern

into your plane.

The pattern automatically adopts the orientation of the plane. If
necessary, press T on your keyboard and then rotate and scale the
pattern.
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Figure 10-10: Use the Create Plane tool to identify surfaces.

6. Replicate the pattern.

Unless your pattern is an exact fit, you need to replicate it to fill the
plane. With the Marquee tool selected, hold down the Option/Alt key.
Then click and drag in your pattern to replicate it. Repeat as necessary
to fill the plane. As you see in Figure 10-11, you can replicate a relatively
small pattern to fill a large area.

If the lighting in your original image varies, set the Healing pop-up menu
(at the top of the window, only with the Marquee tool active) to
Luminance. That helps maintain the original lighting on the new pattern
or texture.

7. Click OK to exit Vanishing Point and apply the pattern or texture to
your image.

After exiting Vanishing Point, you might need to do some touch-up work
on your image with the Clone Stamp tool (depending on how precise you
were when dragging). You might also, depending on the original image,
need to add a layer and paint some shadows or highlights to reproduce
the original lighting in the scene.
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Figure 10-11: Option+drag or Alt+drag with the Marquee tool to copy your pasted selection.

‘x&N\BEB In Figure 10-11, the pasted and replicated brick pattern doesn’t cover the
& door, window, or artwork because they were not selected prior to opening
Vanishing Point. Without that active selection when opening Vanishing Point,
it would have been much more difficult to properly align the pattern without
covering those areas.

Here are some tips for working with Vanishing Point:

1~ Create accurate planes; then drag. Click in four corners of any identifi-
able area of your plane — perhaps a window — and drag the side anchor
points outward (or inward) to identify the whole plane.

1~ Use the X key to zoom. Pressing and holding the X key on your key-
board makes the preview area zoom to show the area where you’re
working. Release the X key to zoom back out.

~ Press T to transform. After pasting your pattern, you can press T on
your keyboard and then scale and rotate your pasted pattern.
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1~ Use the Shift key to drag in alignment. Hold down the Shift key while
Option+dragging/Alt+dragging to replicate your pattern. That keeps the
new part aligned to the old.

 Duplicate elements in the image. Make a selection with the Marquee
tool and 88+Option+drag/Ctrl+Alt+drag to the area where you want to
place the copy.

1~ Paste over objects in Vanishing Point. Create your plane. Use the
Marquee tool to select an area that you want to replace, and then hold
down the 8/Ctrl key and drag to an area that you want to paste into the
marquee selection.

1 Clone in Vanishing Point. Define your plane, select the Stamp tool, and
Option-+click/Alt+click at the source point. Release the Option/Alt key
and move the cursor to the point where you want to start cloning. When
the preview is properly aligned, click and drag to clone.

1~ Paint in perspective. With a plane identified, the Brush tool in Vanishing
Point shrinks or grows in accordance with your perspective plane.

1 Work on an empty layer. You can add an empty layer in the Layers
panel before entering Vanishing Point. Your result is added to the new
layer, which lets you work with blending modes and opacity to merge
your pattern into the original.

Putting Together Images Automatically

You have a couple of features in Photoshop that automatically combine two
or more images into a single image. You can combine overlapping images into
a panorama, or you can combine multiple exposures of the same shot into a
single well-exposed image. You'll find both Photomerge (for panoramas) and
Merge to HDR (for high dynamic range combined exposure images) in the
Filew> Automate menu.

Creating panoramas with Photomerge

Sometimes a snapshot doesn’t adequately portray a scene. (It’s hard to cap-
ture the majesty of the Grand Canyon in a single frame.) For those situations,
take a series of images and combine them into one large panorama with
Photomerge.
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The first step in using Photomerge successfully is taking appropriate photos.
Here are some tips:

1~ Use a properly leveled tripod. Use a tripod, making sure that the
tripod’s head is steady and level so the individual photos align properly.
If necessary, set the legs to different heights.

~ Turn off auto-exposure. If you use your camera’s auto-exposure feature,
each image is actually exposed differently because of the lighting in that

frame. Instead, expose for the center (or most important) photo and use
the same settings for all shots.

~ Don’t use auto-focus with zoom lenses. Auto-focus can change the zoom

factor of the lens. Instead, set the lens to manual focus after using auto-
focus on your most important shot.

1 Overlap by at least 15 percent. Up to one-quarter of each shot (on each

side) should overlap so that Photomerge can properly align neighboring
images.

When working with images that are properly exposed and have suitable
overlap, Photomerge is fully automated. You open Photomerge (visible in
Figure 10-12), select the images you want to use, select how you want the
component images to interact, click OK, sit back, and watch the magic as the
elements are put into order, aligned, and blended.

Photomerge
— Source Files @
Choose two or more files to merge into a 2
panorama [ Cancel
Use: | Files =
- S | Load )
Left.tif ( Browse... )
Right.tif

Center.tif Remove
T Cylindrical Add Open Files

o, e

) Reposition Only

" Interactive Layout

E Advanced Blending

Figure 10-12: Photomerge aligns and blends your elements automatically.
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When creating a panorama of a room or some other scene that has a definite
this-point-is-farthest-from-the-camera vanishing point, use the Perspective
option. When you use the Perspective option, your panorama might appear
to be pinched in the middle. Choosing the Cylindrical option evens out the
top and bottom and the perceived distance (see Figure 10-13).

Figure 10-13: Photomerge using the Perspective option (top) and the Cylindrical option
(bottom).

Combining exposures for HDR images

A rather specialized feature, the Merge to HDR command creates a composite
image of two or more exposures of the same shot, taking the best-exposed
parts of each. You might, for example, take two shots of a room, one exposed
for the room itself and another exposed to capture the detail of the scene
outside the window(s). You can use Merge to HDR to take the best of both
images and create a single image. Here’s how:

1. Choose File=>Automate->Merge to HDR.
The Merge to HDR dialog box makes an appearance.

2. Select the images to use.

Make sure the Attempt to Automatically Align Source Images check box
is marked (as shown in Figure 10-14).

219
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3. Click OK to open Merge to Merge to HDR
HDR, shown in Figure 10-15. -mmm:'mm:’ P {T;

In the upper-right corner of the
Merge to HDR window is the Bit P

Use: | Files 2]

Depth option of creating a more MG.S610.CR2 Chowmn
common 16-bit image or even a Coseia cha T
highly usable 8-bit image rather Me-sstacns Aadopenbier

than the 32-bits/channel HDR
default. You can also adjust the
image’s preview by dragging the
Set White Point Preview slider.
Generally speaking, the slider Figure 10-14: Select the images to merge and
belongs under the right edge of then let Merge to HDR try to align them.

the histogram, just where the

histogram begins to rise. Keep in mind that the slider only changes the
appearance of the preview. The entire tonal range is still saved and avail-
able in a 32-bit image. The Imager>Adjustments>Exposure command is
available in Photoshop to adjust a 32-bit image, too.

# Attempt 1o Automatically Align Source Images

You can elect to save the response curve, the way in which the particular
images are combined, for future use. Click OK and the image is generated.

Merge to HOR (500

Aot Wherped B B
——r—
Cancel |
ket Do | 3 Bt/ Chasnsl =

St Wity Pounil Fioview:

Figure 10-15: Merge to HDR creates a single image from multiple exposures.
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If you choose to use the 32-bits/channel option, you can save your image in
one of three file formats:

1 PSD (Photoshop)

* PSB (Photoshop’s Large Document format, if activated in Photoshop’s
Preferences)

v~ TIFF

Keep in mind that not a lot of programs use 32-bit/channel images, and even
your editing capabilities within Photoshop are limited. But ain’t it great to
know the capability is there, just in case someday you need it? Or even if you
never need it? (You can, of course, use Image~>Moder>16-Bits/Channel and
print your image.)

When shooting images for use with Merge to HDR, use a tripod and disable
auto-focus. Also, the only change to the camera’s settings between shots
should be shutter speed (exposure length). Generally speaking, you’ll want to
work with between two and seven stops of exposure. And keep in mind that
you can use actual exposures or different Exposure settings in Camera Raw.
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Precision Edges with Vector Paths

In This Chapter
Understanding vector artwork
Creating objects with shape layers
Making a new path
Changing the shape of an existing path
Editing the shapes of type characters

M ost of the images with which you work in Photoshop — digital photos
and scanned artwork, layers on which you paint, and filled selections —
are created with pixels. There’s also another type of artwork: vector art, which
you create by defining a path (an outline) and adding color within that path.
That path has a very precise edge, enabling vectors (when printed appropri-
ately) to give you very crisp, clean lines in your artwork.

Typically, vector art consists of specific elements (objects)
that are uniform in color (although vector art can also
include gradients). You might have, for example, a red
triangle, a blue square, and a green circle as your logo
(boring!). These three solid-color objects are best
defined as vector artwork. Vectors, however, are not
appropriate for photographic images and other

such imagery that include subtle transitions among
colors.

In Photoshop, you have tools that create predefined
shapes; you have tools that create freeform shapes;
you have tools to edit the paths that define those
shapes. You also have a shape picker and a bunch of menu
commands. You can even bring in shapes from Adobe
[llustrator and create your own shapes, too. After reading this chap-
ter, you’ll have a solid understanding of all these bits and pieces. | even tell
you where to find dozens, or even hundreds, of custom shapes already on your
computer — absolutely free!
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Pixels, Paths, and You

The vast majority of the artwork with
which you work (or play) in
Photoshop is raster artwork. Raster
imagery consists of uniformly sized
squares of color (pixels), placed in
rows and columns (the raster). Digital
photos, scanned images, and just
about anything that you put on a
layer in Photoshop consists of pixels.
When you edit the image, you're
changing the color of the individual

sometimes in dramatic ways.

Vector artwork is a horse of another
color. Rather than pixels, vector art
consists of a mathematically defined
path to which you add color. In a
dedicated vector art program, such
as Adobe Illustrator, the path pro-
duces the shape of the object, and
you add color along the path
(stroke), within the path (fill), or
both to make the shape become an
object. Photoshop simulates vector artwork using vector paths on shape
layers to hide parts of a layer, so you can fill the “shape” but not add a stroke
to the path. (A shape layer is filled with pixels of a specific color, or which
form a gradient or a pattern; and a vector mask determines what part of the
layer is visible.) Remember that you can use layer styles in conjunction with
shape layers to simulate strokes and other effects.

©PhotoSpin, PhotoSpin image #P1009008
Figure 11-1: Each elementin vector art has a
single specific color.

Figure 11-1 shows a fine example of vector artwork.
Observe that each element in the image consists of
a single color. Each section of the image is easily
identifiable as an individual object, consisting of a
specific color. (Remember, though, that vector
objects can be filled with gradients rather than
color.)

Each element in the artwork is defined by its path, N
which consists of a number of path segments. In |
Figure 11-2, you see the path that defines the
woman’s hair. (You read about the anatomy of a Figure 11-2: Paths define the
path later in this chapter, in the section outline of an object — the
“Understanding paths.”) woman’s hair in this case.
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When artwork is defined by pixels, the little square corners of the individual
pixels can be noticeable along curves and diagonal lines. With vector art-
work, the path is sharp, and the edges are well defined. However, to truly get
the best appearance from vector art or vector type, the artwork must be
printed to a PostScript-capable device, such as a laser printer. PostScript

is a page-description language that takes advantage of the mathematical
descriptions of vector art. When you print to an inkjet printer, the vector art
is converted to pixels. If you print to such a non-PostScript device, use a high
image resolution for best output — 300 pixels per inch (ppi) is usually good.

A vector path can be scaled (changed in size) almost infinitely without losing
its appearance. A vector logo can be used for both a business card and a
billboard without loss of quality because the path is mathematically scaled
before the stroke or fill is added. Raster art, on the other hand, can be
severely degraded by such scaling. For a simple demonstration of the differ-
ence between scaling raster art and scaling vector art, see Figure 11-3.

Raster, from small to large

Raster, from small to large

Raster, from large to small

Raster, from large to small

Vector, from small to large

Vector, from small to large

Vector, from large to small

Vector, from large to small

Figure 11-3: Using text as an example shows the advantage of vector artwork when scaling.
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Type in Photoshop is vector-based: That is, it’s created with paths. Objects in
Photoshop, such as circles and squares that you create with vector paths,
can also be scaled as vector artwork. The paths are recalculated to their new
size and retain their crisp, sharp edges.

Easy Vectors: Using Shape Layers

If you made it through the preceding section, you're officially an expert on
the theory of vector graphics. It’s time to see how you can actually create
these little devils in your artwork. Keep in mind that a vector shape in
Photoshop actually consists of a shape layer with a path that defines what
part of the layer is visible and what part is hidden. The content of the

layer — be it solid color, pattern, or gradient — is visible within the path
and hidden outside the path. The easiest way to create a shape layer in
Photoshop is with the aptly named shape tools, which automatically create a
color-filled layer with a vector path that shows/hides the layer according to
the shape selected. Could you have it any easier? Just drag a tool and create
a vector-based “object”!

Your basic shape tools

Rectangles, rectangles with rounded corners
(rounded rectangles), circles and ovals, multisided
polygons, straight lines and arrows, and a whole
boatload of special custom shapes are all at your

command with a simple click-drag. Select the Mgy e

B ==

D Rounded Rectangle Tool

il

u
appropriate tool in the Toolbox, select the appro- <A G Elipss Tool o
priate foreground color, and click-drag to create () Polvgan Tool u
your object. (The various shape tools are nested in |m ':] X, Line Toal u
the Toolbox, as shown in Figure 11-4.) Sounds W osemshweto v
simple, right? It is — no tricks. Here are some addi- | = .
tional features to make things even easier for you:

1~ Use the Shift key. Pressing the Shift key (both
Mac and Windows) while you drag constrains  Figure 11-4: The shape tools
proportions (maintains the width-to-height are collected in one spot in
ratio). With the Shift key, the Rectangle tool Photoshop’s Toolbox.
creates squares; the Ellipse tool creates cir-
cles; the Polygon tool creates proportional polygons; the Line tool cre-
ates horizontal or vertical lines (or lines at 45° angles). When using
custom shapes, pressing the Shift key ensures that the shape retains the
width-to-height ratio with which it was originally defined.

1~ Use the Option (Mac) or Alt (Windows) key. The Option/Alt key creates
the object centered on the point at which you click. Without the Option/
Alt key, the object is created in whichever direction you drag.
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~ Use the Shift and Option/Alt key. Pressing the Shift and Option/Alt
together helps you create a proportionally constrained object, centered
on the point at which you click.

1~ Use the spacebar. While you’re dragging a shape, keep the mouse
button down and press the spacebar. You can then drag to reposition
the object while you create it. Still keeping the mouse button down,
release the spacebar and finish dragging the object.

1 Check the Options bar. When you switch from shape tool to shape tool,
the Options bar changes to fit your needs. For example, with the
Rounded Rectangle tool active, you choose the radius of the rounded
corners. The Polygon tool offers a simple field in which you choose the
number of sides for the shape. When you’re using the Line tool, choose
the thickness (weight) of the line in the Options bar. And click the trian-
gle to the right of the shape tool icons in the Options bar to add arrow-
heads to the lines.

1~ Change the layer content. After you create a shape layer, you can
change the color of the layer to another color, to a gradient, or even to a
pattern. Use the menu command Layer=>Change Layer Content.

1~ Edit the vector path. As you can see later in this chapter (in the section
“Adding, deleting, and moving anchor points”), you can use the Direct
Selection tool to change the course of the path, altering the appearance
of the shape layer and, therefore, the shape of the object on the shape
layer.

~ Create work paths or pixelfilled shapes. Using the three buttons to the
left on the Options bar, you can elect to create shape layers, work paths,
or add pixels in the selected shape to your currently active layer.

You can easily spot a shape layer in the Layers panel — especially when the
default layer name starts with the word Shape. (You can, of course, change
the layer name by double-clicking it in the Layers panel.) You can see in the
Layers panel shown in Figure 11-5 that the shape layer consists of a color-
filled layer (the thumbnail on the left) and a vector layer mask (the thumbnail
on the right). That vector mask (a heart-shaped path, in this case) is also visi-
ble in the Paths panel when the shape layer is selected in the Layers panel. If
you click the Background layer in the Layers panel, the Shape I Vector Mask in
the Paths panel is hidden.

The Custom Shape tool

Although the basic shape tools are great for circles and squares and lines and
arrows, you’ll probably get the most use out of the Custom Shape tool. With
this tool selected, you click the triangle to the right of the sample shape on
the Options bar to open the Custom Shape picker, as shown in Figure 11-6.
The Custom Shape picker offers a number of ready-to-use shapes. When you
click the triangle in the upper-right corner, you can choose from a variety of
other sets of shapes listed at the bottom of the Custom Shape picker menu.
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Figure 11-5: Dragging a shape tool creates a color-filler layer
with a path to define a shape.
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Figure 11-6: Load additional sets of custom shapes from the list at the bottom of the menu.

When you select a set of custom shapes from the menu (or use the Load
Shapes command to add a set of shapes not in the menu), you are asked
whether you want to add the new shapes to the current content of the
Custom Shape picker (Append), replace the current shapes (OK), or not add
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the shapes after all (Cancel). When you load all the custom shape sets that
come with Photoshop CS4, you’ve got a pretty impressive group from which
to choose!

More custom shapes — free!

The custom shapes already available in Photoshop cover a wide range, but
they might not fill all your needs. You can purchase commercial collections of
custom shapes from a couple of sources. You can create custom paths and
define shapes from them, too. But you've already got bunches of custom
shapes on your computer, just waiting for you to use them. Select
Photoshop’s Type tool and take a look in your Font menu. Check out the
fonts already there with names like Wingdings, Webdings, Symbol, and
Dingbats. These are all examples of symbol fonts, which are fonts that have
shapes and symbols rather than letters and numbers. Many more typical
fonts also have special characters available when you use the Shift key, the
Option/Alt key, and the Shift key in combination with the Option/Alt key.

Here’s how you can define a custom shape from a symbol:

1. Choose Filez>New to open a new document.

The document can be virtually any size and can be either grayscale or
color.

2. Select the Type tool and pick a font.

With the Type tool active, choose a symbol font from either the Options
bar or the Character panel. The font size doesn’t matter much because
you're creating a vector-based shape that you can easily scale. The fore-
ground color doesn’t matter either, because shape tools rely on the fore-
ground color active at the time you create the shape.

3. Type a single symbol and then end the editing session.

Click the check mark button to

the right on the Options bar,

switch tools in the Toolbox, or

press 38+Return (Mac) or

Ctrl+Enter (Windows) to end the

editing session. (The symbol vis-

ible in Figure 11-7 can be pro- Shaps Hama

duced by pressing the V key E e Eho B Wb E3 -
when using the font Webdings.) ===

4. Convert the type charactertoa
shape layer. Figure 11-7: Name your new shape and

click OK.
With the type layer active in the

Layers panel, use the menu command Layer=>Typer>Convert to Shape.

5. Define a custom shape.
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Choose Edite>Define Custom Shape, give your new shape a name in the
Shape Name dialog box (shown in Figure 11-7), and save it. Your new
shape is added to the Custom Shape picker, ready to use.

<MBER
é.o“‘ Later in this chapter, after you master using the Pen tool, remember this sec-
tion. You can also define a custom shape from paths that you create with the
Pen tool — any shape at all!
vg“;\NG! Remember that your custom shapes aren’t truly saved until you use the

Custom Shape picker menu command Save Shapes (to save all the shapes in
the picker as a single set) or the Edit~>Preset Manager command (to save a
set of selected shapes). In the Preset Manager dialog box, 8 +click/Ctrl+click
each of your custom shapes and then click the Save Set button to save them
as a set (see Figure 11-8). Until you take this step, the shapes exist only in
Photoshop’s Preferences file. If the Preferences become corrupt, you could
lose all your custom shapes. This holds true, too, for custom brushes, layer
styles, swatches, and the like — use the Preset Manager to save all your
custom items.

Preset Manager
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Figure 11-8: Use the Preset Manager to save sets of your custom shapes.
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When saving custom shapes (or layer styles or brushes or any of your other
custom bits and pieces) with the Preset Manager, save them in a folder out-
side the Photoshop folder. That prevents accidental loss should you ever
need to (gasp!) reinstall Photoshop. Figure 11-8 shows one possible folder
structure for saving and organizing your custom bits and pieces.

Changing the appearance of the shape layer

After you use any one of the numerous shape tools in the Photoshop arsenal
to add a shape layer to your artwork, you have a number of ways that you
can enhance, adjust, and simply change its appearance:

1~ Add a layer style. Layer styles,
such as bevels, glows, and shad-
ows (applied through the
Layer=Layer Style menu), can
certainly spice up a shape layer.
Compare, for example, the pair
of shapes in Figure 11-9. (Layer
styles are presented in Chap-
ter 12.)

1~ Change the layer content. Via
the menu command Layer=>Change Layer Content, you can select a dif-
ferent color, a gradient, or even a pattern to fill the shape.

Figure 11-9: A simple layer style makes your
shape jump off the page.

1~ Edit the path shape. Click a path with the Direct Selection tool and drag
to change the path’s shape. (This is discussed in more detail later in this
chapter.)

1 Change the layer blending mode or opacity. By default, your shape
layer’s blending mode is Normal, and the Opacity is set to 100%. Your
shape layer blocks and hides the content of every layer below. By chang-
ing the blending mode or opacity, you can make your shape layer inter-
act with the layers below in interesting ways. Experiment with different
blending modes to find one that suits your artistic vision. (Blending
modes are covered in more detail in Chapter 10.)

Simulating a multicolor shape layer

Shape layers are typically filled with a single solid color, although you can
use a gradient or a pattern. Sometimes, however, you're better served with a
multicolor shape. Take a look at Figure 11-10 and compare the pair of shape
layers to the left with the same two shapes to the right.
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Figure 11-10: Dressing up the shapes can make a world of difference.

In addition to the layer styles applied, layer masks hide parts of the more
elaborate pair of shapes on the right. Like the vector path that hides parts of
a shape layer, a layer mask determines what areas of the layer are visible. You
can use layer masks and vector masks together on a single layer, as you can
see for three of the four layers in Figure 11-11.

W | @ | @ |&
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»
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Figure 11-11: Layer masks and vector masks work together to determine layer visibility.
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Comparing the color in the left column in the Layers panel to the artwork
helps you identify what you see in Figure 11-11:

1~ Shape 1 copy: This is the top layer and would normally hide everything
on the layers below. The layer, as you can tell from the leftmost thumb-
nail in the Layers panel, is filled with green. The rightmost thumbnail is
the vector mask created by the Custom Shape tool. You can see the
shape’s path in that thumbnail. The middle thumbnail is the layer mask.
By painting with black in the layer mask, you can hide parts of the layer.
In this case, the right part of the shape layer is hidden.

+~ Shape 2 copy: Again, a pair of masks are used together. You can see that
the vector shape is an entire pair of scissors. The middle thumbnail
shows where the layer is hidden by a layer mask, leaving only the blades
of the scissors visible on the gray-filled layer.

1~ Shape 2: This layer requires only the vector path shape. The gray layer
just above hides what would be black scissors blades.

+~ Shape 1: The layers above partially hide the red shape layer. Notice how
because of the order of the layers in the Layers panel, the blades of the
scissors appear to be in front of the red part of the object and behind
the green part of the object.

Adding a layer mask to your shape layer is as easy as clicking the Add Layer
Mask button at the bottom of the Layers panel (third button from the left),
and then painting with black to hide, white to show, and gray to partially
hide. You can also make a selection in your image and use the Layer->Layer
Mask menu commands. You can add layer masks to any layer except those
named Background. (You can’t have transparent areas on a background layer,
but you can rename a background layer to convert it to a regular layer.)

Using Your Pen Tool to Create Paths

Even with all the custom shapes available, you might need to create a path
that’s unique to a specific image. For that, Photoshop offers the Pen tool and
its associated tools. Before you start creating paths willy-nilly, you can proba-
bly benefit from a little bit of background information about paths.

Understanding paths

As you click and click-drag, you place anchor points, which connect the path
segments that create your path. Path segments can be straight or curved. You
control those curves not with diet and exercise but rather with direction lines
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and their control points. A straight

Lo
path segment is bordered on either -
end by corner anchor points, and a o Smooth
curved path segment is bordered by Anchor CP%ri‘rt]rt‘;' Anchor
two smooth anchor points or one of Points Points

each type. As you can see in Figure

11-12, Photoshop helps you differen-
tiate between path segments and . _
direction lines by using squares Figure 11-12: Paths have square anchor points

(hollow and filled) for anchor points ~and diamond-shaped control points.
and diamond shapes for control
points.

Only smooth anchor points have direction lines and control points. The angle
and length of the direction line determine the shape of the curve. When you
create a curved path segment between a corner anchor point and a smooth
anchor point, only the smooth point’s direction lines adjust the curve. When
you create a curved path segment between two smooth anchor points, both
points’ direction lines affect the curve.

Here’s another important way to classify paths in Photoshop:

1 An open path has two distinct and visible endpoints; think of it as a
pencil line or piece of string.

1~ A closed path has no beginning or end — like a circle or an unbroken
rubber band.

When you use a shape tool, you're creating closed paths. When you click-
click-click with the Pen tool, you create an open path — unless, that is, your
final click is back on the very first anchor point.

Clicking and dragging your way
down the path of knowledge

All that theory about how paths work is fine, but you’ll get a better under-
standing by playing around with the Pen tool. Open a new document (any
size, resolution, and color mode will do) and select the Pen tool. On the
Options bar, click the middle of the three buttons to the left (as shown in
Figure 11-13) so that the tool creates work paths rather than shape layers,
and then start clicking around. Randomly click in various places in the image,
adding new straight path segments as you go.
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SOMBER Use the middle of the three buttons [ Y= -

& to the left in the Options bar when e B C%
you want to create a path. Use the
leftmost of the three buttons when
you need a shape layer. The button
on the right, for adding pixels to the
current layer, is used only with
shape tools.

Figure 11-13: Select the left button to create a
shape layer, or the middle button to create a
work path.

I'm sure Picasso would be proud, but it’s time to let go of your new artwork
and move on — press Delete (Mac) or Backspace (Windows) twice. The first
time deletes the most recent anchor point; the second time deletes the rest
of the path.

Now, in that same canvas, start click-dragging to create curved path seg-
ments. Watch how the distance and direction in which you drag control the
segment’s curve. Just because it’s fun, try a click-drag and, with the mouse
button held down, move the mouse around and around in a circle. “Path
Jump Rope”! Press Delete/Backspace twice to delete the path.

Now, to get a feel for how to control your curved path segments, try this:

1. Choose File~>New to open a new document.
2. Choose 1024 x 768 from the Preset: Web group.

A reasonable size to work with, it should fit on your screen at 100%
zoom.

3. Show the Grid.

Press 8+’ (apostrophe; Mac) or Ctrl+’ (apostrophe; Windows) to show
the Grid in the image. The Grid makes it easier to control the Pen tool as
you drag. You can also show the Grid with the menu command View>
Showr>Grid. In Photoshop’s Preferencest>Guides, Grid & Slices, the Grid
shown in Figure 11-14 is set to Gridline every: 1 inch and Subdivisions: 6.

4. Select the Pen tool in the Toolbox.
5. Click and click-drag as shown in Figure 11-14.

Don’t worry about precision — you won’t be creating a work of art this
time. Click on the dots in numeric order; where you see a dashed line,
click-drag in that direction for approximately that distance.
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Figure 11-14: You don't need to be precise; just more or less follow the four patterns.

You’ve just created four of the more useful scallops and curve sets! These
sorts of paths can be used in a variety of ways, including stroking, filling, and
creating selections (all of which I discuss later in this chapter) to create deco-
rative borders and artistic elements in your images.

You should ki .
about a couple of 1% 8| 0| [0 ENDIOIO[ON 58 e

other features Of Freeform Pen Tool i Enable magnetic pen opticns

the Pen tool before

you move on. With  Figure 11-15: The Pen tool has a couple of tricks up its sleeve!
the Pen tool active,

take a look at the Options bar (or look at Figure 11-15, which shows the
Options bar).

When you have the Freeform Pen option selected in the Options Bar, you
can click and drag around your image, creating a path as you go. It’s much



like painting with the Brush tool or
drawing lines with the Pencil tool —
wherever you drag the tool, the
path is created.

The Freeform Pen offers the
Magnetic option, too. When you
need to make a path (or selection)
around the outside of something of
uniform color in your image, using
the Magnetic option forces the path
to look for and follow edges. Take a
look at Figure 11-16, which shows
an example of an appropriate use
for the Freeform Pen and the
Magnetic option.

A closer look at the
Paths panel

You can save, duplicate, convert,
stroke, fill, and delete paths via the
Paths panel (which, like all panels,
you can show and hide through the
Window menu). You can even create
a path from a selection by using the
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Figure 11-16: Tracing a uniformly colored object
is a great job for the Freeform Pen using the
Magnetic option.

Paths panel. Without the Paths panel, your paths have no meaning or future
and probably won’t get into a good university or even a good collage.

Pick a path, any path

The Paths panel can hold as many paths as you could possibly want to add to
your artwork. You can also see the six buttons across the bottom of the panel
that you use to quickly and easily work with your paths. You can classify
paths in the five different ways shown in Figure 11-17.

You might not use them all, but it’s good to know the five types of paths:

1 Work path: As you create a path, Photoshop generates a temporary
work path, which is not automatically saved. Unless you save your path,
it’s deleted as soon as you start to create another path or when you
close the file. To save a work path, simply double-click the name field in
the Paths panel and type a new name.
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Figure 11-17: The Paths panel is your key to organizing and controlling
vectors in your artwork.

1~ Saved path: Much like working in the Layers panel, you can double-click
the name of any path and rename it in the Paths panel. (You must
rename a work path in order to save the path for later use.) After you
give the path a name, it’s safe from accidental deletion.

v~ Clipping path: Clipping paths are used primarily with page layout pro-
grams, such as Adobe PageMaker and QuarkXPress. Much like how a
shape layer’s vector path determines what parts of the layer are visible,
a clipping path identifies what part of the image as a whole is visible.
You won'’t need a clipping path when you work with Adobe InDesign —
simply create your image on a transparent background and place that
Photoshop file into an InDesign document. To create a clipping path,
first make your path, give it a name in the Paths panel (to save it), and
then use the Paths panel menu command Clipping Path.

1~ Shape layer path: When a shape layer is active in the Layers panel, its
vector mask path is visible in the Paths panel. If you want to customize a
shape layer’s path, you need to make the layer active first. When a shape
layer path is visible, you can drag it to the New Path button at the bottom
of the panel to create a duplicate. (It’s the second button from the right.)
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1~ Vector mask path: When a regular layer has a vector mask assigned and
that layer is visible in the Layers panel, the layer’s mask path is visible in
the Paths panel.

QNING/ When creating a clipping path, leave the Flatness field completely empty unless
Y your print shop specifically instructs you to use a specific value. The Flatness
value overrides the output device’s native setting for reproducing curves.
Using the wrong value can lead to disastrous (and expensive!) mistakes.

To activate a path in the Paths panel, click it. You can then see and edit the
path in the image window. With the exception of shape layer and vector mask
paths, the paths in the Paths panel are independent of any layer. You could
create a path with the Background layer active and then later use that path
as the basis for some artwork on, for example, Layer 3.

The Paths panel buttons

The six buttons across the bottom of the Paths panel (refer to Figure 11-17)
do more than just simple panel housekeeping. Use them to create artwork
from a path and to convert back and forth between paths and selections.

v~ Fill Path: Click a path in the Paths panel and then use this button to fill
the area inside the path with the foreground color. If you fill an open
path (a path with two distinct endpoints), Photoshop pretends that
there’s a straight path segment between the endpoints. The fill is added
to the active layer in the Layers panel. If a shape layer or a type layer is
selected in the Layers panel, the Fill Path button isn’t available. You can
see filled (and stroked) paths in Figure 11-18.

Figure 11-18: Think about whether you want to stroke first (left) or fill first (right).
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1~ Stroke Path: Click a path in the Paths panel and then use this button to
add a band of the foreground color along the course of the path. Most
often, you can think of it as painting the path itself with the Brush tool. If
you have a different brush-using tool active in the Toolbox (Clone Stamp,
Healing Brush, Dodge, Burn, Eraser, and so on), the path is stroked with
that tool. Like a fill, a stroke is added to the currently active layer in the
Layers panel. You can’t stroke a shape layer path. You can, however,
duplicate such a path and stroke the copy on another layer. Take a look
at Figure 11-18 to see how stroking and filling differ.

1~ Selection from Path: When you have a path selected in the Paths panel,
you click this button, and voila! An instant — and very precise — selec-
tion is at your disposal. You can create a selection from any path. If you
want to add feathering to the selection, use the Paths panel menu com-
mand Make Selection rather than clicking the Selection from Path button.

1~ Path from Selection: You can create a work path from any selection
simply by clicking this button. If the path isn’t as accurate as you'd like,
or if it’s too complex because it’s trying to follow the corner of every
pixel, use the Paths panel menu command Make Work Path and adjust
the Tolerance setting to suit your needs.

1~ Create New Path: You'll likely use this button primarily to duplicate an
existing path. Drag any path to the button, and a copy is instantly avail-
able in the Paths panel. When you click this button, you're not creating
(or replacing) a work path but rather starting a new saved path.

1~ Delete Path: Drag a path to the Delete Path button or click the path and
then click the button. Either way, the path is eliminated from the panel
and from your artwork.

The order in which you stroke and fill a path can make a huge difference in
the appearance of your artwork. The stroke is centered on the path, half
inside and half outside. The fill extends throughout the interior of the path. If
you stroke a path and then add a fill, the fill covers that part of your stroke
that’s inside the path. As you can see in Figure 11-18, that’s not always a bad
thing. (Both paths are visible for comparison purposes — normally only one
path is active at a time.)

Keep in mind that Photoshop doesn’t really create vector objects. If you
stroke or fill a path and then edit the path itself, the stroke and fill don’t move
with the path — they stay right where they are, as pixels on a layer. If you're
used to working with vectors in Illustrator, this can be a nasty surprise.
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Sometimes the easiest and fastest way to create a complex path is to make a
selection and convert the selection to a path. You might, for example, click
once with the Magic Wand and then click the Selection from Path button at
the bottom of the Paths panel. Remember to rename the path to save it!

Customizing Any Path

Photoshop gives you a lot of control over your paths, not just when creating
them, but afterward, as well. After a path is created, you can edit the path
itself. While the path is active in the Paths panel, the Edit>Transform Path
commands are available, giving you control over size, rotation, perspective,
skewing, and even distortion. But there’s also much finer control at your fin-
gertips. You can adjust anchor points, change curved path segments, add or
delete anchor points, and even combine multiple paths into compound paths,
in which one path cuts a hole in another. (Think donut.)

Adding, deleting, and moving anchor points

Photoshop provides you with a number of tools with which to edit paths
although you might never use a couple of them. Consider, for example, the
Add Anchor Point and Delete Anchor Point tools shown in Figure 11-19. Now
take a look at the Option bar’s Auto Add/Delete option. With the Pen tool
active, you automatically switch to the Delete Anchor Point tool when over
an anchor point, and automatically switch to the Add Anchor Point tool when
the cursor is over a path segment. Smart tool, eh? The Convert Point tool, on
the other hand, can be invaluable . . . or valuable, at least. Click a smooth
anchor point to convert it to a corner anchor point. Click-drag a corner
anchor point to convert it to a smooth point.

Nested in the Toolbox with the Path Selection tool (which you use to select
and drag a path in its entirety), the Direct Selection tool lets you alter individ-
ual path segments, individual anchor points, and even the individual direc-
tion lines that control curved path segments.

When you click an anchor point with the Direct Selection tool, you can drag it
into a new position, altering the shape of the path. If it’s a smooth anchor
point, clicking it with the Direct Selection tool makes the point’s direction
lines visible (as well as those of immediately neighboring smooth anchor
points).

241
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Figure 11-19: Photoshop gives you every tool you need to edit vector paths.

The Direct Selection tool has no user-definable options on the Options bar.
It’s a pretty straightforward, no-nonsense tool that follows a few simple rules
of behavior (which you can see illustrated by pairs of “before” and “after”
paths in Figure 11-20):

~ Drag a path segment. Drag a path segment with two corner anchor
points, and you drag those points along with you. If the path segment
has one or two smooth points, you drag the segment (reshaping the
curve), but the anchor points remain firmly in place. Note in Figure 11-20
(upper left) that when you drag a curved path segment, the adjoining
direction lines change length, but they retain their original angles.

1 Drag a corner anchor point. Click a corner anchor point and drag, and
the Direct Selection tool pulls the two adjoining path segments along
with it. As you can see in Figure 11-20 (upper center), the other two
anchor points (and the path segment between them) are unchanged.
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Figure 11-20: The pairs of paths are shown in color for illustrative purposes only —
paths are generally black when active.

1~ Drag a smooth anchor point. When you drag a smooth anchor point, all
four of the direction lines associated with the path segments on either
side retain both their lengths and their angles. The direction lines don’t
change; only the curved path segments connected at the smooth anchor
point are altered. In Figure 11-20 (upper right), the path continues to
flow smoothly through the anchor point, even as the point moves.

1~ Drag a smooth point’s direction line. Dragging a direction line changes
the curves on either side of the anchor point so that the path still flows
smoothly through the point. (Remember that you click the control point
at the end of a direction line to drag it.) Figure 11-20 (lower left) illus-
trates how the path segments on either side of the smooth point adjust
as the direction line is changed. However, paths don’t always flow
smoothly through a smooth anchor point — not if you use the following
trick!

1~ Option+drag/Alt+drag a direction line. Hold down the Option/Alt key
and drag a smooth anchor point’s direction line, and you’ll break the
flow of the path through that point. With the Option/Alt key, you change
only the path segment on that side of the anchor point, leaving the
adjoining path segment unchanged. In Figure 11-20 (lower right), the
direction line on the left is being dragged without the Option/Alt key. On
the right, adding the modifier key preserves the appearance of the
adjoining path segment.



2 44 Part lll: Creating “Art” in Photoshop

A\\J

You can use the Shift key with the Direct Selection tool to ensure that you're
dragging in a straight line. You can also use the Shift key to select multiple
anchor points before you drag.

Combining paths

As you’ve probably noticed through the course of this chapter, some paths
are very simple (like the paths in the preceding figure), and some paths are
more complex (like the shapes shown earlier in Figure 11-11). Complex paths
are often compound paths: that is, paths that contain two or more paths
(called subpaths) that interact with each other. Think about a pair of circles,
different sizes, centered on top of each other. What if the smaller circle cut a
hole in the middle of the larger circle, creating a wheel (or, depending on how
early you're reading this, a bagel)? Take a look at Figure 11-21.

There are several ways in which two
(or more) paths can interact.
Complete this sentence with terms
from the following list: “The second
path can (fill in the blank) the original
path.”

1 Add to: The areas within the
two subpaths are combined as if [
they were within a single path.

v~ Subtract from: The second path
is used like a cookie cutter to
delete an area from within the
first path. (When you need to
make a bagel, this is the option!)

+~ Intersect with: Only the areas
where the two subpaths overlap
is retained.

Figure 11-21: Two (or more) paths can interact
with each other, creating a compound path,
consisting of two or more subpaths.
v Exclude from: All the area

within both subpaths is retained except where the two paths overlap.

When any shape tool or the Pen tool is active, the Options bar presents you
with four buttons to determine the behavior of multiple paths. (The first path
that you create will always be just a normal path. The buttons don’t come
into play until you add additional subpaths.) Figure 11-22 shows you the but-
tons, tells you which is which, and provides a simple graphic representation
to demonstrate the interaction. The upper-left path is the original, with the
lower-right path showing how each option controls the interaction between
subpaths.
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Figure 11-22: The buttons control how a second path (and any subsequent paths) interact with
your original path.

Tweaking type for a custom font

I want to show you one more little thing you can do with vectors in
Photoshop, a last bit of fun before this chapter ends. Each individual charac-
ter in a font consists of paths. You can convert the type to shape layers (or
work paths) and change the appearance of the individual characters by edit-
ing their paths with the Direct Selection tool.

1. Open a new document in Photoshop.

2. Select 800 x 600 from the Web presets in the Preset menu and then
click OK.

3. Select the Horizontal Type tool in the Toolbox and set the font.

From the Options bar, choose Arial, set the font style to Bold, set the
font size to 72, choose Sharp for anti-aliasing, left-align, and click near
the lower left of your document.

Okay, in all honesty, you can use just about any settings you want — but
if you use these settings, your image will look a lot like mine.

4. Type the word Billiards in your image.

5. Press 38+Return/Ctrl+Enter to end the text editing session.
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6. Choose Layer~> Type->Convert to Shape.

This changes the type layer (editable text on its own layer) to a shape
layer (a layer filled with color, with only those areas within the vector
path visible in the artwork).

7. Activate the Direct Selection tool.
8. Edit the shapes of the Ls and the D to simulate billiard cues.

Drag the uppermost anchor points even farther upward to create cue
sticks.

See the result in Figure 11-23.

B2 I 2EIEE

Figure 11-23: You can convert vector type to shape layers and edit the individual
character shapes with the Direct Selection tool.
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Dressing Up Images
with Layer Styles

In This Chapter

Understanding layer styles
Applying layer styles with the Styles panel
Creating your own styles

Preserving your custom layer style

In artwork and photography, you use shadows and highlights in your image
to produce the illusion of depth. Highlights and shadows lead the viewer
to imagine that a light is falling on parts of a 3D object. You can also use a
shadow or glow to make it appear that some distance exists between

one object in the image and another object behind it.
Photoshop’s built-in layer styles help you add shadows,
glows, and other effects almost instantly.

In this chapter, | explain how transparent areas on
layers enable lower layers to show through and let
your layer styles appear on those lower layers. You
get a good look at the Styles panel and how you use
it to store and apply layer styles, including your

very own custom styles. | then present the all-
important (for layer styles) Layer Style dialog box
and the various effects that you can add with it. I also
show you how to save (and protect) your custom layer
styles.
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What Are Layer Styles?
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A layer style comprises one or
more effects that surround or are
applied to all the pixels on your
layer. Effects that surround pixels
include strokes (thin or thick out-
lines of color), shadows (just like
the one this book is casting right
now on your desk or lap), and
glows (outlines of semitranspar-
ent color). Effects that are applied
to pixels include overlays of color,
patterns, or even gradients. But
Photoshop offers even more,
including the ever-popular Bevel
and Emboss effect, which does a
great job of giving the content of
your layer a 3D look. And, of
course, effects can be used in
combination; check out Fig-

ure 12-1 for some examples. You
can add effects to layers in several
ways, including through the Layer
Style menu at the bottom of the
Layers panel, as shown in Fig-

ure 12-2. [ explain each of the
effects individually later in this

chapter in the section on creating  gjq,re 12-1: Strokes, shadows, overlays, and
your own custom layer styles. bevels are just some of the effects available.

Just so everyone is on the same
sheet of music, when you refer to a
drop shadow or an outer glow or a
color overlay or any one of the other
items shown in the menu in Fig-

ure 12-2, call it a layer effect or
simply an effect.

Figure 12-2: You can add a layer style through
the Layers panel.
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After you apply an effect to a layer or save it in the Styles panel (which I dis-
cuss a bit later in this chapter), it becomes a layer style. A layer style can
include one effect or several effects. The individual layer effects are built into
Photoshop, but you can add or delete layer styles and even create your own.
By the way, Blending Options, at the top of the list in Figure 12-2, isn’t actu-
ally a layer effect, but rather it governs how the colors of the pixels on the
selected layer interact with pixels on layers below. The black dots to the left
of some effects listed in Figure 12-2 indicate that those effects are already
applied to the layer.

Some layer effects, such as drop 0000, 808w
shadows and outer glows, appear
outside the content of the layer. For
those effects to be visible in your art-
work, the layer must have at least
some area of transparent pixels. If
the layer is filled edge to edge, the
effect has no place within the image
to appear because the glow or

shadow would logically be outside  Figure 12-3: Some layer effects need trans-

the image’s canvas. Take alook at a  parent areas on the layer, or they won't appear.
couple of layer style examples in
Figure 12-3.

TN [T i

In the sample on the left, you can imagine that the shadow logically also
appears to the lower right of the object as a whole (as it does in the sample
to the right). However, that’s outside the image’s canvas, so that part of the
shadow doesn’t appear in the artwork.

\‘&N\BEB Keep in mind that every layer in an image has the same number of pixels —
Ny but some of those pixels can be transparent. When a layer has areas of trans-
parency, layers below in the image can show through. In the two examples in
Figure 12-3, the yellow background layer is visible, giving the upper layer’s
shadows a place to fall. (And remember that a layer named Background can’t
have areas of transparency. Convert it to a regular layer by double-clicking
the layer name in the Layers panel and renaming it.) Chapter 10 is full of
information on working with layers.
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Using the Styles Panel

The Styles panel is, by default, nested
with the Color panel and Swatches
panel. Choose Windowr>Styles to
make it visible. This panel, which you
see with its menu open in Figure 12-4,
is where you find and store layer
styles and is the easiest way to apply
a layer style to your active layer.

To apply a layer style via the Styles
panel, make the target layer active by
clicking it in the Layers panel; then
click the style that you want to apply.
It’s truly that simple! To remove a
layer style from the active layer, click
the leftmost button at the bottom of
the Styles panel. You can click the
middle button to save a custom layer
style (which I explain later in this
chapter), and you can drag a layer
style to the Trash icon on the right to
delete it from the panel.

Take a look at the Styles panel menu,
starting from the top and making

STYLES
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Clear SterJ

Create New Style

Delete Style ——

New Style...

Text Only

+ Small Thumbnail
Large Thumbnail
Small List
Large List

Preset Manager...

Reset Styles...
Load Styles...
Save Styles...
Replace Styles...

Abstract Styles
Buttons

Dotted Strokes
Glass Buttons

Image Effects
Photographic Effects
Text Effects 2

Text Effects
Textures

Web Styles

Close

Close Tab Group
T

Figure 12-4: The Styles panel holds your preset
and saved layer styles.

your way down to the bottom. The first command simply adds the style
applied to the active layer to the panel (like clicking the Create New Style

button). (Refer to Figure 12-4.)

In the second section of the menu, you can choose from five different ways to
view the content of the Styles panel. The Text Only, Small List, and Large List
options might come in handy after you create a bunch of custom styles with
names you recognize, but until you become familiar with the styles in the
panel, their names are pretty much meaningless. The Large Thumbnail option
gives you a better view of the effects in the style, but you see fewer styles at a
time in the panel than you can with the default Small Thumbnails view.

The Styles panel Preset Manager command opens the same Preset Manager
that you access through the Edit menu. Use the Preset Manager (discussed at
the end of this chapter) to save custom styles in sets on your hard drive to
protect them from accidental loss.
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The next four commands in the Styles panel menu are what I call “housekeep-
ing commands” because you use them to control the content of the panel:

1~ Reset Styles: The Reset Styles command returns the content of the panel
to its default. You have the option of adding the default set to the cur-
rent panel content with the Append button or replacing the current con-
tent with the selected set by clicking OK.

1~ Load Styles: Use the Load Styles command to add custom styles from
your hard drive (or another location). You can even purchase prepared
sets of layer styles on CD. The set is added to the current content of the
panel automatically.

1~ Save Styles: The Save Styles command lets you save the current content
of the panel as a set of styles. All the layer styles in the panel at the time
are saved in the set.

1~ Replace Styles: Use the Replace Styles command to remove the current
content and then add the selected set.

Below in the Styles panel menu, you can find a list of all the layer style sets
saved in Photoshop’s Presets=>Styles folder. When you select a set from that
list, you have the option once again of appending or replacing the current
content of the panel. (The list in your Styles panel menu might differ from
what’s shown in Figure 12-4.)

The last two commands in the Styles panel menu are used to control the visi-
bility of the panel (Close) and the visibility of the panel and those panels
nested with it (Close Tab Group), by default the Color and Swatches panels.

Creating Custom Layer Styles

You create a custom layer style by applying one or more layer effects to your
active layer. (Once again, remember that you can’t apply layer effects or layer
styles to a layer named Background.) When you have the effects looking just
the way you want them, you can add that new style to the Styles panel and
even save it for sharing with friends and colleagues. Combining multiple layer
effects lets you create complex and beautiful layer styles that change simple
shapes and text into art.
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Exploring the Layer Style menu

In addition to the pop-up menu at the
bottom of the Layers panel (refer to
Figure 12-2), you can apply layer
effects through the Layer=>Layer Style
menu. As you can see in Figure 12-5,
the Layer Style menu has a few more
commands than the menu at the
bottom of the Layers panel.

The ten items in the Layer Style menu
below Blending Options are the actual
layer effects. A check mark to the left
of the effect indicates that it’s cur-
rently applied to the active layer. The
Copy Layer Style and Paste Layer
Style commands come in handy,

but if you're more mouse- or stylus-
oriented than menu-oriented, you’ll
find it easier to add the style to the
Styles panel and click the style to
apply it to other layers. You can also
Option/Alt+drag a layer style from
layer to layer in the Layers panel to
duplicate it. Clear Layer Style is the
equivalent of using the leftmost
button at the bottom of the Styles
panel — it removes all layer effects
from the target layer. The four com-
mands at the bottom of the menu are
worthy of a little special attention:

New
Duplicate Layer...
Delete

Layer Properties...
Layer Style

New Fill Layer
New Adjustment Layer

Layer Mask
Vector Mask
Create Clipping Mask

Smart Objects

New Layer Based Slice

Group Layers

Hide Layers

Merge Down
Merge Visible
Flatten Image

Matting

»

»

>

»
»

»
»
NHEG

2
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Blending Options...

+ Drop Shadow...
Inner Shadow...
Outer Glow...

Inner Glow...

+ Bevel and Emboss...
Satin...

Color Overlay...

Gradient Overlay...
+ Pattern Overlay...
+ Stroke...

Copy Layer Style
Paste Layer Style
Clear Layer Style

CGlobal Light...

Create Layers

Hide All Effects

Scale Effects...
—

Figure 12-5: You can use the Layer Style menu
to apply layer effects and more.

+ Global Light: A number of layer effects are applied at an angle. Drop
shadows, for example, simulate light coming from a specific angle
(which, of course, determines where in your artwork that shadow falls).
You use the Global Light command to set the default angle at which your
effects are applied. Generally speaking, you want the angle to be consis-
tent from effect to effect and from layer to layer in your artwork. There
are exceptions, however, such as the situation shown in Figure 12-6. In
that artwork, the two type layers have shadows receding at different
angles to simulate a light source positioned immediately in front of and
close to the image. (As you can read in the next section of this chapter,
when you use layer effects that are applied at an angle, you have the
option of using or not using the angle in Global Light.)
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Figure 12-6: Sometimes shadows in your artwork shouldn't all use the
Global Light setting.

1~ Create Layers: Sometimes you need to edit a layer effect — say, to con-
trol where a drop shadow falls on the lower layers in the image. The
Create Layers command rasterizes each layer effect (adds it to the
image as a separate layer or layers containing pixels). You can then
erase portions of the new layers, apply artistic filters, or otherwise cus-
tomize each effect layer. Remember that after a layer style is rasterized
with this command, you can no longer edit it through the Layer Style
dialog box, but the original style (if you added it to the Styles panel) is
still available.

1~ Hide All Effects: You can temporarily hide a layer style with the Hide All
Effects command. Alternatively (and more conveniently), you can click
the eyeball icon next to the layer style in the Layers panel to hide the
effects.

1~ Scale Effects: Use the Scale Effects command to uniformly make the
layer style larger or smaller.

Exploring the Layer Style dialog box

The first step in creating custom layer styles is to become familiar with the
individual layer effects. Each of the ten effects available in the Layer Style
dialog box (see Figure 12-7) has its own set of options. Most of the basic
default values are very good starting points: You might need to change only a
color or perhaps adjust a Size, Distance, or Opacity slider. You can, of course,
do lots and lots of customizing for some of the effects.
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Figure 12-7: The Layer Style dialog box has separate options for each layer effect.

In the column to the left in the Layer Style dialog box, you can select a check
box to apply the effect, but you need to click the name of the effect to open
that effect’s options pane. In Figure 12-7, the check marks show that this
particular layer style includes a drop shadow, bevel, color overlay, pattern
overlay, and stroke. The options pane for Bevel and Emboss is visible, as you
can tell by the highlighting in the left column (not to mention the subtle Bevel
and Emboss in bold at the top-center of the dialog box). And in the far right of
the Layer Style dialog box, note the Preview check box (upper right, which
shows what the layer style will look like) and the small sample just below.
That sample shows how your style will look when applied to a square about
55 x 55 pixels.

As you read the descriptions of the various sets of options, keep in mind
some generalities about a few key options that you’ll see a number of times:

1 Color Selection: When you see a color swatch — a small rectangle or
square, usually near the Blending Mode option — you can click it to
open the Color Picker and select a different color.

1~ Noise: When you see the Noise slider, you can add a speckling effect to
help diffuse a glow or shadow.

1~ Contour: Glows, shadows, and the like can be applied linearly, with a
steady fade from visible to not visible. Or you can elect to have that
transition vary with a nonlinear contour. Generally speaking, nonlinear
contours can be great for bevels, but linear is usually best for shadows
and glows unless you intend to create concentric halos.



Chapter 12: Dressing Up Images with Layer Styles 2 5 5

1~ Angle/Use Global Light: You can change the angle for several layer
effects by entering a specific angle in the numeric field or by dragging in
the circular Angle controller. If the Use Global Light check box is
selected, you change all the angles for that layer style.

Layer effects basics

In this section, I explain the basics of each of the ten layer effects, showing
the options available in the Layer Style dialog box for that effect in an insert,
as well as one or more examples. And don’t forget to take a look at the side-
bar, “The four key blending modes.” Later in this chapter, you can read about
the Opacity and the Fill sliders as well as some other advanced blending
options.

Drop Shadow

A drop shadow is a great way to separate the content of one layer from the
rest of the image, as you can see by comparing the two versions of the art-
work in Figure 12-8. In effect, the content of the target layer is copied, con-
verted to black, and placed behind your layer. The blending mode and
opacity determine how the shadow interacts with the layers below. You
decide how much to offset and blur the duplicate with the sliders.
(Remember that this is a layer style, so no second layer is actually added to
your image.) You'll generally want to leave the Contour option of your drop
shadows set to the linear default. As you saw in Figure 12-6, drop shadows
are great with type layers!

ructure
Blend Made: | Multiply |-$i-

Opachty; sm—— 7 [

@ 120 * ™ Use Global Light
x

Angle
Distancs: sl [[5 [P

M Laver knacks Gut Orop Shadow

Figure 12-8: Drop shadows can visually separate the upper layer from the lower layer.
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Inner Shadow

You can do a couple of things with the Inner Shadow layer effect, as you can
see in Figure 12-9. Compare the two sets of options. On the left, a soft, light-
colored inner shadow using the Screen blending mode softens edges. On the
right, a hard inner shadow, using a dark color and the Multiply blending
mode, produces a totally different look. Despite what your eyes might be
telling you, the layer effect is applied to the red shape on the upper layer.

— Inner Shadow - Inner Shadow
— Structure — Structure

Blend Mode: | Screen L@]:

Opadity; =——— o %

-
Angle:@ 120 © @ Use Global Light

Distance; (— px

Blend Mode: = Multiply =] |
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Distance: = ’ls—‘lﬁx

Choke: =@ [35 |x Choke: se—li— 5 %
Size: = Er—— pX Size: @ e px
— Quality — Quality
Contour: m | Anti-aliased Contour: m _ Anti-aliased
Noise: fr———— [ % Noise: @ [ |

Figure 12-9: Inner shadows can be soft or hard, light or dark.

Outer Glow

The Outer Glow layer effect is much like a nondirectional shadow when
applied using a dark color. However, it also has a variety of uses with a light
color and the Screen blending mode. As you can see in Figure 12-10, it has
practical and whimsical uses. (Please remember that in real life, stars do not
appear between the horns of a crescent moon!)

In the Structure area at the top of the Outer Glow options, you can select the
blending mode and opacity, add noise if desired, and select between a color
(click the swatch to open the Color Picker) or a gradient (click the sample to
open the Gradient Editor). You define the size and fade of the glow in the
Elements area. The Technique pop-up menu offers both Softer and Precise —
try them both. And don’t overlook the options at the bottom, in the Quality
area. Although you use Jitter only with gradients to add some randomness,
the Range slider is an excellent way to control the distance at which your
glow is offset. And when you get a chance, play with different contours for an
Outer Glow effect.
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Figure 12-10: An Outer Glow layer effect is a multipurpose layer effect.

The four key blending modes

Photoshop offers over two dozen different
blending modes, many of which you see in the
Layer Style dialog box. You really need only a
few on a regular basis, although it's always fun
to experiment with the others, just in case one
of them gives you a cool effect.

The Multiply blending mode generally darkens.
When working with dark shadows or glows,
choose the Multiply blending mode so that the
layer effect darkens (but doesn’t hide com-
pletely) the pixels on the layers below. The
Screen blending mode lightens. Use Screen
with light glows and other such effects. The
Overlay blending mode is a mix of Multiply
and Screen. When working with patterns that

contain both dark and light colors, you might opt
for Overlay as the blending mode.

Of course you should remember the Normal
blending mode, too! If you want a glow or
shadow to completely block whatever lies
below, choose Normal at 100% opacity. You
might also want to use Normal with a somewhat
lower opacity for a uniform coverage over both
dark and light pixels. And don't be afraid to
experiment — run through the blending modes
(and opacity settings) to see whether you can
tweak that custom style just a little more. (For
more information on blending modes, see
Chapter 10.)
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Inner Glow

The Inner Glow effect offers you the same control as an Outer Glow, with the
impact of an Inner Shadow. As you can see in Figure 12-11, an Inner Glow can
be the base for a neon glow style. (Add an Outer Glow effect, perhaps a
Stroke effect, and there you go!)
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Figure 12-11: Inner Glow offers more control than Inner Shadow.

You can also develop some rather amazing styles by using the Inner Glow and
the Inner Shadow in combination. Using similar Size settings and varying the
colors and blending modes let you overlay a pair of effects in combination.
And when you play with Inner Glow and Inner Shadow in combination, don’t
overlook the Contour variations.

Bevel and Emboss

Perhaps the most fun of all the Photoshop layer effects, Bevel and Emboss is
a quick and easy way to add a 3D look to your artwork. You can apply a Bevel
and Emboss layer effect to text or to buttons for your Web site. You can also
use this effect to create more complex elements in your artwork, examples of
which appear in Figure 12-12.
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Figure 12-12: The Bevel and Emboss layer effect is very versatile.

When you feel the need and have the time to let your imagination frolic
through the fertile fields of Photoshop fun, filters are first, but the Bevel and
Emboss layer effect follows fruitfully. Take the time to play with the various
settings in the Bevel and Emboss pane of the Layer Style dialog box to see
what they do. Add a new layer, create a simple shape (perhaps with one of
the shape tools), select Bevel and Emboss from the pop-up menu at the
bottom of the Layers panel, and experiment — that’s a far more efficient way
to get to know this effect than reading technical explanations of each of the
options. (One caveat: You won’t see any change in your layer with the Stroke
Emboss style unless you're also using the Stroke layer effect.) Don’t forget to
play with the various Gloss Contour presets!

As you read this book, keep an eye out for the Bevel and Emboss layer effect.
When you come across a bevel or emboss effect, such as those shown in
Figure 12-13, you might want to take a moment to remember your experimen-
tation and think about what settings [ might have used.
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Figure 12-13: Many illustrations in this book use the Bevel and Emboss layer effect.

Satin
The Satin layer effect uses the shape of the object to produce a wave-like
overlay. As you can see in Figure 12-14, it’s more effective with type and com-
plex shapes than it is with large plain shapes.

Satin

|3ATIN

Blend Mode:  Multiply @ -

Opacity; es——— o %

Angle: @ 19 2

Distance; =@ [1; px
Size: el— 1 pX

| Anti-aliased
Contour: ot
E Invert

Figure 12-14: The Satin layer effect is very effective with complex shapes.
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Color Overlay

The key to using the Color Overlay layer effect is the blending mode. (See the
sidebar, “The four key blending modes” elsewhere in this chapter.) When you
use Normal, in effect, you paint all the pixels on the layer with the selected
color. To blend the color with the original artwork or other effects (such as
pattern overlays), choose an appropriate blending mode — Multiply with
dark colors, Screen with light colors — or simply experiment with blending
modes. However, using the Color Overlay layer effect with the Normal blend-
ing mode in a custom layer style is a good way to ensure consistency in art-
work, such as buttons and banners for a Web site. Keep in mind, however,
Cover Overlay at 100% opacity and Normal completely hide any Gradient
Overlay or Pattern Overlay effect.

Although you’ll generally find Color Overlay most useful for simple shapes in
artwork and on Web pages, you can certainly use it for more exciting effects,
such as the effects shown in Figure 12-15. The original is in the upper left, and
each example shows the color and blending mode selected. Remember that
when you use a layer effect, you can later return and alter or remove that
change from your image.

Color

Blend Mode: Soft Light ‘.c.!-

Opacity: se—— %

Color

Blend Mode: | Multiply ,733-

: e—
Opacity: |100 |%

— Color

Blend Mode: ' Soft Light [ :! Blend Mode: | Color Burn »-a-}-

Opacity: =2 [100 |% Opacity; =@r—————= [35 %

- Color

Blend Mode:  Qverlay w-‘f!-

Opacity: =@ [100 |%

Figure 12-15: Color Qverlay can produce subtle or dramatic changes in your artwork.
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Gradient Overlay

Unlike the Gradient Map adjustment (see Chapter 6), which applies a gradi-
ent to your image according to the tonality of the original, the Gradient
Overlay effect simply slaps a gradient over the top of the layer content, using
the blending mode and opacity that you select. You also control the shape of
the gradient, the angle at which it’s applied, and the gradient’s scale (see
Figure 12-16). And don’t forget that a Gradient Overlay using the Normal
blending mode and 100% opacity will hide any Pattern Overlay effect.

| Gradient Overlay
Gradient

Blend Mode: ' Multiply »B"

Opacity: we—— TG |%
Gradient: N W [ Reverse

QQ ( Style: Diamond _[#) @ Align with Layer “ ’ éh
u \ .4 i Ang\e:@\ﬁ‘

2 Za S ﬂl@
J) 5"3“

Blend Mode: Hard Light »-G-]

Opacity: =150 %
Gradient: [T IS [ Reverse Gradient: [l R | Reverse
Style: Radial %) @ Align with Layer Style: [ Reflected &) @ Align with Layer

Angle:@ 20 . Mg\er@ 120 |°
Scale! m—t— (100 |%

- Gradient Overlay
Gradient

Blend Mode: ' Normal »-v:v]
Opacity: --|1DD %

Scale; e——sl—— |75 |%

Figure 12-16: In keeping with its name, the Gradient Overlay effect overlays a gradient.

When working with gradients, you click the triangle to the right of the gradi-
ent sample to open the Gradient panel. You directly click the gradient sample
itself to open the Gradient Editor.

Pattern Overlay

Like the Color Overlay layer effect, Pattern Overlay relies on the blending
mode and opacity settings to determine how the artwork (pattern) that it
overlays interacts with your original artwork. As you see in Figure 12-17, you
can scale the pattern, align it to the upper-left corner of your image (with the
Snap to Origin button), and link the pattern to your layer so that the appear-
ance of your artwork doesn’t change as you drag the layer into position. Click
the triangle to the right of the sample pattern to open the Pattern panel and
then select a pattern.
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Figure 12-17: The Pattern Overlay layer effect adds texture to your layer's artwork.

Stroke

If you've read this chapter to this point, you've seen the Stroke layer effect
for several pages now. Each of the insets from the Layer Style dialog box in
the preceding figures has a one-pixel black Stroke layer effect applied. Adding
that tiny stroke helps set off the dialog box from the background.

Not only is Stroke a handy and practical production tool, but it’s a wonderful
creative effect, too, especially when you use it in conjunction with other layer
effects. For example, a stroke of a contrasting color is a great way to redefine
the edge of your object when working with an outer glow and an inner
shadow. (In the Stroke effect’s options, remember that you click the color
swatch to open the Color Picker.) A simple stroke can convert even the
plainest text into an eye-catching statement. And don’t forget that without
the Stroke effect, the Bevel and Emboss effect’s Stroke Emboss option does
nothing for your artwork. Figure 12-18 has a few examples of layer styles,
including a Stroke effect.
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Figure 12-18: The Stroke effect can stand alone or be used with other layer effects.

Opacity, fill, and advanced blending
In the Blending Options area of the Layer Style dialog box and the upper-right
corner of the Layers panel, you see a pair of adjustments named Opacity and
Fill, as shown in Figure 12-19. Both have an impact on the visibility of the con-

tent of your layer.

Layer Style

Styles

— Blending Options

o 1 Blandi

o

Blending Options: Default

) Drop Shadow
O Inner Shadow
[ Quter Glow
[ Inner Glow
[ Bevel and Emboss
[ Contour
[ Texture
[ Satin
! Color Overlay
) Gradient Overlay
I Pattern Overlay
[ Stroke

Blend Mode: ' Normal B
. —
leacIty. 21100 ﬂ

( cancel )
[ New Style...

E Preview

— Advanced Blendi

| Fill Opacity: '—@m%l

Channels: MR MG @B
Knockout: None 8

200
() Blend Interior Effacts  L2YE'S . L7
¥ Blend Clipped Layers Normal Opacity:| 1005 Hl
ETransparencv Shapes Lock:[T[#[E]@ Fill: 100% b
"I Layer Mask Hides Effi— Blsitlal | Hl
| Vector Mask Hides Ef
- Layer 1
— Blend If: ' Gray - Ye
This Layer: 1] 255
N
o & Background 8
Underlying Layer: (i} 255
o ESL N I AR
a T

Figure 12-19: The Opacity and Fill sliders control visibility of a layer.
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When you reduce the Opacity setting for the layer, you make the layer con-

tent and any layer style partially or completely transparent. Reducing the Fill

slider changes the opacity of the pixels on the layer but leaves any layer

effects fully visible. When might you want to use the Fill slider? The first thing
that comes to mind is when creating the ever-popular Glass Type technique,
which produces see-through text that’s perfect for your copyright notice on

any image:

1. Add some text to an image with the Type tool.

This is a wonderful trick for adding your copyright information to

sample images because everyone can see the image, but no one can use
it without your permission. Start by adding your copyright information

or perhaps the word Sample.

2. Apply a layer style to the type layer.

A bevel, a thin black stroke, and perhaps an inner shadow or white outer

glow make an excellent combination. (Select the individual effects as

described earlier in this chapter.)
3. Reduce the Fill slider to 0%.

Adjust Fill at the top of the
Layers panel or in the Layer
Style dialog box’s Blending
Options pane. You can click and
type in the Fill field, click the
arrow to the right of the field
and drag the slider, or simply
click the word Fill and drag to
the left. The type layer disap-
pears, but the layer effect
remains.

You can see all three steps in
Figure 12-20.

The Blending Options pane of the
Layer Style dialog box offers you a
number of other choices in the
Advanced Blending area, as shown in
Figure 12-21.

Other than the Fill Opacity slider,
you’ll probably never change the
Advanced Blending options from
their default settings, but you might
be curious about what they do.
Here’s a short explanation of each:

Figure 12-20: In some cases, using the Glass
Type effect makes the text more visible.

— Advanced Blending
ot Tauye AP
Fill Opacity: —™*[100 |%
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Knockout: | None @

| Blend Interior Effects as Group
@ Blend Clipped Layers as Group
Iﬁ Transparency Shapes Layer
"I Layer Mask Hides Effects

| Vector Mask Hides Effects

Figure 12-21: You find Advanced Blending
options on the Blending Options pane of the
Layer Style dialog box.
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1 Channels: Clear one or more of the color check boxes in the Advanced
Blending area to hide the layer’s content in that color channel. Clear the
R check box, for example, and you hide the target layer in the Red
channel.

+ Knockout: You can use the content on the target layer to create trans-
parency on lower layers. The top layer becomes transparent as do the
layers below every place that the upper layer had visible pixels. (I think
of it as a “cookie cutter” effect.) If you want to restrict the effect, use the
Shallow option, and the knockout extends only to the lowest layer in
your layer group. The Deep option knocks out to the Background layer
(or to transparency if your image doesn’t have a background layer).

+~ Blend Interior Effects as Group: You can blend the Inner Glow, Satin,
and your overlay effects before the layer as a whole is blended with
lower layers. Use this option if it seems your layer effect’s blending
mode is being canceled out by the layer’s own blending mode.

1~ Blend Clipped Layers as Group: If you have layers clipped together (see
Chapter 10), you can elect to use the base layer’s blending mode for all
the layers or let each layer interact independently. You generally want to
leave this check box selected.

~ Transparency Shapes Layer: Another option that you’ll almost always
want active, Transparency Shapes Layer restricts the layer style to the
visible pixels on the target layer. If, for example, you're working with a
small rounded rectangle and a Color Overlay layer effect, clearing the
check box fills the entire layer — not just the rounded rectangle — with
color.

1~ Layer Mask Hides Effects: If the target layer’s visibility is controlled
with a layer mask (see Chapter 8), you can opt to have the layer style
hidden by the mask, too. You can also use a layer mask to hide just the
layer style with this option — say, when you need to make sure that
your drop shadow doesn’t fall where it shouldn’t. Simply create a layer
mask that hides those areas where you don’t want the style visible and
mark the Layer Mask Hides Effects check box.

1~ Vector Mask Hides Effects: This option uses a layer’s vector mask in
exactly the same way that the Layer Mask Hides Effects option uses a
layer mask. (Remember that a vector mask is a path that determines
which areas of a layer are visible — see Chapter 11 for information on
creating paths.)

If you have an image with a plain white (or plain black) background, you can
make that background disappear with the Blend If sliders (see Figure 12-22).
In the Layers panel, double-click the layer name Background and rename the
layer. At the bottom of the Layers panel, click the second button from the
right to add a new layer. Move the new layer below the original layer. With
the original layer active, open the Blending Options pane of the Layer Style
dialog box and drag the upper-right Blend If slider control to the left until the
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background disappears. As the white background disappears, the checker-
board transparency grid becomes visible. Press 8+E (Mac)/Ctrl+E (Windows)
to merge the layers and retain the now-transparent background.

® O O ¥ ©0080064_MED.tIf @ 33.3% (RGB/8#) © O O ¥ ©0080064_MED.tIf @ 33.3% (Layer ...

[ Layers x |

Narmal

o | b @

;
® w o

s~ O[@]alal3 e I AR
— e - ———
33338 | 9)] /| 3333 |
~slend if:[ Gray 19
This Layer o 251

| 1

-

Underlying Layer: o 255 (R

- &y

©1998 PhotoSpin, PhotoSpin image #0080064
Figure 12-22: Make a white background disappear with the Blend If sliders.

Saving Your Layer Styles

Creating custom styles takes some time and effort. Saving the styles means
that you don’t have to spend time re-creating the style. Save your styles not
only in the Styles panel but also on your hard drive.

Adding styles to the Style panel

After you have your layer style looking just right, you can add it to the Styles
panel. From the Styles panel, you can apply your custom style to any layer
(except, of course, layers named Background) in any image with a single click.
You simply make the target layer active in the Layers panel by clicking it;
then click your custom style in the Styles panel.

To add your style to the Styles panel, you must first create it. Select a layer in
the Layers panel, open the Layer Style dialog box, and select the layer effects
and options. Click the New Style button to save the style or, after clicking OK
in the Layer Style dialog box, click the middle button at the bottom of the
Styles panel (see Figure 12-23). Then, in the New Style dialog box that
appears, assign your custom style a name and click OK. If desired, you can
also elect to save the target layer’s blending mode as part of the layer style.
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Figure 12-23: Click the button at the bottom of the Styles panel to save your custom style.

Preserving your layer styles

Adding your custom styles to the Styles panel makes them available day in
and day out as you work with Photoshop. However, should you ever need to
replace the Preferences file (see Chapter 3) or reinstall the program, all your
custom styles are wiped from the Styles panel. To make sure that you don’t
accidentally lose your custom styles, create and save a set of styles, which
you can then reload into the panel whenever necessary.

The Styles panel menu offers the
Save Styles command (refer to Fig-
ure 12-4), which lets you save all the
styles currently in the panel as a set.
However, for more control — to actu-
ally select which styles you want in
your set — use Photoshop’s Preset
Manager (see Figure 12-24). You can
open the Preset Manager from either
the Styles panel menu or through the
Edit menu. (Make sure that you retain
the . asl extension in the filename so
that Photoshop recognizes the file as
a set of styles!)
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Figure 12-24: Use the Preset Manager to make
sure your custom styles are safe.
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As you can see in Figure 12-24, you use Preset Manager to save many kinds of
custom bits and pieces. And use it you should! Shift+click to select a series of
items or 3 +click/Ctrl+click to select individual items; then click the Save Set

button. Give the set a name (again, with the . as1 file extension), pick a loca-
tion, and click OK.

Saving sets of styles, brushes, custom shapes, and the like in the Photoshop
Presets folder adds those sets to the various panels’ menus. That makes it
quite easy to load the set into the panel: Just choose the set from the panel
menu. However, you should also save a copy of the set someplace safe, out-
side the Photoshop folder, so it doesn’t accidentally get deleted when you
upgrade or (horror!) reinstall.
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13

Giving Your Images
a Text Message

In This Chapter
Testing your type techniques

Creating paragraphs with type containers
Shaping up with Warp Text and type on a path

u n croquis vaut mieux qu’un long discours. Or, as folks often paraphrase
Napoleon, “A picture is worth a thousand words.” But sometimes in
your Photoshop artwork, nothing says Bob’s Hardware quite like the very
words Bob’s Hardware. A picture of a hammer and a picture of a nail — per-
haps toss in some nuts and bolts — all are great symbols for your client’s
logo. However, you also need to give Bob’s customers a name and
an address so they can actually spend some money, which
goes a long way toward helping Bob pay you.

For a program that’s designed to work with photo-
graphic images, Photoshop has incredibly powerful
text capabilities. Although it’s not a page-layout pro-
gram such as Adobe InDesign or a word-processing
program such as Microsoft Word, Photoshop can
certainly enable you to add lines or even para-
graphs of text to your images.

Photoshop offers you three categories of text:

+~ Point type is one or more lines of text, comparable
with the headlines in a newspaper or the text that you
add to, say, a Bob’s Hardware advertisement. Click with a
type tool to add point type.

1~ Paragraph type consists of multiple lines of text. Like in a word-processing
program, a new line is started whenever your typing reaches the margin.
Drag a type tool to create paragraph type.
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1~ Warp type and type on a path are typically single lines of type that are
bent, curved, or otherwise distorted as a special effect. Use the Option
bar’s Warp Text feature or click with a type tool on a path.

In this chapter, I discuss the tools and panels that you use to add text to an
image, how to add paragraphs and columns of text (as you might use in a
brochure or booklet), and even how to make your type bend and twist along
paths.

Making a Word Worth a Thousand Pixels

To control your work with text, Photoshop offers you four tools, the Options
bar, the Character and Paragraph panels, and several options in the
Preferences dialog box (both in the Type section, visible in Figure 13-1, and in
the Units & Rulers section). By default, the Character and Paragraph panels
are hidden; because you can make the major type-related decisions (such as
font style and alignment) right from the Options bar, that’s generally fine. You
might need to show the panels if you're doing some fine-tuning of the text
appearance. When you need the panels, you can show them by clicking the
panel icons highlighted with the red box in Figure 13-1.
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Figure 13-1: Photoshop gives you lots of tools for working with text.
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As you can see in Figure 13-1, the Font menu actually shows a preview sample
of the font styles so that you don’t need to memorize the appearance of all
your various type faces. (The content of your font menu is sure to vary from
that shown here!) And you can choose Preferences>Type to select from five
different sizes for the font preview.

Type can be informative or decorative or both. You can use the type tools to
add paragraphs of text or a single character as an element of your artwork.
(In Chapter 11, you can even see how to make custom shapes from your vari-
ous symbol fonts.) The text can be plain and unadorned or elaborately
dressed up with layer styles, such as drop shadows, glows, bevel effects, and
other effects that you apply to make the layer content fancier. (Layer styles
are discussed in Chapter 12.) However you use it, text can be a powerful ele-
ment of both communication and symbolism. Take a look at Figure 13-2, in
which [ use the Type tool to add the binary code to the left and even the
musical notes below.

Figure 13-2: You can also use type as symbolic or decorative elements.

But before you add any text to your artwork, you need to have a good handle
on the various type tools, panels, menus, and options available to you. I start
with an introduction to Photoshop’s type tools.
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A type tool for every season, or reason

Photoshop offers four type tools — or, perhaps more accurately, two pairs of
type tools — that assist you with adding text to your images. The Horizontal
Type tool and the Vertical Type tool (the first pair) create type layers, which
show up as special layers in the Layers panel that enable you to later re-edit
the text that you put there. The Horizontal Type Mask tool and the Vertical
Type Mask tool (the second pair) make selections on the active layer, just as
if you had used the Rectangular Marquee or Lasso tools (as I describe in
Chapter 8).

In addition to that glorious advantage of being able to easily correct acciden-
tal misspellings, creating and using type layers offer a number of other advan-
tages. You can

1~ Apply layer styles to type layers to fancy them up. For example, try a
simple Inner Bevel or Drop Shadow effect to make the words leap from
the background.

1~ Adjust type layer blending modes and opacity. Doing this can help you
achieve a unique integration with the artwork’s other elements or back-
ground.

1 Produce extraordinarily crisp and clean type on the page. When print-
ing with a laser printer (or other PostScript device), the text on type
layers prints beautifully.

Until the image is flattened or the type layer is merged or rasterized (con-
verted to pixels), you can change any type attribute, such as the spelling,
font, layer styles, opacity, and blending modes as I show in Figure 13-3.

You automatically gain the advantage of using type layers when you use the
Horizontal Type or Vertical Type tools to add text to your images in
Photoshop. (You can spot a type layer in the Layers panel easily. The layer
shows a T instead of a preview for the layer thumbnail.)

Whether you're adding a simple “© Peter Bauer” (yeah, okay, use your own
name if you want) to an image or a couple of columns of text to a brochure,
you'll generally use the Horizontal Type or Vertical Type tools. But when, you
might ask, would you ever need to use the type mask tools? Perhaps never. If
you ever need a selection in the shape of your text, though, you can manage
that trick by adding a type layer and then 3+clicking (Mac) or Ctrl+clicking
(Windows) the type layer’s thumbnail in the Layers panel. Voila! You're pre-
sented with a text-shaped selection, and you still have an editable type layer
that you can hide and save, just in case.
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Figure 13-3: When you have type layers, you have the flexibility to make changes.

That, of course, doesn’t answer the questions of why you might want a text-
shaped selection in the first place, why type mask tools even exist, or why
the sky is blue. Although the third question is probably better answered in a
book named Skies For Dummies, here are a number of reasons to use a type
mask tool:

1~ Stroke: You can stroke a selection, which adds a line of color along the
path of the selection. With a type-shaped selection, this gives you a type-
shaped line of color. Stroke a selection with the menu command Edit=>
Stroke.

v~ Fill: You can fill that selection with color, a gradient, or even a pattern
with the Edit=>Fill command.

+~ Delete: You can delete that selection from an existing area of color, cre-
ating a type-shaped hole in the color or layer. | chopped the words in
Figure 13-4 from the wrench-shaped sign with a text-shaped selection
made with the Horizontal Type Mask tool.
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Figure 13-4: Use type mask tools to quickly and easily make text-shaped selections.

Whether working with type layers or
creating type masks, you have the
option of using either horizontal or
vertical type. The difference between
type that is set vertically and the
more common horizontal type rotated
90 degrees is illustrated in Figure 13-5.
The figure also shows that when you
add text with a type mask tool, you
see the characters cut out of a red
overlay (top right in figure); when
done, you see the traditional march-

ing ants selection border (bottom Figure 13-5: Vertical type stacks the individual
right). Chapter 8 gives you more infor- characters. You can rotate horizontal type for a
mation on working with selections. different look.

You can select type options before adding text to the image, or you can
change your options afterward. When you make the type layer active in the
Layers panel — but haven’t yet selected any text in your image — any
changes that you make are applied to all the text on the layer. You can also
click and drag to select some of the text on the layer and make changes to
only those characters or words.
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When you’re done adding or editing text, you can end the editing session in
any of a number of ways:

v~ Click the check mark button (or the Cancel button) on the Options bar.
v~ Switch to a different tool in the Toolbox.
” Press 38+Return or Ctrl+Enter.

v~ 8+Shift+click or Ctrl+Shift+click to finish that type layer and start a new
type layer.

What are all those options?

Here you are, the proud owner of the world’s state-of-the-art image editor,
and now you’re adding text, setting type, and pecking away on the keyboard.
You're faced with a lot of variables. Which options are you going to need all
the time? Which ones are you going to need now and then? Which ones can
you ignore altogether? Read on as I introduce you to the various text and
type variables, and toss in a few general guidelines on which options are
most (and least) frequently required.

Take a look at Figure 13-6, in which you can see (in all their glory) the most
commonly used text attributes, all of which are available to you from the
Options bar whenever a type tool is active.

Font Family _ Type Color _
(click to open the font menu) (click to open the Color Picker)
Tool Presets Font Size
(click to open the (click to select or Align Align Warp
Tool Presets palette) click-drag to scroll) Left Right Text
[T' N | "B o, B AE 3 o, B [E 1 |
|1 ) el | | )’ iStom .
Orientation Font Style Anti-Aliasing  Align Palettes
(click to switch (click to select (clickto select) Center  (click to toggle
between from the styles visibility of the
horizontal and available for the Character and
vertical type) selected font) Paragraph panels)

Figure 13-6: Use the Options bar to quickly and easily change the primary attributes of your text.
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You can change the following text attributes via the Options bar, which is
usually available at the top of your screen:

1~ Tool Presets: The Tool Presets
panel enables you to select a
predefined set of options that
you've already saved. Say, for
example, that you always use
the same appearance for head-
lines in a recurring project and a
different appearance for the
body type. Set up each as a
preset and then activate all the
options with a single click. (See

Chapter 3 for more detailed ) Tl | Tfoe |
information on tool presets.) . - I
1~ Orientation: The Orientation (g v 18 23 swooms 18)

button toggles existing type
layers between horizontal and
vertical. Regardless of what Figure 13-7: Select specific characters, such
type is selected, the entire type s the words SELECTING THEM, to change
layer is flipped when you click ~ Some or make no selection to change all.
this button. (The button is

grayed out when no type layer is active in the Layers panel.)

+~ Font menu: Click the triangle to the right of the Font Family field to open
the Font menu, showing all your installed fonts in alphabetical order. You
can also click in the field itself and use the arrow keys to switch fonts. If
you select some type with a type tool first (as shown in Figure 13-7),
using an arrow key automatically applies the change to the selected char-
acters. If no characters are selected, you change the entire type layer.

~ Font Style: When a font has multiple styles built in, you can choose a
variation of the font from the Font Style menu. Styles include Regular
(or Roman), Bold, Semibold, Italic, Condensed, Light, and combinations
thereof (as you see in Figure 13-8). Many fonts, however, have no built-in
styles.

+~ Font Size: You can select a font size in three ways: by typing a number in
the Font Size field, by clicking the triangle to the right of the field and
selecting a font size from the pop-up menu that appears, or by clicking
the TT icon to the left of the Font Size field and then dragging left or right
to change the value in the field. Font size is generally measured in points
(1 point = 1/72 inch), but you can elect to use pixels or millimeters.
Make the units change in Photoshop’s Preferences (choose Preferences=
Units & Rulers).
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1~ Anti-Aliasing: Anti-aliasing soft-
CHARACTER |
ens the edges of each charac- ; = ==
o Myriad Pro | . %d d Srel
ter so that it appears smooth Com == Bg:t EO densed = =
. |12 I T tali
on-screen. As part of this gaf 4 % Cfndeﬂos:dense S Sa’n'::,ee
. . . . W | !
process, anti-aliasing hides the | = -———= Condensed Italic Sample
corners of the individual pixels | IT 2 | Semibold Condensed ~ Sample
with which the text is created. | 41" | 0 Semibold Condensed talic :n""t
When outputting to a laser [[T] P ®[8 5o Condensed italic  Sanple
printer or other POStSCl’ipt Cengish: UsA 4] Black Condensed Sample
device anti—aliasing isn’t Black Condensed Italic Sample
) :

. . . Light Sample
required. It is, however, critical Light ltalic Ems
when printing to an inkjet or  Regular Sample
when producing Web graphics. Italic Sample

. Semibold Sample

Generally, the choices here Smihal Gl Sample
have little difference among Bold Sample
them (other than None, of Bold ltalic Sample
. Black Sample

course). Smooth is a good e S

choice unless your text begins
to look blurry, in which case
you should switch to Crisp.
Use the Strong option with
very large type when the indi-
vidual character width must be preserved.

Figure 13-8: Some fonts have many styles
available.

1~ Alignment: The three alignment choices on the Options bar determine
how lines of type are positioned relative to each other. The buttons do a
rather eloquent job of expressing themselves, wouldn’t you say? Note:
Don’t confuse the term alignment with justification, which straightens
both the left and right margins (and is selected in the Paragraph panel).

1~ Type Color: Click the color swatch on the Options bar to open the Color
Picker and select a type color. You can select a color before adding text,
or you can change the color of the text later. If you start by selecting a
type layer from the Layers panel, you’ll change all the characters on that
layer when you select a new color in the Color Picker. Alternatively, use
a type tool to select one or more characters for a color change, as you
can see in Figure 13-9.

1 Warp Text: Warp Text, which I discuss later in this chapter, bends the
line of type according to any number of preset shapes, each of which
can be customized with sliders. (The text in Figure 13-9 uses the Arc
Lower warp style.) Keep in mind, however, that the Warp Text feature
isn’t available when the Faux Bold style is applied through the Character
panel. (I talk about faux styles later in this chapter.)
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tth (1aRas.,

can he individually

Figure 13-9: Select any individual character and change its font, color, size, or any other

attribute.
<MBER Each character in a type layer can have its own attributes. Click and drag
X\
& over one or more characters with a type tool and then use the Options bar or

Character panel to change the text attributes. Color, font, style — just about
any attribute can be assigned, as you saw in Figure 13-9.

<P Like many word-processing programs, you can select an entire word in
Photoshop by double-clicking the word (with a type tool). Triple-click to
select the entire line. Quadruple-click to select the entire paragraph. Click
five times very fast to select all the text.

Taking control of your text with panels

For incredible control over the appearance of your text, use the Character
and Paragraph panels. In addition to all the text attributes available on the
Options bar, the panels provide a wide range of choices. With them, you can
customize the general appearance of the text or apply sophisticated typo-
graphic styling.

The Character and Paragraph panels can be shown and hidden by using the
Panels button on the Options bar or through the Window menu. By default,
the two panels are nested together, so choosing Window=>Character or
Windowr>Paragraph makes both panels available.
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You can use the Character panel to edit a single selected character, a series
of selected characters, or the entire content of a type layer. Figure 13-10
shows what you face when “building character” using this panel.

m- Open palette menu

Font fam”y ——.AdohEJens-:un Pro B ;Reguiar 3—— Font style
Fontsize —T (2w & & [me &1 Leading
Kerning — A [meres [+ &Y Jo #—+— Tracking

Vertical scale —IT [:c0x T [100x — Horizontal scale
Baseline shift —2% (= col- I Text color

Faux styles — |T|7| Tr{m|T[T,| [7]%]

Dictionary —{ L ngisn Usa .'.¢] ag/ smootn :]—— Anti-aliasing

Figure 13-10: More choices than the Options bar!

Unless you're a typographer, a number of the fields in the Character panel
might require explanation:

1 Leading: Leading (pronounced LED-ding rather than LEED-ing and which
refers to the lead strips of metal that typesetters used to place between
lines of type) is the vertical space between lines of text. Generally, you’ll
leave Leading set to Auto. However, you can select one or more lines of
text (select the whole line) and change the spacing. Adding more space
gives the text an airy, light appearance. Reducing the leading tightens up
the text, which enables you to fit more lines in the same area.

1~ Kerning: The space between two characters is determined by the
kerning built into a font. You can, however, override that spacing. Click
with a type tool between two letters and then change the setting in the
Kerning field to change the distance between the letters. You might, for
example, want to reduce the kerning between a capital P and a lower-
case o to tuck the second character protectively under the overhang of
the taller letter. This can produce a cleaner and better-connected rela-
tionship between the two characters.

1~ Scaling: Vertical and horizontal scaling modifies the height and width of
the selected character(s). You'll find this useful primarily for customiz-
ing short bits of type rather than long chunks of text.

+~ Baseline Shift: Produce subscript and superscript characters, such
as those used in H,0 and E = mc?, with the Baseline Shift field. The
Character panel’s Baseline Shift option is best used in conjunction
with a slight reduction in the font size for the specific character(s).
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1~ Faux Styles: Use faux styles to apply the appearance of a character
style, even when they’re not built into the font. From the left, as the but-
tons show, the available faux styles are Bold, Italic, All Caps, Small Caps,
Superscript, Subscript, Underline, and Strikethrough. Generally speak-
ing, if a font offers a specific style in the Font Style menu, you’ll use the
font’s built-in style rather than the faux style.

+~ Dictionary: Photoshop has almost three dozen dictionaries built in.
And, wonderfully or confusingly depending on your personal linguistic
talents, you can assign dictionaries on a word-by-word (or even charac-
ter-by-character) basis. You could, for example, insert a bon mot into the
middle of your text in the language of your choice, assign the appropri-
ate language dictionary, and not have that phrase trigger an alert when
you run a spell check (Editm>Check Spelling).

Type warping isn’t available when Faux Bold is applied to any of the selected
characters. As warped as it might sound, that’s the only faux style that inter-
feres with Warp Text.

If you click in your image window and start typing but no characters appear,
check the Layers panel to make sure no layer is hiding your type layer and
verify that your text color isn’t the same as the background over which
you're typing. If neither of those factors is the problem, it’s likely an invalid
setting in the Character panel. Press the Escape key, and then right-click on
the Type tool icon at the left end of the Options bar and select Reset Tool.

You’ll probably find yourself using certain sets of options pretty regularly in
Photoshop. Luckily for you, you don’t need to make changes on the Options
bar and Character panel every time you want (for example) Arial Bold, 24 pt,
Sharp anti-aliasing, 22 pt leading, and tracking +10. Set up the options once
and then click the Create New Tool Preset button in the panel at the left end
of the Options bar, as shown in Figure 13-11. The next time that you want
those specific text attributes, select the preset from that panel, and you're
ready to type!

[ [T — = | e - E
T Harizontal Type Myriad Raman 24 pt

™ Current Tool Only

Figure 13-11: Tool presets can save you lots of time.
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The Paragraph panel is used, not surprisingly, with paragraph type. The
alignment options that you see in the upper left of the Paragraph panel in
Figure 13-12 can be applied to both point type and type on a path, but you
can usually access your alignment options much more easily from the
Options bar.

) “

PARAGRAPH | =|
= |H— Justification options
— Indent right margin

Alignment options —
Indent left margin —
Indent first line ——"= | |

Space before paragraph —-'= [ve = o | —— Space after paragraph
Hyphen paragraph type —— tiyphenate

Figure 13-12: Most of this panel is only for paragraph type.

\&Q,N\BER [ use the term type container when I discuss the Paragraph panel and para-

5y graph type. Think of it as a rectangular column of text, with the words flowing
from line to line, just as they do when you compose e-mail or use a word
processor. You drag a type tool to create the rectangle, and then you type
inside that rectangle. In contrast, when you simply click a type tool and start
typing, you need to press Return (Mac) or Enter (Windows) at the end of
each line.

You can find specific information about some of these options later in the
chapter (when I discuss paragraph type), but here’s a quick look at the
choices in the Paragraph panel:

1~ Alignment: As the text flows from line to line in your type container, the
alignment option determines how the lines will stack. You can align the
text for a straight left edge, a straight right edge, or you can have the
lines stack centered upon each other. Which option is selected also
determines where text will be placed in relationship to the point in the
image where you click when adding point type.

v~ Justification: Unlike alignment, which balances lines of type based on a
point of origin (left, center, or right), justification equalizes both the left
and right margins of a paragraph of type. As you can see by the icons,
the difference among the four options is the last line in the paragraph.
That last line can be aligned left, centered, aligned right, or stretched to
fit from left to right (called full justification).

1 Indent Margins: Paragraphs of text can be indented from the left margin
or the right. Even if you have only a single word selected, the entire para-
graph is indented. Harkening back to that last term paper you wrote
(whenever that might have been), think in terms of a block quote. You
can also use negative numbers in the Indent Margin fields, which extends
the paragraph beyond the margin.
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+~ Indent First Line: You can indent the first line of your paragraphs
(or extend the first line to the left past the margin with a negative value)
without having to press the Tab key. The option can be set before you
start adding text and is applied to each paragraph.

1~ Space Before/After: When your type container includes multiple para-
graphs (created by pressing the Return/Enter key), you can specify the
distance that’s automatically added between them. Rather than pressing
the Return/Enter key an extra time between paragraphs, set the spacing
in the Paragraph panel.

~ Hyphenation: If you're using justification rather than alignment, I recom-
mend keeping the Hyphenate check box marked. When words at the
ends of lines of justified type aren’t hyphenated, the spacing within the
lines can get rather messy. If you don’t like the look of hyphens along the
right margin, clear the Hyphenate check box.

Keep in mind that after you drag a type tool to create a type container, you
can have as many paragraphs as fit. When you reach the end of a paragraph,
press Return/Enter. A new paragraph is created within the type container.
Consider the type container to be a column of text, such as you'd see in a
newspaper, magazine, or newsletter.

The panel menus — even more options

Like most of Photoshop’s panels, clicking the menu button in the upper-right
corner of the Character or Paragraph panel opens the Panel menu, which
holds a cornucopia of options you probably never need to see. (Consider this:
If it were a really important option, it would be easier to get to, wouldn't it?)

As you can see in Figure 13-13, not all menu options are available for all fonts.
Some of the options are merely command forms of the panel menus (such as
the faux styles), and other options are specific to Japanese fonts. A number
of the options apply only to OpenType fonts, which include a much larger
selection of glyphs (characters) than do other fonts.

Here are a couple of panel menu options with which you should be familiar:

~ Fractional Widths: When selected, Photoshop uses this option to adjust
the spacing between letters on an individual basis. Will you or I spot the
difference? Not with large type, but if you're creating small text (espe-
cially for the Web), clear this option. How small is small? Generally 10 pt
or smaller.

1~ System Layout: Unless you need to match the appearance of text in
TextEdit for Mac or Windows Notepad, leave this option deselected.
When might you need it? When designing interface items for a program
or game.



Chapter 13: Giving Your Images a Text Message

CHARACTER Change Text Orientation

|Adabe jenson pre [ [eola Y v Standard Vertical Roman Alignment |

The 8 Al 3
é"l:a EES Faux Bold

+ Standard Ligatures

ontextual Alternates

IT [oox | T [z | Faux Italic piscretaonary Ligatures
M | comummm | oSS e s

Small Caps b!dswle
[ T]1] Superscript Stylistic Alternates

Fogioh UsA 1) fa e ) Subscript Titling Alternate

. Ornaments
Un_derlme Ordinals |
Strikethrough Fractions |
+ Fractional Widths F

System Layout
No Break
Reset Character

Close
Close Tab Group

Roman Hanging Punctuation |

Justification...
Hyphenation...

+ Adobe Single-line Composer
Adobe Every-line Composer |

Reset Paragraph

Close
. Close Tab Group

Figure 13-13: Not all options are used with all fonts.

1 No Break: When working with paragraph type, you can select one or
more words and choose No Break to prevent them from being hyphen-
ated. You might want to do this with words that are difficult to recognize
when split between two lines.

1 Roman Hanging Punctuation: Found on the Paragraph panel menu, this
option permits the smaller punctuation marks located at the left and
right margins of justified text to hang out past the margins. When
commas and the like are outside the margin, the margin itself has a
cleaner look. Don’t use this option if your layout can’t handle text that
extends past the edges of your column.

1~ Adobe Composer: This choice is actually quite simple: Single-Line
Composer looks at one line of type to determine hyphenation. Every-
Line Composer looks at the entire block of text, generally producing a
more pleasing appearance.
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1~ Reset (panel name): If you're seeing some strange behavior from your
type tools, you might want to invoke the Reset Character and Reset
Paragraph commands. They restore the settings in their respective
panels to the defaults, eliminating any errant setting that might be caus-
ing the problem.

® Remember that you can right-click the tool icon at the left end of the Options
bar and select Reset Tool (or Reset All Tools) to immediately return to the
tool’s default settings. If the Type tool doesn’t seem to be working correctly,
reset and then reselect your options.

Putting a picture in your text

Enough of that heavy stuff for now — time to take a look at one of the coolest
things that you can do with text. Here’s an easy way to create a text-shaped
picture, one that’s fully editable.

1. Using File=>Open, Adobe Bridge, or by double-clicking an image file,
open a photo in Photoshop.

2. If the Layers panel has a layer named Background, double-click the
layer name and rename the layer (as shown in Figure 13-14). If the

BER image has multiple layers, choose Layer->Merge Visible.
\3
‘{g‘x‘ You want to work with a single regular (not background) layer for this

project. Background layers don’t support transparency, and no layers
can be placed below a Background layer.

IEFZEIEAEEI R

New Layer

Name: [Layer 0 | &)
| Use Previous Layer to Create Clipping Mask (" Cancel
P \ J
._.,14 Color:  [_|None E‘

Mode: | Normal ‘-ﬁ Opacity: | 100 B%

Figure 13-14: Renaming a background layer converts it to a regular layer.
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3. Add your type with the Horizontal Type tool.

4. Click the type layer in the Layers panel and drag it below the image
layer.

5. In the Layers panel, Option+click (Mac) or Alt+click (Windows) the
line between the two layers.

The two layers are joined together, as shown in Figure 13-15. When you
clip two layers, the lower layer serves as a mask for the upper layer. The
upper layer is visible only where the lower layer has pixels and adopts
the opacity of those lower-layer pixels.

000 13figl6.psd @ 33.3% (GARDENS, RGB/&#) *

o

LAYERS

" Normal 1% ) opacity: | 100w (ol

i 2 P2 L T
S

33.33% |05 | 1500 pixels x 1000 pixels (300 ppi) B

Figure 13-15: “Clip” the upper layer to the lower layer.

6. Finish the image with a layer style (applied to the lower layer) and
any other artwork that the project requires.

You can click the lower layer in the Layers panel and then click a
favorite layer style in the Styles panel. Or, of course, you can create a
custom layer style by choosing Layer=>Layer Style. In Figure 13-16, you
see a stroke, a bevel, and a slight outer glow applied to the GARDENS
layer.
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Figure 13-16: Add layer styles to the lower layer so that the effects are visible.

Creating Paragraphs with Type Containers
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Although the vast majority of the text that you add to Photoshop artwork is
point type — that is, type that exists on just one or a couple of lines — you’ll
certainly find situations in which you need to use paragraph type in a type
container. The primary advantage of using paragraph type is word wrap.
While you type, the text automatically starts a new line every time it reaches
the margin.

“Why is that a big deal?” you might ask. “I don’t mind pressing the Return or
Enter key at the end of each line.” Ah, but consider the ever-present (when
you type like me) typographical error! What if the very first sentence of your
manual-Return paragraph is missing a word? To insert that word and main-
tain a visually pleasing right margin, you'd need to go back and redo every
line of type. With paragraph type, the content of each line automatically
adjusts as you insert that forgotten word.

The difference between point type to create a column of type and paragraph
type is comparable with the difference between a typewriter and a word
processor. (If you're old enough to remember Wite-Out and Liquid Paper,
raise your hand, but not for very long — I don’t want to tire you out.)

Adding a type container is simple. Click and drag with the Horizontal Type
tool (or, in some rare cases, you might want to use the Vertical Type tool),
and then start typing. The type automatically starts the next line as soon as
you press enough keys to reach the far margin. You can keep typing until you
fill the type container. Press Return or Enter whenever you want to start a
new paragraph within your type container.
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You can also copy/paste text from a word-processing or text-editing program.
You can, for example, open a Microsoft Word document in Word, select the
text that you want by clicking and dragging, and then choose Edit=>Copy to
place the text into the computer’s memory (on the Clipboard). Switch to your
Photoshop document; select a font, font size, and other attributes; drag a
type container; and then choose Edit>Paste (or the assigned keyboard short-
cut) to place your text inside the container. When the text you need already
exists, you not only save time by using copy/paste, but you also eliminate the
possibility of introducing typos.

But what if you have more text than fits in the type container? Unlike
llustrator and InDesign, you can’t link two type containers, enabling the
excess text to automatically move to the next container. Photoshop does,
however, remind you that your text doesn'’t fit by showing you a symbol in
the lower-right corner of the type container’s bounding box — the dashed line
surrounding the type container. As you can see in Figure 13-17, the lower-
right anchor point of the bounding box has a plus sign in it.

3when preparing a layout before the actual text is avallablea
Page layout programs, such as Adobe InDesign, generatej
‘randam nonsense or use prepared placeholder text that you
ran insert into a text frame. It doesn't really matter what theﬁ
placholder text is about, as long as it uses normal-| Iengtl’(
words and sentences so that is looks like real text. That Ietq
you better visualize how the layout will look when the rea‘
hext is later added to the type container.
1 While you could theoretically use a single word, copied and
basted repeatedly to fill the type container, | prefer to copy a
sedmn of text from a document, any document, and theﬂ‘
rag the Type tool to create a container in which | can then
paste For a project such as?hls however, the pasted text
must be non-controversial and not touch on such subjects as

rellglon politics, and the New York Yankees. w I i ne b rea kS at the:l

! You can paste a couple of paragraphs of type repeatedly to

ﬁII your type container, but | suggest that you have at Ieasﬂ at ra n d o m pl -i
lwo complete paragraphs before you start repeating the text """""

over and over again. Generating random text or using a pre~
pared placeholder text file is convenient and works great in a
page layout program. Random text generated by InDeslgn
may appear to be in a foreign language, but is actually just:
honsense, strings of random letters, in random lengths, with
periods at the ends of the “sentences” and line breaks at |he‘

Figure 13-17: A plus sign in the lower-right anchor point warns you that text doesn't fit in the
type container.
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When you have more text than the type container can hold, you have a
number of options:

1~ Enlarge the type container. Click one of the bounding box’s anchor
points and drag to increase the size of the type container. Making a type
container a little bit wider often gives you an extra line or two of text at
the bottom.

1~ Shrink the font. Select the text with a keyboard shortcut (88+A/Ctrl+A)
and select a smaller font size on the Options bar.

1~ Decrease the space between lines. Select the text and decrease the
leading — the amount of space between lines of type — in the Leading
field found in the upper right of the Character panel. By default (the
Auto setting in the Leading field), Photoshop uses an amount equal to
120 percent of the font size. You can often reduce the leading to 1 or 2 pt
larger than the font size before you start overlapping lowercase letters
with descenders (g, j, p, ¢, and y) and uppercase letters on the line
below.

1~ Edit the text. Rephrase the text, using fewer words to convey the same
message. If you're not the author, however, this option might not be
available.

Selecting alignment or justification

Photoshop gives you several options for controlling the appearance of your
margins. In the “Taking control of your text with panels” section earlier in this
chapter, I outline a number of options that you can find on the Paragraph
panel menu. But let me go into more detail about a couple of options that you
have when adding paragraph type.

Perhaps the most important decision (other than font and font size) that you
make when preparing paragraph type is a choice of alignment or justification.
When text is aligned left, the left margin is perfectly straight, and the right
margin is ragged, with each line ending where it ends, without any relationship
to the lines of type above and below. A column of text that’s aligned right has a
clean right margin and a ragged left margin. If you choose center aligned, the
middle of each line of text is centered. Take a look at Figure 13-18 for a visual
comparison.

Unlike alignment, justification gives you straight margins on both sides of the
column of text. The four justification options at the top of the Paragraph
panel differ only in how they treat the last line of a paragraph. As you can see
from the Paragraph panel buttons, the last line can be independently aligned
left, center, or right; or it can be fully justified, spreading the last line from
margin to margin. You shouldn’t use the fourth option unless that last line
(of every paragraph) is rather full because it looks rather strange when just a
couple of words are stretched edge to edge.
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This text is left-aligned.
Left-aligned text has a
straight mar?_in along the
left edge of the text (the
left margin), aligning the
first character of each line.
That is, of course, where
the term left aligned origi-
nates. If you look around
you (not this minute, justin
eneral), you'll see quite a
it of left-aligned text.
Some magazines, many
flyers, and lists of all sorts
are left-aligned. As are the

——

et

When a column of text is Since we're not used to
center-aligned, the seeing a ragged left
middle of each line of margin, right alignment

text is stacked up. Both
the left and the right
margins are ragged.
Well, if each line is ex-
actly the same length,
the margins will appear
to be{ustiﬁed, but that's
not likely to happen.
Center alignment is best
used for such attention-
grabbing purposes as ad-
vertisements. Can you
imagine trying to read an

A

makes the text a bit more
difficult to read. Perhaps '
not as difficult as center- |
aligned text, butaright- |
aligned column of text |
makes the eye jump a bit |
as it moves from line to
line. Use right alignment
for special effect and to
balance certain two- |
column layouts that have a
graphic or other non-text
element between them.

Baragraphs in this very
ook! It's not at all uncom-
mon to have a ragged right
margin. Left-alignment is t might drive you com- column after column of
perfectly acceptable for pletely bonkers!

right-aligned text. | might
many projects. e one of thoserea\de&_}

Figure 13-18: Compare the left and right margins of each column of text.

entire novel with each

] Do not, however, punish
age centered-aligned?

your reader by using

Ready, BREAK! Hyphenating your text

When a word is too long to fit on the current line of text, either it can be
moved to the beginning of the next line (wrapped), or it can be broken into
two parts: one finishing the upper line and the other starting the next line
(hyphenated).

The hyphenation options are for the truly geeky, my-typography-is-my-life types.
The defaults are excellent and can suffice for all but the most precise layouts
(which you should be doing in InDesign or perhaps Illlustrator, anyway).

If you want to fine-tune how hyphen-
ation is applied (or have far too
much time on your hands), select
Hyphenate from the Paragraph
panel menu to open the options
shown in Figure 13-19. The
Hyphenation check box (upper left)
activates/deactivates hyphenation.
The top three fields govern which
words to hyphenate and what limits
to place on the hyphenation. (Think
of the second and third fields as
Hyphenate or cram into the line with-
out hyphenating.) The lower two fields control the appearance of the margin,
limiting the number of consecutive lines that can be hyphenated and the
maximum distance from that margin that a hyphen can be placed.

Hyphenation

Wards Longer Than: |5 | letters [ Cancel )
After First: |2 | letters

Before Last: |2 | letters

Hyphen Limit: |2 | hyphens
Hyphenation Zone i3 ;.)Jca ‘ |

@ Hyphenate Capitalized Words

Figure 13-19: Default hyphenation values give
you good results and a pleasing appearance.



2 92 Part lll: Creating “Art” in Photoshop

Shaping Up Your Language with
Warp Text and Type on a Path

You can change the line along which your type flows either by using the Warp
Text feature or by typing on a path. Type warping uses predefined shapes to
which your type is formed (and can be used with both point and paragraph
type), and typing on a path uses a custom path (and is used only with

point type).

Warping type and placing type along a path are great ways to spice up your
message as long as you don’t overdo it and make the message illegible or dis-
tract from the overall appearance of your artwork. Warp Text is a quick and
easy way to bend text, and placing type on a path is a more complex — and
more controlled — technique.

Applying the predefined warps

With a type layer active in the Layers panel and a type tool selected, click the
button to the right of the color swatch on the Options bar. That opens the
Warp Text dialog box, as shown in Figure 13-20, in which you choose both the
distortion you want to apply as well as the settings.

Warp Text
Style: | 17 Arc E —
@ Horizontal () Vertical

Bend: -33 %

Horizontal Distortion: [0 %

Vertical Distortion: o %

Figure 13-20: The illustration uses two separate type layers, each with its own Warp Text
settings.

Photoshop offers 15 different Warp Text presets, each of which you can cus-
tomize by dragging any of three sliders. Negative numbers can be used, too,
reversing the warp. You can also set the Bend slider to 0 and adjust the lower
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two sliders to create the appearance of depth or perspective for a type layer,
but keep in mind that the Horizontal and Vertical buttons aren’t available for
some of the styles. Warp Text is one of Photoshop’s truly fun features. The
best way to become familiar with it is to open the dialog box and test-drive
each of the variations. And don’t forget to try the Horizontal and Vertical but-
tons when they’re available!

Customizing the course with paths

You can use the shape tools or the Pen tool to create a custom path along
which you add your text. (You find full information about paths and shape
layers in Chapter 11.) To add type along a path, simply select the Horizontal
Type or Vertical Type tool, click the path, and type. The flow of the type from
the point on the path where you click is determined by the alignment option
that you select from the Options bar or the Paragraph panel. If the text is left-
aligned, characters are added to the right of the point where you click (called
the point of origin for the type). Left alignment is great when adding type
along an open path, such as the upper path in Figure 13-21. You might, how-
ever, want to choose center alignment when adding type along the top of an
arc or circle, so you can click on the top of the arc and not worry about drag-
ging the type later to center it.

LAYERS |
Normal ) opacity: 1004 [H)
Lock: \Eﬂ_f EArY rul:

= 1¥s all downhill from here &~ H

Life has its little “UPs".... = M

Figure 13-21: Text alignment determines where the text goes from the point where you click on
the path.
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P If you want type to go in two different directions — say, pointed upward along

both the top and the bottom of a circle — you need to create two separate
paths and two separate type layers, as shown in Figure 13-22.

After you add your type to the path, you can press the 38/Ctrl key and reposi-
tion the type along the path by dragging. When you press and hold &/Ctrl,
the type tool’s cursor changes to an I-beam cursor with a heavy black arrow
on either side, indicating which way you can drag the type. You see the type’s
point of origin as a hollow diamond on the path (not to be confused with the
hollow squares that represent the path’s anchor points). Figure 13-23 gives
you a zoomed-in look at the converted cursor and a comparison of the point
of origin diamond and the anchor point square. Note, too, that not only can
you drag type along a path, but you can also drag it across the path, flipping
over the type.

M
T

AlOje[a[afd

@[O0 || F &

Figure 13-22: Sometimes you need to create two separate type layers, using two separate
paths, to achieve your artistic goals.
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Figure 13-23: When you drag the cursor across the path a short distance, type flips over.

After flipping type across a path, you might need to adjust the tracking (the
space between characters), which is the second field from the top on the right
in the Character panel. And don’t be afraid to click in the type and press the
spacebar a few times to adjust the placement of words along the path.
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A word about fonts

You already have a nice selection of fonts
installed on your computer. Some are installed
with the operating system (Windows or Mac), a
number of fonts may have been installed with
the Adobe Creative Suite, and other programs
could have tossed more morsels into the stew.
However, you might find that the more you work
with text, the more you crave additional fonts.

Although having lots of fonts can stretch your
options, too many fonts can lead to slowdowns

and other problems. If you do find yourself
someday with a massive collection of fonts (I
have over 7,500 fonts), none of which you could
bear to part with (okay, | could part with some
of them), use a font management utility. The
Mac 0S has the built-in Font Book, and Extensis
(www.extensis.com) offers Suitcase Fusion
(Mac, about $100) and Suitcase (Windows,
about $80).




T ey 14

Painting in Photoshop

In This Chapter

Adding color manually for complete control
Discovering tools with and without brushes
Traversing that amazing Brushes panel
Creating do-it-yourself brushes

painting. The word evokes images of brushes and palettes and color being
precisely applied to canvas. Or, perhaps, images of drop cloths, ladders,
rollers, and buckets — color being slopped on a wall and spread around. It
doesn’t generally bring to mind digital image editing. But painting certainly
has a place in your arsenal of Photoshop skills, even if you never create an
image from scratch.

In addition to painting landscapes and portraits (which you cer-
tainly can do in Photoshop, if you have the talent and train-
ing), you can use Photoshop’s painting tools for a variety
of other tasks. For example, you can paint to create
masks and layer masks, adjust tonality or sharpness in
specific areas, repair blemishes and other damage in
an image — even to create graphic elements and
special effects.

In this chapter, I concentrate on those editing-
related painting skills rather than fine art painting.
[ introduce you to the basic concepts of painting in .
Photoshop and also walk you through the basic brush-
related tools and the Brushes panel, concentrating on
those features that you most likely need (as well as a few
of the other, more artistic features). To wrap up the chapter,
[ show you how to create custom brush tips and how to save
them for future use.
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Discovering Photoshop’s Painting Tools

Nothing in Photoshop gives you more precise control of color in your image
than using the Pencil tool with a 1-pixel brush. Remember that your image
consists of a whole lot of little colored squares (pixels) and that the color of
those individual squares is what produces the appearance of a tree or a
sunset or even good ol’ Uncle Bob. If you zoom in really close on an image,
you can paint pixel by pixel — you could even create an entire image, one
pixel at a time!

Whether you're using a tiny brush
with the Pencil tool or a larger

one with the Brush tool, adding
color to your image with the painting
tools enables you to create beautiful
or whimsical imagery, such as what'’s
shown in Figure 14-1 (with acknowl-
edgment to Picasso’s Woman with
Pears).

As you work in Photoshop, however,
you’ll find many very important roles
for the brush-using tools other than
creating imagery. From touching up
dust and scratches in a scan to
removing distant power lines from a
photo to perhaps adding wispy hairs
to soften the outline of a head, you
have lots of reasons to paint in
Photoshop (many of which you can P
read about in Chapters 9 and 10). Original artwork © 2005 Peter Bauer
When you're capable and confident  Figure 14-1: Painting with the Brush tool is yet
using the Brush tool, you might even another way to create in Photoshop.

find it the best way to make selec-

tions in your image. Selections with the Brush tool? That’s right — painting in
an alpha channel creates or refines a saved selection. (You can read about
alpha channels in Chapter 8.) Photoshop even has a tool that you can use

to make selections directly. The Quick Selection tool, like the Magic Wand,
selects areas of similar color. However, instead of Shift+clicking in a variety

of areas with the Magic Wand to add to your initial selection, you simply

drag the Quick Selection tool. The brush diameter, selected in the Options
bar, tells Photoshop the size of the area you want to search for similarly
colored pixels.
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You have 18 tools that use brushes available in Photoshop. Here are just a
few of the things that you can do with these tools:

1 Add color (Brush, Pencil)
v~ Adjust tonality (Burn, Dodge)
v~ Sharpen, blur, and smear (Sharpen, Blur, Smudge)

1 Correct color and texture (Healing Brush, Spot Healing Brush, Color
Replacement)

1~ Select areas of similar color (Quick Selection)

1~ Copy/paste pixels (Clone Stamp)

In this section, I discuss the primary painting tools and introduce you to
some of the other brush-using tools. (Check Chapter 9 for additional informa-
tion on healing and cloning in your image.)

Painting with the Brush tool

You control where the Brush tool | PRI 3 e B b B
works by selecting a brush tip of a
particular size, shape, and hardness
(the fuzziness, or lack thereof, along
the edges of a round brush tip).
Remember, too, that you can use
the Brush and other painting tools
to create subtle changes in existing
colors. By selecting an appropriate
blending mode and opacity, you can
mix the painting color into the exist-  Figure 14-2: Make the primary decisions about
ing colors in your image. Make these painting tool behavior from the Options bar.
basic decisions from the Options bar,

shown for the Brush tool in Figure 14-2.

re—
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As you see in Figure 14-2, the Options bar gives you access to a miniature
Brushes panel, from which you can pick a brush tip, change its size, and
adjust the hardness of the brush’s edges. (Only round brush tips use the
Hardness adjustment.) The five sample lines to the right show Hardness, from
0% to 100% in 25% increments, all using a 40-pixel brush. The Brush tool can
use any brush tip that you have in the Brushes panel — and, as you can read
later in this chapter, you can customize the brush tip in a variety of ways.

You're actually ready to paint in Photoshop already! Select a foreground
color, select the brush size that you want, decide how hard or fuzzy the
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edges should be, change the blending mode and opacity (if desired), and
drag the tool in your image. (And, perhaps best of all, no turpentine needed
for cleaning up — just switch tools in the Toolbox.)

As you work with the brush-using tools, always remember that the selected
brush tip is applied as a series of individual impressions, called instances.
Consider an instance to be a single impression of the brush tip, like tapping a
pen once on a piece of paper — it leaves a single dot. Take a look at the outer
borders in Figure 14-3. Changing the brush tip’s Spacing value (in the main
Brushes panel, opened through Photoshop’s Window menu) shows how
instances appear. In the upper left, the spacing is set to the default 25% and

a continuous line results. To the upper right, Spacing is set to 67%, and the
individual brush tip instances are visible as overlapping circles. To the lower
left, Spacing is set to 133% — this is a setting that you might use for a dotted
or dashed line — and each brush tip instance is visible individually.

In Store Coupon

In Store Coupon

Save 10% Savg 10%

This Friday Only ) On
Valid only at our Columbus V4 ruses | —
area stores, not valid with
any other offers or coupons. Brush Presets : | B IEG
Brush Tip Shape 113 | 5|9 |13
[ Ishaps Dynamics | | | 4 . ; | ; 2'1 2'7 |
|| Scattering B . . . . . .
[ Textura ﬁ a5 45 65 100 00 | 300
:oooo.oo..oooooooo. Comitn | L& L5 % | % &l
.| Diameter 19 px
e In Store Coupon 3 S »
("1 Other Dynamics P .
: Save 10% : i = () Fiip X [ Flip ¥
[ d = _ o [ | Wet Edges B Angle: [o° -
e This Friday Only ¢ RO -
@ Valid only at our Columbus 4 oot B ardness T3
Y area stores, not valid with ° [ Pratect Texture [ :
' ® any other offers or coupons. ° ¥ Spacing Ti4%
L:..................J _%ﬂmmmw
0000
Bl &

Figure 14-3: Changing the Spacing makes the individual brush tip instances visible.

If, when you open the main Brushes menu, you see a Brushes panel that con-
tains only brush tips, click the menu button in the upper-right corner of the
panel and select Expanded View from the top of the panel menu.
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If you know you have the cursor set to show the brush tip, but you're seeing
the tiny little crosshairs instead, check the Caps Lock key on your keyboard.
Caps Lock toggles between precise and brush-size cursors for the brush-
using tools. (During the discussion of Photoshop’s Preferences in Chapter 3,
I showed a comparison of the three brush cursor options in Figure 3-13.)

When you change the Brush tool’s Opacity setting on the Options bar, you
change the appearance of the stroke as a whole. Changing the Flow setting
(also on the Options bar), on the other hand, changes the amount of color
applied with each instance of the brush tip. When the flow is reduced and the
spacing is set to less than 100%, the overlapping area of each brush instance
appears darker (or lighter when painting with, for example, white on black).
One last option for the Brush tool deserves a quick look. To the right of the
Flow field is the Airbrush button. When the Airbrush is on (the button turns
dark), the Flow value takes on more meaning. As you paint with the Brush in
Airbrush mode with a reduced Flow setting, pausing the cursor with the
mouse button down allows color to build up (become more opaque) as if you
were using a real airbrush. You can use the Airbrush both as a traditional air-
brush artist and to simulate spray paint. You can see both in Figure 14-4.

Figure 14-4: Airbrushing and spray painting with the Airbrush option for the Brush tool.

With Photoshop CS4’s support for OpenGL drawing, there’s a neat new trick on
board. If your computer has a processor and video card that support OpenGL
drawing too, you can rotate the image on screen for easier painting. Not rotate
the canvas, but rotate the on-screen image! As you see in Figure 14-5, this can
be great for fine-tuning a layer mask or doing other delicate painting tasks.
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Using the Rotate View tool (nested with the Hand tool and available in the
upper bar on your screen) permits you to arrange the artwork for your most
comfortable painting stroke. While dragging the Rotate View tool, the on-
screen compass’s red arrow always orients you to the top of the screen.
When you want the image oriented back to the top, simply double-click on
the Rotate View tool icon in the Tool panel.
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Figure 14-5: Rotating the on-screen view can make painting much easier and more precise.

Adding color with the Pencil tool

The Pencil tool differs from the Brush tool in one major respect: Regardless
of the Hardness setting in the Brushes panel, the Pencil tool always uses a
hardness value of 100%. With the Pencil tool active, the Options bar offers
the miniature Brushes panel, choice of blending mode and opacity, and the
somewhat-misnamed Auto Erase option. When selected, Auto Erase lets you
paint over areas of the current foreground color using the current back-
ground color. Click an area of the foreground color, and the Pencil applies the
background color. Click any color other than the foreground color, and the
Pencil applies the foreground color. But remember, you're not erasing, just
painting with the background color (even on layers with transparency).

Removing color with the Eraser tool

The third of your primary painting tools is the Eraser. On a layer that sup-
ports transparency, the Eraser tool makes the pixels transparent. On a layer
named Background, the Eraser paints with the background color. On the
Options bar, the Eraser tool’s Mode menu doesn’t offer blending modes, but
rather three behavior choices. When you select Brush (the default), the
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Options bar offers you the same Opacity, Flow, and Airbrush options as the
Brush tool. You can also select Pencil, which offers an Opacity slider, but
no Flow or Airbrush option (comparable to the actual Pencil tool). When
Mode is set to Block, you have a set-size square Eraser tool. Regardless of
which mode is selected, the Options bar offers one more important choice:
To the right of the Airbrush button, you’ll find the Erase to History check
box. When selected, the Eraser tool paints over the pixels like the History
Brush, restoring the pixels to their appearance at the selected state in the
History panel.

A couple of variations on the Eraser tool are tucked away with it in the
Toolbox, too. The Background Eraser tool can, in fact, be used to remove a
background from your image. However, it’s not limited to something in your
image that appears to be a background. Remember that digital images don’t
really have backgrounds and foregrounds or subjects — they just have collec-
tions of tiny, colored squares. What does this mean for using the Background
Eraser? You can click and drag on any color in the image to erase areas of that
color. You can also elect to erase only the current background color and desig-
nate the foreground color as protected so that it won’t be erased even if you
drag over it.

The Magic Eraser, like the Magic Wand selection tool (see Chapter 8), isn’t a
brush-using tool, but this is a logical place to tell you about it. Click a color
with the Magic Eraser tool, and that color is erased, either in a contiguous
area or throughout the image, depending on whether you have selected the
Contiguous option in the Options bar. And, like the Magic Wand, you can set
the tool to work on the active layer or all layers in the Options bar, and you
can also set a specific level of sensitivity (Tolerance). Here is the one differ-
ence between the two: The Magic Eraser is, in fact, a painting tool in that you
can set an opacity percentage, which partially erases the selected pixels.

Picking a color

If you want to apply a specific color to your image with a painting tool, you
have to be able to select that color, right? Photoshop provides you with a
number of ways to select a color:

 Click a saved color swatch in the Swatches panel.

»~ Enter numeric values or drag sliders in the Color panel.

+ Click a color swatch at the bottom of the Toolbox or in the Color panel
to open the Color Picker.

1~ Select the Eyedropper tool and click any color already in your image.
Heck, click in your image with the Eyedropper tool, hold the mouse
button down, and drag to any color anywhere on your screen — that
color doesn’t even have to be in Photoshop!
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In both the Toolbox and the Color panel, the foreground color is shown in the
swatch to the upper left, and the background swatch is partially hidden behind
it. Swap the foreground and background colors by pressing the X key on your
keyboard. Reset them to the default black and white by pressing the D key.

In Chapter 6, I introduce the Color
panel and the various ways you can
define color with it. Now take a look
at the Color panel’s big brother, the
Color Picker (see Figure 14-6). Note
the reminder in the title bar of the
Color Picker window that tells you
whether you’re changing the fore- &
ground or background color. (If you Clotine Chion S klo
find that you're changing the back-
ground color when you want to
change the foreground color, exit the g, 14-6; Use the Color Picker to define
Color Picker, open the Color panel,  .;ors with precision.

and click the foreground swatch.)

The best way to get a feel for the incredible versatility of the Color Picker is
to open it (click a color swatch at the bottom of the Toolbox or in the Color
panel) and click each of the buttons to the left of the numeric fields. Each
option changes how the Color Picker appears as well as how it defines color.

=
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x
x

The default Color Picker configuration uses the radio button to the left of the
H (Hue) field. It presents you with a vertical rainbow slider (the hue) and a
square area that defines saturation (left-right) and brightness (up-down).
Click or drag in the square area to the left and drag the slider up and down
to pick a color. (Compare the two swatches to the left of the Cancel button to
see the new color above the previously selected color.) If you click the button
to the left of the S field, the slider shows saturation, and hue and brightness
are defined in the square area to the left. Starting to see the pattern? Check
out the configuration for Brightness (B) as well as the RGB and Lab options.
And note that you can type numeric values to define a color as CMYK, but
there are no buttons to the left to reconfigure the Color Picker. Likewise, you
can type in the # (hexadecimal) field below the B field, but you can’t use it

to reconfigure the Color Picker. (Hexadecimal color definition is used with
HyperText Markup Language [HTML] code in Web pages.)

Between the two color swatches in the top center and the buttons to the right
are a pair of little icons that aren’t always visible. (Check them out in Figure 14-6
if they’re not currently showing in your Color Picker.) The top warning triangle
tells you that the current color can’t be reproduced within your working CMYK
color profile. Unless you're preparing artwork for commercial offset press,
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ignore it — it has nothing to do with your inkjet printer, for example. If, on the
other hand, you are working on a press-destined project, click the swatch just
below the warning triangle to jump to the nearest reproducible color.

The lower icon, a little cube symbol, lets you know that your current color
isn’t Web safe. Web-safe colors are the couple hundred colors that are exactly
the same in the base color scheme for both Mac and Windows. If visitors to
your Web site have their monitors — or PDAs — set to show only 256 colors,
everyone sees the same thing with Web-safe colors. Generally, you can safely
ignore the warning because the variation isn’t worth worrying about. (If you
do want to work with Web-safe colors, click the swatch below the warning
cube icon and then mark the Only Web Colors check box in the lower left.)

After you define a custom color with the numeric fields or by clicking in the
sample colors to the left, you can easily save the color to the Swatches panel
by clicking the Add to Swatches button. Should you need to reselect that spe-
cific color later, or even when working on another image, it’s right there in
the Swatches panel, exactly as originally defined.

Also note the Color Libraries button. Clicking that button swaps the Color
Picker for the Color Libraries dialog box (as shown in Figure 14-7), in which
you can select spot colors. Spot colors, which I explain in Chapter 6, are
special premixed inks that can be specially requested when preparing a job
for a commercial printing press. Adding a spot color ensures that the color
will appear in the final product
exactly as expected. However,
because they generally require an
extra pass through a press, adding
spot colors increases the cost of
your printing. Spot colors can be
used to define colors for nonpress
jobs, but the color is converted to
your working color mode and
printed with a mixture of your regu-
lar inks. Return to the Color Picker
from Color Libraries by clicking the
Picker button.

Book: | PANTONE solid coated ] [T

(™ Picker )

Type a color nama 1o
sebect it in the color list.

Figure 14-7: Choose custom spot colors in
Color Libraries.

Working with other brush-using tools

Photoshop has a double handful of other tools that use brushes and the
Brushes panel to make changes to your images. You can see the tools not yet
introduced and their Options bar offerings in Figure 14-8, shown in the order
(and groups) in which they appear in the Toolbox.
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Figure 14-8: Photoshop has almost a dozen additional brush-using tools.

These tools aren’t used to paint color in your artwork. Rather, they’re for
fine-tuning details and repairing your images:

1 Healing tools: The Spot Healing Brush and Healing Brush are designed

to repair texture, like smoothing wrinkles or adding the appearance of
canvas. With the Healing Brush, you designate a source point — an area
from which you want to copy texture — by Option/Alt+clicking and then
dragging over the target area. The Spot Healing Brush, on the other
hand, automatically samples the texture around an area and makes the
target area match its surroundings. Quite cool!

1~ Color Replacement tool: Nested with the Brush and Pencil, the Color

Replacement tool replaces the color over which you drag with the fore-
ground color. Remember that the Color Replacement tool alters only the
color, not luminosity, so painting with black over pink gives you gray
rather than black. From the Options bar, you can set the tool to change
luminosity rather than color to darken or lighten, or choose to match
hue or saturation.
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v~ Stamp tools: The Clone Stamp tool, unlike the Color Replacement tool or
the Healing Brush, doesn’t copy an attribute (such as color or texture)
but actually copies pixels. It’s like having copy/paste in a brush. Option/
Alt+click a source area and then move the cursor and drag where you
want to copy those pixels. Powerful! The Pattern Stamp tool paints with
a selected pattern, using the blending mode and opacity that you desig-
nate in the Options bar. The Pattern Stamp tool is sometimes a good way
to add texture selectively.

When working with the Clone Stamp tool and the Clone Source panel,
you can specify and move between up to five different source points.
You also have the option of showing an overlay, which lets you see in
advance what dragging the tool will do to your artwork.

1~ Art History Brush: Nested with the History Brush, this tool uses the his-
tory state selected in the History panel to add an Impressionist look
where you paint.

+~ Focus tools: The Blur and Sharpen tools do just what their names say,
but you'll likely find the default 50% Strength to be way too powerful for
most jobs. Selective sharpening can help bring out details and direct
attention in an image. Likewise, selective blurring can hide minor
defects and help direct the viewer’s eye toward areas of sharpness in the
image. You can use the Luminosity blending mode with the Blur and
Sharpen tools to minimize unwanted color artifacts while blurring or
sharpening.

Tucked in with the focus tools is the Smudge tool. Click and drag to
smear pixels along the path. (I find the Smudge tool especially useful for
dragging out wispy hairs from heads that appear perhaps too well
defined and smooth.)

1~ Toning tools: The Dodge tool lightens, the Burn tool darkens — and if
you use the defaults, they do it too much! When using these tools to
adjust luminosity in your image, it’s best to start with an Exposure set-
ting of about 15% and paint carefully, perhaps repeatedly, rather than
making a huge change with Exposure set to 50%.

You'll find the Sponge tool nested with the Dodge and Burn tools. Use
it to either increase or decrease saturation as you drag. (Decreasing
saturation with the Sponge tool is a great way to create an image that’s
partially grayscale.)

The Healing Brush and the Clone Stamp tool have a button to the right in the
Options bar to open the Sample menu. When the Sample pop-up menu is set
to All Layers or the new Current & Below option, that button gives you the
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option of ignoring adjustment layers. You might want to use this option if, for
example, you're cloning or healing from multiple layers below an adjustment
layer to a new layer that itself would be affected by the adjustment layer. This
prevents the adjustment from being applied twice.

Filling, stroking, and dumping to add color

You have several more ways to add color to your artwork, none of which use
brushes at all. You can, for example, make a selection and fill the selection
with color via the Edit=>Fill command, or you can add a band of color along
the edge of the selection with the Edit=>Stroke command (using the dialog
boxes shown to the right in Figure 14-9). You can also “dump” color into your
image with the Paint Bucket tool, nested below the Gradient tool in the
Toolbox. Use the Paint Bucket to fill an empty selection with color or to
replace the color on which you click with the foreground color.

Don’t forget shape layers, either! They’re a great way to add perfectly defined
areas of solid color to an image. (You can read about working with shape
layers in Chapter 11.)

3 und!-Dnumr. 100% |») Tolerance:[32 | W Anti-alias ™ Contiguous | ) All Layers

Fill
Foreground Color
7 Contt  packground Color 1 E
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I 1 Cancel
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Opacityauu
| Preserve Transparency
[ Stroke 6 0 9
- (_Cancel )
Color: -
Location
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Opacity: |100
| Preserve Transparency

Figure 14-9: Photoshop offers several non-brush ways to add color to your images.
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Using gradients

You can add gradients, which are subtle blends of color, quite easily to your
artwork:

1. Make a selection.

Unless you make a selection first, the gradient fills your entire layer. If
you want the gradient to fill the entire layer, don’t make a selection first.

2. Select the Gradient tool.

Click the Gradient tool in the Toolbox. If you don’t see it, look for it
nested with the Paint Bucket tool.

3. Select a gradient.

You can open the Gradient panel by clicking the triangle to the right of
the sample gradient on the Options bar (see Figure 14-10). You can also
click the sample gradient directly to open the Gradient Editor.

4. Choose a shape.

The five buttons to the right of the sample gradient on the Options bar
show you the shapes available for the Gradient tool. (From the left, the
buttons are Linear, Radial, Angle, Reflected, and Diamond.)

5. Choose additional options.

You can pick a blending mode and opacity, flip the colors in the gradient
with the Reverse option, choose Dither to help disguise the transitions
between colors, and select the Transparency option to preserve any
transparency defined in the gradient.

6. Drag the Gradient tool.

Where you start and in which direction you drag ultimately determine
the appearance of the gradient.

The background gradient in Figure 14-10 uses the Angle Gradient option on the
Options bar and the gradient that you see in the Gradient Editor. Notice in the
Gradient Editor the opacity stops (above the sample being edited) and color
stops (below the sample). The stops — the squares with points positioned
along the sample gradient — determine the color or opacity of the gradient at
that particular point. By default, there’s a smooth and even blend between
neighboring stops, but you can adjust the blend by dragging the small dia-
monds you see on either side of the opacity and color stops. (Hint: The active
stops use filled triangles instead of hollow triangles with their little squares.)
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Figure 14-10: Control gradients with the Options bar, Gradient panel, and Gradient Editor.

Click anywhere along the top (opacity) or bottom (color) of the gradient to
add a new stop. Drag stops to move them. Option/Alt+drag a stop to dupli-
cate it. Change the attributes of the selected stop with the options just below
in the Gradient Editor.

After designing your new gradient, remember to click the New button to add
it to the Gradient panel. But keep in mind that custom gradients aren’t really
saved until you use the Save button or the Preset Manager to create sets on
your hard drive. If you don’t save your custom gradients, they’ll be gone if
you need to reset Photoshop’s Preferences file (see Chapter 3).

Browsing the Brushes Panel

Photoshop’s Brushes panel provides a bewildering array of options, sure to
confuse even the most diligent explorer. Thankfully, unless you intend to create
fine art paintings digitally, you can safely ignore a whole bunch of options.
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SMBER
@“‘ You must have a brush-using tool active to access the Brushes panel. If the

active tool doesn’t use brushes, the entire panel is grayed out and unavailable.
If that’s the case, simply press B on the keyboard to activate the Brush tool.

An overview of options

The Brushes panel, like the Layer # Expanded View
Style dialog box, has a column on the New Brush Proset..
left that lists options. Like the Layer R All Locked Seings
Style dialog box, you mark the check P
box to activate the feature, but you Delesé Brish
have to click the name to open that — [Fo m o Sl Tl
pane in the panel. (If you open the (L] Tl
Brushes panel and see only the et HHHAAE Stroke Toumbral
sample brush tips, open the panel ouson | s | o[®]c[oTo [l "ot
menu and select Expanded View.) et Y I AR :»E-Z'E-:“
As you can see in Figure 14-11, the e - -.3--% i i " * Replace Brushes..
Brushes panel menu offers a pretty e G T P TETEE] sectmotes
normal selection of commands, B e ot s
including the variations in how to dis- — [
play the panel content, some house- e — ?EE:'EEF%E?:M
keeping commands for resetting/ oo e
loading/saving brushes, and a list of - Wet Media Brushes

Close

brush sets at the bottom of the menu. Close Tab Group

And don’t overlook those little lock
icons to the right of the various pane
names. Click the lock to preserve the
settings in that pane while you
switch among brush tip presets. Any unlocked attributes revert to those with
which the brush tip was created. Locking, for example, Shape Dynamics
retains those settings even if you switch to a totally different brush tip.

Figure 14-11: The Brushes panel and its
menu — quite a handful!

Here, in order, are the panes and the options in those panes to which you
should pay attention:

+~ Brush Presets: Here’s where you pick the basic brush tip shape from
the brushes loaded in the panel. You can also resize the brush tip, but
that’s it. Note the lack of a check box in Figure 14-11. You don’t activate/
deactivate Brush Presets; you just pick a brush tip and size and then
move on.
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+~ Brush Tip Shape: Also without a check box, Brush Tip Shape is the pane
in which you customize the selected brush tip. (Refer to the Brush Tip
Shape pane in Figure 14-3.) This is perhaps the most important part of
the Brushes panel. In this pane, you can select a brush tip, change its
size, alter the angle at which it’s applied, change the height-width rela-
tionship (Roundness) of the tip, and adjust the Spacing setting.

+~ Shape Dynamics: Dynamics in the Brushes panel add variation as you
drag a tool. Say you’re working with a round brush tip and choose Size
Jitter. As you drag the brush tip, the brush tip instances (the individual
marks left by the brush as you drag) will vary in diameter. The Shape
Dynamics pane offers Size Jitter, Angle Jitter, and Roundness Jitter. Each
of the “jitters” can be set to fade after a certain number of brush tip
instances or can be controlled with the stylus that you use with a
Wacom tablet. Angle can also be set to Direction, which forces the brush
tip to adjust the direction that you drag or the direction of the selection
or path you stroke. Use Shape Dynamics to add some variation and ran-
domness to your painting, as shown in Figure 14-12.
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Figure 14-12: Use jitter to add variation to the application of your selected brush tip.

1~ Scattering: Scattering varies the number of brush tip instances as you
drag as well as their placement along the path you drag. Like the shape
dynamics, scattering can be set to fade or can be controlled with a
Wacom tablet.
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1~ Texture: Use the Texture pane to add a pattern to the brush tip, as
shown in Figure 14-12. You can select from among the same patterns that
you use to fill a selection. Texture is most evident when Spacing for the
brush tip is set to at least 50%.

+* Dual Brush: Using a blending mode you select, the Dual Brush option
overlays a second brush tip. You could, for example, add an irregular
scatter brush to a round brush tip to break up the outline as you paint.

1 Color Dynamics: Using the Color Dynamics pane, you can vary the color
of your stroke as you drag. This comes in most handy for painting images
and scenes rather than, say, working on an alpha channel. Just as you
might add jitter to the size, shape, and placement of a grass brush while
creating a meadow, you might also want to add some differences in color
as you drag. You could pick different shades of green for the foreground
and background colors and then also add jitter to the hue, saturation, and
brightness values as the foreground and background colors are mixed
while you drag.

1 Other Dynamics: Think of this pane as Opacity and Flow Jitter. You can
add variation to the opacity and flow settings from the Options bar as
you drag.

1~ Other Options: At the bottom of the left column are five brush options
that don’t have separate panes in the Brushes panel. They’re take-it-or-
leave-it options — either activated or not.

e Noise: Adding Noise to the brush stroke helps produce some tex-
ture and breaks up solid areas of color in your stroke.

o Wet Edges: Wet Edges simulates paint building up along the edges
of your stroke.

e Airbrush: The Airbrush check box simply duplicates the button on
the Options bar.

e Smoothing: Smoothing helps reduce sharp angles as you drag your
mouse or stylus. If the stroke you’re painting should indeed have
jagged turns and angles, disable Smoothing.

e Protect Texture: The Protect Texture option ensures that all the
brushes with a defined texture use the same texture. Use this
option when you want to simulate painting on canvas, for example.

When creating a dashed line or stroking a path with a non-round brush tip,

go to the Shape Dynamics pane of the Brushes panel and set the Angle Jitter’s
Control pop-up menu to Direction. That enables the brush tip to rotate as
necessary to follow the twists and turns of the selection or path that it’s
stroking. (You'll generally want to leave Angle Jitter set to 0% so that the
stroke follows the selection or path precisely.)

313



3 ’4 Part lll: Creating “Art” in Photoshop

Creating and saving custom brush tips

You can use any artwork as a custom e E—
brush tip — you can even make a NS
brush tip from your own face! With o g T,
the artwork on a transparent or g

white background (youdon’teven | e ) -
need to make a selection), choose I et
Edit=oDefine Brush Preset. Type a o & B —
name (see Figure 14-13) and click OK. . 1 e
Your new custom brush is added to e

the Brushes panel. After you define a e 90 LE
piece of artwork as a brush, you can as
add that image to any project with a Jnah s

single click or drag. ) e e

\\3 As soon as you define your custom
brush, open the Brushes panel, select
the new brush, and set Spacing and  Figure 14-13: Define the new brush preset, set
any other options that you'll gener-  your options in the Brushes panel, and resave.
ally want to use with the new brush.
Then from the Brushes panel menu, choose the New Brush Preset command
and resave your custom brush. Now when you select your custom brush, you
MBER have your preferred settings all ready to go!

Keep in mind these things when creating custom brushes:

1~ All brushes are grayscale. Regardless of the color in the artwork that
you use to create your new brush, the brush itself is saved as a
grayscale representation of the art.

1 The maximum size for a brush is 2,500 pixels. If you, for example, scan
your signature to use in a custom copyright notice for your images and
Define Brush Preset is grayed out, reduce the pixel dimensions with the
Imager>Image Size command.

~ Only one color is painted. Again, the brush is grayscale: It applies the
foreground color in tints to match the grays in the brush tip (unless, of
course, you use the Color Dynamics option in the Brushes panel).

+ Your art might need more contrast. You might want to convert a copy
of your original to grayscale to see whether it wouldn’t benefit from a
Levels adjustment to boost the contrast. Higher contrast often makes for
better brush tips.

1 Remember to save your custom brushes! Once again (and you’ll proba-
bly read this sort of reminder a few more times elsewhere in this book),
your custom brushes aren’t really saved until you use the Brushes panel
menu command Save Brushes to make a new set of all the brushes cur-
rently in the panel or until you choose Edit=>Preset Manager to make a
new set of only the brushes you select.



Filters: The Fun Side of Photoshop

In This Chapter

Finding out about Smart Filters

Being productive with “fix it” filters

Getting artsy with creative filters

Adding wackiness (and precise correction) with Liquify

Taking a quick look at the specialized filters

Fle Photoshop Filter menu includes more than 100 commands that you
can use to fix, flatter, finesse, and freak out your photos. You can use

most of the filters on most of your artwork and some of the filters on some
of your artwork, and you probably won’t ever use quite a few of the filters.

In this chapter, [ start you off with a discussion of the new Smart Filters feature,
something you should get used to using just about every time you apply a
filter. Next, you get a look at what I call the “production” filters:
namely, the key filters you use to improve or repair your
images. Following that, I show you the basics of two of the
most fun features in all of Photoshop: the Filter Gallery
and Liquify. Not only are they fun, but you can use them
to do wondrous things to your artwork. I wrap up the
chapter with a look at several other key filters.

Smart Filters: Vour Creative
Insurance Policy

One of the most important concepts to keep in mind
when working with filters is Smart Filters. When you apply
a filter to a pixel layer, that’s it — the pixels are changed. But,
when you apply a filter to a Smart Object, you create a Smart Filter.
With Smart Filters, you can apply one or more filters to a Smart Object and
later change your mind about what settings — or even what filters — to use,
without reverting to a saved copy of the file or using the History panel. Unlike
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adjustment layers, which are, in fact, separate layers in the image, Smart
Filters work more like layer styles. They appear in the Layers panel below the
layer to which they’re applied and can be shown or hidden by clicking an
eyeball icon (see Figure 15-1). And, like layer styles, you can reopen a Smart
Filter by double-clicking it in the Layers panel.
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Figure 15-1: Smart Filters are more like layer styles than adjustment layers.

As you can see in Figure 15-1, the layer Inside Passage-02 (the active layer,
highlighted in the Layers panel) has both layer effects and Smart Filters
applied. The type layer above has only layer effects, whereas the other two
Smart Objects, below in the Layers panel, have Smart Filters but no layer
effects. Clicking the triangle to the far right of a layer name expands and col-
lapses the list of effects and filters applied. Clicking the eyeball icon to the left
of an item hides it without removing it. You can delete a Smart Filter by drag-
ging it to the Trash icon (just as you can with layer effects), which removes its
effect from the layer. To reopen a filter’s dialog box to change settings, simply
double-click the filter name in the Layers panel.

‘x‘gN\BEIi Smart Filters can be applied only to Smart Objects (which are discussed in
Ny Chapter 10). Luckily, you can convert any pixel-based layer, even a back-
ground layer, to a Smart Object simply by selecting that layer in the Layers
panel and choosing Layer=>Smart Objectse>Convert to Smart Object. You can
even select multiple layers in the Layers panel and create a single Smart
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Object with that command. You can then apply a Smart Filter to all of the
layers in the Smart Object.

Because you can easily remove or change Smart Filters, they provide you
with a special sort of creative license: the license to experiment and change
your mind. Because they are nondestructive (they don’t make permanent
changes to the pixels in your image), you can use Smart Filters without fear
of damaging your image. Of course that doesn’t mean you shouldn’t work on
a copy of your beautiful photo — it’s always better to safeguard the original
image file and work on a duplicate.

The Filters You Really Need

\&Q,N\BEI?

\\s

Photoshop has several filters that you can use on just about any image to
improve or finesse it. Most photos, for example, benefit from at least a little
bit of sharpening to improve the detail in the image. In some cases, you want
to decrease the visible detail in an image in areas to hide defects, or perhaps
you want to blur a background to draw more attention to the subject of your
shot. And Photoshop has a couple of filters that you'll find handy for correct-
ing lens distortion and reducing noise (specks of red, green, and blue) in digi-
tal photos.

Some filters aren’t available for images in CMYK (cyan/magenta/yellow/black)
color mode, and some aren’t available when you’re working in 16-bit color.

All the filters are available for 8-bit RGB and grayscale images. (No filters are
available for GIF or PNG-8 images, which use Indexed Color mode.) And keep
in mind that you can apply filters to specific areas of an image by making a
selection first. (See Chapter 8 for info on selections and masks.)

You can instantly reapply the last used filter exactly as it was applied with
the keyboard shortcut 38+F (Mac)/Ctrl+F (Windows). If you’d like to reopen
that last-used filter’s dialog box to change settings before reapplying, press
Option+88+F/Alt+Ctrl+F.

Sharpening to focus the eye

When looking at an image, your eye is naturally drawn to certain areas first.
You generally look at bright areas before dark areas and areas of detail before
smoother areas in the image. Compare, for example, the three photos in
Figure 15-2 (which were taken using different focal lengths and lens aper-
tures). Using Photoshop’s sharpen and blur filters enables you to control the
amount of detail throughout your image or in specific areas in order to con-
trol the areas to which you want to draw attention.
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Figure 15-2: Blurry backgrounds help the subject stand out.

Photoshop offers five sharpen filters, three of which you can ignore. The
Sharpen, Sharpen More, and Sharpen Edges filters have no user-definable set-
tings and simply work in accordance with their names. Sure, they do a good
job, but you don’t have that all-important control over your images! Skip
them in favor of the it-takes-some-work-but-it’s-worth-it sharpening filters:
Unsharp Mask and Smart Sharpen.

Unsharp Mask

The Unsharp Mask filter is, indeed, a sharpening filter, despite the name
(which comes from the blurry — unsharp — mask created from a copy of the
image and used in the sharpening). As you can see in Figure 15-3, Unsharp
Mask offers three sliders to adjust the appearance of your image.

B Lillac-03.tif @ 1005% (RGB/B#)

Unsharp Mask

E Preview

2 300%

Amount: 100 %

o

Radius: [3.0 pixels

&

Threshold: |2 levels

Figure 15-3: Despite its name, Unsharp Mask actually sharpens your image.
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In the upper left, you see the original image at 100% zoom. The middle image
shows the sharpening at 100% zoom. To the right is a 300% zoom in the pre-
view area of Unsharp Mask’s dialog box.

Always evaluate your filters at 100% zoom even if you need to shrink the
window to only a critical portion of the artwork. Zoomed in or zoomed out
views might not accurately reflect the changes that you're making because
the image isn’t displayed with one screen pixel representing one image pixel.
You can, of course, open a second view of the same image with the
Windowr>Arrange~>New Window for [filename] command.

Unsharp Mask works by identifying lines of strong Amoun:[100 |%
contrast — the edges of elements within your
image — and increases the contrast along those

edges. Along the border of a dark area and a light e
area, Unsharp Mask uses a thin band of light anda | &
thin band of dark to create a light and dark halo

Radius: [2.5 pixels

| levels

along the edges. That makes the edge appear Figure 15-4: You adjust three
much more defined. Here’s how Unsharp Mask’s sliders when sharpening with
sliders (as shown in Figure 15-4) work to control Unsharp Mask.

the effect.

»* Amount: The Amount slider determines how much sharpening is actually
applied by controlling the brightness and darkness of the halo. An amount
of 50% is often suitable for small images that are already in pretty good
shape. Use 100% for general photos. Use larger values, up to 500%, for
special effects.

+~ Radius: Use the Radius slider to determine the width of the halo. You
typically need a value as low as 1 pixel for small images and perhaps
as high as 7 for larger images that don’t have a lot of tiny detail.

v~ Threshold: The Threshold slider helps you avoid destroying your image
by over-sharpening fine details. If the tiniest details in the image get
wide, bright halos, they can look garish and unnatural. The higher the
Threshold setting, the larger an area must be before sharpening is
applied. Typical Threshold settings are 2 for a small image and 5 or 7
for a large image.

Smart Sharpen

The Smart Sharpen filter provides you with an incredible amount of control
over the sharpening process. Although it won’t (quite) be able to give you a
crisp image of that bank robber from the pixelated, blurry surveillance
camera (that happens only on TV), it will help you improve just about any
image. Those who photograph through microscopes and telescopes might
find this filter particularly useful. However, remember that although you
might improve an image, some blurs won’t be removed by sharpening.

319
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Figure 15-5 shows how well Smart Sharpen works with an appropriate image.
(Note that the Preview box is unchecked in order to show the unsharpened
original to the right.) In this image, the blurring is consistent throughout the
subject of the shot, and there is a reasonable amount of blur. In Figure 15-5,
you can see that when you select the Advanced radio button, you get a pair
of new tabs in the dialog box: Shadow and Highlight. Use those tabs to con-
trol how strongly the effect is applied in the darker and lighter parts of the
tonal range.

Smart Sharpen

=

( Cancel )

[ Preview

L3

) Basic @ Advanced
Settings: = Default . :} —/E| @
FETg = T |

Amount: [110 T%
= |

Radius: |5 | pixels

Remove: Lens Blur -'5!

E More Accurate

Figure 15-5: Smart Sharpen does a great job with appropriate images.

Smart Sharpen also enables you to specify any of three types of blurring that
can be plaguing your image: Gaussian Blur (a uniform blur), Lens Blur (areas
of blur beyond the focal distance of the lens), and Motion Blur (the subject or
camera moving while the shot was taken). If you don’t see distinct evidence
of lens blur or motion blur, stick with Gaussian blur.

\‘\gN\BEI? When working with filters in Photoshop, make all of your final decisions with
© the preview (or the image itself) at 100% zoom. All other zoom factors can
give you an idea of what changes you’re making, but only at 100% zoom can
you be assured that the preview is completely accurate.

Blurring images or selections

As you can see in Figure 15-2, blurred areas in an image attract less attention
than do the sharper parts of the photo. By making a selection, you can selec-
tively apply Photoshop’s blur filters. You can also use the blur filters to hide



Chapter 15: Filters: The Fun Side of Photoshop 32 ’

The Edit=>Fade command

Immediately after applying just about any filter or adjustment command and after using many of
Photoshop's tools, you can adjust the effect with the Fade command, found under the Edit menu.
(Keep in mind that Fade is available only immediately after using a filter, adjustment, or tool. You
can't even use the Save command in between.)

With Fade, you can reduce the opacity of the previous command or tool, thus reducing its impact
on your image. You can also change the blending mode, which alters how the command or tool
interacts with pixel colors prior to your change. Say, for example, you paint a black stroke with the
Brush tool set to Normal and 100% opacity. Inmediately afterward, you choose Edit Fade Brush. You
can then pick a new blending mode and/or reduce the opacity setting, which changes the painted
stroke to appear as if you'd selected the new settings in the Options bar before painting.

You can also apply the Unsharp Mask (or Smart Sharpen) filter and then choose Edit=>Fade Unsharp
Mask, as shown in the figure here. (Yes, the Fade command changes names automatically!) In the
Fade dialog box, changing the blending mode from
Normal to Luminosity ensures that your Unsharp
Mask filter doesn’t alter the color of pixels along
edges. Using the Fade command this way is the
same as if you'd switched to Lab color mode and
sharpened only the L channel — without having to
switch color modes at all.

PG

& Armor.psd @ 66.7% (RGB/8#)

Note that the Edit=>Fade command isn’t available
when you're working with Smart Filters. If you need
to fade the filter, you can first choose Layer=>
Smart Objects=>Rasterize and then apply the filter.
You lose the advantages of working with Smart
Objects and Smart Filters, but the Edit=>Fade com- i n
mand will be available. sa7% 0] b

Fade

o#| Opacity: 90 |%
——————— k Cancel V"

i k
| Mode: Luminosity L% ! -
3 E Preview

flaws in an image, including dust, noise, and unwanted little bits and pieces in
the picture. You might also want to blur all or part of an image prior to using
some of the artistic filters available in the Filter Gallery (which I discuss later
in this chapter).

Photoshop provides you with almost a dozen different blur filters. Although
you’ll eventually develop a special fondness for one or two blur filters, it’s
good to know how each of them works. Table 15-1 gives a quick overview of
the available filters.
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Table 15-1

Filter Name

The Workings of Photoshop Filters

What It Does

Tips on Using It

Average

This filter looks at each of the
pixels in the selection, deter-
mines the average color value,
and then assigns that color

to all the pixels in the selection,
producing an area of solid color.

Changing the opacity or
blending mode with the
Edit=>Fade Average command
afterward softens the
averaging to the point where
it's more useful.

Blur

The Blur filter applies a slight
blur throughout the image or
selection.

Apply the Blur filter and then
use the shortcut 88+F/Ctrl+F to
reapply the filter numerous times
to make the effect stronger.

Blur More

Blur More is simply a stronger
version of the basic Blur filter.

Box Blur

The Box Blur filter blurs the
image vertically and horizontally;
you see the effect most notice-
ably in small highlights that tend
to bloom into squares.

In the Box Blur dialog box,
you control the filter with a
Radius slider.

Gaussian
Blur

This filter produces a smoothly
blurred version of your image
without the distracting artifacts
and lines you get by repeatedly
applying the Blur More filter.

Get more control over the
blurring effect by using the
Radius slider, which lets you
control the amount of blurring.

Lens Blur

This filter simulates the effect in
which the camera’s zoom and
aperture create a sharp fore-
ground and a blurry background.

Use an alpha channel (a saved
selection) to determine where
and how strongly the filter is
applied. For a look at the

Lens Blur filter in action, see
Figure 15-6.

Motion
Blur

This filter lets you choose any
angle and a wide range of
distances (measured in pixels)
to suggest motion for all or part
of an image.

Use it without a selection to
produce the illusion that the
camera (not the subject) was in
motion. Make a selection and
copy itto a new layer to blur
just that part.

Radial Blur

An incredibly powerful, yet
incredibly flawed, tool that blurs
in a spinning motion around a
center point in your image or
selection, or simulates zooming
in on that point.

With no preview available, you

have no idea what settings are

appropriate for your image (and
artistic vision) without trial and

error.
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Filter Name What It Does

Tips on Using It

Shape Blur  Uses the Radius slider and one of
the shapes from your Shapes
picker as a pattern for the blur.

You can load additional shapes
by using the small black triangle
at the upper right of the shapes
area.

Smart Blur  Controls the blur by recognizing
edges (areas of extreme differ-
ence along a line of pixels) and
blurring within those areas.

Use Smart Blur in Normal mode
to eliminate all fine detail in
your image, use it again in Edge
Only mode to trace edges in the
image, and then use the shortcut
88+1/Ctrl+l to invert the image,
which produces a black-on-
white sketch of your original.

Surface This filter goes beyond Smart

Blur Blur in preserving edges. Restrict
the blur to large areas of similar
color in the image, leaving the

fine detail of the image unblurred.

Much like working with the
Unsharp Mask filter, you use
the Radius slider to determine
the amount of change and the
Threshold slider to exempt some
areas of the image from the
change.

Lens Blur (42%)

G
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Figure 15-6: Lens Blur can use an alpha channel (mask) to control the blur.
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Using the Lens Correction filter

The Lens Correction filter (find it among the Distort filters) does a wonderful
job of cleaning up pin cushioning and barrel distortion (the outer edges of your
image appear to bend inward or outward, respectively). You'll see pin cushion-
ing when shooting with a telephoto lens at its max zoom and barrel distortion
at the lens’s lower magnification. Both are most obvious when the photo has
what should be straight lines at the edges. You can also use Lens Correction to
adjust the vertical or horizontal plane of an image. In Figure 15-7, you see the
Lens Correction window, a rather complex working environment.

Lens Correction (66.7%)
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Figure 15-7: Fix barrel distortion, pin cushioning, and perspective with Lens Correction.

Here’s what you have at your disposal in the Lens Correction window:

In the upper-left corner of the window are five tools:

1~ Remove Distortion (top): Select this tool to drag in the preview area to

adjust the distortion factor.

1~ Straighten (second): This tool is simple: Click and drag along any line in
the image that should be straight, and the image is straightened!

 Drag Grid (middle): Use this to reposition the grid overlay, aligning it

with the content of your image.



+» Hand and Zoom: The lower pair of tools should look familiar. The Hand
and Zoom tools function as they do anywhere in Photoshop: When the
image doesn’t fit in the window, click and drag with the Hand tool to repo-
sition; click the Zoom tool to zoom in, or Option/Alt+click to zoom out.

You can also find

1~ Remove Distortion slider: The Remove Distortion slider is the heart of
this filter. You use this to compensate for pin cushioning or barrel distor-
tion in the image. Drag it back and forth until your image’s vertical and
horizontal lines are straight throughout the image.

1 Chromatic Aberration sliders: Sometimes a photograph shows dis-
torted color along fine angular lines, such as the branches of trees or lat-
ticework. You can minimize these colored halos or fringes with the
Chromatic Aberration sliders. Generally speaking, you want to zoom in
close on a specific area of detail to make the adjustment.

1~ Vignette sliders: Drag the Amount slider to the left to add a dark vignette
(fading along the outer edges of the image) or to the right for a white
vignette. The Midpoint slider increases and decreases the amount of
shadowing or highlight along the edges.

+ Transform controls: Use the Vertical Perspective and Horizontal
Perspective sliders to make your image appear parallel to the viewer.
Much like using the perspective crop option or the Edit=>Transform=>
Perspective command, you're changing the perceived angle of the image
to the viewer. (See Figure 9-13 for perspective adjustment in action.)

1 Zoom and grid: Click the minus and plus buttons in the lower-left corner
to zoom out and in, or choose a preset zoom factor from the pop-up
menu. Click and drag on the Size field’s label (the actual word Size) to
resize the grid. Click the color swatch to change the color from the
default gray. (I liked bright yellow for the image in Figure 15-7.)

1~ Saving and loading settings: From the Lens Correction window’s menu
(to the right of the Settings pop-up menu), you can save settings and
load them later. Because you can name the settings, you can save a set
for each of your lenses, at each of their zoom factors, and apply the
same correction easily, time after time.

Cleaning up with Reduce Noise

Digital noise — those annoying red, green, and blue specks in your image —
can ruin an otherwise lovely picture. (To avoid noise, make sure that your
camera is set to shoot at the lowest ISO setting possible.) Photoshop also has
a filter for reducing (not necessarily eliminating) digital noise in your images.
Found in the Filter->»Noise menu, Reduce Noise can do an excellent job of
minimizing the random red, green, and blue pixels in your image, as you can
see in Figure 15-8.
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Figure 15-8: Reduce Noise neutralizes the red, green, and blue specks in a digital image.

When you work with Raw images, do all your noise correction in the Camera
Raw plug-in (see Chapter 7). For images in formats other than Raw, use the
Reduce Noise filter.

Here are the steps that [ recommend when you use the Reduce Noise filter:

1. Set the details sliders to 0 (zero).

In the Reduce Noise dialog box, drag the Preserve Details and Sharpen
Details sliders all the way to the left. This eliminates any interference
with the actual noise reduction.

2. Reduce Color Noise.

Use the Reduce Color Noise slider to minimize the red, green, and blue
specks in your image. Drag the slider slowly to the right until the color
noise is gone.

3. Adjust Sharpen Details.

Increase the Sharpen Details slider 1% at a time until the color noise
returns; then back off 1%.

4. Adjust Preserve Details.

Drag the Preserve Details slider to the right until you have a good bal-
ance between image detail and any luminance noise (bright and dark
specks) in the image.
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If you see noise of one color considerably longer than the others when drag-
ging the Reduce Color Noise slider, click the Advanced button near the top

of the dialog box and work with each channel individually, according to its
needs. Also note the Remove JPEG Artifact check box at the bottom of the
window. If your image is suffering from JPEG compression problems, selecting
that check box might help relieve the effects. (JPEG compression often results
in visible borders between 8 x 8 pixel squares within your image.) Remember,
too, that you can use the button to the right of the Settings pop-up menu to
save your correction for future use — it will be added to the Setting menu.

Getting Creative with the Filter Gallery

You can apply and combine many (but not all) of Photoshop’s creative filters
by choosing Filter=>Filter Gallery. This integrated window lets you use multi-
ple filters at the same time rather than guessing which settings will look good
with another filter applied later. Each filter remains /ive (you can change the
settings) until you click OK. Check out Figure 15-9.

Effects viewing pane Filter pane Filter settings

Texturizer (50%)

© 0 6 H MounainPhi.. bl i fa) (=]

¥ —rBrush Strokes

i 3_—|

Hide effects Filter stack

New Effect Layer button  Trash

Figure 15-9: The expansive Filter Gallery interface.
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“&N\BEH If Filter Gallery is grayed out and unavailable, head for the Imager>Mode
& menu and select 8-Bits/Channel — the Filter Gallery is not available for
images in 16-bit color. Keep in mind, too, that the Filter Gallery can be
applied as a Smart Filter when working with Smart Objects.

The basic workflow goes like this: Adjust a filter, add a new filter to the stack,
select the new filter in the middle pane, adjust the settings to the right, add a
new filter to the stack, and so on. If you adjust your first filter settings and then
click another filter in the middle column before adding another effect, you
replace the first filter rather than adding to it. (If you Option/Alt+click a new
filter, it will be added to the stack rather than replace the active filter in the
stack.) Here’s my step-by-step strategy for working in the Filter Gallery window:

1. Prepare your image before entering the Filter Gallery.

Many of Photoshop’s creative filters work best when you prepare the
image (or parts of the image) first. You have a couple of key filters that
don’t appear in Filter Gallery:

e Smoothing detail: Because Photoshop’s art-related filters can con-
centrate on details in your image, too much fine detail can make
your filter effects crowded and cruddy. Before working with Ink
Outlines, for example, try eliminating the tiny little bits in your
image. You could try either Smart Blur or Surface Blur.

¢ Adding detail: Many of Photoshop’s filters don’t do anything if the
target area doesn’t have some texture or detail with which to work.
That’s where the Add Noise filter comes in handy, adding dark and
light specks to the smooth area. Use the Monochromatic and
Gaussian options, with an Amount setting from 10% to 15%. After
adding noise to the too-smooth area, consider using the Blur=>
Motion Blur filter or the Pixelater>Crystallize filter (to make small
specks bigger).

2. Don’t forget layers and blending modes.

Make a copy of your layer before entering the Filter Gallery so you can
later mess around with layer blending modes and opacity to combine
the filtered version with the original, which can soften or even enhance
the effects you've applied.

3. Add to the stack before selecting filters.

You make your initial filter selection and adjustment. Then before you
switch to a different filter in the middle pane of the window, you need to
add a filter to the stack by clicking the New Effect Layer button in the
lower-right corner (to the left of the Trash icon).

4. Play with the stacking order.

Drag filters up and down in the stack at the lower right to change their
order.
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The order in which the filters are applied often makes a huge difference
in the final appearance of your image.

5. Use the eyeball column.

It’s a good idea sometimes to hide one or more effects in the stack while
you fine-tune a filter’s settings.

Filters are cumulative — changes that you make to one filter can them-
selves be changed by other filters in the stack.

Not all creative filters are available in the Filter Gallery. Remember that
Photoshop has dozens of filters that are available only through the Filter
menu, not through Filter Gallery.

Pull, and Twist with Liquify

Although the Lens Correction filter has added another powerful correction
tool to your arsenal, you still want to sometimes fix a photograph’s perspec-
tive or barrel distortion with Liquify. Perhaps. But with Lens Correction now
available, Liquify can concentrate on its fun side.

[ know of nothing in Photoshop that can bring a smile faster and more easily
than creating some strange creature from a friend or loved one in Liquify. I
will readily admit that the glow produced by the praise of an art critic is grati-
fying, but does it compare to, “More, Uncle Pete! Give me bigger ears!”? It
would certainly be a disservice to the Liquify feature to overlook its powerful
image-correction capabilities, so please remember that almost anything you
can do to emphasize or enhance an attribute can be done in reverse to mini-
mize that aspect of the image. Make someone short and wide? You can also
make them tall and thin. Creating a bulging nose? Create a slim and pert nose.
It’s all possible with Liquify.

That having been said, examine Figure 15-10, which shows some rather dra-
matic changes. (But it should give you some idea of how useful Liquify can be
for more subtle tasks, like trimming tummies, toning arms and legs, thinning
noses, and other such work.)

Take a look at the tools arrayed along the left edge of the Liquify window.
Here’s what they do, starting at the top:

1 Forward Warp tool: Much like Photoshop’s Smudge tool, you click and
drag the Forward Warp tool to push the pixels around.

1~ Reconstruct tool: Use the Reconstruct tool as your “undo.” (When in
Liquify, you can use 88+Z/Ctrl+Z, but it goes back only one step.) Drag
over areas that you want to restore to their original appearance.

329
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Figure 15-10: Liquify gives you unbelievable control over the pixels in your image.

1~ Twirl Clockwise tool: Click and hold the mouse button down or drag in
a circle to spin the pixels within the brush diameter. And if you want to
twirl counterclockwise, simply add the Option/Alt key.

~ Pucker tool: The Pucker tool sucks pixels into the center of the brush.
You can click and hold or drag the Pucker tool. Holding down the
Option/Alt key toggles you to the Bloat tool.

+~ Bloat tool: The opposite of the Pucker tool, the Bloat tool pushes pixels
out from the center. Holding down the Option/Alt key switches to the
Pucker tool.

~ Push Left tool: As you drag the Push Left tool, pixels are shifted to the
left of the path along which you drag (not necessarily to your left). If you
drag up, the pixels are shifted to the left on the screen; drag down, and
the pixels are shifted to the right. Use the Option/Alt key to reverse the
behavior and push pixels to the right of the path.

1 Mirror tool: As you drag the Mirror tool, whatever pixels are immedi-
ately to the left of the cursor as you drag are flipped and pasted into the
brush along the path you drag. When dragging left to right, whatever is
directly above the cursor as you drag is flipped and copied into the
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brush. For best results, use the Freeze Mask tool (see the upcoming
bullet) on the pixels that you want to copy before using the Mirror tool.
Holding down the Option/Alt key reverses the behavior, copying the
pixels to the right of the path as you drag.

+* Turbulence tool: The Turbulence tool is great for adding smooth distor-
tion along the path you drag. Think of it as making waves along the path.

i

Holding down the Option/Alt key switches the Turbulence tool to the
Reconstruct tool.

1~ Freeze Mask tool: One of the most important tools, the Freeze Mask tool
lets you protect areas of your image from change. Paint over an area

(you see a red mask) to freeze it — to keep it from changing.

1~ Thaw Mask tool: Unprotect areas with the Thaw Mask tool. It removes
the red overlay and lets you liquify the area again.

L €

T +~ Hand tool: As always, the Hand tool lets you reposition an image in the
}' window when it doesn’t all fit. Just click and drag your image to move it

£

in the preview window.

v Zoom tool: As you might suspect, the Zoom tool functions as it usually
'J\ does. Click to zoom in, Option/Alt+click to zoom out, and click and drag

to zoom in on a specific area.

To the right in the Liquify window are a number of variables and options. Brush
Size is the tool brush diameter; Brush Density is comparable with feathering
(lower is softer); and Brush Pressure controls the strength of the active tool.

The Reconstruct Options let you restore or partially restore your image to
the original appearance. The Reconstruct button is less like Step Backward or
Undo and more like Fade. Rather than reversing the liquification steps you've
already applied, it weakens them. The Mode pop-up menu offers several ways
to control how strictly the image is reconstructed. The mode that you select
is also used with the Reconstruct tool. (Revert is the most precise mode.)
The Restore All button returns your image to its pre-Liquify appearance.

If you're working on only one layer of your image and that layer has a layer
mask or transparent areas, or if you make a selection before entering the
Liquify feature, you can use the buttons in the Mask Options area to create
frozen areas (areas that are protected from change).

Near the bottom of the right side of the Liquify window (see Figure 15-10),
you can see the View Options, which let you show and hide the mesh: the
actual distortion you're creating. Note the mesh size and color options.
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Do I Need Those Other Filters?

Photoshop has dozens of filters, creative and productive, that you access
through the Filter menu rather than through the Filter Gallery. Some do
strange and wonderful things to your selection or image, and some just do
strange things that you might never need. You can find a description of each
of the filters in Photoshop’s Help, but a couple of them are worth a bit of
attention here.

Bending and bubbling

In the Filter~>Distort menu, you find Soue e

both the Shear and the Spherize fil- T =5} e
ters, both of which are simpler alter- 4 o

natives to Liquify for many projects. ey

@ wrap Arguind

Use the Shear filter to bend a selection | - uscares

back and forth, creating curves. Use p 1 ! = HH
Spherize to create a bulging, rounded e — - L11
image. Both Shear and Spherize are 2
easiest to control when you make a
selection of your target and copy it
to anew layer. And, as you see in Figure 15-11: The Shear filter bends; the
Figure 15-11, Shear works only verti-  Spherize filter bulges and pinches.
cally, so you might need to rotate

your image before and after the filter.

Creating clouds

Clouds make lovely, unobtrusive
backgrounds (as you see in

Figure 15-12) that can be scaled

and transformed to produce smoke
or steam, and you can even create
marbling effects from clouds. In the
Filter->Render menu, you find Clouds
and Difference Clouds. Both filters
use a mixture of the foreground and
background colors to create a cloud
pattern. The Clouds filter replaces
the content of the selection or layer
(if any), and Difference Clouds inter-
acts with the existing pixels (you
can’t use it on an empty layer) pleasant backgrounds.

pretty much like Clouds using the

Difference blending mode. Apply Difference Clouds several times, perhaps as
many as 20, to create abstract backgrounds and marble patterns, or perhaps
to simulate microscope slides.

Figure 15-12: The Clouds filter produces
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In this part . . .

' his part is more specialized than the others in
the book. These two chapters cover features
of Photoshop that you might never need.

Chapter 16 shows you how to streamline some

of your work with Photoshop’s automation com-
mands. You also read about recording Actions and
get a quick look at using scripting to automate
Photoshop. Keep in mind that Chapter 16 also
includes information on creating your own Web
sites in Adobe Bridge, generating on-screen pre-
sentations, creating contact sheets to track your
images, and printing multiple copies of an image
on a single sheet of paper — saving both time and
money!

If you don’t have Photoshop CS4 Extended, you
might skip Chapter 17. However, even if you don’t
have the Extended version, you might want to
take a peek to see how Photoshop can work with
3D, video, DICOM medical imaging, and measure
and record various measurements for scientific
and technical research.
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Streamlining Your Work
In Photoshop

In This Chapter

Working with Actions and the Batch command
Scripting in Photoshop

Automating your work in Bridge

Generating multi-page PDFs and presentations
Generating Web galleries through Bridge

A lot of the work that you do in Photoshop is fun — experimenting with fil-
ters, applying creative adjustments, cloning over former in-laws, that
sort of thing. A bunch of your work, though, is likely to be repetitive,
mundane, and even downright boring. That’s where automa-
tion comes in. If a task isn’t fun to do, if you need to speed
things up, or if you need to ensure that the exact same
steps are taken time after time, automation is for you.

[ begin the chapter with a look at Photoshop’s
Actions and the Batch command, which enable you
to process many files automatically. Next, I give you
a quick look at scripts, such as the very powerful
Image Processor. Scripts are sort of little computer
programs that you use to control your computer —
Photoshop, other programs, your printer, or even an
operating system itself. After that, | introduce automa-
tion through Bridge’s Tools menu and show you the pow-
erful Output panel. Bridge also enables you to generate PDF
presentations, multi-page PDFs (including contact sheets and
picture packages), and even Web galleries of your images.
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Ready, Set, Action!

S

In Photoshop, an Action is simply a recorded series of steps that you can play
back on another image to replicate an effect or technique. To choose a wild
example, say that every image in your new book about Photoshop needs to
be submitted at a size of exactly 1,024 x 768 pixels at 300 ppi, regardless of
content. Record an Action that uses the Image Size command to change reso-
lution and then use the Canvas Size command to expand the image to 1,024 x
768 pixels. Use that Action (play the Action) on each image before submitting
it. Better yet, wait until all the images for a chapter are ready and then use
the Batch command to play the Action automatically on each of them!

Actions and the Batch command not only streamline repetitive tasks; they
also ensure precision — that every one of those images will be exactly 1,024 x
768 pixels, each and every time. But Actions also have a creative side to
them. The lower part of the Action panel’s menu (see Figure 16-1) contains
Action sets that you can load into the panel to produce frame and border
effects, text effects, and more. (The content of your Actions panel menu
might differ from what’s shown in Figure 16-1.) You can also purchase collec-
tions of Actions from commercial sources.

To work with an Action, open an image, select the Action in the Actions
panel, and then click the Play button at the bottom of the panel. As you can
see in Figure 16-1, the three buttons to the left use the near-universal symbols
for Stop, Record, and Play. The three to the right use the standard Adobe
symbols indicating New Set, New Action, and Trash.

Any step in the Actions panel that doesn’t have a check mark in the left
column is skipped when you play the Action. Any step that has a symbol visi-
ble in the second column (the modal control column) pauses when you play
the Action. Click in the second column when you want the Action to wait for
you to do something. Perhaps you’ll click in that column next to a Crop step
so that you can adjust the Crop tool’s bounding box. You might click in the
second column next to an Image Size step so that you can input a specific
size or choose a resampling algorithm. After you make a change or input a
value for that step, press Return/Enter to continue playing the Action.

Notice the grayed-out Save Actions command in the panel’s menu in Figure 16-1.
Remember that you have to select a set of Actions in the panel, not an indi-
vidual Action, to use the Save Actions command. If you want to save only one
Action, create a new set and Option/Alt+drag the Action to that set to copy it.
You can also create a printable text file (. txt) of your Actions set by holding
down the 8+Option/Ctrl+Alt keys when selecting Save Actions. Text versions
of your Actions provide an easy reference for what each Action (and step)
does to an image.
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[ | B |p (3 Default Actions
[ w (3 Pete's Creative Actions
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Il | B Type-to-shape
[ | ¥ 1024x768, no profile ®FL
r Fiatten Image
P ¥ Image Size
Resolution: 300 per inch
i w Canvas Size
Width: 1024 pixels
Height: 76E pixels
Harizontal: canter
Vertical: center
Extansion Calor: white
(I B Assign Profile current document
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Button Mode

New Action...
New Set...
Duplicate
Delete

Play

Start Recording
Record Again...
Insert Menu Item...
Insert Stop...

Action Options...
Playback Options...

Clear All Actions
Reset Actions
Load Actions...
Replace Actions...

Commands
Frames
Image Effects
Production
Text Effects
Textures
Video Actions

Close
Close Tab Group

Figure 16-1: The Actions panel menu includes sets of Actions you can load into the panel.

If you get hooked on Actions, you'll also want to try Button Mode in the
Actions panel menu. Each Action appears in the panel as a color-coded
button. You don’t see the steps of the Action, so you don’t know whether
an individual step is being skipped and you can’t change the modal control
column, but you might like the color-coding to sort your Actions.

Recording your own Actions

The real power of Actions comes to you when you record your own. Sure, the
sets of Actions included with Photoshop are great, and the commercial pack-
ages of Actions have some good stuff too, but it’s not your stuff. When you
record your own Actions, you record the steps that work for your images,
your workflow, and your artistic vision.
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Actions can’t float free in
Photoshop’s Actions panel: Each
Action must be part of a set of
Actions. Before beginning to record N
your Action, you can select an exist- 2 2. 59
ing set or click the fourth button at few Acton
the bottom of the panel to create a =

Set: [ Pete’s Production Actions 1% ( Cancel )
new set. When you have a set I —— T = m—
selected, you can then click the New oo [ e —
Action button (second from right).
Then, in the New Action dialog box
(as shown in Figure 16-2), assign a
name (and color-code for Button Figure 16-2: After you click the New Action
Mode and perhaps assign an F-key button, you see the New Action dialog box.
combination) and click the Record
button. From that point forward, just about everything you do in Photoshop
is recorded as part of the Action until you click the Stop button at the bottom
of the Actions panel. No worries, though — you can always delete unwanted
steps from a recorded Action by dragging them to the Trash icon at the
bottom of the Actions panel. And if you want to change something in the
Action, you can double-click a step and rerecord it.

ACTIONS

Name: |Create layer, add 1-px stroke (" Record )

\&Q,N\BER You can record most of Photoshop’s commands and tools in an Action, but

& you can’t control anything outside of Photoshop. (For that you need scripting,
introduced later in this chapter.) You can’t, for example, use an Action to
print (controlling the printer’s own print driver), copy a filename from the
Mac Finder or Windows Explorer, or open Illustrator and select a path to add
to your Photoshop document. Nor can you record the movement of the
cursor in your Actions, which generally rules out recording painting tools.

Here are some tips about recording your own custom Actions:

1 Open a file first. Open the file in which you’re going to work before you
start recording the Action. Otherwise, the Open command becomes part
of the Action, and the Action will play on that specific file every time you
use it. You can, however, record the Open command within an Action to
open a second file — perhaps to copy something from that file.

1 Record the Close command after Save As. When you record the Save As
command in an Action, you're creating a new file on your hard drive.
Follow the Save As command with the Filem>Close command and elect
Don’t Save when prompted. That closes and preserves the original image.
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1~ Use Percent as the unit of measure. If you need an element in your art-
work to be in the same spot regardless of file size or shape (like a copy-
right notice in the lower-right corner), change the unit of measure to
Percent in Photoshop’s Preferences before recording the Action.

+* Record/insert menu commands. When you use a menu command while
recording your Action, the actual values that you enter into the dialog
box are recorded, too. If you’d rather select the values appropriate for
each individual image (perhaps for the Unsharp Mask filter), insert the
command rather than record it. When you reach that specific spot in
your process, use the Actions panel menu command Insert Menu Item
(refer to Figure 16-1). With the dialog box open, mouse to and select the
appropriate menu command; then click OK to continue recording the
Action. In Figure 16-3, you see the Insert Menu Item dialog box when first
opened (before a command is selected) and after [ used the mouse to
select the Image Size command from Photoshop’s Image menu.

Insert Menu Item

Menu Item: None Selected OK )
- Cancel ) ‘

{ ! | To record a menu item, select a menu item using the mouse.

isciEeouitem

Menu Item: Image:lmage Size f 0K :) ‘

~ Cancel

{ ! | To record a menu item, select a menu item using the mouse.

Figure 16-3: Using Insert Menu Item leaves a dialog box open when playing the Action.

1~ Record multiple versions of a step, but activate one. Say you want to
record an Action that does a lot of stuff to an image, including changing
the pixel dimensions with the Image Size command. However, you want
to use this Action with a variety of images that require two or three dif-
ferent final sizes. You can record as many Image Size commands as you
want in that one Action — just remember to deselect the left column in
the Actions panel next to each of the Image Size steps except the one
you currently want to use. And you can record an Action within an
Action, too. Just play the second Action while recording the first.
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1~ Insert a message or warning. Use the Actions panel menu command
Insert Stop to send a message to anyone who plays your Action. The
message could be something like “You must have a type layer active in
the Layers panel before playing this Action” with buttons for Stop and
Continue. Or you could phrase it more specifically: “If you have not
selected a type layer in the Layers panel, click Stop. If a type layer is
active in the Layers panel, click Continue.” The more precise the mes-
sage, the less confusion later. In Figure 16-4, you see the Record Stop
dialog box, where you type your message when recording the Action
(top), as well as a look at how the message appears when the Action is
played back later (bottom).

Record Stop
Message: { oK )
|If you have not selected a type layer in the Layers ( cancel )

|panel, click Stop. If a type layer is active in the S —
|Layers panel, click Continue]

@ Allow Continue

Adobe Photoshop

If you have not selected a type layer in the Layers panel, click
Stop. If a type layer is active in the Layers panel, click
Continue.

I(_ Stop \I ["Eontinue‘--"

Figure 16-4: Insert a Stop to show a message when the Action is played.

 Remember Conditional Mode Change and Fit Image. These two com-
mands in the Automate menu are designed to be recorded in an Action
that you might later use on a wide variety of images.

e Conditional Mode Change is very handy when your Action (or final
result) depends on the image being in a specific color mode. When
you record Conditional Mode Change in an Action, every image,
regardless of its original color mode, is converted to the target
color mode (see Figure 16-5). Say, for example, that you need to
apply a certain filter in an Action, but that filter is available only
for RGB images. If you record Conditional Mode Change before run-
ning the filter, the Action will play properly.
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Conditional Mode Change

— Source Mode ( ok )
E‘Bitmap ERCE Color
[ Cancel ]
E‘ Grayscale E‘ CMYK Color -
gDuotone E‘Lab Color
E‘ Indexed Color E‘ Multichannel
O Al \ { MNone )

Target Mode ————————
’7Mcde: ¥ Bitmap H
| Grayscale
__1 Duotone
Indexed Color r
RGE Color
CMYK Color

Lab Color
Multichannel

Figure 16-5: Conditional Mode Change converts every image to the target color mode.

e Fit Image specifies a maxi-
mum width and height
that the image being ’*Ctmmin Within———— (50K

Fit Jmage

processed must not gEas 200 PR | tameer)
exceed, regardless of size

or shape — great for
batch-processing images
for the Web. Fit Image
maintains your images’
aspect ratios (to avoid
distortion) while ensuring
that every image processed fits within the parameters you specify
(see Figure 16-6). If you need all landscape-oriented images to be
800 x 600 pixels and all portrait-oriented images to be 600 x 800
pixels, enter 800 in both the width and the height fields.

Height: 800 pixels

Figure 16-6: Fit Image scales all images to fit
within the specified dimensions.

1~ Always record an Action from a copy of your image. Because the steps
that you record in the Action are actually executed on the open file,
record your Action using a copy of the original image. That way, if some-
thing goes wrong, your original image is protected.



34 2 Part IV: Power Photoshop

Working with the Batch command

Photoshop’s File>Automater>Batch command plays back a single Action on a
number of files. You select an Action to play and also a folder of image files to
play it on; then you decide what you want to do with the files after the Action
finishes with them. You can leave the images open in Photoshop, save and
close them, or (much safer) save them to another folder, preserving the origi-
nals. Figure 16-7 shows the Batch dialog box and also the pop-up menu for the
fields in the File Naming area. (When you select a new folder as the Destination

in Batch, you must tell Photoshop how you want the new files to be named.)

— Play

Set: | Pete's Production Actions

Action: | 1024x768, no profile l-@'l

- Source: | Folder E

( Choose... ) Untitled:Users:peterbauer:...:.PScs4forDummies:327258-Ch16:327258-Ch16-Newlmages:
" Override Action “Open” Commands

B Include All Subfolders

™ Suppress File Open Options Dialogs

™ Suppress Color Profile Warnings

~ Destination: | Folder @

Choose... | Untitled:Users:peterbauer: PROJECTS: PScs4forDummies:327258-Ch16:327258-Chl6-Parts:

1 Override Action “Save As” Commands

— File Naming
Example: MyFile20080610001.gif

‘Docum_ent Name @ +‘wyymmdd (date} B +
‘3 Digit Serial Number !ﬁ +‘Exlen5ian ﬁ +
\ 8 3]

Starting serial#: |1

Compatibility: EWinduws V' Mac 05 EUnix

— Errors: | Stop For Errors @

Save As

Cancel |

Document Name
document name
DOCUMENT NAME
1 Digit Serial Number
2 Digit Serial Number
3 Digit Serial Number
4 Digit Serial Number
Serial Letter (a, b, c...)
Serial Letter (A, B, C...)
mmddyy (date)
mmdd (date)
yyyymmdd (date}
yymmdd (date)
yyddmm (date)
ddmmyy (date)
ddmm (date)

¥ extension
EXTENSION
None

Figure 16-7: The Batch command is much simpler than it looks!
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You must remember three things when assigning filenames:

+~ Include a variable. Something must change from filename to filename.
Select one of the top nine items in the pop-up menu (some version of the
document name or a serial number or a serial letter). It doesn’t have to
be in the first field, but one element of the filename must be different
from file to file.

~ Don’t use a period (.) in any field. You can type in any of the fields
(except the last one you use), but for compatibility, stick with letters,
numbers, underscores (_), and hyphens (-).

Absolutely do not use a period (.) in the filename. The only period that
can be used in a filename is the one that’s automatically added immedi-
ately before the file extension.

+ You have two other decisions of note in the Batch dialog box. When
you elect to suppress any Open commands in the Action, you protect
yourself from poorly recorded Actions that start by opening the image
with which they were recorded. However, if the Action depends on the
content of a second file, you don’t want to override that Open command.
Generally, you want to override any Save As commands recorded in the
Action, relying instead on the decisions that you make in the Batch
dialog box to determine the fate of the image.

Sticking to the Script

\\3

You can use AppleScript (Mac), Visual Basic (Windows), and JavaScript (both)
with Photoshop. Photoshop includes several very useful scripts in the Filew>
Scripts menu (see Figure 16-8).

Scripts are much more powerful than Photoshop’s Actions because they can
control elements outside of Photoshop itself. AppleScripts and Visual Basic
scripts can even run multiple programs and play JavaScripts. If you're inter-
ested in scripting, go to the Photoshop folder on your hard drive and explore
the content of the Scripting Guide folder. You can find plenty of information
to get you started!

You can find more scripts on the Internet, including some at http://
share.studio.adobe.com. Select Scripts from the Adobe Photoshop
Download pop-up menu.

343
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# Photoshop Edit Image Layer Select Filter View Window Help

New... #EN

Open... #0

Browse in Bridge... N#O

Open As Smart Object...

Open Recent >

Device Central...

Close BW

Close and Go To Bridge... G BwW

Save #S

Save As... 138S

Check In...

Save for Web & Devices... 43S

Place...

Import »

Export b

Automate >

P Image Processor...

File Info... ¥l Flatten All Layer Effects
Flatten All Masks

Page Setup... 3P

Print... P Layer Comps to Files...

Print One Copy N3P Layer Comps to PDF...
Layer Comps to WPG...
Export Layers to Files...
Script Events Manager...
Load Files into Stack...
Browse...

Figure 16-8: Among Photoshop’s most powerful features is the ability to use scripts to
automate your workflow.

If you shoot in Camera Raw format, perhaps the most useful of the pre-
recorded scripts is Image Processor (see Figure 16-9). You can use Image
Processor to batch-convert your Raw images to JPEG, PSD, or TIFF — and

you can even resize the images automatically while converting! (And while
Image Processor is designed to work with Raw files, you can actually convert

any file format that Photoshop can open.)
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Select the images to process @

() Use Open Images ™ Include All sub-folders

~ [ Cancel )

8 ) @ [ SelectFolder... ) /Users/peterba..$/ImagesToSort ~———
" Open first image to apply settings

( Load... )

© Select location to save processed images
-;t“?' (0) Save in Same Location [ Keep folder structure  save.. )
A J (O] Select Folder... JUsers/peterba.. rocessed JPEGs

File Type
ESave as JPEG g Resize to Fit
Quality: 12 | W:pr
"1 Convert Profile to sRGB H: (800 |px
"1 save as PSD Resize to Fit
v! Maximize Compatibility W px
H: px
"1 Save as TIFF Resize to Fit
LYW Compression W px
I pX
Preferences

g Run Action: | pate’s Producti... W—‘ [ Create layer, a... Fﬁ-{

Copyright Info:  ©2008 Peter Bauer
™ Include ICC Profile

Figure 16-9: Image Processor can batch-convert to speed your workflow.

Image Processor is much simpler than it appears:

1~ Select the images to process. If the images are already open in Photoshop,
great! If not, click the button and select a folder of images. If the source
folder has subfolders and you want to process the images in those subfold-
ers, select that option.

1~ Choose a destination. You can save the files in the folder of origination,
or you can click the button and select a different folder in which to save
the processed images.
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Do not click the Select Folder button and select the source folder. If you
want to keep the processed images in the same folder as the unprocessed
images, simply click on the Save in Same Location button. Photoshop is
smart enough — most of the time — to recognize the source folder and
avoid re-processing already-processed images in an endless loop, but
don’t risk it.

1~ Select the file format and options. Each of the three file formats offers

the option of resizing. JPEG offers options for Quality (the amount of
compression — and associated image degradation) and to convert to
sRGB (for the Web or e-mail). Maximizing compatibility for PSD files
ensures the image can be seen and opened by other programs of the
Creative Suite and earlier versions of Photoshop. TIFF’'s LZW compres-
sion can significantly reduce file size, without degrading the image at all.

At the bottom of the Image Processor dialog box, you also have the options
to run an Action on the images as they’re processed, to add your copyright
information to the file’s metadata (not on the image itself), and to embed the
color profile in the image.

Tooling around in Bridge

The first step in getting familiar with Adobe Bridge and its automation
options is Bridge’s Tools menu (see Figure 16-10). Note that if you have the
Adobe Creative Suite installed, you'll also see other programs listed in addi-
tion to Photoshop.

‘Labe\ Window Help

Batch Rename... 43R
Device Central...

Create Metadata Template...

Edit Metadata Template >
Append Metadata >
Replace Metadata >
Cache >
Photoshop o » Batch...

Image Processor...

Load Files into Photoshop Layers...
Merge to HDR...

Photomerge...

Process Collections in Photoshop

Figure 16-10: The Tools commands can make quick work of big jobs.
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Here’s an overview of some of the tasks you can perform through the Tools
menu:

+~ Batch Rename. Rename a whole series of images in a single process!
Select the image thumbnails or a folder of images in Bridge, open Batch
Rename (see Figure 16-11), construct the new filenames, and click the
Rename button.

When building the new file names, use the plus and minus buttons to the
right to add or subtract each element. The various choices are shown in
the box to the right in Figure 16-11. Each element will have one or two
fields or pop-up menus to the right.

QNING/ Absolutely do not use a period (.) in any text file of the new filename. The
Y only period that can be used in a filename is the one that’s automatically
added immediately before the file extension. In the text fields, use only
letters, numbers, underscores (_), and hyphens (-). To use a period or
any other symbol in the new filename risks making the file unrecogniz-
able by Photoshop or any other program. (This means you, too, Mr. &
Ms. MacUser!)

Batch Rename

Destination Folder { Rename |
(C) Rename in same folder ( Load... Y

() Move to other folder

( )

@ Copy to other folder _ Save..
E— 5 ( Y
{ Browse... ) [Users/peterbauer/PROJECTS /Destination _ Cancel
New Filenames
| Text I-‘:{ PhotoshopCS4forDummies ¥ Text
. v New Extension
.TEX[—M -Chapter16- Current Filename

= = = Preserved Filename
| Sequence Number =R | Four Digits =] SerahisNneE

Sequence Letter

Options Date Time

Metadata

E‘ Preserve current filename in XMP Metadata
Folder Name

Compatibility: EWmduws V] Mac 0S EUnix

Preview
Current filename: 16fig-Output.tiff
New filename: PhotoshopCS4forDummies-Chapter16-000L.tiff

14 files will be renamed

Figure 16-11: Batch Rename enables you to speedily take care of one very important
organizational task.
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1~ Device Central. Used to create images for display on cell phones and
other such smaller screens, Device Central can also be accessed through
Photoshop’s FilewSave for Web & Devices command.

1 Work with metadata templates. Metadata, that useful information about
an image stored with the image, often is repeated from file to file. You
might, for example, add exactly the same copyright information to each
and every image you shoot. Or you might return from a job or trip or
vacation with gigabytes of images shot at the same location or of the
same subject. Using metadata templates enables you to quickly and
easily add metadata to a series of (or even folders of) images, in just a
couple of clicks.

1 Manage Bridge’s cache. The cache is where Bridge stores thumbnails
and metadata of images with which it has already worked. Accessing the
cache for a folder (rather than re-processing each image every time you
open the folder) can save loads of time. However, sometimes the cache
can get corrupted. Should you see, for example, thumbnails of images
that have been moved or deleted, go to the Tools=>Cache menu and
elect to purge the cache. You can also build and export the cache for the
current folder through this menu, which is a great thing to do just before
burning the folder to DVD or CD as a backup!

1 Access automation in other programs. As you can see in Figure 16-10,
Bridge’s Tools menu also gives you access to a number of Photoshop’s
automations and scripts. (If you have Illlustrator and/or InDesign
installed, you’ll have access to some of their features as well.)

Creating Presentations and Multi-page PDFs

Much of the functionality that once appeared in Photoshop’s Filec>Automate
menu has migrated to Bridge, where it’s available to all of the programs of
the Creative Suite. You can create PDFs, both multi-page and presentations,
as well as Web galleries, through Bridge’s Output panel. Access the Output
panel by clicking that workspace name or using the shortcut 38/Ctrl+F1, as
shown in Figure 16-12.

He>- © (2B GBr ¢ oury [N

[-';h.lser; » ﬁpeterhauer » DPRDJECTS > I____|FPI—convcnrmn > Dlmageﬁ L Dlmageﬂank

Figure 16-12: Automate your output with Bridge's Qutput panel.
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Portable Document Format (PDF), the native file format of Adobe Acrobat, has

become an incredibly useful and near-universal format. It’s hard to find a

computer that doesn’t have Adobe Reader (free software to open and view
PDF files) or another program for viewing PDFs, and that helps make PDF a
wonderful format for sharing or distributing your images.

In Bridge’s Output panel, shown in Figure 16-13, you can quickly and easily
create both on-screen presentations (complete with fancy transitions
between images) and multi-page PDF documents (suitable for distribution

and printing).

Her- &

[ iy~ G o |

* IEDCIE EsSENTIALS  FILMSTRIP  METADATA ¥ | |0-

| ravonires | roLoers |
- |25 Applications
» Library
b [ system
v [@] users
v m peterbauer
Desktop
» @ Documents
Downloads

[ Music
» Pictures
v [ PROJECTS
(L] Destination
» [l ImagesTosort
¥ [ PPI-canvention
v (] ImageFiles

>

M imageBank
¥ [l PScsaforDummies
» [l 327258-Cho3
» [l 327258-Cho7
» [ 327258-Ch14
¥ [l 327258-Ch16 3
(L] 327258-Ch16-Newimages
» [ 327258-Ch16-Parts
» [ 327258-Ch17

[Eusers » ¢} peterbaver » [JPROJECTS > [IPPI-c

(0] sourceDOCs

CONTENT

| =

BB | &~

:ﬁ__.‘ PDF
L

Template: Custom
Refresh Preview
+ Documant
b Layout

+ Overlays
v Playback

+ Open in Full Screen Mode

V Advance Every - Seconds
+ Loop After Last Page

Transition: | Wipe
Direction: Left

Speed: Fast

» Watermark

SortbyFilename > A | 3 T pwer B W

QUTPUT

8 WEB GALLERY

 View PDF After Save Save...

20 items, 3 hidden, 20 selected - 132.40 MB

= | (==

Figure 16-13: PDFis a great format for sharing images as presentations or as documents.
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To create a PDF Presentation in Bridge, [ ourur |

take the following steps:

1. Select the thumbnails of the
images you want to include. You
can click and then Shift+click to
select a series of images or
38 +click (Mac)/Ctrl+click
(Windows) to select individual
images.

Hint: You must select the images;
you can'’t select only the folder.
Bridge automatically skips any
non-image files that are selected.

2. In the Document section, choose
an appropriate size.

Choose one of the Web presets,
shown in Figure 16-14, rather than
a paper size. Adobe Reader can
scale the presentation, so 800 x
600 pixels is a good choice unless
you know the presentation will
always be played back on a larger
monitor. Choose your background
color (black is an excellent choice)
and determine whether you want
to require a password to open the
document or to make the presenta-
tion non-printable.

3. Choose a layout of one-by-one.

Unless you actually want more
than one image displayed in each
frame of the presentation, use a
layout of one column and one row,
as you see in Figure 16-15.

4. Choose your playback options.

You select whether you want the
presentation to fill the screen, how
long each frame will be displayed,
whether the presentation plays
once or continuously, and how it
changes from frame to frame.
Figure 16-16 shows the layout.

:i; PDF = WEB GALLERY

Template: Custom ¥

Refresh Preview

* Document

Page Prese 640480 v
Br: v 800 x 600 - v
1024 x 768 |
Widt| 1152 x 864 A4
, 1280 x 1024
Heigh 1600 x 1200 |
Quality? T High Quality v
Background: White v

Document Password:
Disable Printing
b Layout

r Overlays
v Playback

Figure 16-14: Size your presentation for
on-screen display rather than print.

ouTRUT |

:ij PDF = WEB GALLERY
Template: Custom v

Refresh Praview
¢ Document
¥ Layout
Image Placement:

Across First (By... =

Columns: 1

Rows: 1

+'Use Auto-Spacing
Rotate for Best Fit

Repeat One Photo per Page

» Overlays
¥ Playback

Figure 16-15: It's possible to have multiple
images in each frame, but not typical.



5. [Optional] Add the filename or
a watermark to each frame.

In the Overlays section (shown
later in this chapter in Figure
16-19), you can elect to add

the filename (with or without
the file extension) below each
image, choosing the font, style,
size, and color of your choice.
You can also add a watermark,
perhaps your copyright informa-
tion at a reduced opacity, across
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OUTRUT |

:-'L— PDF = WEB GALLERY
Template: Custom v

Refresh Preview

¢ Document
b Layout

» Overlays
¥ Playback

+ Open in Full Screen Mode

the center of the image. You’ll  Advance Every [§ Carands

find that your options in the  Loop After Last Page

Watermark section (shown in . -

Figure 16-20) include all the font Taesition: | Wipe

choices, Opacity, and Foreground Direction:  Left X
or Background. (Unless your Speed: Fast v
images include transparency

or reduced opacity, select » Watermark

Foreground.) v View PDF After Save Save...

6. Preview your presentation.

Figure 16-16: The options in Playback govern
how the presentation will be displayed.

Click the Refresh Preview

button near the top (shown in
Figures 16-14 through 16-16) to
make sure you’ll get want you want.

7. Save your presentation.

Way down at the bottom of this dialog box (and shown in Figure 16-16),
you can choose to view the presentation (or not) when ready with the
View PDF After Save option. Click the Save button, name the presenta-
tion (Bridge will automatically add the . pdf file extension), choose a
location in which to save, and click Save.

Collecting thumbnails in a contact sheet

In the old Dark(room) Ages, photographers regularly made a record of which
images were on which film strips by exposing those strips on a piece of pho-
tographic paper, thus creating a contact sheet. The contact sheet serves the
same purpose as thumbnails or previews in Bridge or the Open dialog box or
thumbnail images on a Web page — they show which image is which. Hard
copy contact sheets are useful to present to a client. Bridge can automate the
process for you in the Output panel by generating a PDF that contains small
copies of each image in a folder. Here’s the procedure:
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1. Select the thumbnails of the images you want to include.

Hint: You must select the images; you can’t select only the folder. Bridge
automatically skips any non-image files that are selected.

2. Select an appropriate page size
in the Document area.

Choose from among the presets
or define a custom size. If the
contact sheets will be printed,
use a paper size, as you see in
Figure 16-17. If they’re intended
only for on-screen display,
select a size from the Web pre-
sets (shown in Figure 16-14).
Elect to generate high-quality or
low-quality thumbnails and pick
a background color. (Black is
beautiful and makes your
images “snap,” but also uses a
lot more ink when printing.) You
can also require a password to
open the document or forbid
printing the contact sheets.

3. Define your layout.

In the Layout section, you
choose how many thumbnails
in each row and column

(Figure 16-18). You can choose
to have the images added to the
page row by row (the second
image is to the right of the first)
or column by column (the
second image is directly below
the first). You can also define the
spacing between thumbnails, but
the Use Auto-Spacing option is
almost always a safe choice.

You can also elect to auto-rotate
images so that, regardless of ori-
entation, all the images are the
same size. Do not select Repeat
One Photo per Page when gener-
ating contact sheets. (With that
option selected, instead of con-
tact sheets you’ll have pages
with multiple copies of one
image).

OUTPUT |_

:-L— PDF = WEB GALLERY

Template: Custom v

Refresh Preview

¥ Document

Page Preset: U.S. Paper v
Size: Letter v
Width: &5 inches v
Height: 11 e
Quality:  High Quality v
Background: White v

Document Password:

Disable Printing

Figure 16-17: Select the size and orientation of
the contact sheets in Document.

¢ Document

¥ Layout
Image Placement: Across First (By... v
Columns: 4 Top: 0:17  in
Rows: & Bottom: 817  in
Horizontal: 0-49  in Left: 0.17  in
Vertical: 0:25 | in Right: .17 in

kUse Auto-Spacing
Rotate for Best Fit

Repeat One Photo per Page

Figure 16-18: Define the number of thumbnails
and set the spacing (or use the convenient
Auto-Spacing option).
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. Choose whether to use the file- |) Document

If your folder is filled with portrait-oriented images, you can certainly
have more columns than rows so that each image better fills the area
allotted for it. For example, when printing 20 portrait images, using

5 columns and 4 rows produces larger printed images than using

4 columns and 5 rows.

name as a caption. bl ayout
¥ Overlays
In the Overlays section (shown . .
. N + Filename Extension
in Figure 16-19), you can elect to
use the filename as a caption, Font: | Arial v Regular v
with or without the file exten- Size: [ 10 pt v

sion. If you use this option, be
sure not to choose a font size

Color: Black v -

too large to fit within the space
allocated for each thumbnail!

Figure 16-19: Filenames can help your client

. Add a watermark (or not). order prints, but only you might need to see a

You also have the option of file extension.

adding a watermark (circled

in red in Figure 16-20), but that’s splashed across the middle of the page
and might serve little purpose. If, however, you have an even number of
rows and adequate spacing among thumbnails, you could consider
sneaking in a line of information about the job or your copyright info.

ourrur |

:-LPDF ' WEB GALLERY
Template: Custom "
Refresh Preview
+ Document
» Layout
b Overlays

» Playback
* Watermark

Warermark Text;

Font: Arial v Boldi. v
Size: = BB o
Celor: Black |

Opachty: o] m& X

@ Foreground

CBackground

Figure 16-20: A well-placed watermark depends on the number of rows and the spacing.

6. Preview and save.

Click the Refresh Preview button (visible in Figure 16-20 to the upper-
right) to get a look at what you're creating, make any changes necessary,
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and then click the Save button. You next see a dialog box in which you
name the presentation (Bridge automatically adds the .pdf file exten-
sion) and choose a location in which to save. Bridge creates a multi-page
PDF, generating as many pages as necessary to hold all of the selected
thumbnails.

Saving paper with picture packages

Using Bridge’s PDF-generation feature is also a great way to put multiple
copies of an image on the same page for printing. Suppose you need to print
a dozen copies of an image, each at 4 x 5 inches. Printing each on a separate
sheet of paper takes 12 sheets (oh, the cost!) and 12 print cycles. Define a
custom layout in Bridge’s Output panel (as shown in Figure 16-21) to put four
4 x 5 images on a single page, and you use three sheets of paper and wait
through only three print cycles. Um, let’s see, which do you want to do?

CUTPUT PRI L ourrer |

5. por %5, WEB GALLERY

Template, Custom
Refresh Preview
# Document
* Layout
Image Placement;  Across First (By... ¥
Columns: & | Top: 0RS
Rows: & 4 Bottom: SN
Horizontal; B0 in Len; OISH
vertical 800 in Right 080
Use Auto-Spacing
Rotase for Best Fit
~ Repeat One Photo per Page

L R

Figure 16-21: Multiple images on a single page to create a picture package.

You have to do the math to get your picture packages to print at the size you
want. In this example, | want 4 x 5 inch prints, so [ split the difference between
size of the prints and paper in the Top/Bottom and Left/Right margins.

Creating Web Galleries

In Bridge’s Output panel, you can also generate galleries of your photos (see
Figure 16-22). Create quick, yet elegant, stand-alone Web sites of your photos
for posting on the Internet.
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e+~ o MAh- 00 GG SSINTIALS  FUMSTRIF  METADATA * Do 3
Aiwers 3 7D peserbower 3 L) MIOICTS 3 L M-comimtion 3 Llmagafies 3 L imepeiash ¥ AN = imthums A 7 " el B

= ¥ -, WEB CALLERY

Template:  $tandard
Stvle. Mediwm ThRembnail
Refresh Priview  Preview in Browser
I+ sneiota =
| + Color Paletne.

» Appeasance
* Create Gabery

Browse_ Save

59 M, § oo, 11 seswenta - £20.88 - b P o | 8 e

Figure 16-22: Use Bridge to create Web sites of your images.

It takes only a few steps (okay, and a lot of experimentation) to create gor-
geous galleries to display your photos just the way you want them to be seen.
Here’s what to do:

1. Select the thumbnails of the  Site Info

images you want to include. ,
Gallery Title:

Hint: You must select the
images; you can’t select only the
folder. Bridge automatically Sl

skips any non-image files that Places & People of Note
are selected.

Peter Bauer Photography

About This Gallery:
2. Select a template. All images ©2008 Peter Bauer

To the upper-right in Figure
16-22, you can see the Template
menu. Choosing the template
that’s just right for you might Your Nama:
take a number of experiments,
but it’s certainly worth explor-
ing each of them, one at a time. e e

Peter Bauer

3. Fill out the Site Info. pete@IndyPixels.com

Copyright Info:

This section is where you name
©2008 Peter Bauer

the site, provide your contact
info, and list the copyright + Show Title Bar
notice (see Figure 16-23).

Figure 16-23: The Site Info section provides
your visitor with vital information.
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4. Choose colors for the gallery. v Color Palette
The options in this section vary, Background: Menu:
depending on the template :
M B
selected. Figure 16-24 shows Bl vain . e
what choices you'll need to Ml Thumbnail B Hover
make when selecting the Bl siicieshiow Text
Standard template.
5. Fine-tune the appearance. Title: Thumbeail:
Title B H
The content of the Appearance Ul e
section (Figure 16-25) also Text Selected
varies, depending on the

selected template. _ )
Figure 16-24: Various templates have different

6. Preview. components and differing color options.

Click the Refresh Preview
button (shown in the upper-
right in Figure 16-22) to see the  [3 Appearance
fruits of your decision-making
process in steps 1-5. You can
also preview in your Web

Show File Names

Preview Size: Medium v
browsers, which can show you
any potential problems with Thumbnail Size: ' Medium &
complex templates in certain Slide Duration: 5 seconds
browsers. It’s a great idea, too,
to take the time to preview each | Transition Effect:  Fade M

of the templates, perhaps using
the default color schemes and

appearance settings, just to get  Figure 16-25: The choices you make in
a feel for them. Appearance vary from template to template.

Bridge saves you time by only processing the first ten of the selected
images when generating a preview. When you finally have the gallery
looking juuuust right and click the Save button, all of the selected images
are processed.

7. Generate the gallery.

Bridge offers you the option to save your gallery to your hard drive or to
directly upload it to the host Web server. The Web server is a computer
owned by your Internet Service Provider (ISP). (Most Internet service
agreements these days include space on the servers for your personal
home page.) Check with your ISP for specific upload instructions — the
process varies quite a bit from ISP to ISP.

If you’d like to share a gallery with friends or clients but you don’t have a
Web server, save the gallery to your hard drive, send the entire content of the
folder you choose as the destination, and instruct the recipient to open the
file named index.html using a Web browser’s File>Open command.
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Introducing Photoshop CS4
Extended

In This Chapter
Exploring Photoshop CS4 Extended
Working in 32-bit color
Stacking modes for Smart Objects
Getting an overview of 3D, video, and analytical features

Spelling out some new capabilities

ou might have purchased Photoshop CS4 and are wondering about

the features of Photoshop CS4 Extended. You might have received
Photoshop CS4 Extended as part of a bundle or the Adobe Creative
Suite and aren’t sure whether you need these features. You
might be browsing in the bookstore, trying to determine
whether to purchase Photoshop CS4 or Photoshop CS4
Extended. (If this last scenario is the case, my advice
to you is this: Purchase this book first and then, with
any money you have left over, buy the version of
Photoshop that best fits your needs. Read about the
Extended features, and if you don’t need them, save
some money and buy Photoshop CS4. And then buy
lots more copies of this book to give to friends,
family, and co-workers.)

In this chapter, I introduce you to the various special
features of Photoshop CS4 Extended. This chapter won’t
get you fully up-to-speed on how to work with the features;
instead, it’s meant to quench your curiosity about the differ-
ence between Photoshop CS4 and Photoshop CS4 Extended. (For an
in-depth look at working with the special features of Photoshop CS4
Extended, see Photoshop CS4 Bible, Professional Edition from Wiley.)



3 5 8 Part IV: Power Photoshop
Understanding Photoshop CSh Extended

For years, Adobe has heard the pleas of researchers, scientists, and other
highly specialized users of Photoshop to include features that fulfill their
needs. Adobe now provides the tools these specialists need. But rather than
just adding them into Photoshop CS4 and making everyone pay the costs for
developing these features that few will use, Adobe packaged them as a sepa-
rate, higher-priced version of the software. “Let those who need the new fea-
tures subsidize their costs!” was the decision. And, in my opinion, it was a
fine decision. As I explain, these extended features don’t really have a place
in the workflow of most Photoshop users.

That doesn’t mean that if you do [Filter m'éb View Window Help |
have Photoshop CS4 Extended that : Set Meakurement Scale > '
you’ll never use any of these features! Select Data Points 4

(“How do I know which version | Record Measurements

have?” Watch as Photoshop starts to Ruler Tool

see which splash screen appears.) v Count Tool

Even if you didn’t specifically pur-
chase the Extended version (it might
have been part of a package deal),
you might someday decide to work Figure 17-1: Photoshop CS4 Extended includes
with 32-bit, high dynamic range the Analysis and 3D menus.

images. Or you might find a need to

calculate a height or a distance using the measuring tools in Vanishing Point.
But unless you actually work directly in one of the target fields for the fea-
tures of Photoshop CS4 Extended, you're not likely to miss the additional
capabilities at all. Another clue that you're working in Photoshop CS4
Extended is that you can see the Analysis and 3D menus, visible in Figure
17-1, which contain commands related to working with the new measuring
capabilities (discussed later in this chapter).

Place Scale Marker...

Painting and Layers in 32-Bit Color

One of the new features of Photoshop CS4 Extended that appeals to some
photographers is the ability to work with layers and painting tools in 32-bit
color. With layers comes access to some blending modes. And, as you can
see in Figure 17-2, 32-bit images can even have adjustment layers. Okay, well,
some adjustment layers. . .
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# Photoshop File

Edit Image Select Filter  Analysis

New »
Duplicate Layer...

3D View Window Help

New Fill Layer
New Adjustment
Levels...

Exposure...

Vibrance...

. Hue/Saturation...
Smart Objects »

Video Layers »

Photo Filter...
Channel Mixer...

Figure 17-2: A 32-bitimage can contain layers and adjustment layers, but only in the Extended
version of Photoshop.

“&N\BEB Although you can now create a 32-bit/channel high dynamic range image
& through the Filem> New command, they’'re generally the product of the

Filec>Automater>Merge to HDR feature. Shoot (with a tripod) several expo-
sures of the same scene, changing only the shutter speed from shot to shot
(and don’t use autofocus), and then merge the entire tonal range, from the
darkest exposure to the brightest, into a single image. You can also create a
32-bit image with Merge to HDR using several different Camera Raw adjust-
ments of a single exposure.
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Because you can now paint in 32-bit
color, you need a way to identify
colors with which to paint. If you
click the color swatch at the bottom
of the Toolbox, the new HDR Color
Picker opens (see Figure 17-3).

In addition to the Eyedropper, among
other tools available when working
in 32-bit color are the Type, Sharpen,
Blur, Gradient, and Quick Selection
tools. However, the toning tools
(Dodge, Burn, and Sponge) and some
tools that rely on color (including the
Spot Healing Brush, Healing Brush,
Patch tool, Magic Wand, Color

Color Picker (Foreground Calor, 32-bit

. o ) - TOK e
N ¢ o )
[ Add Ta Swatches |

..... =
32-bitvalue [ Coler Libraries |

R |0.6254

G:|0.0303

B 0.0119 |

Preview Stop Size: | 1 (8]
| Relative Ta Document

Intensity/Color Picker

Intensity: e |0.00 |stops

| ®H: 2 "

i Os (8 |%
OB 63 [%
IR 159
0G: {8

A, OB 3

Figure 17-3: A 32-bit painting requires 32-bit
color definition.

Replacement, Paint Bucket, and
Magnetic Lasso) aren’t suitable for
use with 32-bit color. Still, the
improved capabilities for working
with high dynamic range images
make it feasible to actually be productive using 32-bit color.

Smart Object Stack Modes

Working with Photoshop CS4 Extended, you can combine a number of images
into a single stack as a Smart Object. Within the pile of images, you can deter-
mine how the pixels in each interact with those in the others. Select several
related or contrasting images and add them as layers to a single image, select
the layers, and create a Smart Object by choosing Layer=>Smart Objects=>
Convert to Smart Object. Return to the Layer=>Smart Object submenu and
take a look at the Stack Modes submenu that’s now available. These options
determine how the content on the layers within the Smart Object interact to
produce the appearance of the Smart Object itself. (Not quite the same, but
similar to the way layer blending modes help determine the overall appear-
ance of your artwork.) You can find technical explanations of each option in
Photoshop’s Help, but I show a couple of stacks as examples. On the left in
Figure 17-4, you see a combination of the layers (shown to the left as thumb-
nails) using the stack mode Summation, which pretty much adds up all the
lightness of each pixel in each channel, on each layer. To the right, several
images shot for use with Merge to HDR are combined in a Smart Object using
the stack mode Mean, which averages the values for each pixel in each chan-
nel. Not quite Merge to HDR, but with some planning and prep, it could be a
supplemental technique.
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Figure 17-4: A couple of different uses for stack modes.

Working with 3D Artwork

EATURL Photoshop CS54 Extended offers vastly improved 3D capabilities, with 10 new
§ tools, a dedicated 3D panel, and an entire new menu of commands (see
Figure 17-5). With Photoshop CS4 Extended, you can also now paint directly
on 3D objects, convert 2D layers to 3D layers, merge 3D layers into a compos-
ite, create 3D from grayscale depth maps, and edit meshes, materials, and
lights. In addition, CS4 Extended boasts behind-the-scenes improvements in
high-quality ray tracing, more export options, and much faster performance.

s B o | 9 Q& B w- New Layer from 3D File,..

= o [ o] view [Cortem Vo 1 T 1| 3 || Orimcation: 5528

Render Settings...
Auto-Hide Layers For Performance

Invert Visible Surfaces

3D Paint Mode > T
0 ek =)

eI

Paint Falloff...
Reparameterize...

Merge 30 Layers
Export 3D Layer..,

Render far Final Qurpur
Rasterize

{ o s )

Browse 30 Content Online,.,
ot Aan. | Dratt =
Chotral Amlsimet Coler. .

Lot Saction

PR E 7 e A  HR BN O N FB0 T

Otfset:
Tt A:
il B =

Figure 17-5: New toys and tools for the 3D artist in you!



3 6 2 Part IV: Power Photoshop

\J
) If you're interested in working with 3D in Photoshop, I highly recommend

that you pick up a copy of a book that goes into more detail on the subject.
(Let me recommend the Photoshop CS4 Bible from Wiley.)

Editing Imported Video

Photoshop CS4 Extended supports video layers — layers that contain actual
video that you can edit and manipulate. (Obviously, you can’t print an image
with playable video right on the page.) The Layer menu’s Video Layers sub-
menu offers a number of commands for inserting video clips, replacing exist-
ing clips, and inserting, duplicating, and deleting individual frames. But the
heart of video in Photoshop CS4 Extended is the Animation (Timeline) panel
(see Figure 17-6).

Set Start of Work Area
Set End of Work Area

GoTo >
Allow Frame Skipping

Move Layer In Point to Current Time
Move Layer End Point to Current Time
Trim Layer Start to Current Time

Trim Layer End to Current Time

Trim Document Duration to Work Area

Split Layer
Lift Work Area
Extract Work Area

Flatten Frames Into Layers

Edit Timeline Comment...

Document Settings...

Convert to Frame Animation

ANIMATION (TIMELINE) |}

0 ¢ 7 Onion Skin Settings...
0:00:05:08 (30.00 fps) k Enable Onion Skins

1 Enable Timeline Shortcut Keys
& Clobal Lighting | Panel Options...
PUIS TN~ S i e e—— s, =

Clase
Close Tab Group

Figure 17-6: The Animation panel menu has many commands for editing video.

One of the ways you can edit video in Photoshop is to take advantage of
the enhanced cloning capabilities. Select a frame from which to clone,
Option/Alt+click the element you want to clone, advance to the frame into
which you want to clone, and then click and drag to clone. Repeat for each
additional frame. To track what and where you're cloning, open the Clone
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Source panel and select the Show Overlay option. The source frame appears
as an overlay on the destination frame (see Figure 17-7).

CLONE SOURCE

Bt

Untitled-2 : Layer 1

Offser: willoox | =
%[138 px H:[100.0% Lﬁ
v | apo | [o]

Frame Offset: [0 ) Lock Frame

™ Show Overlay ™ Clippad
‘Opacity: [100% 11 Auto Hide

s

ANIMATION

0:00:08:26 (30.00 fps)
¥ Comments
B ey 4
% Clobal Lighting
Al P a g § =

Figure 17-7: Show Overlay is very handy when cloning from frame to frame.

If the Layer=Video Layers menu is grayed out, open the Animation panel’s
menu and select Convert to Timeline or click the button in the lower-right
corner of the Animation panel to toggle from the panel’s Frame Animation
mode. Keep in mind, however, that converting the panel also converts any
active video clips. Converting a video clip to frame-based animation uses only
the keyframes, not all frames. If you want to generate a frame-based animation
using all frames, choose File>Importr>Video Frames to Layers (see Figure 17-8).

megeTompor - o)

() From Beginning To End h .
@ Selected Range Only

[Hold dewn the Shift key while maving the .

slider or clicking the arrows)

[ Limit To Every 2 Frames

q Make Frame Animation
e

Figure 17-8: You can import video as a frame-based animation.
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Measuring, Counting, and Analyzing Pixels

Designed for researchers and scientists, the measuring capabilities in
Photoshop CS4 Extended are quite powerful. You can measure just about any-
thing and count the number of whatevers in a technical image, perhaps from a
microscope or telescope.

Measuring length, area, and more

If you know the exact size of any element in an image, you can then discover
just about anything you want to know about anything else in that image. The
key is to set the measurement scale, as shown in Figure 17-9.

S"Phntnshng File Edit Image Layer Select FiIterSD View Window Help

(B P oosc | W Q$ | E E Default

— Select Data Points 3
‘ &Q Record Measurements {3 M

%308 via Iw 237 H:0.00 ‘ A0 L1:237

+ Ruler Tool
Count Tool

Place Scale Marker...

Measurement Scale
Presets: | Custom )4{ ( 0K )
Pixel Length: ES € Cancel ]
Logical Length: ‘2.5 (_ Save Preset...
Logical Units: ‘inches | Delete Preset
138 pixels = 2.5000 inches
I i y The Ruler tool has been activated while this dialog is open.

“* You may use it to measure the pixel length for use in your scale.

MEASUREMENT LOG |

EOR AR
Label Date and Time Document Source Scale Scale Units. Scale Factor | Count Length Angle ‘
0001 | Ruler3 6/11/08 12:58.... |DICOMsample.psd | Ruler Tool Custom (138 pix... | inches 55.200000 1 3.859376 | -88.924143
0002 | Ruler 4 6/11/08 12:58.... | DICOMsample.psd | Ruler Toal Custom (138 pix... | inches 55.200000 1 3.466967 | -86.404330
- Ruler 5 6/11/08 12:58 . | DICOMsample psd | Ruler Tool Custom (138 pix... | inches 55.200000 1 2972340 -80.882137

Figure 17-9: Drag a known distance; set the measurement scale.

In this example, we know the knee is 2.5 inches wide, and we can see in the
Options bar that the Ruler tool (nested in the Toolbox with the Eyedropper)
was Shift+dragged over 138 pixels. We can, therefore, set the scale to 138
pixels = 2.5 inches. Now, using any selection tool or the Ruler tool, we can
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isolate any part of the image, click the Record Measurements button in the
Measurement Log panel (which you open, like any panel, through the
Window menu), and we find out more than we ever wanted to know about
that particular selection.

In addition to various sizes, the Measurement Log also records information
about the color or gray values in the image (see Figure 17-10). You can also
add the measurement scale to the image (as an editable layer group) with the
Analysis=>Scale Marker command.

[ Dty an T Tuaimen Tt ™ SalsUnts | Gess Fanee | Cosnt | i Angls A

[ cesie| e inn] e 105000 18000000 1rranne 1hn0see0 | Sifariooeed|

Figure 17-10: The Measurement Log panel records so much info, it's shown here in two
sections.

After you have made and recorded all the various measurements you need,
you can select all the lines in the Measurement Log (or only a few) and click
the third button in the upper-right corner of the panel to export the data for
use in a spreadsheet program.

Photoshop CS4 Extended also offers measurement in perspective through
Vanishing Point. Suppose, for example, that for some reason or other you need
to calculate how much wallpaper to order for the room shown in Figure 17-11.
You know the height of the window (70 inches) and, using that as your known
measurement, you can have Photoshop calculate the height and length of
each wall.

365
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Figure 17-11: Measurements can also be made in perspective with Vanishing Point.

Counting crows or maybe avian flu

Nested with the Ruler tool and the Eyedroppers in the Toolbox is the Count
tool. Zoom in and start clicking on whatever it is that you need to count,
whether it’s birds in the sky or viruses on a slide. Each item you click is labeled
with a number. If you want to record the count (shown in the Options bar and
on-screen as the most recent number), click the Record Measurements button
in the Measurement Log (shown in Figure 17-12).

New in Photoshop CS4 are Count Groups. You can now record and work with
multiple counts. To the right of the Count Groups menu in the Options bar
(see Figure 17-12) are buttons to show/hide the currently-selected count
group, to start a new count group, and to delete the current count group.
Click the color swatch in the Options bar to select a new color for the count
group, and you can customize both the size of the circle that marks the count
and the marker number — individually for each count group.

(Don’t you love the way that Warning symbol in the margin catches your eye?)
Adjust the marker and label sizes before you start clicking around in your
image with the Count tool — changing the size after placing your count mark-
ers can shift them in the image window, destroying your meticulous placement.
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Figure 17-12: Click on each item and Photoshop keeps a running tally for you.

Ignoring MATLAB, DICOM, and Other Initials

Photoshop CS4 Extended offers all of these interesting features for scientists,
researchers, and technicians, so it only makes sense that it should work with
some of the file formats they actually use and integrate with their software.
When you come across the term MATLAB in Photoshop CS4 Extended, recog-
nize it as a software environment (sort of like a programming language) that
speeds calculations and helps coordinate work in various technical pro-
grams. Unless you actually work with MATLAB, say in a research lab, there’s
nothing else you really need to know. (If you're intrigued by the idea, visit
www . mathworks . com.)

Another set of initials in Photoshop CS4 Extended might be of interest: DICOM
(Digital Imaging and COmmunication in Medicine). If your doctor’s office, hos-
pital, or lab has sent you home with a CD that contains the results of your CAT
scan, MR, ultrasound, or X-rays, you can open the files and take a look right in
Photoshop. Copy the files to your hard drive. (Don’t open files into Photoshop
directly from CD or DVD.) Choose File>Open, and in the Open dialog box,
select the frames in which you're interested, and click Open. In the dialog box
that opens (shown in Figure 17-13), select the frames, elect to open as layers in
an image or in a grid pattern (N-Up), and open. (You can also use Photoshop’s
Filec>Place command to add a DICOM image to an existing image.)



Part IV: Power Photoshop

[Users/peterbauer/PROJECTS/PS-CS4-for-Dummies/327258-Ch17-Parts/CS3-Parts/IMGO0000

S

Frame Impart Options

) Import frames as layers
() N-Up canfiguration

Rows: Columns:

DICOM Dataset Options.

1 Anonymize

Expart Options

Prefix: DICOM Frame

(" Export presentation (PEG)... )

Header;
#Dicom-Data-Set
# Used TransferSyntax: JPEG Lossless, Non-hierarchical m
(0008,0005) CS [ISO_IR 100]

(00C8,0008) CS |DERIVED PRIMARY]
(0008,0012) DA (20010102]

(0008,0013) TM [161508)

(00C8,0016) Ul =ComputedRadiographyimage!
(00D8,0018) Ul [1.3.51.5155.1085.20010102.1161119.1
(0008,0020) DA [20010102]
(0008,0022) DA [20010102]

L 170 Default (0008,0030) TM [163326.000000]
% Lung b (0008,0032) TM (163012
¥ show Windowing Options - Bone 2 (0008,0050) SH [12845230]
% Abdomen (0008, 0060) CS [CR]
Window Level: 1400 Window Pres % ‘(ﬂb

Window Width: 2800 | Reverse Image

€ Open ) Cancel

Figure 17-13: Review medical imagery right in Photoshop CS4 Extended.
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In this part . . .

Don’t get nervous — this is The Part of Tens
and not The Part of Tense!

In Chapter 18, I present you with ten of my favorite
Photoshop tricks and techniques. Chapter 19
contains a list of a mere ten of the hundreds of
reasons why working with a Wacom Cintiq display
or Intuos drawing tablet can make your work in
Photoshop more efficient — and even help you
avoid at least one common computer-related
disability.

Chapter 20 provides you with ten reasons to shoot
digitally. If you already own and use a digital
camera, read it anyway for some tips. And then
loan it to an analog colleague.




Pete’s Top Ten Favorite Photoshop
Tips and Tricks

In This Chapter

Playing with artistic and creative tricks

Exploring a few useful tips

Adding Artistic and Creative Effects

Ihave literally thousands of Photoshop tips and tricks to share with you,
but space here allows for only ten. Actually, just about anything you do
that doesn’t use Photoshop’s default values or presets could be considered a
tip or a trick. However, you're likely interested in creative and productive
shortcuts rather than something like this: Save copies of your custom brushes,
styles, and other such bits and pieces somewhere other than the Photoshop
folder so you don'’t lose them should you ever need to reinstall the
program. (Oops! I snuck in an extra tip, didn’t I?)

In this chapter, | present ten of my favorite creative and
useful techniques. Some of these tricks I developed
while helping solve problems in my role as Help Desk
Director for the National Association of Photoshop
Professionals (NAPP), and others are tried-and-true
helpers that have been around for years.

At

Surely you'd prefer to read Fill a layer with brown, use
the Add Noise filter (Gaussian Distribution, Monochrome),
and then apply a Motion Blur filter to create a wood grain effect
rather than If you need to apply a grayed-out filter to a CMYK image,
apply it to one channel, and then the other three individually using 88+F/Ctrl+F.
(Now, don’t consider those to be tips or tricks — remember that the chapter
title says “Ten”!) Here are some of my favorite and most useful creative tips.
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Smoothing skin perfectly

When you see glamour shots — you know, photos of The Beautiful People
who look so absolutely perfect — one of the things you'’re not seeing is the
texture of the skin. No wrinkles. No creases. No pores? Indeed, the skin
appears to be perfectly smooth (see Figure 18-1).

© @ @ ©1150039_MED.TIF @ 150% (Layer 1, RGB/8)

® O O & © 1150039_MED.TIF @ 50% (Layer 1, RGB/8)

© 2003PhotoSpin, PhotoSpin image #1150039
Figure 18-1: Use the Healing Brush and a plain-color source area to smooth skin.

Here’s how you can achieve that effect without blurring:

1. Open a copy of your image.

Whenever you use a technique that makes permanent changes to the
pixels in your image, you should work on a copy. That preserves the orig-
inal image, which not only protects you from any errors that you (or
Photoshop) might make but also keeps that original for different tech-
niques and tricks in the future. (Does that count as a tip?)

2. Add a new layer by clicking the New Layer button in the Layers panel.
3. Make a selection.

The selection should be away from the face area, and sized at least one-
half the width and height of the face.

4. Fill the selection with color; then deselect.

Press Option+Delete (Mac)/Alt+Backspace (Windows) to fill it with the
foreground color (it doesn’t matter what color).
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5. Select the Healing Brush and set the source point.

Make sure that the Sample: All Layers option is selected in the Options
bar and that Aligned is deselected. Option/Alt+click in the center of the
filled selection.

6. Paint over the skin.

In the Layers panel, click on the lower layer, the original image layer, to
make it active. Click and drag with the Healing Brush to smooth areas of
skin. The Healing Brush replaces the texture of the skin (pores and all)
with the texture of the source area (smooth). Use short strokes that
follow the contour of the face. Make sure that you don’t paint over eye-
brows, nostrils, lips, and other areas of critical detail.

From a photo to a painting

You have dozens of ways to create a “painterly” effect in Photoshop. Here’s
one of my favorites, as illustrated by Figure 18-2.
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Figure 18-2: Blur shadows, sharpen highlights, and add texture for a “painterly” effect.
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1. Open a copy of your image as a Smart Object.

Choose File=>Open as Smart Object or, if the image is already open,
choose Layer~>Smart Objects>Convert to Smart Object. When working
with Smart Filters, you can later — if necessary — re-open the filter and
change the settings.

2. Select the shadows and blur.

Open the Channels panel and 88/Ctrl+click the RGB channel at the top to
make a selection according to the brightness of each pixel. Use the
shortcut 38+Shift+I/Ctrl+Shift+] to invert the selection (select shadows
rather than highlights). Apply a slight Gaussian Blur, perhaps 1 or 2
pixels, to blur detail in the darker areas. (Remember that you can use
the shortcut 38+H/Ctrl+H to hide the “marching ants” and make the
selection border disappear — and that’s not yet another tip!)

3. Select the highlights and sharpen.

You need to reselect the highlights, so again 88/Ctrl+click the RGB chan-
nel at the top. Apply the Sharpen=>Smart Sharpen filter with initial set-
tings of Amount: 200% and Radius: 2 pixels. (Adjust the values to match
the content of your image and your artistic vision.)

4. Add a canvas texture to the image.

Don’t deselect (so that the texture will be applied a bit more promi-
nently to the image’s highlights than to the shadows). Use the
Texturer>Texturizer filter to add a slight canvas texture, enhancing the
painterly effect.

Creating a sketch from a photo

Simulating a painting in Photoshop is great, but sometimes you might need
line art or a sketch. Photoshop has a couple of filters that do a nice job of cre-
ating pencil sketches, but none of them really do a great job with outlines.
Here’s an easy way to create line art from a photo (see Figure 18-3).

1. Open a copy of your image and create a Smart Object.

Again, open your image as a Smart Object or convert with the command
Layer->Smart Objects>Convert to Smart Object before. When working
with Smart Filters, you can later — if necessary — re-open the filter and
change the settings.

2. Apply the Smart Blur filter.

Set the filter to Quality: High and Mode: Normal. Use settings that
remove all the tiny detail in your image (such as pores and individual
hairs or blades of grass) but maintain edges and major detail (such as
eyes, noses, golf balls, and trees).
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. Define edges with Smart Blur.

Reopen the Smart Blur dialog box and set the Mode pop-up menu to
Edge Only. Adjust the sliders until the white-on-black preview shows
approximately the amount of detail you want in the final image; then
click OK.

. Invert the colors.

Using the button at the bottom of the Layers panel or the Layer=>New
Adjustment Layer menu, add an Invert adjustment layer. (Not only is it a
good idea to use adjustment layers rather than adjustment commands,
but you’ll find that you can’t use most adjustment commands with Smart
Objects.)

. Blur the lines.

Click the Smart Object layer again in the Layers panel to make it active
and apply a 1- or 2-pixel Gaussian Blur to soften the edges of the lines.

. Adjust the thickness of the lines with a Levels adjustment layer.

In the Levels dialog box, drag the middle slider control left and right
until you're satisfied with the image’s appearance. If desired, you can
further refine the sketch with the Sharpen=>Unsharp Mask filter.

@ @ @ © 0990140_MED.1if @ 66 © @ @ © 0990140_MED copy.psd...
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© 2003PhotoSpin, PhotoSpin image #0990140

Figure 18-3: You can use the versatile Smart Blur filter to produce
line art from a photo.
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Creating snow or rain

Here’s a multi-use technique that you 000 ¢ el @ 12SNUCHE @ OO ¥ icvheb copy..
can use to create falling snow or rain 7
(as shown in Figure 18-4):

1.

. Still in the Layers panel, change

R 7

Add a new layer to your image
by clicking the New Layer
button in the Layers panel.

the layer’s blending mode from
Normal to Screen.

Because this technique uses a
separate layer, you can consider
it to be nondestructive (you can
always delete the layer later), so
you don’t have to work on a copy
of your image. But it’s always a
good idea to work on a copy, just in case.

Figure 18-4: Use the Noise and Crystallize
filters to produce snow or rain.

. Choose Edit->Fill to fill the layer with black.

Because the layer’s blending mode is Screen, you won'’t see the black fill.

. Add Noise to the layer.

Use the Noiser>Add Noise filter to add some variation to the layer. Use
Amount: 20%, Distribution: Gaussian, and mark the Monochromatic
check box.

. Enlarge the noise with the Crystallize filter.

Use the Pixelater>Crystallize filter to turn the little noise into larger
chunks. Use Cell Size: 3 for small snow or rain; try 7 or 10 for larger
flakes. You can also apply a slight Gaussian Blur to increase the size.

. Sharpen the edges.

Using the Unsharp Mask filter, sharpen until the snowflakes have distinct
edges. Use Amount: 100%, Radius: 2, Threshold: 0. When you create rain,
use Amount: 40%.

. Apply a Levels adjustment.

In the Levels dialog box, drag the middle slider about halfway to the left;
then drag the left slider slowly to the right until you see the amount of
snow or rain that you want. Afterward, if desired, you can apply the
Motion Blur filter to the falling snow/rain. And, of course, you can add a
layer mask to control visibility.
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The Glass Text effect

Perfect for adding a large copyright notice right across the center of your
image (while allowing the image’s beauty to still show through), this tech-
nique is so easy it doesn’t even need a step-by-step explanation. Simply type
your copyright info or any other text and add a Bevel and Emboss layer style
(perhaps with a slight Inner Shadow and maybe a 1-pixel black Stroke effect).
Then, at the top of the Layers panel, reduce the Fill slider (not the Opacity
slider) to 0 (zero). The pixels on the layer become transparent, but the layer
style remains visible.

Useful Tricks to Make Life Easier

Here are five techniques that make life easier and your work look snappier
and more professional.

Changing product colors in a snap

Use the Replace Color feature (in the
Image=>Adjustments menu) to
quickly and easily make variations
of a single image by changing color.
Replace Color is especially handy in
production environments, letting
you shoot one shot and produce
numerous color variations. (See
Figure 18-5.)

© 1998 PhotoSpin, PhotoSpin image #0070004
Figure 18-5: The Replace Color adjustment
makes quick work of color changes.

Open Replace Color and Shift+drag
the Eyedropper tool through the
color you want to change. Adjust the
Fuzziness slider to fine-tune the selection; then adjust the Hue/Saturation and
Lightness sliders to change the color.

¥ If the target color appears in more than one part of the image, perhaps a red
blouse and red lipstick, make a loose selection around the area you want to
change (excluding the other areas) before opening Replace Color.

Deleting a plain white background

Lots of stock photographs come as a subject shot against a plain white back-
ground. Clip art also generally comes on a plain white background. Most of
these images have clipping paths or alpha channels that you can use to
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extract the subject from the background to add it to another image. And
when there is no path or channel? Open both images in Photoshop and drag
the stock photo’s Background layer from the Layers panel to the window of
the destination image. Make sure that the upper layer is active in the Layers
panel and then open the Blending Options panel of the Layer Style dialog
box. In the Blend If area at the bottom, drag the upper-right slider handle to
the left until the upper layer’s white background is completely gone. (See
Figure 18-6.)
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Both images © 1998 PhotoSpin, PhotoSpin image #0010032 (background) and image #0120013 (foreground)
Figure 18-6: Use the Blend If sliders to hide a white background.

Ouick and easy edge effects

Need some way to make your images stand out? Try this:
1. Add a new layer to your image by clicking the New Layer button in
the Layers panel.

To avoid making any permanent change to your image (primarily so you
can change your mind about the border later), work on a new layer.

N

. Select a border area around the image.

Choose Select=>All and then choose Select>Modify=>Border. Enter a
value twice the width that you want for your edge effect.

3. Fill the selection with black, gray, or white.
e Black: Makes your image look brighter and more saturated
e Gray: Minimizes any perceived color shift
e White: Mutes the image somewhat but allows it to stand on its own

Alternatively, use any color from the image (or its inverse).
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4. Apply filters to the layer.

Open the Filter Gallery and apply one or more filters to the border to
create an interesting edge effect (such as the samples in Figure 18-7).
Remember, too, that you can convert this layer to a Smart Object before
applying filters so that you can later change your settings.

Not that this counts as an additional tip in this chapter, but remember that
you can open this image, open another image of the same size, and drag the
frame layer from the Layers panel of the first image to the window of the
second image to duplicate it. Reusable frames!

Figure 18-7: Filtering a border area creates interesting edge effects for your images.

Making dashed and dotted lines

Changing a couple of settings in the Brushes panel enables you to create
dashed and dotted lines with ease. In the Brush Tip Shape pane, increase
Spacing to a value higher than 100% to separate the individual imprints of the
brush tip (the brush tip instances). Switch to the Shape Dynamics pane and
select Direction from the Angle Jitter pop-up menu. For best results, make a
selection and choose Edit=>Stroke to apply your dotted or dashed brush
along the selection border.
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Printing multiple documents at the same time

You have a bunch of images to print from your latest job, but you also have a
bazillion other things to do — you don’t want to sit at your computer and
open one image, print, close, open the next image, print, close, open the next
image, print, close, and so on, all afternoon long. Instead, use the Output
panel in Bridge to create a multipage PDF document (see Chapter 16) and
print all of the pages — all of your images — from Acrobat or Adobe Reader,
without sitting around to babysit the computer!



Ten Reasons to Love
Your Wacom Tablet

In This Chapter

Considering reasons to use a tablet

Setting up your tablet for efficient Photoshop work

More Natural Movement

Health and Safety

Drawing tablets from Wacom enable you to use a special stylus, which
you hold like a pen or pencil or brush, to move the cursor (rather than
using a mouse, track pad, or trackball). There are several reasons why using
a stylus is a huge improvement over a mouse, and I give you five to start off
the chapter. Another five reasons you’ll love your Wacom tablet involve maxi-
mizing your efficiency; those reasons conclude the chapter.

Whether you use a pen only to sign your name or
you'’re a traditionally trained artist, the movement of
a stylus is far more natural than pushing a mouse
around a desk.

Use of a drawing tablet instead of a mouse can help
avoid repetitive stress injuries and carpal tunnel syn-
drome, and can be vastly more comfortable for those of us
who suffer from arthritis and tendonitis.
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Artistic Control

Extended Comfort
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Figure 19-1: Scattering, Color Dynamics, and
You can lean back and relax or sit up Other Dynamics also have pen-controlled
straight: With fingers poised over options.

the keyboard or hand grasping

mouse, you're pretty much locked into a single position, often for hours at a
time. With the long cord of a Wacom tablet plugged into a handy USB port,
you have the flexibility to change positions, move back from the monitor,
even slouch in a way that would make Mom turn pale — all while still sending
input to the computer. (Or how about a Bluetooth cordless model?) Whether
you work with the tablet on the desk or on your lap, it doesn’t matter; do
whatever is most comfortable and efficient for you.

Programmable ExpressKeys and Touch Strips

How about convenient controls, right on the tablet, that let you access modi-
fier keys, keyboard shortcuts, and even brush sizes and tool selection? No
need to lean back in toward the desk to press a key or two; just program your
most-needed keystrokes to the tablet.
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The Optimal Tablet

The inexpensive Bamboo and Bamboo Fun come in two sizes (just under

4 x 6 and 5.3 x 8.5 inches for the working areas) and have 512 levels of
pressure sensitivity. The moderately-priced and very convenient Graphire
Wireless has an active area of 6 x 8 inches and 512 levels of pressure sensitiv-
ity. The professional Intuos line includes six different sizes, from 4 x 6 to

a whopping 12 x 19 inches. The 12 x 19-inch and 6 x 11-inch sizes are
specifically designed for widescreen and dual-monitor systems. If you have a
fine-arts background, you might want a larger tablet. If you are not a
traditionally-trained artist, you might be more comfortable with a smaller
tablet, on which you can make smaller strokes. Regardless of what size tablet
you have, don’t forget that you can zoom in on a specific area of your image
while you work. (And keep in mind that you might also want to have a
smaller tablet to slide right into your laptop case, too.)

The Pen’s Switch

Most (but not all) Wacom pens have a switch, called the DuoSwitch, right on
the side that (by default) lets you right-click or double-click simply by rock-
ing the switch. Rather than tapping the pen twice on the tablet to double-
click (which could leave two spots of color if the Brush tool is active), simply
press the DuoSwitch’s upper rocker. And, of course, you can program the
DuoSwitch to other functions as well, such as a specific keystroke, a modifier
key, even panning and scrolling.

. er om Taties
Setting Preferences e

After downloading and installing the TS .qo nl:,l‘ m-,m. -
latest version of the Wacom driver for rost E |/
your tablet, open the Control Panel _— ot
and customize your tablet. (On a Appien, <118 2
Mac, choose System Preferencesw> (BT Touch Suip_ Pop-up Mar
Wacom Tablet. In Windows, choose e
Starte>All Programs=>Wacom e [~ =
Tablet=>Wacom Tablet Properties.) e L —
The Control Panel (see Figure 19-2) increase Srush izs Wrush sl :
enables you to assign a specific func- mT_’nm_: Rt co i _‘
tion or keystroke to each of the B o et
ExpressKeys and Touch Strips, as S
well as program your various pens (ST [S—TT
and mouse.

Figure 19-2: Think about what keys and
keystrokes are best assigned to the easy-to-
reach ExpressKeys.
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Don’t forget the accessories

Wacom offers a variety of pens, several different mouse versions (including a
five-button model), and even an airbrush to help you get the very most out of
your tablet. Choose the input device that’s best for you — or switch among
several, using the one that’s most appropriate for the specific job at hand.

Cintiq for the Ultimate Control

WMBER
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The ultimate tablets are, of course, the Cintiq tablets, which integrate a
monitor into the tablet, enabling you to paint or draw directly on your image.
Wacom offers three sizes of Cintiq
displays, ranging from 12" to 21"
measured diagonally. And although
$999 to $1,999 may seem like a lof

of money for a tablet, it’s not too
extreme when you consider the
money you may save by not purchas-
ing a monitor. Whether you use the
integrated stand and paint on your
Cintiq on your desk (see Figure 19-3)
or take advantage of the long

cable and work with the display in
your lap, you're bound to find
increased accuracy and productivity Figure 19-3: Consider using a Cintiq in place of
at your fingertips — literally! a standard monitor.

Until you're perfectly comfortable using a stylus and tablet, the Cintiq line
might be a bit of a stretch. But after you've worked with the more affordable
lines of tablets (Intuos, Graphire, and the entry-level Bamboo), you may
develop a craving for a Cintiq!
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Ten Reasons to Own
a Digital Camera

In This Chapter

Five professional-life reasons to go digital

Four personal-life reasons to go digital

One good-for-the-future-of-the-planet reason to go digital

p icking just ten reasons to own and use a digital camera is hard. In an
effort to play to heartstrings everywhere, ['ve included ideas about
job-related shooting, uses in the home, travel considerations . . . the list goes
on and on, but this list only goes up to ten. After that, you have to use your
imagination.

The gap in capability between 35mm film and high-end
digital cameras disappeared some time ago. The technol-
ogy that allows digital cameras to match 35mm quality
is now found in quite reasonably priced equipment.
(Admittedly, only the most expensive digital camera
backs for very expensive high-quality cameras can
even think about competing with medium or large
format film.) If you haven’t yet gone over to the
digital side, here are some convincing arguments

to make the jump. If you already are digital in mind,
body, and lens, read the list anyway — it might

give you a few points for future discussions with
traditionalists.
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Shooting Digital for Your Work

In the field, in the studio, and even in the home and on the road, digital offers
a number of advantages over film:

1 No processing time (or cost): You don’t have to wait to start editing
your images. Instead, you download to your computer and open the
images in Photoshop. No longer do you have those pesky delays for
processing/printing/scanning, nor those bothersome bills for film
processing.

+~ Instant feedback: You can evaluate the shot immediately on the
camera’s LCD screen, which allows you to quickly delete any boo-boos
before anyone else sees them. Oh, and that frees up storage space, too,
of course! And don’t forget about LCD previews available on many cam-
eras, which let you makes decisions even before you shoot.

1~ Create libraries of textures and patterns: Shoot digital images of clouds
and bark and grass and fabric and concrete and bricks and whatever to
create libraries of textures to use in Photoshop. Use blending mode and
the Texturer>Texturizer filter with your library images to create wonder-
ful backgrounds and artistic effects, such as the visually interesting
background in Figure 20-1.

branches and clouds, to add detail to an image.
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1~ Remote control: Use your computer’s monitor (if your camera/software
allows) to adjust and perfect the shot before shooting. The screen is a
lot larger and more accurate than the camera’s LCD. This is often
referred to as tethered shooting.

~ Multiple exposures for one image: Bracket the exposure and then com-
bine the images automatically in Photoshop with Merge to HDR, shown
in Figure 20-2. (See Chapter 10 for specific instructions on shooting for
Merge to HDR.)

Merge to HOR (500
saurtes Warped est

“ !;II .“‘:'

Figure 20-2: Combine multiple exposures to capture a greater tonal range.

Shooting Digital for Yourself

Owning a digital camera comes in handy for your personal life, too:

~ Travel convenience: With a digital camera, you eliminate worries about
X-ray machines, baggage scanning, and film storage. And don’t forget
how much easier it is to carry a half-dozen flash cards than dozens of
rolls of film!

 Home inventory: Do it. Really. Do it. Go around the house and take
photos of the important stuff. (Don’t forget the jewelry!) If your camera
has a date/time stamp, use it. You don’t even need to print these shots.
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Just drop that flash card or whatever storage device your camera uses
in the safe deposit box at the bank. Or mail it to your family attorney. Or
put it in an envelope at the office. But have it safe, just in case Mother
Nature (or Human Nature) requires you to file an insurance claim.

1~ Family gatherings: Hey, aren’t you the Photoshop expert? Doesn’t that
make you the perfect person to take this group photo? (Read about
instant feedback in the preceding section.)

1~ Explore your artistic boundaries: It really doesn’t cost anything (dollar-
wise) to shoot digitally. Take the off-angle shot. Play with aperture and
exposure. Have fun, play, and experiment. And see what you really have
inside you.

Shooting Digital for the Rest of Us

Digital photography is so much more environmentally friendly than film that
it boggles the mind! No toxic waste related to film production. No processing
chemicals to dispose of (or illegally dump down the sink). Really, truly, digital
is a more Earth-friendly way to shoot. And isn’t that a nice thought with
which to end this book?

[ wish you peace, love, health, and happiness!



o Symbols &
Numerics ®

... (ellipsis), 44

_ (underscore), 343
3D artwork, 361-362
8-bit color, 111

16-bit color, 112

32-bit images, 358-360

o/ o

access automation (Adobe
Bridge program), 348
actions
Batch command, 342-343
conditional mode change
option, 340
defined, 335-336
fixed image option, 341
messages or warnings, 340
multiple versions, 339
New Action dialog box, 338
recording new, 337-341
Save Actions command, 336
symbols, 336
units of measurement, 339
adjustment layers
adding, 180-181
adjustable adjustments, 180
advantages of, 179-180
basic description of, 158
deleting, 180
fill layers, 181
hidden adjustments, 180
limitable adjustments, 180
limiting use of, 181-183
reversible adjustments, 180
tweakable adjustments, 180
visibility, toggling, 180
Adjustments panel, 93

Index

Adobe Bridge program
access automation, 348
Batch Rename tool, 75, 347
cache, 348
Device Central option, 348
Favorites tab, 74
Filter tab, 73
Keywords tab, 73
Label menu, 73
metadata templates, 348
Output panel, 348
presentations, 349-351
selecting multiple
images in, 73

stacks, 74

starting, 72

Tools menu options,
346-348

workspace, customizing, 74

Adobe Web site, 63

airbrushing, 301

alignment
paragraphs, 283, 290
text, 279

All Channels view (Histogram

panel), 91

alpha channels
blurring, 177
defined, 40
editing, 176-177
filters, 177
mask-related selection

commands, 175
painting in, 177
Amount slider, Shadow/
High-light adjustment,
102

anchor points
adding, 241
corner, 234
defined, 233
deleting, 241

moving, 241-242
smooth, 234, 241-243

anti-aliasing, 160-162, 279

antivirus software, 20-21

AppleScript utility, 343

Applications folder, 16

aspect ratio, 31, 53, 76-77

Auto Color correction,
92,116

Auto Contrast corrections,
92,116

auto corrections, tonality,
92-93

Auto Tone corrections,
92,116

autobackup software, 21

auto-collapsing panels, 56

Automate command (File
menu), 217

Average filter, 322

ol e

background layers, 205

backup software, 21

barrel distortion, 324

Basic panel, Camera Raw
plug-in, 146-147

Batch command, 342-343

Batch Rename tool (Adobe
Bridge program), 75, 347

bell curve distribution, 91

bending and bubbling
effects, 332

Bevel and Emboss layer
effect, 258-259

Bicubic resampling
algorithm, 34

Bicubic Sharper resampling
algorithm, 34

Bicubic Smoother resampling
algorithm, 34

Bilinear resampling
algorithm, 34
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binary code, 24
bitmap color mode, 110
Black & White
adjustment, 120
black and white images, 95
blending modes
cloning with, 194
Color, 206
Difference, 206
example of, 205
Hard Light, 206
layer, 204-207
layer style, 264-266
Luminosity, 207
Multiply, 206, 257
Normal, 206, 257
Overlay, 206, 257
Screen, 206, 257
Soft Light, 206
Bloat tool, 330
Blur filter, 322
blur filters, 320-322
Blur More filter, 322
Blur tool, 307
blurring alpha channels, 177
Border command, 172
Box Blur filter, 322
Bridge program. See Adobe
Bridge program
Brightness/Contrast
adjustment, 93, 116
brightness, Curves adjust-
ment, 98. See also
tonality
Browse command (File
menu), 72
Brush tool, 298-302
brushes
custom created, 314
dual, 313
stroke, 313
texture, 313
tips, 311-312, 314
Brushes panel, 310-314
brush-using tools, 305-307
bubbling and bending
effects, 332
Burn tool, 105, 189, 307
burning images, 82

oo

cache
Adobe Bridge program, 348
cache level preferences, 58
Calibrate tab, Camera Raw
plug-in, 155
Camera Raw plug-in
Basic panel, 146-147
Calibrate tab, 155
Cancel/Reset button, 156
Detail tab, 149-151
Done button, 156
histogram in, 143
HSL/Grayscale feature,
152-153
with JPEG and TIFF file
format, 138
lens correction, 153-154
Open Image/Open Copy
button, 156
Parametric panel, 148
Point panel, 149
preview area, 144
Saturation tab, 152
Save Image button, 156
Split Toning tab, 153
Tone Curve tab, 148-149
tools and review options,
138-142
updates, 137
window components, 134
workflow options, 144-146
camera resolution, 27
cameras. See digital cameras
Cancel/Reset button, Camera
Raw plug-in, 156
Canvas Size command
(Image menu), 35
captions, 353
card readers, 67
categories, assigning to
images, 73
Channel Mixer adjustment,
121-122
channel preferences, 56
Character panel, 280-282

Check Spelling command
(Edit menu), 282
Chromatic Aberration
sliders, 154
Cintiq tablets, 384
clarity slider, 146
clipped color, 130
clipping groups, layers,
208-209
clipping paths, 238-239
clipping values, 103
Clone Stamp tool, 187,
193, 307
closed paths, 234
closing image files, 17
Clouds filter, 332
CMYK color mode, 62,
108-109
color
adjustment commands, 116
Auto Color correction,
92,116
Auto Contrast
adjustment, 116
Auto Tone adjustment, 116
bitmap, 110
Black & White
adjustment, 120
blending modes, 194
Brightness/Contrast
adjustment, 116
calibrating, 61-62, 80
Channel Mixer adjustment,
121-122
clipped, 130
CMYK mode, 62, 108-109
Color Balance
adjustment, 119
color cast, 92, 113, 155
color channels, 211-212
color data, 113
color depth, 108, 111-113
color management solu-
tions, print options,
80-81
color models, 108, 111
color modes, 108
color profiles, 108



Color Range
adjustment, 128

color shift, 92

color table, 109-110

Curves adjustment, 117

Datacolor Web site, 80

Desaturate command, 126

DigitalColor Meter
program, 81

duotone mode, 110

Equalize adjustment, 129

Exposure adjustment, 118

fades, 127

flesh tone formulas,
131-132

gamut, 108

Gradient Map feature, 124

grayscale mode, 109

histograms, 114

Hue/Saturation
adjustment, 118

ICC profiles, 62

indexed mode, 109-110

intensity, 127

Invert adjustment, 122

LAB mode, 110

layer styles, 254

Levels adjustment, 116

luminance, 127

manual corrections,
130-131

Match Color dialog box,
126-127

multichannel mode, 110

multicolor shape layer
simulation, 231-233

painting, 303-305

PANTONE Web site, 62, 80

Photo Filter
adjustment, 121

Posterize adjustment,
122-123

print color considerations,
78-80

Replace Color command,
128-129, 377

RGB mode, 108-109
RGB working space, 61
Selective Color
adjustment, 125
Shadow/Highlight
adjustment, 125
spot, 115, 305
subtractive modes, 109
Threshold adjustment, 123
Variations adjustment, 125,
129-130
Vibrance adjustment, 118
Web-safe, 305
X-Rite Web site, 62, 80
Color blending mode, 206
color coding menu
commands, 51, 56
Color Management button
(Print dialog box), 79
Color Noise Reduction
slider, 149
Color Overlay layer
effect, 261
Color Picker tool, 304
Color Range command,
170-171
Color Replacement tool,
192, 306
Color Sampler tool, 114, 139
Color Settings dialog box,
61-62
Colored Pencil filter, 198
ColorVision Web site, 62
combining images. See
compositing
combining paths, 244
commands, menu
accessing, 44
color coding, 51, 56
grayed out, 45
hiding, 51
keyboard shortcuts, 44
commercial printing, file
formats for, 40

complex selections, 211-212
compositing
basic description of, 201
color channels, duplicating,
211-212
Merge to HDR command,
219-221
panoramas, 217-219
Vanishing Point tool,
213-217
compound paths, 244
compression, lossy, 41
contact sheets, 351-353
Content-Aware Scale
command
(Edit menu), 35
content-aware scaling, 35
Contract command, 173
contrast
Auto Contrast correction,
92,116
Brightness/Contrast
adjustment, 93, 116
control points, 234
Copy command (Edit menu),
42,159
corner anchor points, 234
Count tool, 366
crashes, 62-63
Crop tool, 77, 139-140
cropping versus
resampling, 33
Crystallize filter, 376
cursor preferences, 58-59
curved path segments,
235-236
Curves adjustment,
97-100, 117
custom fonts, 245-246
custom layer styles, 251-255
Custom Shape tool, 227-228
custom shapes, 229-230
custom workspaces. See
workspaces

Index 3 9 ’
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darkening images, 105
dashed lines, 379
Datacolor Web site, 80
DCS file format, 40
de-glaring effects, 189
degradation, 41
deleting
adjustment layers, 180
anchor points, 241
items from images, 192-196
layer styles, 250
paths, 240
white backgrounds,
377-378
Depth workflow option, 144
Desaturate command, 126
Deselect command, 170
Despeckle command, 192
Detail tab, Camera Raw
plug-in, 149-151
Device Central option
(Adobe Bridge
program), 348
DICOM (Digital Imaging and
Communication in
Medicine) feature, 367
dictionaries, text, 282
Difference blending
mode, 206
digital cameras
card readers, 67
downloading from, 67-68
for personal shooting,
387-388
reasons to use, 385-388
shooting for work, 386-387
travel convenience, 387
digital images
binary code and, 24
defined, 24
file formats for, 37-39
Image Size, 28-30

Digital Imaging and
Communication in
Medicine (DICOM)
feature, 367

digital negative, 100

DigitalColor Meter
program, 81

Direct Selection tool, 179, 241

direction lines, 233

distortion, 31

DNG file format, 136

documents, open documents
as tabs preference, 56

Dodge tool, 105-106,
189-190, 307

Done button, Camera Raw
plug-in, 156

dotted lines, 379

double chin minimizing
effects, 189

downloading scripts, 343

Dreamweaver Web design
tool, 15

drop shadows, 252, 255

duotone color mode, 110

Duplicate command (Image
menu), 193, 211

duplicating paths, 240

dye sublimation printers, 82

oF o

edge effects, 378-379
Edit menu commands
Check Spelling, 282
Content-Aware Scale, 35
Copy, 42, 159
Fade, 20
Fade Motion Blur, 20
Fade Unsharp Mask, 20
Fill, 308
Paste, 42, 159, 289
Stroke, 308
Transform, 42, 160
editing
alpha channels, 176-177
imported video, 362-363
8-bit color, 111

Ellipse tool, 226

ellipsis (...), 44

Elliptical Marquee tool,
163-164

e-mailing images, 83

EPS file format, 40

Equalize adjustment, 93, 129

Eraser tool, 302-303

Expand command, 172

Exposure dialog box,
104-105, 118

Extensis Web site, 22

eyedroppers, tonal correc-
tions with, 96-97

ofF e

Fade command (Edit menu),
20
Fade Motion Blur command
(Edit menu), 20
Fade Unsharp Mask
command (Edit menu),
20
fades, color, 127
faux styles, 282
Favorites tab (Adobe Bridge
program), 74
feathering, 160-162, 169,
209-210
file formats
for commercial printing, 40
DCS, 40
for digital images, 37-39
DNG, 136
EPS, 40
GIF, 39
JPG/JPEG, 38-39, 41
PDF, 38, 83
PNG, 39
for PowerPoint, 40-42
PSB, 38
PSD, 37, 40
Raw, 133-134
saving images in other, 37
TIFF, 38, 40
for Web graphics, 39
for Word, 40-42
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File Handling panel
preferences, 57
File menu commands
Automate, 217
Browse, 72
File Info, 55
Import, 68
New, 66
Open, 66
Open As Smart Object, 17
Open Recent, 75
Place, 204, 367
Print, 79
Save, 36
Fill command (Edit
menu), 308
fill layers, 181
fill values, 207-208
filling paths, 239
Filter Gallery, 198, 327-329
Filter tab (Adobe Bridge
program), 73
filters
alpha channels, 177
Average, 322
Blur, 322
blur, 320-322
Blur More, 322
Box Blur, 322
Clouds, 332
Colored, 198
Crystallize, 376
Gaussian Blur, 322
keyboard shortcuts, 317
Lens Blur, 322
Lens Correction, 324-325
Motion Blur, 322
Radial Blur, 322
Reduce Noise, 325-327
selections, 177
Shape Blur, 323
Sharpen, 317-318
Shear, 332
Smart, 315-317
Smart Blur, 323
Smart Sharpen, 319-320
Spherize, 332
Surface Blur, 323

Texturizer, 198

Unsharp Mask, 318-319
flesh tone formulas, 131-132
flipped text, 294-295
floating panels, 45
folder organization, 71-72
fonts

custom, 245-246

font-management

utilities, 22

glyphs, 284

OpenType, 284

previews, 15

selection, 296

size of, 278

styles, 278

Suitcase Fusion

font book, 22

symbol, 229
foreshortening, 197
formats. See file formats
Forward Warp tool, 329
Freeform Pen tool, 236-237
freeform tools, 48
Freeze Mask tool, 331
function keys, 50
fuzzy images, 171

oG o

galleries, Web, 354-356

gamma correction, 104

gamut, 108

gamut preferences, 59

Gaussian Blur filter, 322

General panel preferences, 55

GIF file format, 39

glass text effect, 377

glasses, de-glaring, 189

Global Light layer style
option, 252

glyphs, 284

GPU setting preferences, 58

Gradient Map feature, 124

Gradient Overlay layer
effect, 262

gradients, 309-310

Graduate Filter tool, 141

393

graphics, file formats for, 39

grayscale color mode, 109

Guides, Grid & Slices panel
preferences, 60

o o

Hand tool, 139, 325, 331
Hard Light blending
mode, 206
HDR (high dynamic
range), 113
Healing Brush tool, 187, 306
hidden adjustments, 180
hiding
layer styles, 253
menu commands, 51
panels, 45
high dynamic range
(HDR), 113
high-key images, 89
highlights
Histogram panel and, 89
sepia effects, 153
Shadow/Highlight
adjustment, 100-103
Histogram panel
All Channels view, 91
bell curve distribution, 91
highlights, 89
levels histogram
comparison, 94
midtones, 89
panel configuration, 91
shadows, 89
skewed histogram
example, 90
tonality, 88-92
histograms
in Camera Raw plug-in, 143
color, 114
History Brush tool, 18, 307
history state preferences, 58
HSL/Grayscale feature,
Camera Raw plug-in,
152-153
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Hue/Saturation
adjustment, 118
hyphenated text, 284, 291

o]e

ICC profiles, 62
image files
closing, 17
opening, 17
renaming, 75
saving, 17
saving as PSD file format, 17
working on copies of, 17
Image menu commands
Canvas Size, 35
Duplicate, 193, 211
Image Size, 27
Transform Canvas, 198
Image Processor prerecorded
scripts, 344-346
image resolution
basic description of, 27
changing size of, 28-32
selection considerations,
35-36
Image Size dialog box, 28-30
images
aspect ratio, 31
black and white, 95
cropping, 33
deleting items from,
192-196
e-mailing, 83
high-key, 89
importing, 65-69
low-key images, 90
purchasing, 69
resampling, 32-33
rights-managed, 69
rotating, 198
royalty-free, 69
scaling, 30-31
sharing, 83
size of, changing, 29-33
text in, 286-287

Import command (File
menu), 68
importing images
discussed, 65
downloading from digital
cameras, 67-68
opening images into
Photoshop, 66-67
scanning prints, 68-71
indentation, 283-284
InDesign tool, 15
indexed color mode, 109-110
inkjet printers, 36, 81-82
Inner Glow layer effect, 258
Inner Shadow layer
effect, 256
installation, Photoshop
installation considerations,
20-22
reinstallation, 63
interface panel preferences,
55-56
interpolation, 77
Inverse command, 170
Invert adjustment, 122

o]o

jaggies, 26, 162
JavaScript utility, 343
JPG/JPEG file format
basic description of, 38-39
Camera Raw plug-in
with, 138
resaving images in, 41
justification, paragraphs,
283, 290

oK o

kerning, 281
keyboard shortcuts
about this book, 4
basic description about, 18
customizing, 52
filters, 317

function keys, 50
menu commands, 44
Undo command, 18
keywords, assigning to
images, 73
Keywords tab (Adobe Bridge
program), 73

o/ o

LAB color mode, 110
Label menu (Adobe Bridge
program), 73
landscape print mode, 76
laser printers, 82
lasso selection tools, 165-167
Lasso tool, 167
layer masks, 178-179, 232
Layer Style dialog box,
253-255
layer styles
adding to Styles panel, 267
applying, 250
basic description of, 247
Bevel and Emboss effect,
258-259
blending modes, 264-266
color, 254
Color Overlay effect, 261
custom, 251-255
defined, 248
deleting, 250
drop shadows, 252, 255
Global Light option, 252
Gradient Overlay effect, 262
hiding, 253
Inner Glow effect, 258
Inner Shadow effect, 256
loading, 251
opacity values, 264-265
Outer Glow effect, 256-257
Pattern Overlay effect, 262
preserving, 268
replacing, 251
Satin effect, 260
saving, 267-269



size of, changing, 253
Stroke, 263
Styles panel, 250-251
text, 274
layers. See also adjustment
layers
background, 205
basic description of,
202-203
blending modes, 204-207
clipping groups, 208-209
feathering, 209-210
fill values, 207-208
layer styles, 231
linking, 203
nested groups, 203
opacity values, 207-208
shape, 224
stacking order, 203
leading text, 281, 290
Lens Blur filter, 322
lens correction, Camera Raw
plug-in, 153-154
Lens Correction filter,
324-325
Levels correction, 94-96, 116
lightening images, 105
line screen frequency, 36
Line tool, 226-227
lines, dashed and dotted, 379
linking layers, 203
liquefy tools, 329-331
loading
layer styles, 251
selections, 175
lossy compression, 41
low-key images, 90
luminance, 127, 150
luminance noise, 192
Luminosity blending
mode, 207

ol o

Magic Wand tool, 168
Magnetic Lasso tool, 167
margins, 290

marquee selection tools,
162-165
Masking slider, 151
mask-related selection
commands, 174-175
masks
adding to layers and Smart
Objects, 178-179
vector paths, 179, 239
Match Color dialog box,
126-127
MATLAB feature, 367
Measurement Scale feature,
364-365
medical imagery review,
367-368
megapixel (MP), 27
memory usage
preferences, 57
menus
commands, 44-45, 51, 56
customizing, 51
ellipsis (...), 44
panel, 46
submenus, 44
Merge to HRD command,
219-221
messages or warnings,
actions, 340
metadata, 135, 348
Midtone Contrast slider,
Shadow/Highlight
adjustment, 103
midtones, 89
Mirror tool, 330-331
modifier keys, 48-49
moiré patterns, 70-71
monitor resolution, 28
Motion Blur filter, 322
moving
anchor points, 241-242
panels, 45, 50
MP (megapixel), 27
multichannel color mode,
110
Multiply blending
mode, 206, 257

o\ o

NAPP (National Association
of Photoshop
Professionals), 10, 371

Navigator panel, 193

Nearest Neighbor resampling
algorithm, 34

nested groups, layers, 203

New Action dialog box, 338

New command (File menu),
66

noise

Color Noise Reduction
slider, 149

Despeckle command, 192

luminance, 192

Reduce Noise filter, 191,
325-327

Normal blending
mode, 206, 257

o () o

opacity values, layer styles,
207-208, 264-265
Open As Smart Object
command
(File menu), 17
Open command
(File menu), 66
Open Image/Open Copy
button, Camera Raw
plug-in, 156
open paths, 234
Open Recent command (File
menu), 75
opening
image files, 17
images into Photoshop,
66-67
OpenType fonts, 284
Options bar, 45, 47-48
organization
about this book, 2-5
Adobe Bridge program,
72-74

Index 3 95
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organization (continued)
folder structure creation,
71-72
image files, renaming, 75
subject-based schemes, 71
Outer Glow layer effect,
256-257
Output panel (Adobe Bridge
program), 348
overlapped paths, 244
Overlay blending mode,
206, 257

oo

page layout, 14-15, 36
page setup options,
printing, 79
Paint Bucket tool, 308
painting
airbrushing, 301
in alpha channels, 177
Blur tool, 307
Brush tool, 298-302
Brushes panel, 310-314
brush-using tools, 305-307
Burn tool, 307
Clone Stamp tool, 307
color selection, 303-305
Dodge tool, 307
Eraser tool, 302-303
gradients, 309-310
History Brush tool, 307
Pattern Stamp tool, 307
Pencil tool, 302
photo to painting effect,
373-374
Sharpen tool, 307
Sponge tool, 307
toning tools, 307
panels
Adjustments, 93
auto-collapsing, 56
Brushes, 310-314
Character, 280-282

controlling content of
number of, 47
expanding/collapsing, 45
floating, 45
hiding, 45, 50
Histogram, 88-92
menus, 46
moving, 45, 50
Navigator, 193
Options bar, 45
Paragraph, 283-284
pickers, 47
redisplaying, 56
remember panel location
preferences, 56
resizing, 46
Styles, 250-251, 267
Tool Presets, 53
troubleshooting, 63
panoramas, 217-219
PANTONE Web site, 62, 80
Paragraph panel, 283-284
paragraphs
alignment, 283, 290
indentation, 283-284
justification, 283, 290
margins, 290
spacing before/after, 285
type containers, 288-289
word wrap, 288
Parametric panel, Camera
Raw plug-in, 148
Paste command (Edit menu),
42, 159, 289
Patch tool, 187
Path Selection tool, 241
paths
activating, 239
anchor points, 233-234,
241-244
clipping, 238-239
closed, 234
combining, 244
compound, 244
control points, 234
creating selections from, 240

curved segments, 235-236
custom fonts, 245-246
customizing, 241-245
deleting, 240
deleting areas within, 244
direction lines, 233
duplicating, 240
filling, 239
Freeform Pen tool, 236-237
open, 234
overlapped, 244
renaming, 238
saving, 237
segments, 233
shape layers, 238
straight segments, 234
subpaths, 244
vector mask, 239
Pattern Overlay layer
effect, 262
Pattern Stamp tool, 307
patterns
pasting, 214
repeating, 194, 215
PDF file format
basic description of, 38, 40
image sharing, 83
presentations, 348-350
pen switch, Wacom
tablet, 383
Pen tool, 234, 236
Pencil tool, 302
people portraits
double chin minimizing
effects, 189
glasses, de-glaring, 189
Red Eye tool, 186-187
smooth skin effects,
372-373
teeth whitening effects, 190
waist reduction effects, 188
wrinkle reduction
effects, 187
Performance panel
preferences, 57-58
perspective, 197, 210
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Photo Filter adjustment, 121
Photomerge tool, 217-219
photos. See images
Photoshop
basic description of, 9-12
installation, 20-22
starting, 16
Photoshop CS4 Bible,
Professional Edition, 357
Photoshop CS4 Extended
3D artwork, 361-362
32-bit images, 358-360
basic description of, 13
Count tool, 366
DICOM feature, 367
MATLAB feature, 367
Measurement Scale feature,
364-365
medical imagery review,
367-368
overview, 357-358
Smart Objet stack
modes, 360
video layers, 362-363
PhotoSpin Web site, 1
pickers, 47
picture packages, 354
pictures. See images
pin cushioning, 324
pivot points, 148
pixels
basic description of, 25-26
defined, 10, 24
MP (megapixel), 27
pixel-filled shapes, 227
zoom example of, 25-26
pixels per inch (ppi), 27
Place command (File menu),
204, 367
plug-ins
Photoshop installation
considerations, 21
setting preferences for, 60
Plug-Ins panel
preferences, 60
PNG file format, 39

point of origin, 293
Point panel, Camera Raw
plug-in, 149
point type text, 271
Polygon Lasso tool, 167
Polygon tool, 226-227
portrait print mode, 76
posterization, 95-96, 112
Posterize adjustment,
122-123
PostScript page description
language, 225
PowerPoint, file formats for,
40-42
ppi (pixels per inch), 27
preferences
basic description of, 54
cache levels, 58
channel, 56
cursor, 58-59
Cursors panel, 58-59
File Handling panel, 57
gamut, 59
General panel, 55
GPU setting, 58
Guides, Grid & Slices
panel, 60
history state, 58
Interface panel, 55-56
memory usage, 57
open document as tabs, 56
Performance panel, 57-58
plug-in, 60
Plug-Ins panel, 60
remember panel
location, 56
resetting back to default, 63
ruler setting, 60
scratch disk, 57
screen mode, 56
slice number settings, 60
tool tips, 56
transparency, 59
Transparency & Gamut
panel, 59

Type panel, 60
Units & Rulers panel, 60
presentations, 36, 348-350
Preset Manager tool, 47, 230
preview area (Camera Raw
plug-in), 144
Print command
(File menu), 79
Print dialog box, 79-80
printer resolution, 28
printing
alternatives, 81-82
aspect ratio and, 76-77
basic description of, 75
color management
solutions, 80-81
commercial printing, file
formats for, 40
dye sublimation printers,
82
good color technique,
78-80
inkjet printers, 36, 81-82
landscape mode, 76
laser printers, 82
multiple documents, 380
page setup options, 79
portrait mode, 76
print sizes, 76-77
printer selection, 79
resolution
considerations, 78
tonal range, 82
PSB file format, 38
PSD file format, 17, 37, 40
Pucker tool, 330
punctuation marks, 285
purchasing images, 69
Push Left tool, 330
push/pull tools, 329-331

oQo

quarter tones, 98
Quick Mask mode, 178
Quick Selection tool, 167-168

397
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Radial Blur filter, 322
Radius sliders, Shadow/High-
light adjustment, 103
rain and snow effects, 376
raster images, 12, 109, 224
ratings, assigning to
images, 73
Raw file format
Camera Raw update, 137
metadata, 135
sidecar files, 135
unprocessed image data,
133-134
RBG working space, 61
Reconstruct tool, 329
Rectangle tool, 226
rectangles, rounded, 226
Rectangular Marquee tool,
163-164
Red Eye Removal tool,
139, 141
Red Eye tool, 186-187
Reduce Noise filter, 191,
325-327
Refine Edge tool, 168-169
renaming
image files, 75
paths, 238
repeating patterns and
textures, 194, 215
Replace Color command,
128-129, 377
resampling algorithms, 32, 34
resampling images
Crop tool, 77
cropping versus, 33
how to, 32
Reselect command, 170
resizing panels, 46
resolution
camera, 27
defined, 26
image, 27-32, 35-36
monitor, 28

print considerations, 78

printer, 28

scan, 69-70

workflow options, 145
response curves, 220
Retouch tool, 139-140
reversible adjustments, 180
RGB color mode, 108-109
rights-managed images, 69
Rotate tool, 11
rotating images, 198
rounded rectangles, 226
ruler setting preferences, 60
Ruler tool, 198

oS e

Satin layer effect, 260
Saturation tab, Camera Raw
plug-in, 152
Save Actions command, 336
Save As dialog box, 37
Save command (File
menu), 36
Save Image button, Camera
Raw plug-in, 156
saving
image files, 17
layer styles, 267-269
paths, 237
resaving images in JPEG
format, 41
selections, 175, 211
scale, 210
scaling
images, 30-31, 35
text, 281
scanning prints
moiré patterns, 70-71
Photoshop-compatible
plug-ins, 68
scan resolution,
determining, 69-70
scattering, brush tips, 312
scratch disk preferences, 57

Screen blending mode,
206, 257
screen mode preferences, 56
scripts
AppleScript utility, 343
defined, 335
downloading, 343
Image Processor
prerecorded, 344-346
JavaScript utility, 343
Visual Basic utility, 343
S-curves, 98
segments, path, 233
Select All command, 170
selections
adding to, 164
anti-aliasing, 160-162
basic description of,
158-159
Border command, 172
Color Range command,
170-171
complex, 211-212
Contract command, 173
controlled, 166
creating from paths, 240
Deselect command, 170
Direct Selection tool,
179, 241
Expand command, 172
feathering, 160-162, 173
filters, 177
intersection with, 164
Inverse command, 170
lasso selection tools,
165-167
layer masks, 178-179
loading, 175
Magic Wand tool, 168
marquee selection tools,
162-165
mask-related selection
commands, 174-175
Path Selection tool, 241
Quick Mask mode, 178



Quick Selection tool,
167-168
Refine Edge tool, 168-169
Reselect command, 170
saving, 175, 211
Select All command, 170
sharpening, 177
Smooth command, 172
subtracting from, 164
transforming shape of,
173-174
uses for, 158-159
Selective Color
adjustment, 125
sepia effects, 153
Shadow/Highlight adjust-
ment, 100-103, 125
shadows
Histogram panel and, 89
minimizing, 106
Shape Blur filter, 323
shape layers, 224, 238
shapes
appearance of,
changing, 231
custom, 229-230
Custom Shape tool, 227-228
layer masks, 232
multicolor shape layer
simulation, 231-233
pixel-filled, 227
rounded rectangles, 226
squares, 226
symbol fonts, 229
sharing images, 83
Sharpen filters, 317-318
Sharpen tool, 307
sharpening selections, 177
Shear filter, 332
shortcuts. See keyboard
shortcuts
sidecar files, 135, 142
Single Column Marquee tool,
163, 165
Single Row Marquee tool,
163, 165

sites. See Web sites
16-bit color, 112
size
of fonts, 278
of images, changing, 29-33
of layer styles,
changing, 253
print, 76-77
workflow options, 145
sketches, 374-375
skin, smoothed effects,
372-373
slice number setting
preferences, 60
Smart Blur filter, 192, 323
Smart filters, 315-317
Smart Guides, 60
Smart Objects
adding masks to, 178-179
applying Smart filters to,
316-317
basic description of, 145
creating from existing
layer, 204
stack modes, 360
uses for, 203-204
Smart Sharpen filter, 319-320
smooth anchor points, 234,
241-243
Smooth command, 172
smooth skin effects, 372-373
snow and rain effects, 376
Soft Light blending
mode, 206
Space workflow option, 144
spell checking, 282
Spherize filter, 332
Split Toning tab, Camera Raw
plug-in, 153
Sponge tool, 190, 307
spot channels, 40
spot color, 115, 305
Spot Healing Brush tool,
194-195, 306
squares, 226
stack modes, Smart
Objects, 360
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stacking order, layers, 203

stacks (Adobe Bridge
program), 74

stamp tools, 307

star ratings, assigning to
images, 73

starting

Adobe Bridge program, 72
Photoshop, 16

straight path segments, 234

stroke, brush, 313

Stroke command (Edit
menu), 308

Stroke layer effect, 263

styles, font, 278

Styles panel, 250-251, 267

submenus, 44

subpaths, 244

subscript characters, 281

subtractive color mode, 109

Suitcase Fusion font book, 22

superscript characters, 281

support, 63

Surface Blur filter, 323

sweet spot, 39

symbol fonts, 229

oJ e

tablets, Wacom. See Wacom
tablets
tabs, open document as tabs
preference, 56
teeth whitening effects, 190
Temperature and Tint
sliders, 139
text
alignment, 279
anti-aliasing, 279
Character panel, 280-282
dictionaries, 282
faux styles, 282
flipped, 294-295
fonts, 278, 296
glass text effect, 377
hyphenated, 284, 291
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text (continued)
images in, 286-287
kerning, 281
layer styles, 274
leading, 281, 290
Paragraph panel, 283-284
paragraphs, 283-284
point of origin, 293
point type, 271
punctuation marks, 285
scaling, 281
spell checking, 282
subscript and superscript
characters, 281
type, 276-277
type, adding to paths,
293-294
type mask tools, 275-276
type-shaped selection, 275
warp type, 272, 279, 292
texture, 194, 215, 313
Texturizer filter, 198
Thaw Mask tool, 331
32-bit images, 358-360
3D artwork, 361-362
Threshold adjustment, 123
thumbnails, 351-353
TIFF file format, 38, 40, 138
Tint and Temperature
sliders, 139
tips, brush, 311-312
tolerance setting, Magic
Wand tool, 168
Tonal Width sliders,
Shadow/Highlight
adjustment, 102
tonality
auto corrections, 92-93
Auto Tone correction, 92
basic description of, 87
basic tonal adjustment
example, 88
Curves adjustment, 97-100
darkening, 105
eyedroppers, 96-97
Histogram panel, 88-92

lightening, 105
quarter tones, 98
tonal range, 88
Tone Curve tab, Camera Raw
plug-in, 148-149
toning tools, 307
Tool Presets panel, 53
tool tip preferences, 56
tools
Bloat, 330
Blur, 307
Brush, 298-302
Burn, 105, 189, 307
Clone Stamp, 187, 193
Color Picker, 304
Color Replacement,
192, 306
Color Sampler, 114, 139
Count, 366
Crop, 77, 139-140
Custom Shape, 227-228
Direct Selection, 179, 241
Dodge, 105, 189-190, 307
Ellipse, 226
Elliptical Marquee, 163-164
Eraser, 302-303
Forward Warp, 329
freeform, 48
Freeform Pen, 236-237
Freeze Mask, 331
Graduate Filter, 141
Hand, 139, 325, 331
Healing, 187
Healing Brush, 306
History Brush, 18, 307
Lasso, 167
lasso selection, 165-167
Line, 226-227
liquify, 329-331
Magic Wand, 168
Magnetic Lasso, 167
marquee selection, 162-165
Mirror, 330-331
modifier keys, 48-49
Options bar, 47-48

Paint Bucket, 308

Patch, 187

Path Selection, 241

Pattern Stamp, 307

Pen, 234, 236

Pencil, 302

Photomerge, 217-219

Polygon, 226-227

Polygon Lasso, 167

Preset Manager, 230

presets, 53

Pucker, 330

Push Left, 330

push/pull, 329-331

Quick Selection, 167-168

Reconstruct, 329

Rectangle, 226

Rectangular Marquee,
163-164

Red Eye, 186-187

Red Eye Removal, 139, 141

Refine Edge, 168-169

Retouch, 139-140

Rotate, 11

Ruler, 198

shape, 226-227

Sharpen, 307

Single Column Marquee,
163, 165

Single Row Marquee,
163, 165

Sponge, 190, 307

Spot Healing Brush,
194-195, 306

Thaw Mask, 331

Turbulence, 331

Twirl Clockwise, 330

Type, 273-274

Vanishing Point, 14, 213-217

White Balance, 139

Zoom, 139, 325, 331

Tools menu options (Adobe

Bridge program),
346-348



Transform Canvas command
(Image menu), 198
Transform command (Edit
menu), 42, 160
transformation, selection
shape, 173-174
Transparency & Gamut panel
preferences, 59
transparency adapters, 70
transparency grid, 267
transparency preferences, 59
Turbulence tool, 331
turning off warnings, 61
Twirl Clockwise tool, 330
type containers, paragraphs,
288-289
Type panel preferences, 60
Type tool, 273-274

olf o

underscore (), 343
undo operations, 18-20
Units & Rulers panel
preferences, 60
units of measurement
actions, 339
ruler setting preferences, 60
Unsharp Mask filter, 318-319
usability, about this book, 1-2

o o

Vanishing Point tool, 14,
213-217

Variations adjustment, 125,
129-130

vector artwork, 223
vector mask path, 239
vector paths, 179, 223-225
Vibrance adjustment,

118, 147
video layers, 362-363
vignetting features, 154-155
viruses, 20-21
Visual Basic utility, 343

o[/ o

Wacom tablets
accessories, 384
Cintiq tablets, 384
convenience of using, 382
ease of use, 381-384
pen switch, 383
preferences, setting, 383
pressure sensitivity, 383
waist reduction effects, 188
warnings
actions, 340
turning off, 61
warp
Forward Warp tool, 329
warp type text, 272,
279, 292
watermarks, 353
Web galleries, 354-356
Web graphics file formats, 39
Web pages, image resolution
and, 36. See also page
layout
Web sites
Adobe, 63
ColorVision, 62
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Datacolor, 80
Extensis, 22
image sharing, 83
PANTONE, 62, 80
PhotoSpin, 1
X-Rite, 62, 80
Web-safe color, 305
white background deletion,
377-378
White Balance tool, 139
white point, 146
Word file formats, 40-42
word wrap, 288
workflow options, Camera
Raw plug-in, 144-146
workspaces
accessing saved, 50
basic description of, 49-50
gaining more room, 50
how to customize, 50-51
preset, 51
zoom options, 50
wrinkle reduction effects,
106, 187

o X o
X-Rite Web site, 62, 80

o/ o

zoom options
within workspace, 50
Zoom tool, 139, 325, 331
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